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Chapter 1: How to Use this Manual Chapter 1
1. How to Use this Manual

Introduction

Welcome to the Magaya Supply Chain Solution Operations Manual.

This manual is designed to teach you how to perform operations procedures 
with the Magaya Supply Chain Solution.

The Magaya Supply Chain Solution logistic software is designed to cover the 
complete logistics process of merchandise delivery from seller to buyer. The 
software gives you all the functionality of the Magaya Cargo System, Magaya 
WMS, and Magaya Distribution System. You also get additional sales and 
purchasing capabilities to connect all your processes from Quotations to 
Purchase Orders and shipments.

How This Manual is Organized

This operations manual is designed to be task oriented. You can skip to any 
topic you need and get step-by-step procedures for all the operations tasks 
performed in the Magaya Explorer. It includes links to related topics in the 
Magaya Knowledgebase. This manual is organized into the following sections 
and topics:

• Introduction to the Magaya Supply Chain Solution and an overview of the
purchasing and sales process from the perspective of a logistics provider
and for the wholesaler. See how the software features perform the steps
and connect the transactions.

• The next group of chapters explains how to configure the software for the
first time, how to set up your warehouse to match your operations, and
how to identify items in the warehouse.

• The chapter on Purchase Orders explains how to create Purchase Orders
(PO) and how to convert the PO into a Pickup Order to arrange the
pickup of the items. When the merchandise arrives at the warehouse, the
Pickup Order can be converted into a Warehouse Receipt (WR). The
accounting department can instantly use the original PO to create a bill for 
Accounts Payable.

• The chapter on Sales Orders shows you how to create Sales Orders in the
Magaya Supply Chain Solution when customers request merchandise. See
 1
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how the information in the Sales Order can be transferred to a shipping 
order and sent to the integrated accounting system where invoices are 
automatically created. Local deliveries and international shipping can be 
processed with all trade documentation included. Learn how to use the 
Inventory Organizer and enter Resale Items into your system. If you’re 
selling online (or your customers are), you can connect the sales orders 
with the e-commerce platform, Logistico.

• The Jobs chapter defines Jobs and how the Supply Chain Solution helps
you track the progress of a Job. Also see all the features in the Jobs screen
and learn how your customers can view the status of their Jobs online.

• The next group of chapters explain how to create Pickup Orders, receive
cargo, and write a quotation for services you offer.

• The last two chapters explain how to manage and move items in the ware-
house and how to release cargo from the warehouse. All the functions that
the Supply Chain offers are explained in combination with the WMS
Mobile handheld units, which can be used in all steps of the process.

For details on installing the software, see the Magaya Software Installation 
Guide available on the Learning Center link found on Page One, the welcome 
screen in your software. Also see the Knowledgebase:

Magaya Software Installation Steps

http://knowledge.magaya.com/#/article/install_software_steps

For details on navigating the interface of Magaya software, see:

Navigating the Interface

http://knowledge.magaya.com/#/article/magaya_explorer_intro

About Magaya Software

Magaya software uses a database server to store and save all your company 
information and logistics transactions. The software also uses a communication 
server to allow your customers (with permissions) to view their transactions. 
You can also communicate with other companies who are using Magaya soft-
ware access your data remotely. The operations and accounting functions are 
integrated in the software.

Magaya offers the following software products:

• Magaya Cargo System
2
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• Magaya Warehouse Management System (WMS)

• Magaya Supply Chain Solution

• Magaya Distribution System

Magaya also offers plug-ins for additional functionality:

• Magaya LiveTrack for online tracking of shipments, submitting sales
orders, shipping orders, a way for your customers to pay their invoices
online, request bookings and more

• Magaya WMS Mobile for wireless scanners

• Magaya File Mile app for deliveries and pickups

• Magaya Transaction Tracking

• Magaya AMS (Automated Manifest System)

• Magaya AES (Automated Export System) for filing EEI to the US Customs 
ACE portal

• Magaya ISF (for the 10+2 Customs initiative)

• Magaya XML API and an EDI

• Magaya INTTRA (to communicate with ocean carriers)

• Magaya VIN Decoder for shipping cars and other vehicles

• Magaya Bar Coding

• Magaya ABI Integration

• Magaya Scale Integration

• Magaya Express Link integration with UPS and FedEx

• Magaya Cloud
 3
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Where to Find Help

Click the Help menu in the top toolbar of your software to access resources such 
as videos, user manuals, the Knowledgebase, and more.

Page One is the welcome screen in your software that contains links to all these 
resources plus a way to contact Magaya Tech Support and view Support 
requests and case history for your Magaya account.

Tips and suggestions are also available in Magaya software on dialog boxes and 
other locations in the software program. Click on the “Magaya Tip” button to 
access resources such as how-to articles and videos. (They can be turned off in 
Maintenance > Configuration > General > “Show learning tips and hints.”)

Additional user manuals and video tutorials are available from the Magaya 
Learning Center page, found in Page One. Videos are also on the Magaya Soft-
ware YouTube channel.

If you have questions or need help, please contact Magaya Corporation:

Phone: (786) 845-9150

Email:support@magaya.com

Use of Magaya software and its documentation are governed by the terms set 
forth in your license.

Copyright © 2017 by Magaya Corporation. All rights reserved.
4



5

Chapter 2 Chapter 2: What is the Magaya Supply Chain Solution?

Chapter 2: What is the Magaya Supply Chain 
Solution?



Chapter 2 Wholesaler and 3PL Overview
Wholesaler and 3PL Overview

Introduction to Magaya Supply Chain Solution Software

The Magaya Supply Chain Solution is software designed for:

1) wholesalers who own and resell inventory, and

2) for distributors and logistics providers who do not own inventory.

The software also provides shipping procedures. Let’s look at the features in the 
software specifically for wholesalers (and others who buy and sell items) and the 
features for distributors.

Software Features for Wholesalers

We will use the term “wholesalers” here to define businesses that buy and own 
inventory. That inventory becomes an asset of the business.

These inventory items are defined in your Magaya software in the Warehousing 
subfolder “Inventory Item Definitions”. These definitions can contain as much 
information as needed about an item such as its dimensions, a Part Number or 
SKU, the manufacturer, the income and expense accounts that the item is 
assigned to, a minimum stock quantity and a low-inventory alert notice, and 
other custom information specific to your business.

The benefit of entering this item detail into your Magaya software is to speed up 
the receipt and processing of items you handle regularly. As a result, the item 
data does not have to be manually entered every time the items are ordered, 
received, or shipped. When used with wireless handheld scanners, the software 
enables even greater efficiency, accuracy, and speed. The wireless handheld 
scanners running the Magaya WMS Mobile application can be used for every 
step of the process.

The process of buying goods begins with a Purchase Order (PO). The PO 
contains all the details of the purchase such as a description of the items, the 
quantity, the supplier, the prices, payment terms, etc. Magaya software also 
gives you the option to add custom fields to the PO form so you can enter and 
track information that you need.
6
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The PO can be entered into the Magaya Supply Chain Solution by you or your 
staff. Magaya software also gives you the option to receive Purchase Orders into 
your Magaya system via an EDI (Electronic Data Interchange).

Magaya software also has many features that enable the automation of many 
aspects of PO creation and management. For example, when the items arrive at 
the warehouse, the PO can be automatically converted into a Warehouse 
Receipt. If your customer requests a pickup of the items, a Pickup Order can also 
be created based on the PO. More details on these automated features and 
step-by-step procedure of how to create Purchase Orders are explained in the 
topic “Create Purchase Orders.”

The following flowchart illustrates the processes performed by wholesalers:
 7
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When items arrive at the WH and are stored, the related financial transactions 
are created. For example, Magaya software connects the PO to the built-in 
accounting system and can convert the PO into a Bill. The inventory items are 
also added to the company assets.

When your customers want to buy items, you can create a Sales Order in your 
Magaya system to sell the items, or accept a Sales Order from the customer via 
the Online Sales Order feature that is connected to your Magaya system.

To ship the items, you can create a Cargo Release or Shipment transaction from 
the Sales Order. The system also enables you to accept online shipping orders 
and instructions from your customers. An invoice with all the details can also 
be created from the Sales Order. The items sold are calculated as income. 
Step-by-step procedures for these processes are explained in the topic “Create 
Sales Orders.”

Software Features for Distributors

For Distributors who do not own the inventory, the Magaya Supply Chain Solu-
tion provides features that help you manage the entire process of handling 
inventory items for your customers, from the receipt and storage of goods 
(warehousing processes), to the shipping or local delivery. The Magaya Supply 
8
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Chain Solution includes features that apply to each part of the distribution 
process as shown in this flowchart:

The process begins when you have set up your Inventory Item Definitions and 
a customer sends you a Purchase Order of the items they want to buy.

The Magaya Supply Chain Solution provides features for arranging a pickup of 
items and for receiving items that are delivered. A Warehouse Receipt (WR) is 
created to record the items received, the date and time of the arrival, and other 
details. If a Pickup Order is created, all the details in it can be converted into a 
WR to avoid re-entering the same data.

The Magaya Supply Chain Solution provides features for all the steps of 
receiving and storing items. Locations of items can be entered manually or via 
a wireless handheld scanner running the Magaya WMS Mobile application. 
Wireless handheld scanners can be used in every step of the distribution process 
to improve speed and accuracy.
 9
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Details about items can be defined in your Magaya software to improve the effi-
ciency of receiving and managing items. Using the Inventory Item Definitions 
enables you to setup an item description once in your system and process those 
items quickly each time after initial data entry and avoid repeated data entry.

To offer a more complete service, you can use the built-in accounting processes 
to create invoices and bills. When customers want to buy items, the customer 
can place an order online using the Online Sales Order feature or you can create 
a Sales Order in your Magaya system. This feature is connected to your Magaya 
system so customers can view available inventory and place orders at any time.

To ship the items, you can create a Cargo Release or Shipment transaction from 
the Sales Order. The Magaya system also enables your customers to place orders 
online. An invoice with all the details can also be created from the Sales Order. 
The items sold are calculated as income. Step-by-step procedures for these 
processes are explained in the topic “Create Sales Orders.”

Additional Features Overview

The Magaya Supply Chain Solution also offers the following features to help 
wholesale businesses and distribution centers manage inventory:

• Wireless handheld scanners running the Magaya WMS Mobile applica-
tion can be used to streamline every step of the process

• Quotations can be converted into Sales Orders

• Track all steps of a project in the Jobs screen

• Remote access to your database for you, employees, and online access for
customers for real-time status updates of inventory and shipments

• Customization of documents and fields in dialog boxes to gather data for
transactions, reports, and more

• Liquidation and financial reports

The building block of all these capabilities is the Inventory Item Definition. See 
the topic “Inventory Item Definitions” in the Supply Chain Solution user 
manual or the Knowledgebase:

Creating Inventory Item Definitions

http://knowledge.magaya.com/#/article/create_inventory_item2
10
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Air Waybills

This article explains the fields in an air waybill (AWB).

Air Waybill Introduction and Fields

An Air Waybill (AWB) is a contract of the freight charges from the company 
that will handle air transportation to a customer. There are two types of AWBs:

• Master Air Waybill: This is a contract from an airline to a freight
forwarder.

• House Air Waybill: This is a contract from a company that handles the
transportation (for example a freight forwarder) to a customer (for
example a seller).

AWB Wizards Fill in the Fields:
11
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Magaya software fills in the fields with information from the shipment wizards. 
You can also enter text in the document, but you don’t need to.

We recommend using the wizards!

Templates: Magaya software includes different templates for AWBs. These are 
available to select while creating a shipment transaction with the wizard or from 
the “Add Doc.” button on the Shipment toolbar. See the section below for more 
on templates.

There are some fields that are different in the Master and in the House AWB. 
These are:

AWB Numbers:
 12
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The air waybill number is located on the top right-hand corner, the top 
left-hand corner, and on the bottom right corner of the form.

The AWB number is filled in from the “General” tab in the shipment transac-
tion screen and the shipment wizard of your Magaya system.

• Master AWB Number: The AWB number consists of the issuing carrier’s
three-digit IATA airline code number and a serial number of eight digits
(separated by a hyphen), including a check digit placed at the end. The
check digit is determined by using the unweighted Modulus 7 system: The
number is created automatically by adding 11 to each number until the
last digit totals 6. Then start over. Example: 777-12345675 (the number 5
at the end is the check digit) The next number will be 777-12345686. It is
acceptable to insert a space between the fourth and fifth digits of the serial
number.

• House AWB Number: is not created according to a standard.

Shipper name and address:

• Master: Displays the freight forwarder’s name and contact information.
(Shipper’s account number field is optional.)

• House: Displays the customer’s information, for example a seller.

Consignee name and address:

• Master: Displays the destination agent information. (Consignee’s account
number field is optional.)

• House: Displays the recipient’s information, for example a buyer.

The shipper and consignee information comes from the “Entities” tab of the 
shipment in your Magaya system.
13
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If filing an electronic air waybill (eAWB), the address and phone number are 
required for entities.

Accounting Information:

• Master: Displays the invoice numbers, purchase orders (PO), payment by
cash, check or the credit card number.

• House: Displays the invoice numbers, purchase orders (PO), and Master
Air Waybill number (MAWB).

Issuing Carrier’s agent name and city:

• Master: Displays the freight forwarder’s name and contact information.

• House: Displays the freight forwarder’s name and contact information.

NOTE: Ensure your profile is complete to avoid errors when filing.

The following fields are the same for master and house forms:

• Agent’s IATA Code: Displays the IATA code. (This is a seven-digit
number in non-CASS areas, and in CASS areas it is a seven-digit code
followed by a three-digit CASS address code and a check digit as deter-
mined by Modulus 7.) Note: CASS is Cargo Accounts Settlement Systems,
an electronic data processing method. Contact Magaya to learn more
about CASS.

• Account number: This field is optional for printed AWBs but required for 
eAWBs. See also the “Identification Number” field, which is also required.

• Airport of departure (address of first carrier) and requested routing:
This field displays the airport name or three-letter IATA code.

• To: Displays where the first carrier is going (enter the IATA airport code
or city that is the first transfer point)

• By First carrier: Displays the name of the first carrier or IATA two-char-
acter code.

NOTE:  The other fields “To” and “By” are to second or third destinations by
second or third carriers. Use as applicable.

• Reference number: This field is an option.

• Optional shipping information: optional

• Airport of destination: Enter the final destination airport name or city

Flight Date: Displays the date of the flight. The date and actual date are
filled from the “Routing” tab of the shipment transaction in Magaya.

• Currency: Indicate if the currency is US dollars, etc. Use the ISO
three-letter currency code applicable for the country of departure.
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• CHGS Code: Displays applicable charges code. This field is optional.

• WT/VAL and Other: For Weight and Valuation. Mark an X in the box for 
PPD (prepaid) or COLL (collect).

• Declared value for carriage: Displays declared value, or enter “NVD” for
No Value Declared. This field is found on the General tab of the shipment
transaction in Magaya.

• Declared value for customs: Displays a declared customs value, or enter
“NCV” for No Customs Value, or leave the field blank. This field is filled
in from the General tab of the shipment wizard screen. This field is found
on the General tab of the shipment transaction in Magaya.

• Amount of insurance: optional. (Magaya software has a connection to an
insurance portal. Ask Magaya about cargo insurance.)

• Handling Information: This field displays information carriers need.
Cargo-IMP (Interchange Message Procedures) codes and abbreviations
may be used. If dangerous goods are being shipped, they must be labeled
and a Shipper’s Declaration is required. The name of the person to be noti-
fied may be entered in this field. Enter names of accompanying docu-
ments such as Shipper’s Certification of Live Animals.

To display information in this field, enter it in the “Clauses” which is avail-
able in the shipment wizard on the General tab.

• NOTE:  SCI is for Special Customs Information such as European Union
(EU) destination country code.

Freight charges are displayed in the AWB from the Charges screen of the 
wizards (and/or shipment screens) into these fields of the air waybill:

• No. of pieces RCP: This is the number of pieces shipped and applicable
rating. RCP is Rate Combination Point and is used for combined rates.
Each rated group must be on a separate line (such as dangerous goods).

• Gross weight: This is the gross weight and mark K for kilograms and L for
pounds (lbs.). Enter the tare weight of the unit load device if applicable on
a separate line with the rate class of “X”.

• Rate class: This is the appropriate rate class code.

• Commodity item number: This is the appropriate rate class code. This
field is optional.
15
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Chargeable Weight

Chargeable weight is determined by comparing the gross weight and the volume 
weight (the space the items take up in the plane). The larger weight is the 
chargeable weight.

To calculate the volume weight, multiply the length by the width by height (all 
in inches) and divide by a dimensional factor.

The volume weight equation is:

Length × Width × Height ÷ Dimensional Factor = volume weight

Where the dimensional factor 166 is used for international freight

Or,

Where the dimensional factor 194 is used for domestic freight

Or,

Any other number defined by the carrier.

• Rate Class: This is the rate class for chargeable weight on separate lines.

• Rate/Charge: Use the appropriate codes to itemize the rate per charge, for
example “M” or “Min” for minimum charge.

• Total: This is the total charge or discount for each line entry. If a discount,
indicate a total discount with a minus sign.

• Nature and quantity of goods: (inc. dimensions or volume): This is a
general description of the items and greatest length, width, and height and
number of pieces. Indicate if any dangerous goods, live animals, consoli-
dations, etc. This field is found on the General tab of the shipment trans-
action in Magaya. The AWB document will include this description plus
the dimensions, which are found on the Commodity dialog box.
 16
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Sample Air Waybill

The following is a sample of an air waybill:

Also see: The topic “Due Agent Due Carrier” explains what charges are due to 
the agent and to the carrier.
17
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http://knowledge.magaya.com/#/article/AWB_due_agent_carrier

AWB Printing and Document Templates

For tips on printing AWBs and learning about the different types of document 
templates, see the topic “Air Waybill Printing Tips” in the Magaya Knowledge-
base:

http://knowledge.magaya.com/?search=AWB_print_errors

Magaya software includes different templates for AWBs. These are available to 
select while creating a shipment transaction with the wizard or from the “Add 
Doc.” button on the Shipment toolbar. Click the arrow on the side of the button 
to see options.

From this list, you can select standard documents which are included with 
Magaya software by default or any other documents or templates of your own.
 18
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The “Select Documents” dialog box also includes functions to access the 
Magaya Document Designer, a built-in application that allows you to customize 
documents. See the Magaya Knowledgebase for details:

http://knowledge.magaya.com/#/article/intro_document_designer

After creating a custom document, publish it and download it to your system ia 
the “File > Download Document” menu. Learn more:

http://knowledge.magaya.com/#/article/publish_template

Custom documents can be created by Magaya Corporation for a fee. Contact 
your Magaya sales representative for details.
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Configure Form Filling

Determine what information you want to display in documents, especially the 
AWB and Bill of Lading. Review the configuration options in the Maintenance 
folder.

For details on using this Configuration option, see the Knowledgebase topic 
“Introduction to the Configuration Menu” and the section “Form Filling”:

http://knowledge.magaya.com/?search=configuration_menu

This topic is also available as PDF in the Magaya Software Customization 
Manual.
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Bill of Lading

This article provides an overview to the document called the Bill of Lading and 
the fields in it.

2.4. Introduction to the Bill of Lading

A Bill of Lading (BoL or BL) is a contract used by ocean carriers and freight 
forwarders that lists the transportation related charges. The BL acknowledges 
that the goods have been received on board. The BL serves as a bill and a 
contract. There are two types:

• The Master Bill of Lading is a contract from an ocean carrier to a freight
forwarder. It contains a list of all the goods shipped. The freight forwarder
creates the Bill of Lading (BL) and sends it to the carrier who verifies it,
assigns a Bill of Lading number to it, and returns it to the freight
forwarder. On the Master Bill of Lading, the consignee is the destination
agent.

• The House Bill of Lading is a contract from the freight forwarder sent to
the customer, and it lists the goods for that customer only. On the House
Bill of Lading, the consignee is the entity receiving the goods, for example
a buyer.

Each type of BL lists marks and numbers (such as container and seal numbers), 
number of packages, a description of items shipped, routing information and 
more.
21
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Magaya software fills in the fields with information from the shipment wizards. 
You can also enter text in the document, but you don’t need to.

We recommend using the wizards!

2.4. Bill of Lading Fields

The following explains the fields on the Bill of Lading and what information is 
required in each field.

There are some fields that are different in the Master and in the House BL. These 
are:

Master: The issuing carrier’s name appears on the top of the BL document

House: The freight forwarder or NVOCC’s name displays on the top of the 
document

Exporter:

• Master: This is the freight forwarder name, address, and phone number.

• House: This is the customer’s name, address, and phone number (for
example, the seller)

Consigned to:
 22
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• Master: This is the destination agent (or custom broker, trucker, etc.) 
name, address, and phone number.

• House: This is the recipient’s name, address, and phone number (example, 
the buyer)

Notify Party/Intermediate Consignee:

• Master: This is the destination agent’s name, address, and phone number 
(or custom broker, trucker, etc. who needs to be notified to pick up 
goods).

• House: This is the destination agent’s name, address, and phone number 
(or custom broker, trucker, etc. who needs to be notified to pick up 
goods).

All consignee information is from the Entities tab in Magaya software’s ship-
ment wizards and screens.

Issuing Carrier’s agent name and city: (the same for Master and House)

• Master: This is the freight forwarder’s name and contact information.

• House: This is the freight forwarder’s name and contact information.

Document Number: (the same for Master and House)

• Master: This is the booking number. (The carrier assigns the booking 
number.)

• House: This is the booking number. (The carrier assigns the booking 
number.)

The Booking number and BL number are from the General tab in Magaya soft-
ware’s shipment wizards and screens.

The Bill of Lading (B/L) Number:

• Master: This number is entered by the carrier when they verify the BL that 
the freight forwarder sends. After verification, the carrier returns the BL 
to the freight forwarder. (Also fill in this number on the bottom of the 
form in the field labeled “B/L Number”.)

• House: The freight forwarder generates this number.

Export References:

• Master: Displays the Purchase Order (PO) numbers or invoice numbers.

• House: Displays the MBL number, invoice numbers, PO numbers.

Forwarding Agent: (the same for Master and House)
23
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• Master: This is the freight forwarder’s name.

• House: This is the freight forwarder’s name.

The following fields are the same for the House and Master Bill of Lading:

• Point (State) of Origin or FTZ Number:This is the state or Free Trade 
Zone where the goods originated. (From the Routing tab in Magaya soft-
ware’s shipment wizards and screens)

• Domestic Routing/Export Instructions:This field is optional. It can be 
the destination agent.

• Loading Pier/Terminal: Enter the pier and terminal number (or name) 
where the goods are loaded at the port. (From the Routing tab in Magaya 
software’s shipment wizards and screens)

• Type of Move:Enter the mode of transport such as “Vessel”

• Containerized (Vessel Only):Mark either Yes or No.

• Pre-Carriage by: Enter the name of the pre-carrier (who will move the 
goods from the point of origin to the port of loading). (From the Routing 
tab in Magaya software’s shipment wizards and screens)

• Place of Receipt by Pre-Carrier:The city where the pre-carrier received 
the goods. (From the Routing tab in Magaya software’s shipment wizards 
and screens)

• Exporting Carrier:The vessel’s name and voyage number, or carrier 
name Port of Loading/Export: Enter the name of the port where the goods 
will be shipped out. (From the Routing tab in Magaya software’s shipment 
wizards and screens)

• Foreign Port of Unloading (Vessel and Air Only): Fill in the name of the 
port where the goods will be unloaded. (From the Routing tab in Magaya 
software’s shipment wizards and screens)

• Place of Delivery by On-Carrier: Fill in the name of the destination of the 
goods. (From the Routing tab in Magaya software’s shipment wizards and 
screens)
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Here is the Routing tab for an ocean shipment:

Enter the description of the goods in the following fields:

• Marks and Numbers:This is the container number, seal number and
Warehouse Receipt number, or any numbers or labels that identify the
boxes

• Number of Packages:Enter the quantity of packages.

• Description of Commodities:Enter a general description of the goods
(this is not an itemized list unless required, for example, shipping heavy
equipment or vehicles which requires each VIN or item serial number
listed individually)

• Gross Weight: Weight of goods in kilos and/or pounds

• Measurement:Enter the volume in cubic feet or cubic meters
25
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Freight Charges, Weights, and/Measurements:This field is on the bottom of 
the form. This field lists the charges from the carrier to the freight forwarder. It 
pulls data from the Charges tab of the shipment and places them in the appro-
priate column: Prepaid or Collect. The system calculates the total.

You can print the document to sign it, email it or send it directly from your 
Magaya system to distribute copies to the appropriate parties.

2.4. Sample Bill of Lading Document

The following is a sample Bill of Lading form:
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The Magaya system includes many templates to choose from:

When new document templates are available from Magaya Corporation, you 
can add them to your system by going to File > Download Document. If you 
have custom documents, ensure you do not overwrite them by verifying all 
document names before downloading.

The Bill of Lading document template includes JavaScript that makes it easier to 
customize the template for your needs. Contact Magaya if you have questions.

For information on customizing documents, please see the Magaya Software 
Customization Manual, or contact Magaya.
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2.4. Configure Form Filling

Determine what information you want to display in documents, especially the 
AWB and Bill of Lading. Review the configuration options in the Maintenance 
folder.

For details on using this Configuration option, see the Knowledgebase topic 
“Introduction to the Configuration Menu” and the section “Form Filling”:

http://knowledge.magaya.com/?search=configuration_menu

This topic is also available as PDF in the Magaya Software Customization 
Manual.
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Supply Chain Overview

A supply chain is a network of providers of merchandise, from the raw materials 
suppliers to the final consumer. The supply chain consists of several entities 
such as logistics service providers, manufacturers, transporters, storage facili-
ties, wholesalers and retail stores. Let's look at the supply chain as a whole and 
then see the place of logistics in the chain (item 4 in the list below).

The components of the supply chain can be divided into the following parts:

1) Plan: Establish a plan for the whole supply chain. Planning and managing
the supply chain requires managing the business rules, supply chain
performance, data collection, inventory, capital assets, transportation,
planning configuration, regulatory requirements and compliance, and
supply chain risk.

2) Source: This part of the process focuses on managing the source of
supplies. The sources include stock (inventory), goods to be made to order 
(per specs), and goods to be engineered to order. Identify and select
sources of supplies. The Source part of the supply chain must manage
inventory, capital assets, incoming product, supplier network,
import/export requirements, supplier agreements, and supply chain
source risk.

3) Make = Manufacture: This part of the supply chain focuses on the manu-
facturing of the goods from the supplies (make to stock, make to order,
and engineer to order). The manufacturer must schedule production
activities, issue product, produce and test, package, stage product, and
release product to be delivered.

4) Deliver = Logistics: Logistics ensures economical and efficient movement 
of the goods and activities of all the suppliers involved in transporting,
warehousing and distributing goods. A logistics analysis provides visi-
bility into your supply chain. It will evaluate issues such as if there are
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enough warehouses in the right locations for cost-efficient shipment and 
receipt of goods, what information systems and technology is best to use, 
when to provide services in-house and when to outsource, etc. The role of 
a logistics service provider is to handle customer inquiries about carriers, 
schedule pick-ups, create quotations, and manage warehouse processes (if 
needed) and all the information, transportation, and the finished product 
inventories.

5) Returns: This part of the process manages the return of defective supplies
to the source, return of excess product, etc. This part of the supply chain
is also called reverse logistics.

NOTE:  Part of the above text was drawn from supply-chain.org.

A failure in any part of the supply chain will affect the entire process of getting 
goods from origin to destination.

Logistics Business Overview

The term “logistics” encompasses the whole industry of moving and storing 
goods.The term originated with the military and how they procured and moved 
supplies, troops, equipment, food, etc. as the army moved from place to place. 
Logistics integrates the transportation, inventory, warehousing, material 
handling, and packaging of goods.

Having a good logistics strategy in place ensure economical and efficient move-
ment of the goods and activities of all the suppliers involved.

The logistics process begins with a seller of goods. The seller may manufacture 
the goods and have their own warehouse, distribution center, and transporta-
tion. If they do not have all these capabilities, they will contract with other 
companies for these services so the seller can get their goods from the point of 
origin to buyers at the destination. The other companies the seller can contract 
with include:

• Carriers: Carriers transport goods by cargo ship, air, trucks or railroad.
The choice of transportation type depends on factors such as if the goods
need to be shipped domestically or exported internationally. There are
common carriers (available for hire) and private carriers.
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• Distribution Centers: A Distribution Center (D.C.) is a warehouse for 
storing large quantities of goods. A DC could be a specialized building for 
refrigerated goods or an air conditioned warehouse. Goods are sent to a 
DC from a port. Sometimes goods may need to be deconsolidated from 
the shipping container before delivery to a DC. Once the goods arrive at 
the DC, warehouse receipts are made and goods are palletized and put 
away in assigned zones.

• Logistics Service Providers are freight forwarders, NVOCCs, or 
third-party logistics (3PL) service providers. A logistics service provider 
deals with carriers and others to make the transportation arrangements 
for the seller (or a buyer). Arrangements include procuring price quotes 
for shipments and making the reservations; they create a Bill of Lading 
that lists the goods shipped, the destination, etc. They handle all the docu-
mentation needed for international shipping and U.S. Customs. They may 
also have a warehouse and/or distribution center and offer these services.

Logistics Service Provider Operations

The role of the logistics provider (for example a freight forwarder or NVOCC) 
is to handle all the delivery processes for their customers, from point of origin 
to destination. A logistics provider has a sales department, accounting depart-
ment, and staff who handle all the related operations or traffic department.

Creating a Quotation

The logistics provider’s sales department makes sales calls and takes orders from 
customers. They provide customers with a quotation of the price of the freight 
charges based on the quantity to be shipped, the distance, weight, volume, 
whether the goods will be shipped via air or sea, if there are any storage charges, 
etc. They book the shipment by checking schedules, looking at what they 
already have booked, what they have going out on carriers and if there is enough 
room left in a container to enable them to consolidate the customer’s shipment 
with other customer’s shipments in the same container, heading to the same 
destination. The logistics provider may also provide insurance for the goods.
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Pickup Orders, Warehouse Receipts, and Delivery Orders

When the customer agrees on the quotation price, the traffic department creates 
a pickup order. The logistics provider will pick up the customer’s goods and 
bring them either to the port for immediate delivery or to the logistics provider’s 
warehouse for later delivery. The logistics provider may have their own 
in-house trucking department for pickup, or they may outsource the trucking. 
The customer may bring the goods to the warehouse themselves. If there are 
multiple customers shipping goods to the same destination, the logistics 
provider will consolidate the goods into one container or air shipment to reduce 
shipping costs.

The logistics provider creates a warehouse receipt for the customer that serves 
as proof of receipt at the warehouse. When the goods are shipped to the port, 
the logistics provider issues a Delivery Order, whether the delivery is handled in 
house or outsourced. See the section “Warehouse Processes” below for more. 

Documentation

As part of its operations, the logistics provider creates the following mandatory 
documents:

• A Bill of Lading (Master and House versions)

• A Cargo Manifest
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The Master Bill of Lading is a contract between a carrier and a logistics provider 
(or customer) that contains a list of all the goods shipped. In the case of ocean 
transportation, the logistics provider creates it and sends it to the carrier who 
verifies it, assigns a Bill of Lading number to it, and returns it to the logistics 
provider.

The HouseBill of Lading is sent from the logistics provider to the customer, and 
it lists the goods for that customer only. Each Bill of Lading will list marks and 
numbers (container and seal numbers), number of packages, a description of 
items shipped, routing information and more.

On the Master Bill of Lading, the consignee is the destination agent. On the 
House Bill of Lading, the consignee is the recipient, for example a buyer.

If the carrier is an airline, the Bill of Lading is called an “air waybill.” For details 
on Air Waybills, see the topic “Air Waybills.”

If the carrier is ground transportation, the Bill of Lading is called a “Straight Bill 
of Lading”.

A cargo manifest lists all the goods and is used for all transportation types. On 
the cargo manifest, the customer is referred to as the “house”. The house 
number is listed, as is the shipper, consignee, description of the goods, the 
number of pieces, weight and volume.

Other documents that the logistics provider creates are optional. These include:

• A commercial invoice, a bill for the goods, which itemizes all the merchan-
dise by product name, part number and value

• A packing list, which itemizes the merchandise by weight and volume but 
not price

• A Dangerous Goods document, for hazardous materials cargo

• An EEI (Electronic Export Information), formerly the Shipper Export 
Declaration (SED), is required for items valued over $2,500 exported out 
of the U.S. and U.S. territories (if a logistics provider creates the EEI and 
submits it to Customs for the customer, the logistics provider may include 
a charge for this documentation on the invoice)

• Other documents vary depending on destination such as the European 
Union (EU), the Caribbean Community (CARICOM), the North Amer-
ican Free Trade Agreement (NAFTA), etc.

A copy of the Master Bill of Lading and the Cargo Manifest may be sent on the 
ship, and another copy is sent electronically to the customer and destination. If 
originals are required, then originals are sent via courier.
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In Magaya software, the data that fills the fields of these documents is entered in 
dialog boxes that you use to create the shipping transactions. For example, when 
you create a shipping transaction with the shipment wizard, the information is 
saved and displayed in these documents such as air waybills. You do not need 
to type these forms manually. All the data is also saved for use in reports, etc.

For more details on the BL, please see the topic “Bill of Lading.”

Destination Processes

At the destination, the logistics provider arranges the following:

• Customs clearance (or outsources this to a customs broker)

• Warehouse arrangements

• Transport from the port to the warehouse (unless the customer or buyer
picks up the goods from the port)

• Local delivery (unless the customer prefers to handle this): Local delivery
requires a cargo release document (also called a delivery order) which the
logistics provider creates. The services the logistics provider provides
could be to the customer’s door or to the port.
 34



Chapter 2
Invoicing/Liquidation

The logistics provider’s accounting department handles the invoicing, also 
called “liquidation”. During liquidation, the logistics provider calculates profit 
sharing with the destination agent. The accounting department also creates 
invoices for the customer. The customer’s invoice shows the freight charges 
calculated during the quotation by the sales department, any documentation 
charges or storage charges. These charges may be itemized or not itemized 
(all-inclusive).

If freight charges are prepaid by a single customer to the logistics provider, the 
logistics provider creates a credit memo that will show what the logistics 
provider will pay the agent. If it is not prepaid but collect, the logistics provider 
creates the invoice which will show what the agent will pay the logistics 
provider. If the logistics provider consolidated shipments from many 
customers, the charges will be calculated together. The profit sharing with the 
destination agent is determined depending on the total collect and total prepaid. 
When the goods are delivered to the buyer at the destination, the logistics 
provider’s involvement ends.

This flowchart illustrates the logistics provider operations:
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Warehouse Processes

Processing goods in and out of a warehouse or Distribution Center (DC) 
consists of four major steps:

1) Receive Goods: When goods arrive at the warehouse, the receiving
process begins. A Warehouse Receipt (WR) is issued. The WR serves as
proof that goods were delivered to the warehouse and are being stored
according to the arrangements made by the customer.

2) Put Away Goods: Goods are grouped according to type, placed in a
staging area, and put away. This process usually involves two employees –
one who receives the goods and one who puts them away. To save time,
goods can be grouped and put away directly instead of going to a staging
area. The “put away” process is also called “Move.”

3) Create and Fulfill a Shipping Order: When the sales department creates
a sales order, a Pick Order is also sent to the warehouse for processing. In
the warehouse, the pick and load orders are received on handheld devices
that are connected to a central database. Based on the order, the goods are
picked and often placed in a quality control area to verify quantities and
prepare them for loading.

Information about the movement and location of the inventory in the
warehouse is tracked with the handheld devices and updated in the central 
database, allowing the sales and purchase departments to see how much
inventory they have, what was sold, and what is needed. This enables ship-
ment and delivery of the correct amount of inventory when it is needed.
This practice is called “Just In Time” (JIT) inventory strategy. JIT main-
tains an efficient supply of goods by reducing the cost of storing excess
goods for long periods and increasing customer satisfaction by having
inventory when customers need it. To speed up the process of picking and
loading, goods are not required to stop in a staging area but may be taken
from their locations and placed directly in the loading area where a
Quality Control (QC) process will take place. QC ensures the orders are
correct. Packing slips are printed and placed on the boxes.

4) Load Goods: The goods are loaded onto a delivery truck for transport out
of the warehouse. Handheld units can be used to verify packing lists.
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Warehouse floor plans vary according to the type of warehousing business and 
factors such as the frequency that items are picked and loaded, the need for 
specialty storage space such as refrigerated or a cold storage area, etc.

Within a warehouse, zones and locations are defined so items can be stored and 
found again easily and to facilitate inventory counting. More details can be 
found in the topic “Warehouse Zones and Locations.”

Variations: A company such as a manufacturer may own a warehouse, and the 
sales orders come from within their own company so goods can be shipped out 
to customers.

If a company rents warehouse space from another company, the warehouse 
company provides the services for a fee such as receiving and storing goods, 
picking and loading, and delivery.

A freight forwarder may make arrangements for a customer’s goods to be stored 
and delivered.

Invoicing customers is done based on charges such as inland freight charges that 
calculate distance, weight and other factors, length of time items are in storage, 
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the type of storage such as refrigerated or bonded, commodity type, and other 
criteria. Invoices can be automated to recur on a regular basis.

Inventory Counting

Other warehouse processes include counting inventory. Two methods of 
counting inventory are cycle counts and physical counts.

Cycle counting is the process of verifying inventory accuracy by counting a few 
items every day and comparing the count to computer inventory records then 
reconciling differences. The cause of discrepancies is found and resolved.

Cycle counts can be done by grouping goods in different ways such as by what 
items move the fastest out of the warehouse or grouping goods by value. The 
method of counting goods based on the value of items is Pareto’s rule of “80/20” 
where 20% of the inventory will likely represent 80% of the inventory’s value. 
Goods are assigned a code of A, B, or C, depending on its value. The inventory 
can also be counted by dividing the warehouse into geographic sections or 
zones, and the inventory is counted by section.

A cycle count is done a few times per year while your business is running, unlike 
a physical inventory count that requires a business to shut down and count the 
stock.

Inventory is considered an asset by a company. There are different types of 
assets such as the company land, buildings, furniture, cash, etc., but “inventory” 
here means the goods for sale in the warehouse. Counting the inventory 
provides the company with a value of the inventory, which is put on the 
company’s balance sheet and used for tax assessment. A cycle count must be 
completed and reported to the company’s accounting department in time for 
the company to file its taxes. This timeframe is set by the accounting and/or 
finance department, and it may be 3 months, 6 months or some other time-
frame.

Depending on what the company wants to know about its inventory will dictate 
when it is counted, how often and by what method. The accounting and finance 
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objectives are often different from supply chain management objectives. The 
financial view of inventory is assessing its value to the company’s balance sheet, 
while the supply chain management view of inventory is geared toward supply 
efficiency, having enough inventory to ship when needed, and managing deliv-
eries for timeliness.

For example the goal of the “Just In Time” method of inventory is to ensure the 
right amount of goods are in the warehouse when sales orders come in for those 
goods so they can be shipped when the customer wants them, improving 
customer satisfaction.

While having a lot of inventory in a warehouse may make a company look like 
they have more assets, the supply chain point of view perceives this to mean that 
goods sit for long periods and do not rotate but take up valuable space in the 
warehouse which is costly and reduces operating-efficiency.

Sales Orders and Purchase Orders

The processes of creating sales orders and purchase orders link commercial 
transactions with the logistics/transportation processes.

The purchasing department in a company such as a wholesaler researches prod-
ucts to buy from suppliers and will issue a purchase order (p.o.) for the goods. 
The p.o. has a number and serves as a contract, defining any cancellation poli-
cies and protecting the seller if the buyer refuses to pay. It lists the goods, the 
quantities, price, and the shipping date and address. The goods are brought to 
the wholesaler’s warehouse where all the warehousing processes take place 
(warehouse receipt issued, put away orders, etc.). All the appropriate 
accounting processes are also done such as paying for the purchase. The goods 
in the warehouse are considered an asset by the accounting department.

The supplier creates a sales order when they get a request for goods. The 
supplier sends the sales order to the company making the purchase (the whole-
saler in this example). The sales order has a number associated with it.
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The accounting processes include subtracting the goods from the assets when 
they are sent out, recording the Cost of Goods Sold (COGS = the cost of the 
purchase price), and recording sales as income.

When the wholesaler gets a request for goods from a buyer, the buyer creates 
their own p.o. and sends it to the wholesaler. The wholesaler creates a sales order 
and sends it to the buyer. This sales order triggers a shipping order in the whole-
saler’s warehouse. In the warehouse, pick and load orders are created and 
fulfilled, and the goods are shipped.
 40



41

Chapter 3 Chapter 3: Installing Magaya Software

Chapter 3: Configure Magaya Software



Chapter 3
Introduction to Configuring your Magaya Software

In this section you will learn how to set up your Magaya software after you 
install it. You will learn how to use the Startup Wizard to set up your company 
information and the Accounting Wizard to set up your accounting information, 
how to make changes to information, how to set employee permissions and 
access to the different functions in the software.

Magaya software uses wizards to help you set up information about your 
company, your customers, and other details. The information is saved and 
made available for performing tasks such as creating Warehouse Receipts, 
invoices, shipping documents and other transactions.

Also see Chapter 5 of this manual for a description of the Maintenance folder 
and entering your company information in that folder. The same information 
is available in the Knowledgebase:

http://knowledge.magaya.com/#/article/maintenance_folder

Magaya Software Installation Overview

For information about installing Magaya software, see the Magaya Software 
Installation Guide on the Magaya.com Learning Center web page or see the 
following topics in the Magaya Knowledgebase. The guide covers:

• System requirements

http://knowledge.magaya.com/#/article/system_requirements

• Installation on a single computer, Client-Server Installation on a Network, 
and Terminal Services Installation

http://knowledge.magaya.com/#/article/install_software_steps

• Learn what software components are installed

http://knowledge.magaya.com/#/article/software_components_installed

• How to update Magaya software to the latest version

http://knowledge.magaya.com/#/article/topic_update_software
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• How to uninstall the software

http://knowledge.magaya.com/#/article/uninstall_magaya_software

• Where to find help

http://knowledge.magaya.com/#/article/contact_help

The Learning Center on Magaya.com includes links to manuals, tips, videos and 
more:

http://www.magaya.com/Learning-Center

Working with Wizards in the Software

The software includes many wizards. Using the wizards helps you save time 
because the information is automatically placed in documents such as Ware-
house Receipts, shipment documents, bills, and Cargo Releases. You do not 
need to retype your address, your customer’s address, etc. each time.

When you first install the software, the Startup Wizard opens. It enables you to 
enter the information about your company such as your address and phone 
numbers, select carriers and ports you use frequently, set the currency, and 
other information.

Options:You can begin working with the Magaya software without using the 
Startup Wizard or the Accounting Wizard. You can enter information as you 
work, and the software will save it.
 43



Chapter 3
As you work on different types of transactions in the software, you’ll see many 
of the wizards. They walk you through the steps of the procedures. To learn 
more about them, see each topic in the user manuals and in the Knowledgebase.
44



Chapter 3 How to Use the My Company Info Dialog Box
How to Use the My Company Info Dialog Box

You can use the My Company Info dialog box to enter information about your 
company information such as address and contact information. This informa-
tion will be used in documents in the system. If your company has different divi-
sions, you can enter them in the Divisions section of the Configuration menu 
under the Maintenance folder.

Note: If you filled in information into the Startup Wizard when you installed the 
software, the information will appear in the the My Company Info screen. If 
your company has multiple addresses, enter them in the My Company Info 
dialog box. Let’s see the features available in this dialog box.

1) Go to “File” and select “My Company Info.”

2) Enter information in the fields on the tabs such as phone number, website, 
and address(es). Most of the fields are optional.

3) Click the OK button to save the information and exit the dialog box when 
done entering information on all the tabs that apply.

The My Company Info dialog box offers you a place to add your company 
address and other addresses if you have additional offices in other locations.
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Then you can select from the address list in transactions such as the Entities tab 
of a shipment:

Let’s look at the first tab of the My Company Info dialog box, the General tab.
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On the General tab:

• The Identification Number can be any of the choices available in the drop-
down such as DUNS, Employee Identification Number (EIN) etc.

• The Magaya Network ID is automatically filled in.

Contacts: Add individuals here who are interested parties that you will send 
transactions to or need to notify. When you click the “Email” button, the names 
will be included in “To” field of the email. The names will be saved in the 
Contacts list of the Maintenance folder. Right-click a name for options.

On the Agent tab, enter codes such as your IATA, FMC, SCAC, and TSA 
numbers. These codes will be filled into Customs documents and others in the 
system if they are required.

To save data, click the “OK” button. You can return to the My Company Info 
dialog box at any time to add or change information as needed.

Note: Your company name and address will also be filled into the Magaya 
Network Community company profile. You can change or add information to 
publish the profile on the Magaya Network so you can connect with other 3PLs 
or agents, and they can contact you to partner with you for shipping and more. 
For more details, see the Magaya Software Communications Manual.

For an overview of the Magaya Network, see the Knowledgebase article:

http://knowledge.magaya.com/#/article/intro_magaya_network
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Adding Data into your Magaya System

Data can be entered manually as you work, or you can import data such as lists 
of your customers, agents, vendors and inventory items. To learn more, see the 
following topics in the Knowledgebase and user manuals:

Enter data in the Maintenance folder:

http://knowledge.magaya.com/#/article/maintenance_folder

Learn how to import a list of customers into your Magaya system:

http://knowledge.magaya.com/#/article/import_customer_list

For general tips about using the Import Wizard, see:

http://knowledge.magaya.com/#/article/import_wizard_tips
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Administrator Overview

Overview of System Administrator Tasks

This section provides a brief overview of the tasks for a person who has Admin-
istrative rights in the Magaya system.

Steps for these tasks are included in our user manuals and in our knowledge-
base:

http://knowledge.magaya.com

Magaya Corporation offers training for administrator tasks, as well as 
employees. Please see www.magaya.com.

Magaya software is also available in the Cloud. See:

http://knowledge.magaya.com/#/article/cloud_getting_started

Administrator Tasks

Administrator rights are automatically given to the person who installs the soft-
ware. This administrator (admin) can make changes to the system and create 
other users and assign admin rights to as many other users as needed. Admin 
tasks include:

• Set up employee permissions and roles (see the Permissions topic in
Chapter 4 in the Magaya Cargo System User Manual) or the following
topic in the Knowledgebase:

http://knowledge.magaya.com/#/article/permissions_2

• Make certain changes in the Maintenance > Configuration folder to
customize your Magaya software to the specific needs of your company
(see the Magaya Cargo System User Manual for information on the soft-
ware interface), or see the following topic in the Knowledgebase:

http://knowledge.magaya.com/#/article/configuration_menu

• Create Company Divisions such as Ocean, Air, or Exports, etc. See the
following topic in the Knowledgebase:

http://knowledge.magaya.com/#/article/divisions
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• Publish a template that is created in the Magaya Document Designer so 
all employees can use it. See the Knowledgebase article:

http://knowledge.magaya.com/#/article/publish_template

If a button or function is grayed out, that may mean admin rights are needed for 
that function. See the topic on Permissions for details.

Admin functions for the Magaya Communication Server and setting email 
options are explained in the Magaya Software Communications Manual and in 
the following topic in the Knowledgebase:

http://knowledge.magaya.com/#/article/communication_server

Software Customization Options

Customizations can be made to the software such as adding your company logo 
to your documents, including invoices:

http://knowledge.magaya.com/#/article/add_image_logo

Add custom fields to display in documents and show in reports:

http://knowledge.magaya.com/#/article/custom_fields

Use JavaScript to calculate numbers. You can also customize the view you and 
employees see in any list in the system, configure document numbering, how 
forms are filled out (including the AWB), what to print on labels, and how to 
automate charges.

To learn more about these customization options, please search our Knowl-
edgebase or see the Magaya Software Customization Manual.

Database Administration Tasks

Systems administrators and IT staff can perform many functions in the software 
such as:

• Backup the software database and automate the backup process

http://knowledge.magaya.com/#/article/backup_database

• Improve the performance of the database:

http://knowledge.magaya.com/#/article/database_performance
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• Update the software to the latest version:

http://knowledge.magaya.com/#/article/topic_update_software

For database administrator information, please search our Knowledgebase or 
see Chapter 8 of the Magaya Software Customization Manual.

Communications Functions

Magaya software is built on the Magaya Network. This network connects your 
database to Magaya’s servers and to others such as 3PLs in your network and 
agencies such as U.S. Customs. See the following topic in the Knowledgebase:

http://knowledge.magaya.com/#/article/intro_config_customs

The Magaya Communication Server is at the core of the network. It manages all 
communication between your system and the online tracking tool, LiveTrack. 
It enables your system to send updates to customers via an email link, and 
handles calls to the API. Learn more:

http://knowledge.magaya.com/#/article/communication_server

Learn about the network configuration, which ports to use, and more in 
Chapter 8 of the Magaya Software Communications Manual.

All tracking and online functions such as online payments and the apps are also 
covered in the Communications user manual and the Knowledgebase. Also find 
information on setting up the email system in Magaya, Cloud access, AES 
(ACE) and other Customs connections.

Navigating the Interface

To learn about navigating the software interface, see the guide “Navigate the 
Software Interface” available from the Magaya.com Learning Center or see the 
following topics in the Knowledgebase:

Introduction to Magaya Explorer

http://knowledge.magaya.com/#/article/magaya_explorer_intro

Menus and toolbars:

http://knowledge.magaya.com/#/article/menus_toolbars
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Folders and subfolders:

http://knowledge.magaya.com/#/article/folders_subfolders2

Lists and documents:

http://knowledge.magaya.com/#/article/2_work_document_and_list

Adding more columns to lists to see related information:

http://knowledge.magaya.com/#/article/related_columns
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Permissions

Permissions Introduction

Administrators can assign permissions to employees in your company based on 
the employee's job or role. For example, you may want to give the Accounts 
Receivable (AR) clerk access to certain billing functions, allow a warehouse 
employee access to other functions, or limit access to certain functions such as 
accounting for certain employees who do not handle accounting in their job 
role.

Overview of Permissions Available:

In the Permissions dialog box is a table of cells that enables you to restrict access 
according to the following:

• Create: Allows a user to create but not modify (or edit) a transaction

• Read: a user can read only (or view) but not make changes to files

• Edit: a user can edit files

• Delete: a user can delete files

• Export: Allow a user to export files out of the Magaya system, including
the ability to email data from the system (this does not refer to export type
shipments)

• Or any combination of access. For example, if you want a user to be able
to create and edit, check Yes for both.
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Click the Yes or No cell to allow or deny permission for members of that group:

In the Permissions dialog box, check the box “Apply these permission to chil-
dren” if you want to make the permissions status apply to the folder and 
subfolders (“children”) under it. For example, apply permissions to the 
Accounting folder and all the subfolders under it.

Leave the option unchecked if you want to set the permissions individually for 
each subfolder.
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Examples: As a result of allowing a user to create but not edit, that user will see 
limited functions on the toolbar for that transaction document or list.

If a user can create but not edit Invoices, the “OK” button will be grayed out (not 
active) when they open an invoice dialog box. They can view (read only) but not 
make changes.

To enable a user to create shipment documents but not edit them, go to the ship-
ment folder > File > Permissions and click Yes for Create and No for Edit for 
that user’s group. (A user must be assigned to a group first; see the section “How 
to Set Permissions.”) A user can also be given permission to liquidate a ship-
ment but not modify the transactions created in the liquidation by clicking Yes 
for Create and No for Edit for shipments.
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Add a New Employee

Add a new employee as needed. If employee names are already entered in your 
Magaya system, go to the section “How to Set Permissions”.

1) Go to Maintenance > Employees.

2) Click the Add button.

3) Enter the employee’s name, address and other information as applicable
by clicking on the appropriate tabs.

4) Click the OK button to save the information and exit the dialog box. The
employee’s name now appears in the list.

To set the employee’s password, see the section below “Set Up Passwords for 
Employees.” See the following Knowledegebase article to learn what else you 
can do on the Employee profile such as set up an email signature:

http://knowledge.magaya.com/#/article/maintenance_folder

How to Set Permissions

Overview: This is an overview of how to set permissions for employees/users:

1) Define the groups in your company.

2) Assign employees to the groups.

3) Assign permissions to groups per folder.

Only administrators can set permissions. If the menu option “File > Permis-
sions” is grayed out, then you do not have administrator rights on that 
computer.

1) Define Groups:
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Magaya software comes with some default groups. You can add more or edit a 
default group as needed for your company.

1) Go to Maintenance > Employees.

2) Click Actions and select “Access Groups”.

The Group List opens.
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3) Click the Add button in the Group List to add a new group. Enter a group
name and description information.

The description and name can be edited later if needed.

4) Click the OK button to save the information and exit the dialog box.

A maximum of 32 groups can be created.

By default Magaya software creates a group called “Everyone” in all folders. To 
restrict access to certain folders, you will need to edit this default by removing 
“Everyone” from the folders that need to be restricted.

Steps to remove “Everyone” from all the folders:

• Go to the folder.

• Click File > Permissions.

• Click on “Everyone.”

• Click the box for “Apply these permissions to children”.

• Click on the Remove button and OK.

Note: Magaya software comes with the default groups of “Importers” and 
“Exporters”. We recommend that you do not delete or modify these default 
groups.

2) Assign Employees to Groups:

1) Go to Maintenance > Employees.

2) Double-click an employee’s name to open their profile dialog box.
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3) Click the Permissions tab.

4) Click the Add button. A new dialog box opens called “Select Group.” Click 
on a group to highlight it and to make an employee a member of that 
group. Add as many groups as is applicable for the employee. Add one 
group at a time.

5) Click the OK button. Now the employee belongs to that group.
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3) Assign Group Permissions per Folder:

1) Select the folder (or subfolder) to assign permissions, for example: Ware-
housing.
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2) Go to File > Permissions.

3) In the dialog box, click the Add button to add a group.

4) Click the cells in the table to set Yes or No permission to Create, Read, 
Edit, Delete and Export.
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5) Click the checkbox “Apply these permissions to children” if you want to 
apply the permissions to all the subfolders under the folder you have 
selected.

6) Click the OK button to save the information and exit the dialog box.

Examples of System Functions Related to Permissions:

If an employee belongs to the Importers or Exporters group, they will be able to 
use the Shipment Wizards on the main toolbar.

If an employee belongs to the Accountant group, AR or AP group, they will be 
able to liquidate cargo operations such as Cargo Releases and Shipments.

See also the sections on Roles to fine tune access to the system.

To quickly see what folders each employee has access to, click the “Detail” 
button in the Employee list and then select “Folder Permissions” option from 
the dropdown menu.

Set Up Passwords for Employees

You can also require a password for an employee. The password and other 
options are on the “User” tab in the Employee dialog box.
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Passwords can be any letter and/or number combination. Passwords must be a 
minimum of six characters. To set an employee password:

1) Go to the Maintenance folder and select “Employees”.

2) Double-click an employee’s name (or select the name and click the Edit
button). The Employee profile dialog box opens.

3) Click on the User tab:

• Enter a password and retype it in the “Confirm” field.

• Select the division of the company for that the employee, if your
company has divisions. (Divisions can be added from the Employee
list. Click the Actions button, and add the divisions in that list. Divi-
sions can also be set up in the Maintenance > Configuration menu.
For steps, see the Magaya Software Customization Manual)

• Click the applicable checkboxes to enable access to the following:

- Allow Magaya Network access gives the employee access to the
Magaya Communication Center and its features. Thisbox is checked 
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by default. Leave it checked. If not, the user will not be able to use 
many functions in the system.

- Allow Magaya Software API access establishes this user and pass-
word access to the Application Programming Interface (API) if your 
company uses the API feature to import or export data.

- Allow Magaya WMS Mobile access gives the employee use of the 
Magaya WMS Mobile handheld scanner devices.

4) Click the OK button to save the information and exit the dialog box.

Give the user name and password to the employee. For details on other user 
login authentication options, see the Magaya Software Customization Manual. 
An employee’s access can be disabled on this screen also.

Scenario: Limiting Permissions

This section provides an example of setting up permissions for different 
employees based on what functions you as an administrator want an employee 
to access. This is especially useful for limiting access to accounting functions in 
the software. For example, you can give different permissions to an Operations 
Manager and an Operations Employee.

1. Create the Employee:

For this scenario we added the employees “Operations Manager” and “Opera-
tions Staff”. (Your employees will be entered by their names).

2. Create the Group:

We also added a group called “Limited Accounting”. Follow the steps in the 
section "HowtoSet Permissions" for details on how to add a group to your 
system. Access to this group can be further customized per employee and per 
folder such as the Accounting folder.

3. Assign the Employees to Groups:
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In this example, the manager has access to both the AR and AP groups so this 
manager can liquidate shipments:

The employee “Operations Staff” is assigned to the groups of Importers, 
Exporters, Accounts Receivable, and Everyone. This gives this employee the 
ability to add charges to transactions and create shipments, but they do not have 
access to liquidation:

An employee who belongs to the Importers or Exporters group will be able to 
use the Shipment Wizards on the main toolbar to create Shipments.

4. Assign Folder Permissions:
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Select the Accounting folder, click File > Permissions. Remove the groups 
Everyone, Exporters, and Accounts Receivable and click the box “Apply these 
permissions to children”. Add the Limited Accounting group, but do not check 
the box “Apply these permissions to children”.

To limit permissions further for the Operations Staff (optional), select the 
subfolder that you want to enable the employee to see such as Invoices (the 
document view only to limit access to reports) and the Bills (document view). 
Do this by selecting the subfolder (Invoices) and clicking File > Permissions and 
adding the Limited Accounting group. Do the same with Bills.

For the Operations Manager, go to Accounting > File > Permissions. Add 
Importers and Exporters group. Add the group Limited Accounting. Do not 
check the box to apply this setting to children. Go to Invoices, add Limited 
Accounting. Go to Bills and add Limited Accounting.

To verify the set up, log in as the Operations Manager and go to the Accounting 
folder. There should be only two items: Invoices and Bills. Then go to a Ship-
ment and verify that the Liquidation button is active on the Shipment Toolbar. 
Also verify the access for the Operations Employee.

Roles Overview

With the Roles feature, the system administrator can grant or restrict access for 
an employee (or a group) to different actions in the system. A role can be an 
action such as giving an employee:

• Access to the company financial reports

• The ability for an employee to create tracking users

• The ability to process liquidations

• Access to the accounting configuration or other options in the Mainte-
nance > Configuration menu

A role that is granted or denied supersedes any other permission an employee 
might have.

NOTE: When a new version of Magaya software is released and you update to 
it, ensure you are familiar with the new features and changes in the release, espe-
cially new roles or permissions because they may change access of employees. 
New features are announced on Magaya.com and in the newsletter.
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Add a Role to an Employee

To add a role to an employee’s profile in your Magaya system:

1) Go to Maintenance > Employees

2) Select the Employee’s name to highlight it.

3) Click the Actions button and select “Roles”. (Alternative: Right-click on 
the employee’s name and select “Roles” from the pop-up menu.)

A list opens.
67



Permissions Chapter 3
4) Click the Add button in the list. A dialog box opens:

Click the dropdown menu to select a role to assign to this employee (or 
group). There are many default roles such as those shown in this screen-
shot:
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When you select a role, a definition of that role appears:

5) Click “Allow” or “Deny”, and click “OK” to save. In this example, click 
“Allow” to apply this rule to this employee.

The newly assigned role appears in the list.
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View Roles for Employees: In the Employee List, click the “Details” button on 
the toolbar next to the “Actions” button. A new panel opens. Select “Roles” from 
the dropdown menu to see the roles for each employee.
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Introduction: WMS Mobile and Wireless Setup

This topic explains how to set up the wireless infrastructure for the WMS 
Mobile application that runs on handheld devices, how to configure the hand-
held devices per user, perform an initial inventory set up, and view messages.

If you are moving from the Magaya Cargo System to the Magaya WMS or 
Magaya Supply Chain Solution, you will need to perform certain steps to set a 
location for each item in your warehouse. Steps are also explained for those new 
to the software.

Wireless Infrastructure Setup and Hardware Requirements

The main requirement for using Magaya WMS Mobile is to have a wireless 
infrastructure in the facility where it is going to be used. The handheld devices 
need to be wirelessly connected to the server computer running the Magaya 
Database Server and Magaya Communication Server.

To expand an existing network to wireless, you need to install one or more wire-
less access points. The access points are wired to your network and are equipped 
with antennas that broadcast and receive communication signals which are 
routed back to your wired network.

The number of access points required in your facility depends on the area you 
want to cover with the wireless network. The reach of an access point is usually 
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around 300 feet. For example, to cover a 200 x 500 foot warehouse, you may 
need two access points to fully cover the whole facility.

The number of access points needed may also depend on the amount of equip-
ment you have in your warehouse. For example, very high racks can cause inter-
ference so you may need more access points to cover the same area. The 
illustration shows two access points with a range of 300 feet each; the signal 
range overlaps in the center and reaches to the back wall of the warehouse to 
ensure all racks and areas are covered. There are companies that can perform a 
site survey before installing the access points to guarantee 100% wireless 
coverage of the entire facility.

Recommended Hardware

The recommended hardware to use the Magaya WMS Mobile application 
includes wireless handheld devices, access points, and antennas.

The following Symbol® handheld devices from Motorola work with the Magaya 
WMS Mobile application:
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• MC9200 Zebra (formerly Motorola Solutions, as of 2014) runs on
Android KitKat, Windows Embedded Compact or Windows Embedded
Handheld

• Motorola/Zebra MC3200 (runs on Windows Embedded Compact 7)

• Motorola MC3190

• Motorola MC5574

• Motorola MC9190

• Motorola MC9590

• Honeywell 6100

• Honeywell 6500

• Honeywell MX7

• Intermec handheld, model CK71 and others by Honeywell

• Pidion BIP6000

Handhelds with a VGA resolution of 640 x 480 are supported. All screens are 
automatically resized for the different manufacturers of handhelds.

If your Motorola device has a compatible camera, you can take pictures of cargo 
with your handheld, and the images will be directly attached to the transaction. 
See the section “Taking Pictures” in the topic “Receive Cargo with Magaya 
WMS Mobile:”

Receiving Cargo with WMS Mobile

http://knowledge.magaya.com/#/article/wms_mobile_receive

Support for Pictures/Photographs:

• Motorola MC55 (Black and White B/W)

• Motorola MC75 (B/W)

• Motorola MC75A (B/W)

• Motorola MC9500

The recommended operating system is Microsoft Windows® CE 5.0 or higher 
and Windows Mobile.

WMS Mobile supports devices with Windows Embedded Compact 7. Any 
device that will run the Windows Embedded Compact 7 must also download 
the version of the .NET framework that is hosted at m.magaya.com during the 
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initial installation. This .NET framework must be included on the handheld or 
the application will not start.

A wireless network infrastructure will include access points and antennas such 
as:

• Cisco AIR-ANT2506 antenna

• Cisco Aironet 1240 AG Wireless Access Point (shown below)

See the Hardware Compatibility List for a list of hardware that has been certified 
to work with Magaya software:

http://knowledge.magaya.com/#/article/hardware_compatibility_list

Hardware Costs

The average retail price of the hardware required to run a wireless network in 
your warehouse is:

• Handheld devices: $1000 - $2300. You may have to add the cost of the 
cradle, extra batteries and other accessories, $100 more per device.

• Cisco Wireless Access Point Cisco Aironet 1240AG: $600-$700

• Cisco Antennas Cisco AIR-ANT 2506: $100

For example, for a 100,000 square-foot warehouse, you may need two access 
points with two antennas per access point. The cost will be approximately (2 x 
$700) + (4 x $100) = $1800.

If you need two employees using handhelds, you may select the MC3090; in this 
case you need to add 2 x $1300, total $2600.
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Your hardware cost should be $4400. Remember this does not include hardware 
installation cost, which depends on the installed infrastructure of your facility 
and the number of access points you need to install. This pricing data is current 
as of the publication date of this documentation. Consult with your vendor for 
exact pricing.

Initial Inventory Setup on Magaya WMS Mobile

To set up the inventory in the warehouse, you must assign a location to every 
item by scanning the barcodes for items and their locations. This process is only 
done once.

To enable the Initial Inventory function on the Magaya WMS Mobile handheld 
devices, go to the Maintenance folder of Magaya Explorer.
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Follow these steps on the handheld device to assign locations to items for the 
initial inventory process:

1) Click the “Initial Inventory” icon on the main menu of the Magaya WMS 
Mobile:

2) Scan or enter pieces.

3) Enter quantities.

4) Scan or enter current location.

Perform these steps to scan all the items needed.

Since this initial setup can take a long time, the recommended process is to 
begin entering the most important items first or the items that will remain in the 
warehouse for the longest time, and then enter the remaining items progres-
sively.
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When the process is completed, go to the Maintenance > Configuration > WMS 
and click on the checkbox “Enable Initial Inventory for WMS Mobile Users” to 
uncheck this option. Then the icon for Initial Inventory will disappear from the 
WMS Mobile screen.

If you are upgrading from the Magaya Cargo System, please see the section 
“Upgrading from the Magaya Cargo System” in the following Knowledgebase 
article:

Import Inventory Data

http://knowledge.magaya.com/#/article/import_inventory_data
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Configure WMS

Introduction to WMS Configuration

The WMS configuration section in the Maintenance > Configuration folder 
contains settings to set up the Magaya WMS Mobile plug-in application and 
related functions.

Let’s first look at the options on the “General” tab.
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Pallet IDs: Click on this button to configure Pallet IDs numbering format. In 
the dialog box that opens enter a Prefix and/or a Suffix (optional) and the 
number to begin numbering the Pallet IDs:

To print the Pallet IDs, go to File > Print Pallet IDs. Enter the amount you want 
to print in the dialog box:

The WMS General configuration tab also offers other options:

Set the default package type for new pallets by clicking on the dropdown to 
make a selection.
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Check the other checkboxes as applicable to your business:

• Keep inventory by serial number: When cargo arrives, you will scan the 
serial number for each item so you know the location of each serial 
number. If an item is moved, the serial number must be scanned during a 
Move. When an item is shipped out, the serial number must be scanned.

• Save serial number when items go out: This will enable you to know 
which shipments and customers received which serial numbers. The 
handhelds will ask for the serial number.

• Inventory will be closed on or before this date (a checkmark in this box 
activates the date field). If you set this date, this will affect assets as of the 
date set here. Any transactions before this date cannot be modified by 
users. Only the administrator can make modifications.

• Prevent the loading of items that are in Receiving locations: Check this 
box to ensure that items that are in a "Receiving" location are not loaded 
into a Cargo Release or a Shipment.

• Force the selection of existing part numbers when adding commodi-
ties: Check this option if you want the system to perform this way.

• Create an informative Task when breaking down compound items:

Click the Save or Reset button.

Inventory Adjustments Configuration

The Magaya system (version 9.3 and higher) can adjust the accounting needed 
when inventory items are lost, found, or damaged. See the following Knowl-
edgebase article:

Counts

http://knowledge.magaya.com/#/article/counts
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WMS Mobile Configuration

The functions on the WMS Mobile Configuration tab enable the setup of 
processes and users of the handheld devices. Let’s look at each option:
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WMS Mobile Units: Click on this button to open the measurement units dialog 
box.

These measurement units will be used in all transactions done by the handheld 
devices.

Warehouse Equipment: This is for descriptions of the types of equipment used 
by warehouse personnel such as forklifts, etc. Then you can match the equip-
ment to an employee (if you set up this function in the WMS Mobile Users 
dialog box which is accessible from the Configuration screen.)
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In the Warehouse Equipment List dialog box, click on the Add button to add a 
piece of equipment. A new dialog box opens:

In the dialog box, enter the description, make, model, and serial number of the 
equipment.

Also check (or uncheck) the tasks that can be performed with this equipment. 
Click OK when done to return to the configuration screen.

Tasks: Also check (or uncheck) the tasks that can be performed with this equip-
ment. Click OK when done to return to the configuration screen.

Mobile Location: Equipment csuch as forklifts and carts an be defined as a 
Mobile Location in your system. This is useful to track items when moving them 
or counting them. When you select the equipment from the Mobile Location 
dropdown menu, the system links the two, which enables the system to save the 
progress of items as they move through the warehouse. The WMS Mobile user 
will be able to select this piece of equipment on the wireless handheld screen and 
scan items to it.

Learn more about mobile locations in the following Knowledgebase article:
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Mobile Locations

http://knowledge.magaya.com/#/article/mobile_locations

WMS Mobile Users: Click on this button to view a list of the employees who 
will use the Magaya WMS Mobile application.

Note: To add an employee to this list, go to the Maintenance > Employees 
section of Magaya Explorer. In the Employee profile, go to the User tab and 
check “Allow WMS Mobile Access”.

When you double-click an employee’s name in the WMS Mobile Users list, a 
dialog box opens with the following settings:

• If you check the box “Ask for user identification (location, equipment)”, 
the system will ask the employee what location they will work in and what 
equipment they will be using. This is an optional checkbox. When a task 
is created for this user, the system will know their location so the user will 
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not be required to enter it each time. If you check this box, the permissions 
for this user will be affected by the equipment assigned to that employee.

• Select English or Spanish as the language for the WMS program.

• To change permissions for a WMS Mobile User, uncheck the box for the 
types of tasks you want to remove permission for this user to perform. The 
system default turns on all the tasks. Permissions will be overridden if you 
check the box to “Ask for user identification (location, equipment). For 
example, if a piece of equipment is not used in Receiving tasks, then the 
user who has that equipment assigned to them will not be able to do 
Receiving tasks on their handheld even if it is checked here. If you do not 
check that box, the Permissions here will not be affected by equipment 
assignments.

• To set up the Printer configuration for labels or for Packing Slips, the set 
up must be done from your company’s server or computer server (the one 
running the Magaya Communication Server).

Counts Numbers: Click on this button to open a dialog box to enter the number 
you want to begin inventory count sessions with. You can also add a Prefix or a 
Suffix if needed.

Operations Settings: These settings apply to the WMS Mobile handheld 
devices. First, ensure users are not logged into the handhelds. Click the button 
to open the dialog box. On the “General” tab, check the operations that you 
want to allow repacking: For Receiving, Moves, and Picking tasks.
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On the “Receiving” tab, checkmark the operations preferences:

If you have a default receiving location defined in the Locations list, you can set 
it as the default receiving location for all cargo received. Then the user will not 
see the screen on the handheld that they would normally see to enter a receiving 
location.

To have WMS Mobile users skip entering the entities on an uniformed receiving 
task, check this box. Then the user will not see that screen on the handheld and 
can go straight to scanning items.

If a new item is created on the handheld, this checkbox will make the system as 
the WMS Mobile user if a new tracking number should be created for the new 
item. If this box is unchecked, the system will not display that dialog box.

Check the box “Prompt properties when new item is created” if you want the 
handheld user to see the screen with the dimensions, etc. Uncheck this if you 
want the user to skip the screen.

Check “Allow empty pallets” if you want to allow the user to create a pallet but 
not place any items in the pallet.

Note: To change any of these WMS Mobile Configuration settings, ensure users 
are not logged into the handhelds.

Check the other checkboxes as applicable to your business:

Enable initial inventory for WMS Mobile users (only for Magaya Cargo System 
users moving to Magaya WMS): This will be done when first transitioning from 
the Magaya Cargo System to Magaya WMS. You will scan each item and its 
location so it is in your WMS. When done, you can delete this checkbox to 
remove this task from the handhelds.

Create pallets outside Warehouse Receipts (WR) in WMS Mobile Manual 
Receive: This gives the handheld user flexibility to create pallets that are not 
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assigned to a WR when manually receiving items. This pallet will show in the 
Warehouse Inspector view but not in the WR.

Verify items after batch pick: If you want the system to verify items after 
picking, check this box.

Autocreate a Pick Task after a Cargo Release is created: This is only for 
creating individual Cargo Releases, not batch creation.

Autocreate a Load Task after a Pick Task is completed

Ask for quantity after first scan in a Pick or Load Task

Click the Save to save your settings, or click Reset to return to the defaults.

Directed Operations Smart Warehouse Configuration

The Directed Operations tab enables you to set up functions such as inventory 
replenishment and put away for a smart warehouse.

See the topic “Directed Operations: Getting Started Building a Smart Ware-
house” in the Magaya Knowledgebase, found in Page One, the welcome screen 
of your Magaya software:

Building a Smart Warehouse

http://knowledge.magaya.com/#/article/directed_operations_getting_started

Click the Save or Reset button.
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Chapter 5: Set up your Warehouse

Overview

This chapter explains how to:

• Import Existing Inventory Data

• Define Inventory Items, Resale Items and Expiration Dates

• Set Pricing for Items and Create Sales Promotions

• Set up Warehouse Zones and Locations

• Define Package Types

• Work with Commodity Classification Codes

• Understand the Warehouse Inspector screen
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Import Existing Inventory Data

Introduction

To start using Magaya WMS (or the Magaya Distribution System or the Supply 
Chain Solution), existing inventory needs to be entered into the application. 
This process can be divided into three steps:

• Import Part Numbers

• Import Locations

• Import Existing Inventory

When importing data, the format of the data file must match the format in the 
new system. For example, if you have three columns of data in the spreadsheet 
such as part number, location, and quantity, then you will need to select the 
three corresponding columns in the Magaya software “Import Data” dialog box.

For tips using the Import Wizard, see the Knowledgebase topic:

http://knowledge.magaya.com/#/article/import_wizard_tips

Follow the steps in the wizard to import data.
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Import Part Numbers

If you have been working with another system, part numbers can be exported 
from the old system and imported into your Magaya system as csv or xml. To 
import part numbers, follow these steps:

1) Go to the Inventory Item Definitions list in the Warehousing folder and 
click the Actions button.

2) Select “Import.” The wizard opens. Click the “Next” button to start.

This example will explain how to import CSV.

3) Click the “Import CSV” button. Select how you want to import the data by 
checking if you want to include a header, select the type of delimter and 
separator (see the next below for more details).
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4) Click “Browse” to open the file on your computer (or network) that 
contains the data you want to import.

Recommended fields of data to import are the part number, manufac-
turer, description, length, height, width, weight, and price. For example:

You can import other fields such as Customer, Model, or custom fields, 
depending on your needs.

Options are:

• Include Header: If you click the “Include Header” checkbox, then the 
system will import the data starting on the line below the column header 
in your spreadsheet.

• Delimiter: Choose double or single quotes based on what you have in 
your original file. The data is between the quotes. You may also choose not 
to have a delimiter.

• Separator: If you want to separate data by comma, semicolon, or tab, 
make the selection from the dropdown “Separator”. If you are importing 
a CSV file, choose Comma.

• Field Type: This defines the type of field you have selected in the list such 
as Text, Decimal, etc. If the field is checkmarked in the list, the box for 
“Process this column” will be highlighted.

Part 
Number Descrip. Length Width Height Weight Manuf. Price

001 Battery 
6024

8 6 8 26 Duralast 66.00

002 Battery 
6070

8 6 8 26 Duralast 67.00

003 Battery 
6026

8 6 8 26 Everlast 69.00
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5) This screen enables you to preview the data before importing and to make
changes if needed. For example, you can group the information:

The asterisk (*) indicates a column that cannot be imported.

To change a CSV column heading, click the heading and make the selection. 
Depending on what you're importing, the columns will correspond to the list 
you're working with.

Any column marked with an asterisk won't be imported, but it's helpful to see 
on the screen for grouping.

To import resale inventory items, include columns for Price and Cost. You can 
create a custom field to see the most recently imported items. See the topic on 
Custom Fields or contact Magaya:

http://knowledge.magaya.com/#/article/custom_fields

The next screen shows the results of the import process, what was saved 
(imported) and anything not imported due to errors. To see the error reason, 
click the line item. You can export the errors and save them.

6) Click "Finish" to close the wizard. The new data is shown in your Magaya
system.

If you import by XML, the wizard gives you the option to overwrite existing 
elements. To do this, click the Options button in the wizard screen which show 
the data to be imported.
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You can also exclude an item in the list by selecting it and clicking the Delete 
button.

If there is an error in the importing process, the wizard shows the unsaved 
items. Click on a line to see the error message.
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Import Locations

Locations can be exported from another system or a spreadsheet and imported 
in Magaya software.

It is recommended that you define your warehouse zones in your Magaya data-
base before you import the locations. For details, see “Warehouse Zones and 
Locations” in this user manual, or see the Knowledgebase.

1) Go to the Locations list in the Warehousing folder and click the Actions 
button:

2) Select “Import.” The wizard opens. Follow the prompts as explained 
above.

3) Select to import from CSV or XML.
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4) Click “Browse” to open the file on your computer (or network) that 
contains the data you want to import..

Recommended columns are the location code, description, type, and 
zone. You can import other fields as needed, for example:

The items will have a status of “Pending.” Verify all the data after importing.

Import Existing Inventory

Note for existing customers: If you change physical locations in your ware-
house, and you want your Magaya system to reflect the changes, be sure you 
already have locations in your Magaya system. Then you can import new loca-
tions, and then import the warehouse, which will be the old locations. The cargo 
in the warehouse needs to be “On Hand”. Then move the items in the system, 
scan the items, and scan the new locations. When done, delete the old locations.

Inventory will be imported as Warehouse Receipts (WR). The following table 
illustrates the minimum data that must be imported:

1) Go to the Warehouse Receipts list, click the Actions button, and select 
“Import.”

2) Select “Import.” The wizard opens. Follow the prompts as explained 
above.

3) Click “Browse” to open the file on your computer (or network) that 
contains the data you want to import.

4) Group the WRs by Part Number or Location so the system does not 
generate just one WR. If you import a long list of thousands of items, the 

Code Description Type Zone

A1 Zone A, Row 1 Storage A

A2 Zone A, Row 2 Storage A

Part Number Location Code Pieces

001 A1B1 25

002 A1B2 30

003 A1B3 15
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system will create one WR that will be difficult to modify because of the 
large data size.

Upgrading from the Magaya Cargo System

If you are upgrading from the Magaya Cargo System and need to migrate data 
from that system to the Magaya WMS, Distribution System, or Supply Chain 
Solution, this section will explain how to set up your inventory in the new 
system.

If you’re installing Magaya WMS or Magaya Supply Chain Solution, then follow 
the steps in the section “Import Existing Inventory.”

Before you begin to migrate data, you may need to delete some locations from 
your Magaya Cargo System if you will not use those locations in the new soft-
ware program.

All items that are in a location you delete will then be available to move to new 
locations. Follow these steps in your Magaya Explorer to delete locations:

1) Go to Warehousing > Locations.

2) Select a location (or multiple locations) and click the Delete button. If 
items are in any of the locations, a notice will appear:

Click Yes to continue, or click No to return to the Locations list.

If you click Yes, the location will be deleted from the Magaya system, and 
the item(s) will not be listed in the Warehouse Inspector. The item can be 
found in the Commodity List, but it will not have a location assigned to it. 
The status of these items will be “Pending”.

If you need to create new locations and zones in your Magaya Explorer, see the 
Knowledgebase article:

Warehouse Zones and Locations

http://knowledge.magaya.com/#/article/intro_WH_zones_locations
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Initial Inventory Set Up: Follow these steps to enable the Initial Inventory 
function for the Magaya WMS Mobile handheld users:

1) Go to Maintenance > Configuration > WMS and click the checkbox
“Enable Initial Inventory for WMS Mobile Users.”

Note: If the Magaya WMS application is running on the handheld device 
when you set this configuration, you may need to exit the application and 
restart it.

When the process is completed, return to this Maintenance > Configuration > 
WMS screen and uncheck this option “Enable Initial Inventory for WMS 
Mobile Users”. The icon will no longer display on the Magaya WMS Mobile 
main menu.

For information on assigning locations to items, see the Knowledgebase article:

WMS Mobile Setup

http://knowledge.magaya.com/#/article/wms_mobile_setup
98

http://knowledge.magaya.com/#/article/wms_mobile_setup


Chapter 5 Create an Inventory Item Definition
Create an Inventory Item Definition

This topic explains how to create an Inventory Item Definition for a regular 
inventory item in Magaya Explorer.

Note: Your dialog box may vary slightly, depending on which Magaya software 
you’re using, but the majority of the functions are the same. The Magaya Supply 
Chain Solution is shown and explained here.

An Inventory Item Definition is just what it sounds like – the definition of an 
item in inventory such as those items that wholesalers stock for resale or items 
that you receive regularly for a customer. Also see the topic “Add a Resale Item” 
to learn about resale items.
99



Create an Inventory Item Definition Chapter 5
When an Inventory Item Definition is created in Magaya Explorer, the defini-
tion of that item will be available in the Magaya system to be used for transac-
tions such as Warehouse Receipts and Pickup Orders.

The advantage of creating an inventory item definition is to simplify receipt of 
items that are sent to your warehouse regularly. When the items are received 
and you create a Warehouse Receipt (WR) in Magaya Explorer, you can select 
the Part Number inside the Commodity dialog box, and the item information 
will be filled in automatically. This is also available on the Commodity tab when 
creating a Pickup Order.

If you have the Magaya Bar Code plug-in activated, you can scan the barcode of 
the item you defined and all the information about that item will appear in the 
WR. You will not have to retype the dimensions, etc. each time you receive that 
item.

When you select the part number in a WR, the item is automatically added to 
the On Hand inventory. When an item is released in a Cargo Release or a ship-
ment, it is removed from inventory.

Step-by-Step Procedure

To create an Inventory Item Definition, follow these steps:

1) Go to the Warehousing folder > Inventory Item Definitions

2) Click the Add button and select “Add Inventory Item.” A dialog box
opens.

The other Add button option, “Add Resalable Inventory Item”, opens a
dialog box with all the fields that are used for defining resale items and
their Items and Services. For more details, see the topic “Add Resale
Items”:

http://knowledge.magaya.com/#/article/add_resale_item

3) Start with the General tab:

• Enter the part number. The part number may be assigned by the
manufacturer or the customer, or it can also be your internal
number that you use to keep your inventory. Dashes in the number
are not recommended. This field is mandatory. Note: The part
number cannot be edited after the inventory item definition is
created.

• Optional: Click the SKU button if you are tracking inventory by the
Stock Keeping Unit (SKU), pronounced either “skew” or by its
acronym letters SKU. An SKU identifies an identical item from
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different manufacturers. A new dialog box opens. Enter the SKU 
number and click the Add button. Click the OK button to save SKUs 
and return to the General tab of the Inventory Item Definitions 
dialog box.

To see SKUs in the Inventory Item Definitions list, click Actions > 
Choose Columns > Item Code.

• Enter a description of the item.

• Enter the Model number or name that was assigned by the manufac-
turer.

• Select the Client from the dropdown menu. (Use this if you have a 
regular customer who buys this product. Note: If you assign a client, 
the inventory item is linked to the client. The inventory information 
for this item will be available for the client to see online via using 
Magaya LiveTrack.)

• Select the manufacturer name from the dropdown menu.
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• Enter the amount per pallet, if the items are shipped in a pallet in the 
same amount each time. This will also be used to estimate how many 
items can build a pallet.

• Check the box to “Keep Inventory by Serial Number” if you are 
keeping track of your inventory by serial number. (The serial 
number is unique per item. For example, the computers in an office 
may all be from Dell, and they may be the same model, but each one 
has a different serial number. If one computer needs a repair and will 
be sent back to the manufacturer for the repair, the serial number 
will ensure that the correct computer is sent for repairs and will 
make it easier to trace.

• Check the box to “Save Serial Numbers When Items Go Out” if you 
want to track the serial numbers after the items are dispatched (i.e., 
for Customs clearance at destination countries).

• The package type, dimensions, and Unit fields are optional but are 
helpful to speed up the receiving process. We recommend you fill 
them in here. When this item is received in a WR or sold in a SO, this 
information will be automatically added to those transactions.

• Has Variable Weight: This option is useful for items such as perish-
ables. By checking this, the item can be received in multiple boxes 
and weighed together, but it can be released in partial releases. 
During release, the user can enter the weight of the partial pieces 
being released so the correct charges are calculated. The system will 
adjust the weight o f the remaining on-hand pieces accordingly. A 
column for “Total On-Hand Weight” can be selected from the 
Choose Columns dialog box in the Inventory Items Definition list, 
which will show the calculated weight of variable-weight items.
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• Commodity Type: The system has “Freight All Kinds” as a default 
commodity type. You can add others and then use them in Rates and 
other places such as reports.

• Inactive: If this is checked, the system asks you to confirm that you 
want to deactivate that item. If items are on hand or arriving, they 
can still be loaded. If you deactivate an item when you still have 
inventory, the system will notify you.

4) On the Accounting tab, you can add the value, set cost and income 
accounts for inventory items, and minimum stock information. This is 
useful for companies that sell inventory.

• Use the Purchase Item and Sale Item dropdowns to assign cost and 
income accounts to the item. (This field uses the Items & Services)

The Unitary Value will be displayed in a Commercial Invoice docu-
ment, often used by freight forwarders. It is the selling price of an 
item, and it also appears in the Sales Order. (Optional field.)

• Click the “Commissions” button to set up a commission for a sales-
people who sell inventory. See the Magaya Software Customization 
Manualfor steps.

• Select how inventory is released such as First In/First Out.

• Select the Costing Method: either by specific price for the item or by 
average cost. See the Magaya Accounting manual or search in the 
Knowledegebase for keywords “Average Cost.”

• The minimum stock information can be set so that your system 
sends an alert when the inventory for this item reaches the number 
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you define here as the Minimum Stock so that replenishment can be 
done.

You can alert an employee to replenish the items or leave the field 
blank so it will go to all the handheld scanners.

Note: The screenshot below is from the Magaya Supply Chain Solu-
tion, which offers more features than the WMS.

To send the customer (client) an email notice of low inventory, check the box 
“Alert Client by email.” Ensure there is an email address in the customer profile.

Extra Info: If your company has a replenishment operation, see how to set up 
your Magaya system to replenish inventory by reading the topic “Replenish-
ment” in the Knowledgebase:

http://knowledge.magaya.com/#/article/replenishment
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If you selected a Preferred Vendor, you can also choose to create a PO with that 
vendor when inventory is low. The PO will appear in the Purchase Order list 
(for users of the Magaya Supply Chain Solution).

When you are finished entering information for the Inventory Item Definition, 
the item is now saved in your Magaya system and ready to be used in WRs and 
other transactions.

When you edit an Inventory Item Definition, the Part Number is grayed out and 
cannot be changed. If the Part Number is not correct, delete the item and create 
a new Inventory Item Definition for the item.

The Criteria tab displays criteria used in the Location Definition to help whne 
doing procedures for putting away this item, replenishing it or picking it for a 
release. For more, see the topic “Location Definitions.”

Inventory Item Definitions List

The Inventory Items Definitions list can be used to displayed a variety of infor-
mation about your inventory in a way that is helpful to your specific operation. 
For example, you can set columns by using the “Actions” button.

Save a List View:

You can save a view so you don’t have to create it every time you want to see 
certain details. Follow these steps:

First, filter the list to view only the items you want to see. Save that view by 
clicking the star on the top of the list and select “Save this view.”
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Name the view to save it.

This view of the list can be accessed at any time by clicking the dropdown menu 
which shows all the views saved.

Customer Column:

The “Customer” column displays the customer that an Inventory Item Defini-
tion is assigned to. You can assign a customer name to an item at any time - 
when you create the item definition or later.

Logistico: If you use Magaya’s e-commerce platform, Logistico.com, then the 
Customer name is the Logistico subscriber, who may have more than one online 
store that you fulfill orders for.

Detail Panels:

To see details about an item quickly, click the “Detail” button from the list 
toolbar. A panel view opens with many options. For example, you can view 
Summarized Inventory for an item definition.

This screenshot shows the item status, location, available pieces and total pieces.
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An item will have a status of “On Hand” if the amount of pieces in the Available 
column and Total column are equal.

The “Used” status indicates zero Available pieces. If there are fewer Available 
pieces than Total, the status will be “In Process.”

See the options and actions available for the list of inventory item definitions in 
this Knowledgebase article:

http://knowledge.magaya.com/#/article/actions_inventory_item_def
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Actions with Inventory Item Definitions

Introduction to Actions for Inventory Item Definitions

In addition to creating Inventory Item Definitions in the software, you can 
perform other tasks in the Inventory Item Definitions list by clicking the 
Actions button.

To create a report of “In and Out” information, select “Reports” and choose a 
summary or a detailed report by the Item Definition or by the Inventory Item.

To view the inventory for an item, select the item and select View Inventory. A 
list will open showing all the items of this type that are on hand. To close the list, 
click the red X in the top corner of the list.

To view arriving inventory, click on the Actions button and select View 
Incoming Items. This will list all items of this type that are on their way to your 
warehouse as part of a Pickup Order.

Adjust Accounting for Inventory: See the section below “Inventory Adjustment 
Wizard.”
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To update the quantity of pieces, select Update Quantity of Pieces. The system 
keeps the quantities automatically. Updating is only necessary if a discrepancy 
exists between the amount of pieces and the content of the inventory list. The 
updating process may take a long time to complete.

Update Items Properties: Click to open a wizard to update multiple items at 
one time. It updates all items that have a status of On Hand. See the section 
below “Update Properties of On Hand or Arriving Items in Batch.”

Reset Lead Times: The Lead Time is the estimated time between the ordering 
and the receipt of items. Reset it if changes were made. See the Purchase Order 
for an item to view the Lead Time column in the Commodities tab of the PO.

Define Bill of Materials: Used to create nested part numbers. See the topic 
“Nested Part Numbers” for detail:

http://knowledge.magaya.com/#/article/Nested_part_numbers_get_started

You can also import and export data to and from your Magaya system.

You can add custom fields to an Inventory Item Definition. The custom fields 
will be available when you receive those items and enter them into a Warehouse 
Receipt. See the topic “Custom Fields” in the Knowledgebase for details:

http://knowledge.magaya.com/#/article/custom_fields

Detail button: Click the Detail button to open a new panel. In that panel, you 
can select to display more details such as attachments, SKUs, and more. If you 
have more than one warehouse, you can see inventory in the warehouses. Click 
the Detail button again to close the panel.

To see more details about your inventory quickly, click the “Detail” button to 
open a panel.

Configure Columns: Click the Actions button to access the “Choose Columns” 
dialog box where you can set the column width, order, and which columns to 
see.
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Column choices include viewing minimum and maximum lead time for items. 
It shows the time between when the Purchase Order was placed and when the 
item was received.

There are many columns to select from, including hazardous materials, dimen-
sions, value, categories, to see the creation date of an item, to see if items are on 
hold or not, etc.

Inventory Adjustment Wizard

Adjustments to your accounting are shown in accounting transactions such as 
invoices or customer's payments. Types of adjustments include inventory assets 
and costs when you purchase and sell items. To see these and other examples of 
inventory adjustments, see the Knowledgebase article:

Inventory Adjustments

http://knowledge.magaya.com/#/article/adjustments

The software includes a wizard to do inventor y adjustments.
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In the next screen, select the entries you want to work with:

In the next screen, select the items (or transactions).
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The next screen shows a summary of what you selected.

Check the box if you want summarized entries.
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In the next screen, the default account for the adjustments, Inventory Adjust-
ment, is selected. You can change it if you have a different account.

If the adjustments will apply to a certain division, select it.

Review the transaction that were generated before saving them. Double-click 
the item in the list to view it. If you need to make changes, make them in the 
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item or click the “Back” button. When you click the “Finish” button, they will 
be saved.

Here is an example of an adjustment saved to the list of bills.
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Update Properties of On Hand or Arriving Items in Batch

This wizard updates inventory with a status of “On Hand” or “Arriving” in a 
batch process (all at once): It's useful for making changes to many commodities 
instead of going one by one.

First, update the Inventory Item Definition with the information that you want 
to change. For example, if you have an Inventory Item Definition with blank 
fields for the dimensions, enter values in the dimension fields.

Click “OK” to save. Now the Inventory Item Definition has the properties that 
you want to apply across all On Hand commodities of that Inventory Item Defi-
nition. Use the wizard as described below to apply the updated properties.
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From the Actions button in the list of Inventory Item Definitions, select 
“Update Items Properties.”

Note: You can also open the wizard by selecting one or more items in the list, 
and right-clicking the item(s) to access the same pop-up menu.

A wizard opens.
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In the next screen, select the items to update.

Filter the list if needed by clicking the “Filter” button.

Next, select the properties to update:

Note: The “Next” button is activated only after making a selection from the list 
of properties.

In the next screen: The function of this screen is to apply the changes to the 
properties. After the screen, the wizard is finished, and you cannot go back from 
this screen to undo the changes. Read the following to understand what will 
happen:
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- If you check the box to override existing item weight/dimension (or other 
properties you selected in the previous screen), then it will update the informa-
tion you entered in the Inventory Item Definition before starting the wizard and 
apply it to all On Hand items.

- If you leave the option unchecked, then only the items with a value of zero (0) 
will be updated.

Click “Next” to execute this process. (You cannot undo this.) When it’s finished, 
the last screen appears. Click the “Finish” button to close the wizard. The prop-
erties are now updated.

Note: If you want to upload new Inventory Item Definitions, regardless of 
what’s on hand, then see the following Knowledgebase article:

Add a Resale Item

http://knowledge.magaya.com/#/article/add_resale_item
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Add Resale Items

Introduction to Adding Resale Items to your Magaya System

Resale items are inventory items in your Magaya system that are available for 
sale. These are items you purchased, entered in your Magaya system, and now 
are available to resell. Resale items are saved in the Inventory Items Definitions 
list, which is in the Warehousing folder.

You can also enter “compound items” to create nested part numbers. For 
example, to receive a case of wine and resell or ship the case or individual 
bottles, and enter a part number for the case and another PN for a bottle. Then 
you can create a Bill of Materials to create a compound/nested PN. See the 
following Knowledgebase article for details:

Nested Part Numbers

http://knowledge.magaya.com/#/article/Nested_part_numbers_get_started

This article explains how to add resale items and the following:

• How to handle expiration dates for items and how to receive a perishable
item

• Working with the Inventory Items Definitions list

• How to update Inventory Item Definitions by uploading file

• How to convert an existing inventory item into a resale item

Selling Resale Items Online: You can create an online store to sell items. To 
make items available for the Online Sales Order feature in Magaya LiveTrack, 
the items must be resale items. Regular inventory items will not appear online 
in the online store. For more details on the online sales orders feature, see the 
following Knowledgebase article for details:

Online Sales Orders: Getting Started

http://knowledge.magaya.com/#/article/online_sales_orders_intro
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Steps to Add a Resale Item

1) Go to the Warehousing folder > select Inventory Item Definitions.

2) Click the “Add” button and select “Add Resalable Inventory Item” from
the pop-up menu:

A wizard opens with fields to enter the details of the item.
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3) Enter the following information in the fields of the Resalable Inventory 
Item Wizard:

• In the “Inventory Item Definition” section, enter the part number, 
model name (or number), an item description, the package type, and 
dimensions.

If you keep inventory by serial number and/or want to save the serial 
numbers when items are released, check the boxes.

• In the “Associated Items and Services” section, enter the Purchase 
Price and select the currency. The purchase price is the price you 
paid for the item. The system automatically creates an Expense Item 
(Cost) in the Accounting folder’s “Items & Services” list. It is also 
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automatically assigned to the inventory assets. (The currency drop-
down is available if your system is set up to use multiple currencies.)

Enter the Sales Price and select the currency. The sales price is the 
price that your customers will pay for the item. The system creates 
an Income Item in the “Items & Services” list.

Select the Manufacturer (optional).

Select the Client (optional) if you want this item to be assigned to 
only one client (customer).

• In the “Generated Items and Services” section, most of the fields are 
filled in. Changes can be made to the Costing Method, Inventory
Account and Inventory Type. FIFO is First In, First Out. LIFO is
Last In, First Out.

Note: For details on costing methods, see Chapter 10 in the Magaya 
Software Accounting Manual.

4) Click the Finish button. The resale item is saved in your list.

Note: This resale wizard does not have a field to attach photographs of inventory 
items. Go to the Inventory Item Definition dialog box if you want to include 
photos of the items.
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Handling of Expiration Dates for Items

In Magaya software, the Inventory Item Definition can help you manage the 
expiration dates of perishable items.

Set the expiration type when you define a new item (see the section Add Resale 
Items). The system will then load items based on this setting. If you want to add 
this information to an existing item, open the Inventory Item Definition, go to 
the Accounting tab, and set the Inventory Type. NOTE: If an item is “On Hand,” 
then set the expiration date for that item before changing the Inventory Type.

Receive a Perishable Item:

When you receive a perishable item, set the expiration date in the Commodity 
dialog box on the Identification tab.

NOTE: If an item is defined to have FEFO or LEFO, it must have a date entered 
on the Commodity dialog box for all On Hand inventory.
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When receiving items using the Magaya WMS Mobile scanners, scan the item 
and enter the expiration date on the Identification tab. (Complete steps for 
receiving items using Magaya WMS Mobile are in Chapter 13.)

Multiple items can be scanned, and each can have a separate expiration date. 
each will be on a separate line. (Lines can be merged if the dates are changed to 
match.)

Moving Items that have Expiration Dates: If an item has an expiration date 
and you try to move it into the same location as another item with the same 
expiration date, the system will prompt you to select a date.
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View Resale Items in Lists

To view the resale items in your Inventory Item Definitions list separate from 
non-inventory items, try these two options to see which you like best: First, add 
a column to the list to display which items are resale:

1) Click the Actions button and select “Choose Columns”.

2) Select “Sellable” and save it. Then click on the column header to group all 
resale items together.

Another way to view the Inventory Item Definitions list is to filter it and save it:

1) Click “Filter” > Advanced Filter.

2) Click “Sellable” in the list of available fields. Next to the condition 
“Equals” select “Yes” and click “Add.”

3) Click OK to save the filter. The list now displays only resale items.

4) Save this view by clicking the star in the top toolbar.
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Tip: Another helpful column to view is “Incoming Pieces.” It shows the quantity 
of items that are on order and expected to arrive.

The Actions Button in the Inventory Item Definitions List: Includes functions 
for updating quantity of pieces, resetting leads times, and more. See the topic 
“Other Actions with Inventory Item Definitions.”

There is another way to view inventory items in the Accounting folder: Go to 
the “Items & Services” List:

Click the “Actions” button and select “Inventory Item Definitions” from the 
menu:

This is useful for companies that have many inventory items.

Additional Information: For more details on creating an online store with the 
Inventory Organizer, see the Magaya Software Communications Manual. For 
details on Items & Services, see the Magaya Software Accounting Manual.

Update Item Definitions

There are two ways to update information in your inventory items: by updating 
what’s on hand with a wizard, or updating all items in the Inventory Items Defi-
nitions List by uploading a new list. We’ll start with explaining how to upload a 
list.

When the price or other information changes for items that you resell, you can 
update your existing item definitions by importing the new information from a 
csv file. You can update many items at one time, saving data entry. This can be 
 127



Chapter 5 Add Resale Items
done by exporting the inventory item definitions, editing them, and importing 
them back into your Magaya system. Let’s look at the steps.

1) Go to the Inventory Items Definitions list. Sort the list to display only the 
items and the column heading you want to export. Options: If you don’t 
want to change the column, etc., then you can save the current view of the 
list as it is so you can see it again after the importing process. Click the star 
button on the top of the list to save the list. To learn more about sorting 
and filtering lists, see the topic “Working with Document and List Views.”

2) Click “Actions” and select “Export.”

Select “Export to CSV, HTML, or Excel.” Click OK.

3) Select a location to save the file such as on your computer desktop by 
clicking the “Browse” button in the dialog box. If you didn’t turn off 
columns in the previous step, you can turn some off now by unchecking 
the column names.

4) Locate the file and open it in Excel or Notepad.

Edit the inventory item definition such as prices or other details. Save it.

5) Import it back into your Magaya system by clicking the “Actions” button 
and selecting “Import.” In the Data Import dialog box, click the correct 
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button for your file type (“Import CSV . . .” or “Import XML . ..”). Navigate 
to the file location, select it, and click “Import.”

The inventory item definitions will load into the Data Import dialog box. 
Review the data.

Click the “Options” button and check the box to “Allow overwriting 
existing elements.” This will enable the system to import your changes 
into your Magaya system.

6) Then click the “Save” button and close the dialog box. The data is 
imported, updated with your new information.

To use the wizard to update information in “On Hand” or “Arriving” items, see 
the wizard in the Actions button of the Inventory Items Definitions List. For 
details, see:

http://knowledge.magaya.com/#/article/actions_inventory_item_def
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Convert an Existing Inventory Item into a Resale Item

An existing inventory item can be changed to a resale item:

1) Open the Inventory Item Definition dialog box and go to the Accounting
tab:

2) Fill in the value for a unit (unitary value = your purchase price); this is
optional in this screen. The price from the Purchase Item field will be used
in POs, and the price from the Sales Item field will appear in Sales Orders.

Click on the Purchase Item field and the Sales Item field to create these. If
the Purchase Item and/or Sales Item are not available in the dropdown
menu, click the plus sign in the dropdown menu combo box to create the
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items. For more details on creating Items and Services, see the Magaya 
Software Accounting Manual.

Fill in the other fields as needed.

3) Click OK to save.
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Nested Part Numbers: Getting Started

This topic provides an overview of setting up and working with nested part 
numbers in your Magaya system.

Introduction to Nested Part Numbers

Nested part numbers are useful for 3PLs who distribute goods for their 
customers and often need to break cases of items to fulfill orders. These 3PLs 
often have areas in their warehouse dedicated to picking individual items for 
orders; other areas for replenishing those pick items; and a storage area for the 
bulk quantities.

The Magaya system enables purchasing individual items or as bulk packages 
that include other items inside them called a compound item. A package may 
arrive with one part number on it, but it has many of the same items inside such 
as a case of wine with 12 bottles of the same wine inside.

You can create a Bill of Materials for a compound item, for example defining the 
individual bottles of wine and then defining a case as containing 12 bottles. Your 
Magaya system will keep track of all the individual items and the compound 
items you defined, including their quantity, location, cost and resale price.

The system enables you to receive compound items and break them down as 
needed to replenish your inventory pick locations so you can fill orders effi-
ciently.
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When you sell items, the system processes the accounting for the items. You can 
sell items individually, in packages you create with quantities to fulfill an order, 
or just ship them out the same as they came in.

This feature is available in the Magaya Supply Chain Solution, Magaya WMS, 
and the Magaya Commerce System. It is shown here with the Magaya Supply 
Chain Solution on a PC and the Magaya WMS Mobile on a Motorola handheld 
device.

Overview of the Steps

To get started using nested part numbers, read these steps below to get an over-
view of the whole process. Full details are explained below in the referenced 
topics

1) Define the Compound Items and the Bill of Materials. This can be done 
for new or existing items, both resale and non-resale inventory items. It 
cannot be done for a Kit. (Done in the Inventory Items Definitions List)

2) Configure WMS: To create an alert (Generic Task) to fulfill the break-
down of a compound item (set in Maintenance > Configuration > WMS, 
and fulfill on handheld device via Messages icon in WMS Mobile main 
screen)

3) Purchase Compound Items or Individual Items (by creating a Purchase 
Order), and create the bill

4) Receive Compound Items (by creating a Warehouse Receipt)

5) Break Down Compound Items as needed (right-click the item in the WR’s 
Commodities tab)

6) Sell Compound Items or Individual Items (by creating a Sales Order); and 
create the invoice

Additional Options and Information:

• Rebuild a broken down compound item to correct a mistake (in the WR’s 
Commodities tab or in the Warehouse Inspector)

• “Release” the empty boxes after breaking down and selling items (to clean 
up); this creates an Adjustment Cargo Release (automatically); if 
rebuilding a compound item, the Adjusted CR is deleted automatically as 
well as any other related transactions such as a bill.

• Inventory Adjustments are explained throughout the process in the 
following sections. Adjustments for scrapped inventory will exclude 
compound items that have been billed or individual items billed, sold, or 
included in a Sales Order.

• The Average Cost of compound items is the same as with any other stock 
item. When a bill is created for a compound item, the purchase amount is 
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added to the Average Cost divided by the amount of the billed pieces. 
When a compound item is broken down into individual items, the 
Average Cost is only affected when all the items are sold. When all the 
individual items are invoiced, the original purchase amount is subtracted 
from the Average Cost divided by the amount of billed pieces.

Define the Compound Items and the Bill of Materials

A compound item can be defined for a new or existing inventory item, whether 
it’s a resale and non-resale item. For steps on creating new resale items, see the 
topic “Add a Resale Item.”

1) Go to the Inventory Items Definition List. Right-click an item, and select 
“Bill of Materials” from the pop-up menu.

Note: The item must be of the Item Type “Stock Item” not “Kit Item.”

2) Click the “Add” button in the dialog box that opens (on the “Bill of Mate-
rials” tab).

In the Bill of Materials tab, you add the items that will go inside the 
compound item. You can select from the Item Definitions list (or create a 
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new item in the dropdown menu). Enter the quantity of individual items 
that will make this compound item.

Click “OK” to save the item, and then click “OK” to save the Bill of Mate-
rial.

Note: A compound item can have as many items inside it as needed, but 
you cannot add duplicate items.
 135



Chapter 5 Nested Part Numbers: Getting Started
To see the columns in the Inventory Items Definitions List, click the Actions 
button and select choices such as “Pieces in Compound Items” to see the quan-
tities that have the status “On Hand.”

The “Detail” button also displays a panel for the Bill of Materials and other 
details.

The Detail panel options are:
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• Bill of Materials: Displays the list of part numbers included in the Bill of 
Materials of the selected part number.

• Included in Bill of Materials of Compound Items: Displays a list of the part 
numbers that have the selected one in their Bill of Materials.

• Pieces in Compound Items: Displays the hierarchy of parent compound 
items where the selected part number is included, starting from the inner 
levels to the top most levels, and displays the quantity of the selected part 
number that are included in every parent compound item.

Configure WMS

To create an alert to fulfill the breakdown of a compound item, follow these 
steps:

1) Go to Maintenance > Configuration > WMS. Check the box to create an 
informative task when breaking down compound items.

2) Save the configuration.
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Result: This configuration tells the system to create a notice which will appear 
in the Tasks List in your Magaya Explorer.

It will also display in the Messages of the WMS Mobile main screen after a 
compound item is broken down from a Warehouse Receipt.
138



Nested Part Numbers: Getting Started Chapter 5
Purchase Compound Items

Purchase compound items (or individual items) by creating a Purchase Order 
as you normally would. For details on creating Purchase Orders, see the topic 
“Create Purchase Orders.”

Create the Bill: When the bill is created, the purchase amount is added to the 
Asset Account.
 139



Chapter 5 Nested Part Numbers: Getting Started
Receive Compound Items

Receive compound items by creating a Warehouse Receipt as you normally 
create one. If you already created a PO, you can convert the PO into a WR via 
the Actions button in the PO.

Notice the icon for received compound items that are On Hand.

Break Down Compound Items

After compound items are received, they can be broken down into individual 
parts. This is often done to ensure enough individual items are available to fulfill 
Pick Tasks for customer orders. The compound items must have a status of On 
Hand. They cannot be in a Sales Order, in a Task, in use by another employee, 
or be inside a pallet or container.
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When you need to break down a compound item, follow these steps:

1) Open the WR dialog box, and go to the Commodities tab.

(Alternate method: Breakdown from the Warehouse Inspector by 
right-clicking the item.)

2) Right-click on the item to break down. Select “Break down Compound 
Item” from the pop-up menu.
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3) Select the WMS Mobile user to fulfill this break down task.

Note: If you do not select a WMS Mobile user, the alert will be sent to all 
WMS Mobile users.

The alert appears in the WMS Mobile “Messages” folder on the main 
screen.

In addition to the handheld alert, a Generic Task is created and displayed 
in the Task List in your Magaya Explorer.

If you breakdown a line that has more than one piece, the system asks how 
many pieces you want to breakdown. Enter the quantity in the “Select 
Partial Pieces” dialog box.
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The broken down items display in the Commodity tab of the Warehouse 
Receipt. Notice the icon.

The broken down items also display inthe Commodity List. Notice the 
icon.

Note: When a compound item is broken down and items are removed 
from the original box, the system automatically creates an Adjustment 
Cargo Release to remove it from your Magaya system. An empty box no 
longer contains items of value. See the section “Adjustment Cargo 
Release” for details.

The Magaya system adjusts the accounting of the purchased items by prorating 
the amount. The system calculates the amount of the broken down item as a 
percent of the original amount.

Sell Compound Items

You can sell compound items (or individual items) by creating a Sales Order as 
you normally would create for a sale.
 143



Chapter 5 Nested Part Numbers: Getting Started
This example shows a customer order of 15 bottles, which is created from one 
case (of 12 bottles) and 3 individual bottles that were broken down from another 
case.

The system processes the order by allocating inventory from the On Hand items 
to fulfill the quantity requested by the customer.

Configuration Notes: If your Magaya system is configured to allow backorders, 
the system will create a backordered item when the On Hand inventory is gone. 
If your system is configured to allow items to be allocated from a Receiving loca-
tion, then you can place items in a SO even if the items are in a Receiving loca-
tion. (Configure these settings in Maintenance > Configuration > Sales.)

Create the Invoice: When the invoice is created, the purchase amount is 
removed from the Asset Account and added to the Cost Account.
144



Nested Part Numbers: Getting Started Chapter 5
Adjustment Cargo Release

When a compound item is broken down and items are removed from the orig-
inal box, the system automatically creates an Adjustment Cargo Release to 
remove it from your Magaya system.

Rebuild a Compound Item

If an error is made, for example the wrong compound item is broken down, that 
item can be rebuilt. To rebuild a compound item, the quantity of individual 
items must be the same as the Bill of Materials. The individual items must be On 
Hand in the same location, not is use by another employee, not in a Sales Order, 
a Task, a Shipment, container or pallet.

To rebuild a compound item, go to the Commodity tab of the Warehouse 
Receipt (or the Warehouse Inspector and find the item).
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Click on the compound item (not the individual item).

If the item does not meet the requirements, an error message displays. Other-
wise, the item is rebuilt instantly. The compound item will return to a status of 
On Hand. The Adjustment CR is deleted as well as any other transactions such 
as an invoice or bill.

Additonal Resources

If you replenish items, or are considering a replenishment operation, see the 
following Knowledgebase article on creating a "smart warehouse" with your 
software to enable you to receive, put away, replenish and release items in 
sequences that you define:

http://knowledge.magaya.com/#/article/directed_operations_getting_started
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Price Rules and Price Management

Introduction

To assign different sales prices to inventory items in groups, use the Price Rules 
and Tiers in Magaya software. This topic explains how to configure your 
Magaya system, to define pricing rules, pricing tiers, and then to use the prices 
in Sales Orders and Commerce Quotations. This pricing feature is available in 
the Magaya Supply Chain Solution and the Magaya Commerce System.

Configure the Pricing Engine

To configure your Magaya software to use the Pricing Engine:

1) Go to Maintenance > Configuration > Sales

2) Check the box for “Enable Pricing Engine.”
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3) Save.

This configuration gives you the option to set pricing rules and tiers which will 
be applied when Sales Orders or Commerce Quotations are made, so the user 
who is creating the SO or Quote has the correct prices automatically.
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Create a Pricing Rule

To create a pricing rule, go to the Pricing Rules function inside the Sales folder.

Click the “Add” button to open the Pricing Rule dialog box.
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The Pricing Rule dialog box has many sections to help you define the rule 
according to your needs. Let’s look at each section in detail.

1) Name the rule, describe it and select a Tier (see the section “Create a
Pricing Tier” for details.). The tier is a required field.

2) Items: Select an option:

• Apply to all items in your Inventory Items Definitions list. This is
useful to ensure every item included in a Sales Order or Quote has a
price, even if you did not enter prices for every item. (You can view
cost and selling price by adding columns to the Inventory Items
Definitions list.)

• Apply to a category of items, as defined in your Inventory Organizer. 
Examples of categories include “Electronics” or “Perishables.”

• Apply to a specific item, which is your list of Resale Inventory Item
Definitions that have Part Numbers.
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3) Clients: (also called “Customers”): Select an option:

• Apply to all clients

• Apply to a group of clients: An example of a client group is “Whole-
salers.” To define a group, click the dropdown menu and click the
plus sign in the menu:

Define the new group on the “General” tab, and add entities to the 
group on the “Entities” tab, which displays your lists of customers, 
vendors, etc. These groups are saved in Maintenance > Entity 
Groups. The system also gives you the option to add an entity to a 
group by right-clicking on their name in the list.

• Apply to a specific client: Select the client name from the dropdown
list. This displays your lists of customers, vendors, etc.
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4) Timeframe: This option defaults to starting on today’s date. Set an end
date if you want this pricing rule to apply only during a certain timeframe
such as for a holiday weekend sale.

5) Quantity: This option enables you to set a minimum and/or maximum
quantity of items that your customer needs to buy to get this price.

This Quantity option is useful for setting a pricing such as “Buy 3 for $10.” 
Enter “3” in the “Start at ___ pieces” field. This means the minimum of 3 
must be bought to get this pricing. The “Start” quantity is optional.

6) Increment: This is useful for “Buy 1, get 1 free” sales. Check the box for
“Every” and enter a “2” in the field next to it. Check the box to only apply
to full increments (required).

The “Full increments” checkbox means the price only applies when selling 
the quantity specified in the rule. Uncheck it if you want to give the price 
no matter how many they buy.
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7) Calculate pricing based on a set of options you determine:

Examples include a markup or markdown by a percent, rounding a price 
up or down, and adding or subtracting a set amount. The Magaya system 
will calculate the price for you and enter it on the Sales Order or Quote.

This calculation is based on the terms you set such as using a previous tier, 
the costing method configured for your system, the purchase price, sales 
price or other.

Note: Pricing rules apply to new items added to Sales Orders or Quotes. If you 
edit an existing SO with items in it, those items will remain at their prices. Only 
items newly added to the SO will reflect the price from a new rule.

Examples:

Buy 1 Get 1 Free: Create a rule for a specific item, starting at a quantity of 2, 
increment of 2 and markdown 100% to give one item for free. Two must be 
bought or the rule does not apply.
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Buy 3 for $10: Create a rule for a specific item, starting at 3, increment is 3, and 
set the fixed amount. This can have the “full increments” checkmark on or off.

Items ending in 99 Cents: Create the tier and the rule to ensure prices end with 
99 cents.
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Create a Pricing Tier

The Pricing Tier is a way to ensure a profit will be on the item even if you sell it 
at a discount. Tiers are rules and a method of picking rules. Tiers also cascade, 
ensuring that a set of rules will be applied after applying another set of rules.

Tiers resolve conflicts that could arise for the same item by telling the system to 
choose how to apply the price based on the tier. For example, you can have 
different types of discounts for different types of customers such as those who 
buy in bulk from you versus other clients. The system will apply to rules for you 
and display the price result in the Sales Order or Quote. You can have multiple 
rules per tier. To tell the system to cascade from its previous tier, select “the 
“Result of previous tier” option under “Based on” of any rule in that tier.

The tier is a required field when creating a pricing rule.

1) Go to Sales > Pricing Tiers.

2) Click “Add” to open a new dialog box.

3) Click “OK” to save.

This tier can now be used in pricing rules.

How to use Pricing Rules and Tiers

Create a Sales Order (or Commerce Quote) as usual.
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On the Commodities tab, enter the items to sell.

You can have two different prices in a single Sales Order, depending on which 
tier you apply to each item.
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Warehouse Zones and Locations Introduction

Magaya Explorer provides you with a way to enter the names of locations in 
your warehouse into the Magaya Explorer and use them to assign the cargo to a 
certain location in the warehouse. You can also create reports about your ware-
house using the location information.

TIP:  When you first start using Magaya software, it is recommended to set up your 
warehouse locations and warehouse zones. This will make the locations available 
to use in Magaya Explorer and ease the creation of Warehouse Receipts.

Before entering zone and location information in Magaya Explorer, sketch out 
your warehouse on paper. Draw the loading area, receiving area, doors, walk-
ways and areas for a forklift to drive around, racks and rows, and other details. 
Label each part of the warehouse. See an example of a floorplan in Chapter 2 of 
the Magaya WMS Operations Manual and in the following Knowledgebase 
article about warehouse management:

http://knowledge.magaya.com/#/article/warehouse_management_overview

Every warehouse is different, and each is suited to the type of business done. A 
warehouse that needs more storage space and that conducts infrequent pick and 
load orders may use higher racks. A warehouse that handles many pick and load 
orders will need those inventory items in an easy-access location to make the 
pick and loads faster.

If you have forklifts or carts that you want to label as a mobile location, learn 
about that process in the Knowledgebase article “Mobile Locations”:

http://knowledge.magaya.com/#/article/mobile_locations

Your locations may be named according to the products you sell, the customers 
you sell to, or the area in a warehouse such as a separate fenced-off area that is 
locked or an outdoor yard. Many use names such as Row 1, Row 2, Row 3, etc. 
Enter the information into the Magaya Explorer according to your needs.

After creating the locations and zones, use the Warehouse Inspector in Magaya 
Explorer to move items in the warehouse. See the chapter “Manage and Move 
Warehouse Items” in the Magaya WMS Operation Manual or the Magaya 
Supply Chain Operations Manual for details. These same topics are available in 
the Magaya Knowledgebase, found in the welcome screen of your software, 
“Page One”.
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To import locations from another software system, see the topic “Import Loca-
tions” for steps in the Knowledgebase, which is available from Page One:

http://knowledge.magaya.com/?search=import_inventory_data

Directed Operations for a “Smart Warehouse”:

If your warehouse is set up to fulfill orders for online retail customers, please see 
the topic “Directed Operations: Getting Started Building a Smart Warehouse.” 
This topic will help you learn how to set up and run your warehouse for guided 
receiving and put away, replenishing inventory locations for optimized picking 
and loading of orders using sequencing logic. Also learn how to set up multiple 
warehouses in your Magaya system. See the article in the Knowledgebase:

http://knowledge.magaya.com/?search=directed_operations_getting_started

How does Magaya Explorer use Warehouse Zone and Location 
Information?

There are different types of labels to use in your warehouse to identify zones and 
locations:

• Barcode labels on shelves and racks to track cargo locations by handheld 
scanners connected to Magaya WMS, or

• Signs to mark rows and racks

You can enter this information into Magaya Explorer, and it will help you know 
where everything is in your warehouse.

When you enter a warehouse zone and location in Magaya Explorer, those 
zones and locations are now available to use when you receive cargo and put it 
away in your warehouse.

For example, when you create a Warehouse Receipt, you can select the location 
from the Commodities dialog box (on the Commodities tab of the WR). The 
“Location” field has a dropdown menu; all the locations entered are available 
from this dropdown. You can also set a Default Receiving location by 
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right-clicking a Receiving location in your Locations list; this saves a step when 
receiving items.

You can also use the location information to create a report by warehouse loca-
tion (by using the Actions button in the Commodity List under the Ware-
housing folder).

We also recommend reading the article that explains how to identify items in 
your warehouse such as by serial numbers, pallet IDs, and more:

http://knowledge.magaya.com/#/article/identify_items_wh

Getting Started: Set Up Your Warehouse

When you set up your warehouse in your Magaya system, we recommend the 
following procedures:

Create Warehouse Zones:

http://knowledge.magaya.com/#/article/create_WH_zones2

Create Warehouse Locations:

http://knowledge.magaya.com/#/article/create_wh_locations

Define Inventory Items: This will help you when you receive the same items 
regularly so you can save data entry:

http://knowledge.magaya.com/#/article/create_inventory_item2

Nested Part Numbers: If you handle compound items such as packages that can 
be sold in bulk or broken down into individual units, see this article on setting 
up “Nested Part Numbers” in your system:

http://knowledge.magaya.com/#/article/Nested_part_numbers_get_started

Cargo Reports: There are many reports about the cargo or inventory. Start here:

http://knowledge.magaya.com/#/article/reports_in_and_out_cargo

After your warehouse is setup, you will be ready for operations such as receiving 
cargo and/or inventory, moving items to optimize space, release items for 
customer requests, and view all the details in your Magaya system.
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How to Create Warehouse Zones

Warehouse Zones Overview

Warehouse Zones are larger areas in the warehouse that contain smaller loca-
tions. For example, a zone may be a row with many locations for each level and 
section of the row. A zone may also have more than one row.

Another example of a “zone” is if you have an outdoor yard, the yard may be one 
zone and it can have two or more locations inside it.

Your Magaya system comes with a “Default Zone” in the Warehouse Zones List. 
This zone can be renamed, but it cannot be promoted because it is the top-level, 
or main warehouse for your system.

If you have more than one warehouse, you can organize your Warehouse 
Inspector by defining each one as a “zone” and then promote it to a “warehouse” 
by using the Warehouse Promotion Wizard from the Warehouse Inspector 
screen. This feature is available in the Magaya Supply Chain Solution and 
Magaya WMS. (Learn more in the topics “Multiple Warehouses” and 
“Sequencing in the Warehouse” in the section “Additional Resources” below.)

Tip: Add zones first. Then add locations so you can assign a location to a zone.
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Steps to Create a Warehouse Zone

To create a warehouse zone, follow these steps:

1) Go to the Warehousing folder > Locations.

2) Click the “Actions” button and select “Warehouse Zones.”

Note: Some of these menu options will be grayed out (unavailable) 
depending on which Magaya software product you are using.

3) In the new list that opens, click the “Add” button. A dialog box appears.
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• Enter the name of the zone.

• Enter a description of the zone (optional but recommended).

• Select the parent zone (if applicable).

• Select a division (optional).

• Select a customer (optional). This will assign all the locations inside
this zone to this customer, which saves you time from having to
assign each location individually.

• Select a Default Receiving Location (if this is a promoted “ware-
house”).

Click OK to save the information and close the dialog box.

The zone is saved in the list.

To make a zone visible in the Warehouse Inspector, assign a Location to it. Then 
refresh the view of the Warehouse Inspector.

Options Available for Zones:

Right-click a zone to see a pop-up menu of options.

Options include choosing columns to view, importing or exporting data from 
this list, or deleting empty pallets in the zone (if there are multiple empty pallets. 
The system also gives you the option to delete pallets from a promoted ware-
house zone or individual pallets from the Warehouse Inspector view.)
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Additional Resources

The following articles in the Knowledgebase provide related information:

If you have more than one warehouse, you can define each one as a “zone” and 
then promote it to a “warehouse” by using the Warehouse Promotion Wizard 
from the Warehouse Inspector screen. Learn more in the topic “Multiple Ware-
houses”:

Multiple Warehouses

http://knowledge.magaya.com/#/article/multiple_warehouses

See also “Sequencing in the Warehouse”:

Sequencing in the Warehouse

http://knowledge.magaya.com/#/article/sequencing_warehouse

See also the article on the Warehouse Inspector:

Warehouse Inspector

http://knowledge.magaya.com/#/article/warehouse_inspector
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How to Create Warehouse Locations

Warehouse Locations are the places in your warehouse for storing commodities 
and inventory. These often include a Receiving area, a Staging area, locations on 
racks in different rows, an outdoor storage area, a Quality Control area, a Ship-
ping area, and others.

Locations can also be “mobile” such as a truck, forklift or a cart. These types of 
equipment can be defined as mobile to improve visibility in the warehouse and 
the process of moving items. When an item is scanned from one location into 
another, the system saves the movement, tracing the item every step of the way. 
See the section “Create a Mobile Location” in the Magaya WMS User Manual.

Tips: When selecting bar code labels for racks, ensure the barcode stickers are 
durable, can handle temperature changes, and can be read from the distance 
that the barcode reader laser can reach, especially for high racks. See the Hard-
ware Compatibility List for Magaya-compatible handheld bar code scanners.

Definitions can be added to locations for picking, putting away and replenish-
ment operations. This feature is available in the Magaya Supply Chain Solution 
and Magaya WMS. See the topic “Location Definitions” for more.

There is an option to create a sequence for locations. This will define the order 
that will be used to put items away or to pick them to fulfill orders. The default 
sequence is alphabetical from A to Z. To change the order of the locations, go to 
the Warehouse Inspector view. Read details in the topic “Sequencing.”
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Steps

Follow these steps to add locations:

1) Go to the Warehousing folder > Locations.

(Note: This screenshot shows the Magaya Cargo System. Your Ware-
housing folder may look different, depending on your permissions access 
and if you have a different Magaya software.)

2) Click the “Add” button. A dialog box opens.
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• Enter a code such as an abbreviation for the location. (When 
working with WMS Mobile, the barcode on the location label must 
be the same as this code field. Be sure to match these code lists when 
planning your warehouse.)

• Enter a description. (For example, the warehouse location of the 
first row in the warehouse and the first section of the row might be 
Row 1 Section 1. The code can be: R1S1. The Staging Area could 
have a code of STAGE. The naming of the location codes and 
descriptions are determined by you.)

• Definition: Select a definition for this location. This is useful for 
picking, putting away and replenishment operations. (This feature is 
available in the Magaya Supply Chain Solution and Magaya WMS.) 
See the topic “Location Definitions” for more.
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• Select the type of location from the dropdown: Receiving, Storage,
Shipping, Replenishment, Picking, Quality Control, Mobile, or
Other.

The location types “Shipping” and “Quality Control” are the only 
location types used in Pick and Load Tasks for the Magaya WMS 
Mobile application.

To create locations for a Put Away sequence, select the Type as 
“Storage” or “Replenishment.”

To create locations for a Picking sequence, select the Type as 
“Picking.”

You can move locations in or out of a sequence in the Warehouse 
Inspector screen. First, select the sequence you want, then move the 
locations.

You can also further refine information about your locations by 
using the Location Definitions option available by right-clicking the 
 167



Chapter 5 How to Create Warehouse Locations
location. See the topic “Location Definitions.”

• Select the zone from the dropdown to assign this location to a zone. 
Magaya software comes with one Default zone. (Note: If you have 
not added any zones yet, the dropdown will not have any options to 
select.

It is recommended that zones be added before locations into Magaya 
Explorer. See the section on Warehouse Zones for information on 
adding zones into Magaya Explorer. You can also assign a location 
to a zone later by right-clicking the location and selecting “Add to 
warehouse zone”).

• Select a customerfrom the dropdown if you want to assign a specific 
location in the warehouse to a customer. That means only the inven-
tory for that customer will be stored in that location. This field is 
optional.
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• The length, width, and height are optional. (Note: As of this docu-
mentation, the weight field cannot be filled in here. It is populated if 
you have created “Location Definitions” and select a definition.)

Click the OK button to save the information you entered. The warehouse 
location will appear in the list.

If a Location was assigned to a zone, view the change in the Warehouse 
Inspector.

After Completing this task:

You can sort through the list of locations by using the Filter button. The Filter 
button has two options: Standard and Advanced.

Option: Set a Receiving Location as the default by right-clicking on the Location 
from the Location List.

If you receive cargo in the same area, set that as the default receiving location 
to make Warehouse Receipts faster to process. The default location will be the 
location assigned to all cargo automatically.

If you set a Default Receiving Location, it will speed up the process of receiving 
and putting away items when using the Magaya WMS Mobile handheld scan-
ners. (If you are logged into the handheld unit, log out to activate the setting.)
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Bulk Assign Locations to a Zone:

Select the locations you want to assign to a zone, right-click and select “Add to 
Warehouse Zone” from the pop-up menu.

In the dialog box that opens: Select the zone you want to add these locations to:

Details Panels:
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In the Locations list, you can see what items are in a location by selecting a loca-
tion to highlight it, clicking the “Detail” button, and selecting a panel to see a 
summary or detailed view of items.
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Location Definitions

This topic explains what a Location Definition is and why it is used in a ware-
house. This is part of the Directed Operations procedures to create a smart 
warehouse. To learn more about the other parts of the Directed Operations 
procedures, see the topic “Directed Operations: Getting Started Building a 
Smart Warehouse.”

Introduction to Location Definitions

A Location Definition is exactly that, a description that defines the characteris-
tics of a location in the warehouse.

Why add definitions to your warehouse locations? To optimize processes in 
your warehouse system. This will enable the system to find the best locations 
when putting away items received or picking items to release. This is ideal for 
use with a replenishment operation. The definition can tell the system to detect 
when the location gets low on items so items can be refilled in the location.

One of the results of improving the warehouse workflow will be reducing the 
high cost of picking tasks by having the most commonly picked items in the 
locations that are easiest to access. Definitions will help keep those locations 
stocked with inventory to avoid downtime. Definitions can include locations for 
fragile items or heavy items, and you can also define which part numbers will go 
in which locations. While these recommendations can be overridden by the 
handheld user depending on circumstances, these definitions are designed to 
improve the processes.

After defining the locations, the definitions can be assigned to locations individ-
ually or in bulk.

The locations can be organized into a sequence to improve the workflow 
processes of picking and putting away items.

The Location Definitions work together with the WMS Configuration of 
Directed Operations and with the WMS Mobile Tasks. If you have multiple 
warehouses, you can define the locations and sequences for each warehouse, 
and assign users to each warehouse.
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Steps to Define Locations

1) Go to Warehouse > Locations > Actions > Location Definitions

2) In the list that opens, click the “Add” button, and enter the following
information in the Location Definitions dialog box:
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3) Options tab: Enter the description information as noted below:

Name: Enter a descriptive name that will be easy to identify later

Location Type: Select from the dropdown menu
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Dimensions: The Dimensions field enables you to add dimensions of that 
location into your Magaya system.

Click the Dimensions dropdown menu. If this is the first time using this 
feature, there will not be any dimensions in the dropdown menu. After 
you enter dimensions, they will be available to select next time you 
perform this operation.

To add new dimensions, click the green plus sign in the dropdown 
toolbar. Enter the length, width and height of the location. Click OK to 
save it.

Level: Select a level. The “Lowest” level is the level that is closest to the 
floor. This is for informational purposes only.

Maximum weight: Enter a maximum weight that this location can hold.

Special Options: This is for informational purposes only. Check the 
following options that apply to this location
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• Needs equipment: For example, if this location requires a vertical
order picker, a high lift forklift, or other device to reach items, check
this box.

• Allows loose cargo

• Allows repacked items

• Can mix repacked items
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4) Item Definitions Quantity tab: This enables you to connect Part Numbers
(or Item Definitions) to the location. This tells the system to put away this
part number in this location. If a location is full, the system recommends
the next location you define. The user can override the recommendations.

Click the “Add” button to open a dialog box to choose a Part Number 
(Item Definition).

In the Quantity dialog box, select the Part Number from the “Item Defini-
tion” field.

The Maximum Quantity is the maximum number of items the location 
can hold. Tip: Use this number to refill so as to avoid multiple tasks to 
refill this locations.

The Minimum for Replenishment can be set as a percent or quantity. This 
tells the system to create a Guided Put Away Task to refill the location with 
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more items. Then the Guided Put Away Task is automatically sent to the 
handhelds.

The “Quantity to Refill” field is how many items to include in the Task. 
Manual Put Away Tasks can override the recommendations set here. This 
field is optional.

Click OK to save the Quantity information for the item.

5) Criteria tab: Use this tab to add all the available criteria to add to define
this location better. A criteria is a broader way to describe what a location
may hold and what is preferred to be held in this location.

Click the “Add” button to add criteria. Click the arrow button to move a 
selected criteria to apply it to this location definition.

The criteria can also be seen on the Inventory Item Definition dialog box 
and are available for any Inventory Item Definition.
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Assign the Definitions to Locations

Assign the definitions individually or in bulk (also referred to as “in batch”).

Individually: Right-click a location. Select “Assign Location Definition” from 
the pop-up menu.

Bulk (or Batch) Assignment: Filter the list or select multiple locations by 
clicking “shift” on the keyboard, and then right-click and select “Assign Loca-
tion Definition” from the pop-up menu.

Recommended Next Steps

After defining locations, you can add them to zones. If you have multiple ware-
houses (or want to treat one zone in your warehouse separate from the others), 
you can “promote” that zone to a warehouse.

Be sure to read the topics about creating zones, receiving cargo, moving items 
in the warehouse, and releasing cargo to get a full view of warehousing opera-
tions.

A sequence can be added to your Magaya system which will organize the loca-
tions into a sequence to guide the put away or the picking of items. See the topic 
“Sequencing” in the Knowledgebase.
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Additional topics for guided put away, replenishment, and picking are available 
and can be done in your Magaya system if you have this type of operation. Please 
see the topic “Directed Operations: Getting Started” to learn more.
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Mobile Locations

Introduction to Mobile Locations

Locations can also be “mobile” such as a truck, forklift, or a cart. These types of 
equipment can be defined as mobile to improve visibility in the warehouse and 
the process of moving items. When an item is scanned from one location into 
another, the system saves the movement, tracing the item every step of the way. 
This is useful also if the battery is exhausted on a handheld scanner, all the data 
about the moved cargo will be saved.

This process links the equipment with the location, enabling it for use with 
WMS Mobile tasks. When an employee needs to use a piece of mobile equip-
ment, they can select it from the WMS Mobile handheld screen. You do not 
need to assign mobile equipment to an employee in the “WMS Mobile Users” 
Configuration dialog box. An employee can also change from one piece of 
mobile equipment to another at any time.

Create a Mobile Location

Overview: To create a mobile location, you will need to perform two steps: First, 
create a mobile location in the Locations list, and then configure mobile equip-
ment in the Configuration menu of Magaya Explorer. This feature is available 
in Magaya software 9.3 and above. Let’s look at these steps in detail.
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Steps to Create a Mobile Location:

1) Go to Warehousing > Locations. Click “Add.”

In the dialog box, enter a description of the mobile location such as a name 
for the cart or forklift.

- Select the Type "Mobile."

- Select the Zone "Mobile Locations."

- Enter dimensions (optional but helpful to define capacity of this cart).

Click OK to save.

Here is a view of the Locations list with Mobile locations created:
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2. Configure the Mobile Equipment:

1) Go to Maintenance > Configuration > WMS > WMS Mobile > Warehouse 
Equipment

2) Click “Add.” In the dialog box, enter the information for this mobile loca-
tion:
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- Description: Enter the name

- Make: Enter the make (or brand)

- Model: Enter the model number/name

- Serial: optional

- Mobile Location: Select the same mobile location that you created previ-
ously. (A mobile location can only be assigned to one piece of mobile
equipment. If you disable that location from the Locations list, it won’t be
available here.)

- Tasks: All are checked (active) by default. Uncheck any if needed.

- The field “Current User” will only display a user name when the equip-
ment is in use by an employee. The user can be cleared from this field to
release the equipment if the user does not log out of the handheld.

Click OK to save.

Now users of the WMS Mobile handheld scanners can select the mobile equip-
ment they need to use for a task.

While one employee is using that piece of mobile equipment, no other employee 
can use it (until they select another option or “None”). If a user does not need 
to use mobile equipment, they can select “None” from the menu.

To release a piece of mobile equipment, the user selects “None” from this 
screen. Note: The user can be cleared in the Configuration menu option “Ware-
house Equipment.”

For details on using mobile equipment for Tasks, see Chapter 13 in the Magaya 
WMS User Manual.
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Sequencing in the Warehouse

Introduction to Warehouse Sequencing

This topic explains how to manage the locations in your warehouse by adding a 
sequence to them.

What is "sequencing"? Sequencing is the order that you define in your Magaya 
system that tells the warehouse employees which locations to place items in 
when putting items away and which locations to pick from.

The system creates directed (or “guided”) tasks for the WMS Mobile handhelds 
that use the information from the sequence to recommend locations for the user 
and recommends a travel path in the warehouse. This is especially useful for 
large warehouses, for high-volume e-commerce fulfillment centers, and for 
batch picking because it defines an efficient path through the warehouse, saving 
time when putting away items or picking them to fulfill orders.

Planning: Before beginning the sequencing procedure in your Magaya system, 
ensure your operations are clearly defined by answering questions such as:

• Which locations do you want the system to recommend to fill first when
putting away items?

• If one location is full, which location do you want to fill next?

• Do you want to use the same sequence for picking and for putting away?

Magaya software comes with a Default Zone which is your main warehouse. It 
is in the Warehouse Zones list (accessible from the Actions button in the Loca-
tions list). All the locations in the default zone are sorted alphabetically from A 
to Z as the default, root sequence. To change this default order, follow the steps 
below.

Create a Sequence for a Single Warehouse

This section explains how to set the sequence for a single warehouse using the 
Sequence tab view in the Warehouse Inspector screen. (If you have more than 
one warehouse, see the topic “Multiple Warehouses” in the Knowledgebase.)
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Clicking a zone to highlight it will open new tabs on the right side of the Ware-
house Inspector screen. You can view the Locations in the zone or click the 
“Sequence” tab to see the sequence for the locations.

This will show the locations in a zone, not the zone itself, in the sequence tab.

To view a sequence type, click the dropdown menu in the screen:

By default, before making any changes to the order of locations or sequence, the 
system displays the locations in alphabetical order (A at the top and Z at the 
bottom).
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To see more options when working with the locations in the Sequence tab, 
right-click a location to see a pop-up menu.

Items that are not in a sequence are ones that you don’t want the system to 
consider when performing a guided put away, replenishment, or picking task.

If you add a new location to your system, it will be in the bottom half of the 
Sequence tab because it is not part of a sequence yet. You must add it to one if 
you want it in one.

Creating a Put Away Sequence

In the Sequence tab > Put Awayview, you can see how the locations in a zone 
are populated with the items. This view shows the locations in a zone that are 
included in the sequence for Put Away. The recommended locations for Put 
Away are Storage and Replenishment location types. (If you need information 
on creating locations or adding definitions to locations, search the Knowledge-
base for “Create Locations” and “Location Definitions.”)
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In this screen, you can view and make changes to an existing sequence. 
(Sequences can also be imported. See the section “Import a Sequence.)

Click a location to highlight it and to activate the buttons on the right. Then 
move the location up or down to position it where you want it in the sequence 
or remove it. The locations at the top of the sequence will be given priority when 
used to put away items. This means the system will recommend this location as 
the first place to put away items to the warehouse user working with a handheld 
device running Magaya WMS Mobile. The system will also use information in 
the Location Definition to recommend where to put away an item. See the topic 
“Location Definitions” for more. If you remove a location from a sequence, the 
location is moved to the bottom screen, which is outside the sequence.

Click "Save." A dialog box will ask if you want to save changes. If you click “No, 
your changes will be cleared, not saved.

Creating a Picking Sequence

To see the Picking sequence, click the Picking view from the "Current 
Sequence" button.

Any locations that are not part of this view are displayed in the bottom half of 
the screen. From the list of locations outside the sequence, you can add locations 
from there to be part of the sequence or remove them.
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In the top half of the screen, which shows the locations in the sequence, you can 
move individual locations up or down. This will change how the system recom-
mends locations to put items in (or to pick from).

Click "Save." A dialog box will ask if you want to save changes.

The order of the locations in this view: the locations in a zone on the top of the 
list are the ones that will be filled first. This means the system will recommend 
this location to the warehouse user working with a handheld device running 
Magaya WMS Mobile. The system will also use information in the Location 
Definition to recommend locations.

Import a Sequence

If you have many locations, it can be time consuming to set a sequence in the 
Warehouse Inspector screen by moving each location one by one. You can 
import a list of locations that are in the desired order. Use a text file.

Create the text file with one location code per line. List them in the order you 
want in the sequence. For example, if you want the system to give preference to 
a location, make it the first in the list.
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Click the "Import" button in the Sequence tab (or right-click the warehouse 
icon).

Browse to the file. Import it.

The system validates the file to ensure the location information matches the 
Magaya system.

Recommended Next Steps:

If you have not added definitions to locations, do that next.

Also ensure the handhelds users have the correct permissions and are assigned 
to the correct warehouse.

If that's done, then you're ready to start sending tasks to the handhelds to put 
away items, pick or replenish items. For more on creating Put Away Tasks or 
Pick Tasks, see the Knowledgebase for the topics “Release Cargo with WMS 
Mobile Devices” and “Receive Cargo with WMS Mobile.”

See the "Directed Operations: Getting Started" topic for a list of all related topics.
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Multiple Warehouses

This topic explains how to define more than one warehouse in your Magaya 
system. If you have two or more warehouses in different locations, perhaps 
different cities or countries, follow the steps in this section to define each ware-
house.

If you have one warehouse, see the topic “Sequencing in the Warehouse.”

What is "sequencing"? Sequencing is the order that you define in your Magaya 
system that tells the warehouse employees which locations to place items in 
when putting items away and which locations to pick from. The system creates 
tasks for the WMS Mobile handhelds that use the information from the 
sequence to recommend locations for the user. This is especially useful for batch 
picking because it defines an efficient path through the warehouse, saving time.

Multiple Warehouses: Using the Warehouse Promotion Wizard

To define more than one warehouse in your Magaya system, use the "Ware-
house Promotion Wizard." This wizard guides you through organizing your 
locations for putting away items and for picking them. You can use this wizard 
even if you don’t need to define sequencing now, but you only want to separate 
warehouses in your system.

You can select any warehouse zone in your Magaya system and define it as a 
separate warehouse and define its sequence with the wizard. (If you don't have 
warehouse zones set up in your system yet or need information on creating 
them, see the section on setting up warehouse zones first.)
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The "Warehouse Promotion Wizard" is found in the Warehouse Inspector. 
Right-click a warehouse zone and select "Promote to Warehouse."

NOTE: Make sure you don't have filter applied on the locations inside the zone 
you want to define as a warehouse.

Follow the prompts in the wizard, starting with the first screen:

Click to the next screen to begin the wizard.

This screen enables you to select a high-level method of sorting the locations in 
the warehouse. It helps you apply a method to all the locations in bulk instead 
of one by one. In the next screen you can fine tune that method by rearranging 
individual locations. Options for sorting include alphabetical, height or weight. 
This sequence can be applied to the process of picking items to release them. In 
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the next screen, you will see an option to apply the sequence to the process of 
putting away items also.

This setting will give preference to the locations at the top of the list first.

The options in the Bulk Location Sort screen include:

• Alphabetical: select either ascending (this will result in an A-Z order with 
A at the top), or select descending (this will result in a Z-A order, with Z 
at the top). Note: The Magaya system arranges locations in alphabetical 
order A-Z by default.

• Capacity: Sort to give preference to fill the fullest locations first (“Fullest 
to emptiest”) or to the emptiest locations first (Emptiest to fullest).

• Height: Highest location (may require a forklift to reach) or fill the lowest 
(ground level) locations first

• Weight: Heaviest to lightest (the result is the locations that can handle the 
heaviest items will be filled first) or Lightest to heaviest

On the next screen, you can move individual locations in the sequence. The 
order of the sequence is top to bottom; the first location in the list equals the first 
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location in the sequence. To move a location, click it to highlight it. Click the Up 
or Down button to move the location.

This screen also includes the option to apply this sequence to the process of 
putting away items and of picking them:

• To make the Put Away sequence the same as the picking tasks, check the 
box on the screen.

• If you want a different sequence for putting away items, leave the box 
unchecked and go to the next screen. Define the sequence for putting away 
items.

The next screen will depend on whether you check the box or not: If you check 
the box, the next screen will finish the wizard. If you do NOT check the box, the 
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next screen will show you the “Bulk Location Sort” screen so you can create a 
sequence for the Put Away process.

Finish the wizard and close it. Your sequence is saved.

Results:

Notice the icon changed in the Warehouse Inspector from a warehouse zone 
icon to a warehouse icon.
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The Sequence tab in the Warehouse Inspector enables you to adjust the order of 
locations as needed. You can also exclude a location from sequencing, for 
example, if you don’t want a location to be considered during a guide Put Away, 
Replenishment, or Picking Task.

By completing the wizard, the system also creates an option in the Employee 
profile dialog box that enables you to assign that employee to a specific ware-
house. When this employee logs into WMS Mobile on the handheld scanner, 
they will log into the warehouse that they have been assigned to.

The employee will not see locations from any other warehouse defined in your 
Magaya system. See the topics on WMS Mobile for Put Away and Pick Tasks to 
see this in action.

After completing the wizard, the system now enables you to set a default 
receiving location for each warehouse in your system.
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The Warehouse Receipt dialog box will display a dropdown menu to select the 
warehouse.

If you need to change a warehouse and return it to a "zone", you can do this by 
right-clicking on the warehouse icon and selecting "Demote Warehouse." See 
the section "Demote Warehouse" for steps.
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Demote a Warehouse

If you no longer have a separate warehouse, you can change your Magaya 
system to reflect the change.

Right-click a warehouse icon in the Warehouse Inspector screen. A wizard 
opens.
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The next screen in the wizard shows the locations to be merged back into the 
root sequence.

The next screen gives you the option to choose how to incorporate the locations.

When you demote a warehouse, you can choose where the locations will go. For 
example, the locations can return to your main warehouse. And you can choose 
exactly where in the main warehouse such as at the top of the list of locations or 
at the bottom. You also have the option to sequence those locations or not put 
them in a sequence.
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Options:

• Organize locations later: The locations will not be placed in any sequence.
They will remain as they are. If you select this option, this will be the last
step in the wizard.

• Organize locations now: This option opens another screen:

- Append the locations to an existing sequencing,

- Or sort the sequence

The next screen shows the locations that will be moved. Here you have more 
options to move any location up or down in this Picking sequence. Another 
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option is to use this same sequence for the Put Away sequence by checking the 
box.

If you check the box to use the same sequence for the put away, then the wizard 
will finish. If not, then you will have a screen to adjust the put away sequence.

Click “Finish” to save the changes and close the wizard.

Click the “Refresh” button in your Magaya system to see the changes in the 
Warehouse Inspector screen.

Recommended Next Steps:

If you have not added definitions to locations, do that next. Also ensure the 
handhelds users have the correct permissions and are assigned to the correct 
warehouse. If that's done, then you're ready to start sending tasks to the hand-
helds to put away items, pick or replenish items. See each of these topics for 
details on the procedures. See also the "Directed Operations: Getting Started" 
topic for a list of all related topics.
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Commodity Classifications (HTS)

What are Commodity Classifications?

Commodity Classifications are codes used to categorize commodities. These 
classifications are also called Schedule B codes or export codes. They are 
10-digit numbers based on the 6-digit international Harmonized Tariff System 
(HTS) and defined by US Customs. The codes help you determine a country’s
applicable tariff and tax rates for a commodity. There are approximately 9,000
codes. The codes are grouped together into chapters.

Customs codes are updated via a Web service so your Magaya system always has 
the latest codes. To manually check for updates and load them into your system, 
go to the Commodity Classifications list > Actions > Update.
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Commodities in the code list include types of foods, furniture, textiles, plastics, 
metals, glass, chemicals, vehicles, footwear, and many more.

If a Schedule B code has a description of “nesoi”, this means the item is “Not 
Elsewhere Specified or Included”. (This is Chapter 98 – Special Classification 
Provisions.) The commodity number should not be used until a check has been 
made to determine whether there is a classification elsewhere into which the 
item will fit more specifically. Other classifications under the same general 
heading should be examined.

NCM is the code for commodities in Brazil and other countries in South 
America. Enter it on the Commodity dialog box on the Identification tab.

These codes are required in shipments exported from the US. The code must be 
on the EEI (formerly SED). All the codes are available on the EEI tab in Magaya 
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Explorer when you enter commodities or add a container into a Warehouse 
Receipt, Pickup Order, or Shipment:
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Actions with Commodity Classifications List

The Commodity Classifications list is located under the Warehousing folder:

Your view of the Warehousing folder may differ from this image, depending on 
the software you’re using or your permissions.

To filter the list of Commodity Classifications, click the “Filter” button and 
select either the Standard or Advanced filter option.

This is a screenshot of the Standard Commodities Classification Filter:

You can select a chapter from the dropdown or enter a term in the “Find What” 
field. The results will display in the list and the dialog box will close.
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The Advanced Filter has many options for filtering your list:

• Click on the field you want to use in your filter by selecting it from the list 
of Available Fields on the left. For example, “Description”.

• Set the condition you want to apply. Tip: Select “Contains” so you can 
enter a keyword or partial commodity classification. If you select “Equals” 
you must enter the whole commodity classification. If not, the filter will 
not find it.

• Enter the description (keyword) in the field next to the condition drop-
down.

• Add any additional conditions as needed.

• Click OK to see the filtered list.

The filter applied in the Commodity Classifications list will remain active until 
you clear it, as it will for any list. The counter at the bottom of the screen tells 
you how many items are displayed out of a total possible. The filtered list will 
also display when you view cargo on the “EEI” tab inside the “Commodities” tab 
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of a Warehouse Receipt or Pickup Order. You can change the filter by clicking 
on the Browse button to open the list.

Filtering Tips:

• Since some descriptions are long, double-click on the code in the filtered
list to view it.

• If you use a commodity regularly, check the box “It is commonly used”.
Then the code will display in the Browse list inside the Commodities tab,
on the EEI tab.

To Add a Commodity Classification:

If you need to add a Commodity Classification to the list:

• Go to the Warehousing folder and click on Commodity Classifications.

• Click on the Add button.
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• Enter the code and description.

• If this item is required to have a Unit of Quantity, then add it here. The 
fields for Quantity 1 and Quantity 2 use abbreviations such as DOZ for 
Dozen, GRS for Gross, and KG for Kilograms. An X is used in the field if 
no unit is required. See census.gov for a list of abbreviations.

Note: These fields will appear in the AES (ACE) validation screen as “First 
Unit” and “Second Unit” when you send the EEI to US Customs. See the 
topics “Magaya AES” and “Shipments” for details on filing the EEI to the 
US Customs ACE Portal.

• Click OK. The classification is added.

Other Actions available with the Actions button:

• To view the Export Codes only, select Export Codes.

• To view License Type Codes, select License Type Codes.
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Update the HTS List

To manually update the list of HTS codes, click Actions > Update.

Click “Yes” to update.

The EEI filing system in Magaya validates the codes to ensure they are current.
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Package Types

Introduction to Package Types

Magaya software includes a list of default package types. If you need to 
customize package types, you can do this in the Package Types list located in the 
Warehousing folder.

Note: Your view of the Warehousing folder may vary from this screenshot due 
to your permissions and software product.

There are different reasons why a custom package type would be needed. For 
example, if you build your own pallets, enter the dimensions into your Magaya 
system so the dimensions are automatically filled in when you add that pallet to 
a shipment.
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How to Customize a Package Type

To create a new, custom package type, follow these steps:

1) Click the Add button. A dialog box opens with the followingtabs: Descrip-
tion, Dimensions, and Express Link. The fields change based on the type
of package you select from the dropdown menu.

2) Enter information in the Description tab. On this tab, certain fields appear 
depending on the type of package you select from the Type dropdown
menu:

- If you select “Container,” the fields for the container code and equip-
ment type become available. To specify air, ocean, or ground, click the
button with the three dots (next to the dropdown menu) to select a code
or type

Note: If you choose another package type such as “Crate,” the container 
fields are not available.

3) On the Dimensions tab, enter the package dimensions.
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4) On the Express Link tab, check the box to enable mapping if you want to
create a custom package type and connect it to your Express Link func-
tion. There is an option to map to FedEx packages or UPS package types.

Click OK to save.

Now the package type is available for use in your Magaya system. You can also 
add or edit a package type while you are adding commodities to a Pickup Order, 
Warehouse Receipt, or Shipment.

Extra Info: The Package Types list contains options similar to many other lists 
such as choosing columns, importing or exporting data, and creating reports.
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Introduction to Identifying Items

Items in the warehouse can be identified in different ways: by their part number, 
serial number, Magaya receiving label with a Magaya tracking number, the 
pallet ID label, or by the Magaya shipping label. This topic will explain how to 
identify items in each of these ways and include resources for more details on 
using scanners to identify items.

ID by Part Number

The part number is usually the manufacturer’s identification number that is on 
the box when the items arrive at your warehouse. It is not necessary to print 
labels for these boxes because they have a part number label on them already.

When the items arrive, scan the part number and store the item in a location. 
Scan the location to record it in your Magaya database.

Extra Info: There are different types of scanners compatible with Magaya soft-
ware. See the “Additional Resources” section below for details.
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This method is often used when it is necessary to keep items by part number in 
order to know how many of a certain part number are in stock. This part 
number will appear on the Commodity dialog box.

To create part numbers, go to the Warehousing folder in Magaya Explorer and 
click on Inventory Item Definitions. For details, see “Inventory Item Defini-
tions” in Chapter 7 of the Magaya WMS Operations Manual or the following 
Knowledgebase article:

http://knowledge.magaya.com/?search=create_inventory_item2

If you don’t want to the system to create a tracking number for items with part 
numbers, check the box for this option in the Configuration > Labels menu.

Labels can have external tracking numbers. The Commodity dialog box has a 
tab for External Tracking Numbers. Learn more in the topic “Commodities” in 
the Knowledgebase available from Page One, the welcome screen in your 
Magaya software.

ID by Serial Number

The serial number is assigned by the manufacturer. The serial number identifies 
each individual item of a type that comes into the warehouse. For example, you 
may receive 50 items such as laptop computers. The 50 laptops are all the same 
part number, but each laptop has its own serial number to identify it.

When you receive the item, scan the part number and then scan each serial 
number barcode. This is useful if a manufacturer recalls items. Then you can 
find the exact set of serial numbers affected by the recall and send those items 
back to the manufacturer.

This will also keep track of which customers buy which serial numbers. You can 
configure your Magaya system to keep a record of the serial numbers (Go to 
Maintenance > Configuration > WMS). This is also useful when exporting 
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items to certain countries that require serial numbers be reported on documen-
tation.

If you add resale Inventory Item Definitions to your Magaya system, you can tell 
the system to save the serial numbers for that part number when items are 
released.

When you receive or release items by serial numbers, you will see a dialog box 
that will populate with the serial numbers as you scan them. The numbers can 
also be entered manually in the Commodity dialog box on the “Identification” 
tab.

Serial numbers can be displayed in LiveTrack grouped together (as summarized 
items) for your customers to see. Click the button to expand and view each item. 
This grouping is useful if there is a long list. It makes it easier to view the trans-
action.

To learn more about bar code scanners, see the “Additional Resources” section 
below.
216



Chapter 6
ID by Magaya Receiving Label

Items can be identified by printing a Magaya receiving label with a Magaya 
identification number on it. This number contains your Magaya Network ID 
number, the Warehouse Receipt (WR) number, and the line item in the WR for 
that item (whether it is the first item listed, the second, etc.).

Print this label from the WR document view by clicking on the arrow on the side 
of the Print button and selecting “Print Labels.”

The image below is a WR label. The Magaya identification number appears 
under the bar code, which consists of a unique ID number (3678) generated by 
 217



Chapter 6
the software, the WR number (2075), and the line number for this item (2) in 
hexadecimal format.

Using Magaya labels is useful for regular cargo items that do not have a part 
number.

If a customer prints the labels themselves using the Magaya Online Shipping 
Orders feature at their location before items are sent to your warehouse, the 
labels will have a Pickup Order number instead of a WR number.

For more on printing labels, see the section “Print Labels” in the following 
Knowledgebase article:

http://knowledge.magaya.com/?search=2_work_document_and_list
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ID by Pallet ID Label

By placing a pallet ID label on a pallet of items, the items inside the pallet are 
identified. You can print pallet IDs in advance and use them as needed when 
creating pallets in the warehouse for storage, moving, or shipping items out.

Palletizing items by using the Pallet ID increases warehouse productivity 
because you only have to scan one bar code (the pallet ID label) to move the 
items inside the warehouse or for other operations.

To print pallet IDs, go to File > Print Pallet IDs:

Enter the number of how many pallet IDs you want to print.

For more on printing labels, see the “Additional Resources” section below.

ID by Magaya Shipping Label

The Magaya shipping label contains the Magaya tracking number, Cargo 
Release number, air waybill or Bill of Lading number (for shipments using the 
Magaya Supply Chain Solution or Magaya Cargo System). This identifies not 
only the item but which shipment the item belongs to, but this label will usually 
also have the shipper and consignee on it. This label can be scanned to verify the 
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items to be shipped to guarantee accuracy using the “Verify Packing List” 
option in the software if needed.

You can add a Packing List or a Loading Guide to a shipment by clicking the 
“Add Doc.” button on the Shipment toolbar.

To print a Magaya shipping label, go to the document view of the Cargo Release 
or shipment and click on the arrow on the side of the Print button and select 
“Print Labels”.

These labels are used to identify pallets after repacking items. When you include 
the pallet in a shipment, you can still use the pallet ID to locate the pallet. When 
you print a shipping label and place it on the pallet, you can scan the barcode on 
the shipping label (or the pallet ID label) to identify it. The system saves both 
numbers.

Additional Resources

The following Knowledgebase articles are available from Page One, the 
welcome screen in your Magaya software. These topics are related to learning 
how to identify items in your warehouse.

Understanding the “Identification” tab on the Commodity dialog box:

http://knowledge.magaya.com/#/article/commodities_tab

Hardware Compatibility List:

http://knowledge.magaya.com/#/article/hardware_compatibility_list

CubiScan Scale Integration, and other fixed scanners:

http://knowledge.magaya.com/#/article/Cubiscan

Bar Code Scanner (handheld reader):

http://knowledge.magaya.com/#/article/bar_code_scanner_get_started

WMS Mobile:

http://knowledge.magaya.com/#/article/wms_mobile_getting_started

For more on printing labels, see the section “Print Labels” in the following 
Knowledgebase article:

http://knowledge.magaya.com/?search=2_work_document_and_list

Verify Items in a Packing List:
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http://knowledge.magaya.com/#/article/verify_packing_list_scanner
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Purchase Orders

Introduction to Purchase Orders

Purchase Orders (PO) are contracts between buyers and sellers that define the 
terms of the transaction such as price, quantity, due date, incoterms, etc.

There are two ways to handle POs:

• If you are a wholesaler or trader who buys and sells goods, the PO makes
a record of your purchase of items which become part of your inventory
assets. The items you purchase need to be entered into your Inventory
Items Definitions list first before you start creating POs for them. See the
section on Inventory Item Definitions for details of entering the item
description, part number, cost and resale value, and salesperson’s
commission.

• If you are a logistics provider, the PO often originates from your
customers who are buying items and you provide the logistics services for
those items. The POs may arrive via EDI into your Magaya system, or they
may be emailed to you for manual entry into your Magaya system. You
can also import a list of POs via the Actions button in the PO List as
explained below.

The Magaya Supply Chain Solution enables both wholesalers and logistics 
providers to track POs and to easily convert the information in the POs into 
other related transactions such as Pickup Orders, Warehouse Receipts, or Bills.

To optimize receipt, put away and replenishment of items, see the topic 
“Directed Operations: Getting Started.” It explains how to perform these proce-
dures in your Magaya software:

Directed Operations for a Smart Warehouse

http://knowledge.magaya.com/#/article/directed_operations_getting_started
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Configure Purchasing: Creating Bills

Configure your system to determine when a bill can be created from a PO by 
checking the options to turn on:

• Allow to create bills for Purchase Orders without commodities: Check-
mark this option to allow users to create bills for POs that don’t have any
commodities but may have other charges. This is useful to keep track of
items such as office supplies purchased. The PO status will be “Open” (not
“Empty”).

• Allow to create bill for Purchase Orders only after all inventory is received: 
The commodities must be On Hand to create the bill.

• Create bills from purchase orders, including only the processed items
(arriving, pending, or on hand)

• Allow to create Purchase Orders with clients as sellers: This will enable the
system to display entities from the Customer List in the dropdown menu
on the PO for the “Seller” field.
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Steps to Create a Purchase Order

This section explains how to create a Purchase Order (PO) manually in your 
Magaya system.

1) Expand the Purchasing folder.

2) Click Purchase Orders (document or list view).
225



Purchase Orders Chapter 7
3) Click the Add button. A dialog box opens:

4) Enter the following information in the General tab of the dialog box. You
can widen the box by clicking and dragging the bottom corner. You can
start with any tab in the dialog box; this example starts with the General
tab:

• The Purchase Order number is an internal number set in your
Magaya system. It is filled in automatically based on the Configura-
tion setup in the Maintenance folder. It can be changed if needed.
The date and employee fields are also filled in automatically and can
be changed as needed.

• Select the payment terms from the dropdown. If the customer (the
seller) has payment terms set up for their account, the terms will
display here. If needed, the field can be typed over to enter a custom
number.

• Click the “Via” field to select a mode of transportation such as air,
ocean, etc. If a mode is not selected, the expense freight charges are
grayed out on the Charges tab.
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• The Reference # field will match the sales order number from the 
seller or any reference number the seller gives you. This number can 
be entered when you create the PO or later, and it can be helpful 
when you create reports.

• If a salesperson will receive a commission, select their name from the 
dropdown.

• If the PO needs approval, select the name of the person who 
approved it and the approval date.

• Select the Incoterms such as DDP (Delivered Duty Paid). This list of 
incoterms is pulled from the incoterms included in your Magaya 
system Configuration. (Additional incoterms can be added to that 
list as needed.) If the vendor/seller has Incoterms set in their profile 
(on the Pmt. Terms tab), they will be automatically filled in here 
when their name is selected for the PO.

• Select the shipping date.

• Connect the PO to a Job (optional) by clicking the “Set” button. To 
delete a Job number, click the X button next to the “Set” button. For 
more on Jobs, see the topic “Jobs: Managing Projects.”

• If this PO is for a division within the company, select the division 
from the dropdown.

• Select the Buyer, usually you, the wholesaler. (If you are a logistics 
provider, the buyer is the customer who is buying the items.)

• Select the Seller, usually the supplier or vendor that you buy from. 
This list pulls names from the Vendor list in your Magaya system. If 
the seller has payment terms set in their profile, those terms will be 
included in the PO, and the terms will be carried over into the Bill.

• If the Purchase Order has been accepted by the Seller, check the box.
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5) On the Commodities tab, enter the items to purchase:

• Click the “Add” button. A line is highlighted. Click in the Part
Number column of the line to activate a dropdown menu for the part 
number. Note: The list of part numbers pulls from the Inventory
Item Definitions list. (The items must be Resale items.) Items that
are Backordered can be added to a PO.
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• Click the “Browse” button to look for items.

More on the Commodities Tab:

Each line in the Commodities tab has a line number. Scroll across the 
commodity list to view the columns heading “Line No.” Click on it to drag 
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it to the start of the line if preferred. To change the order of items, 
right-click for a pop-up menu.

There is also a template that can display the line numbers in the PO docu-
ment. Select the template from the “Actions” button and link it to the PO.

The columns can be configured by right-clicking on a line item and 
selecting “Choose Columns” from the pop-up menu. Columns include 
“Requested Date” and “Landed Costs.”

If you need to enter additional information about a commodity, 
double-click the Status column of the line. The Commodity dialog box 
opens. The Pieces field is grayed out; this data must be entered manually 
on the PO. If you use the Commodity dialog box to enter an item in a PO, 
and you do not select a part number, the system will ask you for one.

The status of items is “Ordered”. The status will be updated as you 
perform related transactions; for example, when the items are received 
and placed in locations, the status changes to “On Hand”.

To cancel an item, right-click on it and select “Cancel the Line.”

6) On the Charges tab, enter the expense charges for freight and other 
expenses. The charges displayed here are the services you provide; they are 
not the (cost) charge per item, which is included in the Inventory Item on 
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the Commodity tab. The Charges tab shows totals for expenses, income, 
and the profit:

7) On the Events tab, enter events as needed. To display events related to this
order, check the box. For more details on entering events, see the section
on Events.

8) On the Attachments tab, add any documents or images. For more details
on adding attachments, see the section on Attachments.

9) Add notes in the Notes tab, and add internal notes on the Internal Notes
tab. For more details on using the notes tabs, see the section on Notes.

10) Click OK. The information entered in the dialog box appears in the
Purchase Order form.
231



Purchase Orders Chapter 7
Import a List of Purchase Orders

To import a list of Purchase Orders into your Magaya system, follow these steps:

1) Click Actions> Import

2) In the Import Wizard, set the fields that apply to the file you’re importing, 
the file type, and select the file to upload. You can import Buyers, Sellers 
and addresses when importing Purchase Orders from a CSV file.

See the following Knowledgebase article for tips about using the Import 
Wizard:

http://knowledge.magaya.com/#/article/import_wizard_tips
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3) In the wizard screen of Column Options, you can choose to group the POs
in different ways. Another option is to change the column headings by
clicking on a heading.

4) In the next screen in the wizard, confirm the data to enter.

5) The next screen shows the results of the import process, what was saved
(imported) and anything not imported due to errors. To see the error
reason, click the line item. You can export the errors and save them.

6) Click “Finish” to close the wizard. The new data is shown in your Magaya
system.
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Requested Date

In a PO, you can set the date that an item was requested. Click the column for 
the item to display a calendar and select the date.

The Requested Date can be viewed from the columns in the PO List by clicking 
the “Detail” button and selecting the “Detailed Inventory” panel.
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Actions for Purchase Orders

Many actions can be performed with a purchase order. Access the Actions 
menu from the list view or the document view:

The pop-up menu can also be accessed by right-clicking on a PO from the list 
view. Options on the menu are:

• Create reports (from the list view of the POs, not the document view): Use 
this option to make reports by seller, buyer, mode of transportation, etc. 
(If you added Custom Fields, they can be used in reports.)

• Go to document: This option opens the document view of the PO you 
selected.

• Attachments: This option opens a screen and display any documents or 
images attached to the PO. In this screen, you can also add or delete 
attachments.
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• Print a batch of POs you select. The Print dialog box opens. Follow the 
prompts.

• To exclude a PO from view on the online tracking tool, Magaya LiveTrack, 
select Exclude from Tracking. When an item has been excluded from 
tracking, a checkmark will appear next to the option.

• Cancel Purchase Order. A checkmark will appear in the pop-up menu for 
any cancelled POs. (The column “Is Cancelled” can be added by choosing 
the column from the Actions menu > Choose Columns.)

Note: To cancel a line in the PO, open the dialog box and go to the 
Commodities tab. Then right-click on the line and select “Cancel this 
Line”:

• Create Pickup Order. Use this if you arrange to pick up the items. When 
you convert a PO into a Pickup Order, you can load the PO or select items 
from the PO.

• Create Warehouse Receipt for items as they arrive. The status of the items 
will be “On Hand.” When converting a PO into a WR for items with vari-
able weight, you can indicate the actual weight received. You canl oad the 
PO or select items from the PO. This will help the receiving process for 
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loads that come in with only partial amounts from different Purchase 
Orders.

• Create a Bill. This bill is filled in with the charges from the PO automati-
cally. It is saved in the Bills list of your Accounting folder.

If there are charges for more than one vendor, the system will create a bill
for each vendor with the appropriate charges. If there are charges in more
than one currency for the same vendor, the bills will be split with the
charges of the different currencies.

• Create a Sales Order to sell items.

From the Purchase Order list, you can view a date range of transactions by using 
the date menus at the top of the list. To save a view, click the star button next to 
the date range options.

To select a different template, click the Actions button from the document view. 
The Summarized template groups all items with the same part number and 
selling price.

The status of a PO depends on the status of the items in the PO. For example, if 
the PO has 10 items and 4 were delivered but 6 are arriving, the status of the PO 
remains “Arriving”. To see the status of individual items, see the Commodity 
List in the Warehousing folder. The status can be one of the following:
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• Open: As soon as items are entered, the PO has a status of Open.

• Approved: The Approved status indicates the PO has been approved.

• Arriving: When the PO is converted to a Pickup Order, the status of the
PO is Arriving.

• On Hand: When the PO is converted into a Warehouse Receipt (the items
are received), the status is On Hand.

• Loading: The items in this PO have been placed in a shipment.

• In Transit: The shipment is in transit.

• Delivered: The shipment has been delivered.

Other options: Choose columns, import or export data, and see the history of a 
PO, including all transactions related to it.

NOTE: Items from a PO canbe loaded into a shipment even if the status of the 
item is “ordered.”

Online Tracking of Purchase Orders

The Magaya Supply Chain Solution gives you the option to make a Purchase 
Order (PO) visible or not visible online to your customers. This option is on by 
default.

From Magaya LiveTrack, the customer can view and print the PO, sort the list 
by date range, or use the Filter button to narrow down the view if the list is long.

If you do not want a customer to see an individual PO, the PO can be excluded 
from online view by selecting the PO and then selecting option “Exclude from 
Tracking” from the Actions button (or by right-clicking on the PO).

To exclude the list of all POs from the tracking view of a customer, follow these 
steps:

1) Go to Maintenance > Customers.

2) Click the Actions button (or right-click on the customer name) and select
“WebTrack User List”. A list opens.

3) In the list, double-click on the customer name to open the WebTrack User
dialog box. In the dialog box, click on the Tracking tab and uncheck the
Purchase Orders option.
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Accounting Transactions of Purchase Orders

Purchase Orders can be converted into Bills:

1) Go to the document view of the PO and click the Actions button to select
“Bill”. (Or right-click on the PO from the PO List.) The Bill dialog box opens:

2) In the Bill dialog box, changes can be made such as adding, editing, or
removing charges. Add attachments, events, or notes as needed.

The bill includes all the items in the PO. If you want to exclude an item, select it 
from the list and click the Remove button. Then you can return to create 
another bill later from the PO for any remaining items.

If there are charges for more than one vendor, the system will create a bill for 
each vendor with the appropriate charges. If there are charges in more than one 
currency for the same vendor, the bills will be split with the charges of the 
different currencies.

3) Click OK to save the Bill. It is saved in your Magaya Accounting folder > Bills.
The cost of each item is added to the related inventory asset account. (When
items are included in an Invoice and sold, they are deducted from assets and
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added to costs.) To see the asset account, go to the Chart of Accounts, right-click 
on the asset account and run a report for it.

If you are including landed costs or working with average cost of items, please 
see the Magaya Software Accounting Manualfor details.

If the accounting information for each item in the PO is not complete, the 
system will notify you:

To correct this, go to the Inventory Item Definition (in the Warehousing 
folder). Go to the Accounting tab, and add the accounting information there.

For more details on working with Bills, see the Magaya Software Accounting 
Manual.
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Sales Orders

Sales Orders: Introduction

NOTE: This article explains the Sales Orders in Magaya software version 10.2 
and later, which was released December 2015. Prior to version 10.2, the sales 
orders had a smaller screen and fewer features. If you don’t want to use the new 
features explained in this article, you can still get the current version of Magaya 
but configure the current version to function the same as it did in 10.2 or earlier: 
Go to Configuration > Sales, check the box “Automatically allocate sales order 
lines when added.”

Introduction to Sales Orders:

Sales Orders are used by wholesalers, distribution centers, or others who sell 
items. Having sales orders in your Magaya system helps you sell items, create 
reports, and track your wholesale operations and the related accounting 
processes more accurately. Let’s look at some of the main features for creating 
sales orders in your Magaya system.

As you create a Sales Order (SO), you have the option to select items from your 
inventory list, even if the item is out of stock. Items can be reserved or allocated 
right away. You can define and use substitute items. More than one user can 
create SOs at the same time.

The information entered in the Sales Order dialog box is transferred to a Sales 
Order document automatically, and the template for the document can be 
customized.

The system gives you the option to create new Sales Orders from scratch or use 
the information in an existing Purchase Order or Quotation to build a Sales 
Order. You can convert many SOs into Cargo Releases or Shipments for any 
SOs that have On Hand items. Also, your sales people and customers can create 
SOs online in LiveTrack and send them to your Magaya system.

Note on e-commerce connection, Logistico: The 10.2 and higher version of 
Magaya software is needed for customers who use Magaya’s e-commerce plat-
form, Logistico. See Logistico.com for details. Also see the Knowledgebase topic 
on Logistico for details on configuring your Magaya system to work with Logis-
tico.

Configure Sales Orders for Logistico

http://knowledge.magaya.com/#/article/Logistico_configure_sales_orders
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Configure Sales Orders

Go to Configuration > Sales. Check the options you want based on your busi-
ness model:

Backorders: To enable your Magaya system to create backordered items, check 
the option to allow creation of Sales Orders with backordered items. A Backor-
dered Item is an item that has not been purchased and is not in your inventory. 
Checking this enables your system to process inventory items even when you do 
not have the items on hand by saving the items in the “Sales Order Lines” List 
under the Sales Orders folder. This also enables your system to create Quota-
tions and convert them into Sales Orders, even for out-of-stock inventory 
items.The items can also be placed in Purchase Orders by right-clicking the item 
in the Sales Order Lines list.
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Configure for Allocating Items

To configure your system to allocate items immediately in the Sales Order, 
check the box “Automatically allocate sales order lines when added.” This will 
take an On Hand item from inventory in the warehouse and allocate it for the 
SO. If you leave this unchecked, the system will reserve items in the SO, but not 
take a specific item from the warehouse.

If you want your system to allocate items when the Cargo Release or Shipment 
transaction is created, check the box “Automatically allocate Sales Orders when 
released.” Check this option if you use the Logistico platform.

Restrict the locations that can be used to allocate items in Sales Orders by 
checking the locations to allow and uncheck to restrict use:

By default, the system checkmarks all the locations in the list as “allowed”. To 
restrict a location, uncheck the box.

This function can prevent the addition of certain items in Sales Orders. If a user 
creates a Sales Order and tries to add items that are in a restricted location, the 
system will display an error message.

For details on the other options in the Sales Configuration menu, see the topic 
“Configuration Menu”.

Steps to Create a Sales Order

This section explains how to create a new Sales Order manually in Magaya soft-
ware version 10.2 or later.
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1. Expand the Sales folder. Click “Sales Orders”

2. Click the “Add” button. A dialog box opens:

Let’s look at each tab in detail.
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3. Enter the following details on the General tab:

• The Sales Order number is an internal number assigned by your Magaya
system. It is filled in automatically based on the Configuration setup in the
Maintenance folder. It can be changed if needed.

The transaction date and employee fields are also filled in automatically,
and they can be changed as needed.

• Select the shipping date (when the items will be released) This is optional.

• If this sales order is for a division within the company, select the division
from the dropdown.

• If a salesperson will receive a commission, select their name from the
dropdown. To generate the commission, go to the Actions button after
completing the sales order.

• Select the Buyer, the customer who is buying the goods from you, the
wholesaler. If the order was created in LiveTrack by a customer or sales-
person, their name will display.

If the buyer has payment terms set up in their profile, they will be used in
this SO. These terms are carried over into the invoice.

If you are a 3PL who has an online retailer as a customer who sent in a sales 
order, the seller will be the billing client.
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4. Add items on the “Lines” tab by selecting a Part Number from the dropdown
list and clicking the “Add” button:

The Lines tab displays the items that the customer wants to buy. There may be 
a different status for some line items, depending on what inventory is on hand, 
backordered, etc. (See below for status definitions.) If a line item has the status 
of “Allocated,” then that means a specific item in a specific location has been 
assigned to go in this Sales Order. This location information does not show on 
the Sales Order document for the customer.

In a line item, you can change the description or price by selecting the field and 
typing over the existing text.

If you try to add more pieces than what is available, a dialog box called “Reser-
vation Conflict” opens:

It tells you that the quantity requested could not be reserved because there isn’t 
enough inventory incoming or on hand. You must tell the system what you 
want to do. Choose any combination of options below:

• Use available quantity: This will fill the SO with what is available, even if
what’s available is less than what the customer wants. For example, a
customer may order 20 items, but only 15 are available. The system asks
you how you want to fulfill the remaining quantity.
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• Allow the use of backordered lines: This will backorder more items.

• Allow the use of substitute Part Numbers:

Try to resolve with the least number of substitutes: If you have assigned a 
substitute item, the system will use it. This will be grayed out if you have 
not assigned a substitute in the Inventory Item Definition.

In an SO, you can set the date that an item was promised. To access the Promise 
Date function, click the column for the item to display a calendar and select a 
date.

Status of Items:

Let’s look at the status options available for the lines. Right-click a Line Item to 
view a pop-up with status options and functions. The functions available 
depend on the current status of the item.
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• Allocate Selection: This menu option is only available if lines are
Reserved, i.e., unallocated. It will select a specific item (PN and/or serial
number) that is in a specific location.

Let’s look at the status definitions:

• Allocate All: This will allocate all the line items in the SO, not just the one
highlighted.

• Manually Allocate: Enables you to go into the inventory and select the
exact items from specific locations and quantity of pieces. If an item is On
Hold, it can only be allocated manually. Only Reserved items can be
manually allocated. This does not use the sequence, and it’s not as effi-
cient.

• Deallocate Selection: to change a line item from Allocated to Reserved.
This function will change the status of selected items from "Allocated" to
"Reserved". It returns the item to inventory and to "On Hand" status. Items 
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cannot be deallocated if they are in a Cargo Release or Shipment, and if the 
SO was invoiced.

• Deallocate All: changes all to Reserved and returns the inventory. Items
cannot be deallocated if they are in a Cargo Release or Shipment, and if the 
SO was invoiced.

• Reserve Selection: Available if a line has the status of Backordered. An
item has a status of “Reserved” if there are items available. If no items are
available, they will be “Backordered.” When an item is in Reserved status,
the quantity of items to be sold is set aside in the system, but the actual
physical items are not selected in the warehouse from a specific location.
The system enables more than one salesperson to place orders at a time
because it will backorder an item if another salesperson reserved all the
available items in another SO.

• Set Selection as Backordered: Available if a line has the status of
Reserved; is returned to status of Backordered. A Backordered Item is an
item that has not been purchased and is not in your inventory. Ensure
your system is configured to allow backorders.

• Set All as Backordered: Returns the reserved quantity for all the reserved
lines and sets them as Backordered.

• Cancel Selection: This displays the line item but it is grayed out and the
status is “Canceled.” To be eligible to be canceled, items cannot be
invoiced or released.

• Cancel All: This displays all the line items as Canceled. They are grayed
out but still show. To be eligible to be canceled, items cannot be invoiced
or released.

• Remove Selection: This removes a selected line (or lines) but still keeps
the transaction. Can't be done if items are in a Cargo Release or Shipment,
and if the SO was invoiced.

• Remove All: This removes all line items but still keep the transaction.
Applies to lines that are not in a Cargo Release or Shipment, and can't be
done if the SO was invoiced.

• Other functions: Move lines up or down; reset line numbers; ungroup a
kit; see custom fields; see the history of the item or choose the columns
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The “Allocated” tab on the SO General tab shows the actual items that are allo-
cated.

Double-click a line to view the Commodity dialog box. Right-click a line to view 
a pop-up menu with options such as “Choose Columns” which includes 
columns to add such as the Location Code so you can see the item’s location.

In the “Allocated Items” tab, you can right-click for options. The information 
on the Allocated Items tab does not appear on the Sales Order document, i.e., 
it’s not visible to the customer.

The system will use your FIFO or LIFO setting (if you configured it) to fulfill the 
order. If your system has a sequence setup in the warehouse, the system will use 
the sequence to fulfill the order. For more details on these topics, search the 
Knowledgebase for “Sequencing:”

Sequencing

http://knowledge.magaya.com/#/article/sequencing_warehouse

Show Statistics: To see details about an item, highlight the line, and click the 
“Show Statistics” button. If you have an image saved in the Inventory Item Defi-
nition, it will appear here. It will also show how many of this item are on hand, 
backordered, etc. Hover over a field to see information.

5. Enter the following on the Advanced tab: These fields are optional.

• Connect the sales order to a Job (optional) by clicking the “Set” button. See 
the topic “What are Jobs?” for more details.

• If the sales order needs approval, select the name of the person who
approved the sales order and the approval date.
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• Select the payment terms from the dropdown. If the buyer has payment
terms set up in their profile (or your system), the terms will be displayed
in this SO. The field can be typed over to enter a custom number.

• Click the “Via” field to select a mode of transportation such as air, ocean,
etc. This is optional, but if a mode is not selected, then freight charges are
not activated on the Charges tab.

• The Reference # is the number is the Purchase Order (PO) number of the
company that is buying the items.

• Select the Incoterms such as DDP (Delivered Duty Paid). This list of inco-
terms is pulled from the Incoterms included in your Magaya system
Configuration. If the buyer/customer has Incoterms set in their profile (on 
the “Pmt. Terms” tab, i.e, payment terms), they will be automatically filled
in here when their name is selected for the SO.

• If there was a Purchase Order and it has been accepted by the Seller, check
the box.

The other tabs on the Sales Order contain the following options:

1) On the Charges tab, enter the income charges and income freight charges. 
For more details on charges, see the Charges section.

2) On the Events tab, enter events as needed. To display events related to this
sales order, check the box. For more details on entering events, see the
section on Events.

3) On the Attachments tab, add any documents or images. For more details
on adding attachments, see the section on Attachments.

4) Add notes in the Notes tab, and add internal notes on the Internal Notes
tab. For more details on using the notes tabs, see the topic “Notes”.

5) The Custom tab displays custom fields for the SO transaction. For details
on custom fields, search for the keywords “Custom Fields” in the Knowl-
edgebase.

6) Logistico tab: When a SO is received from the Logistico e-commerce plat-
form, then a “Logistico” tab appears on the SO dialog box. It will include
the sales channel (which online retail store the order came from), the
carrier, the shipping cost, and service type such as UPS Ground.

Click OK. The information entered in the dialog box appears in the Sales Order 
form.
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Sales Order Lines

Sales Order Lines will include all lines from all Sales Orders, including the status 
of each line item such as Backordered, Reserved, Allocated, etc.

The Sales Order Lines list is Read Only. The Add and Edit functions are grayed. 
The following functions are available by right-clicking a line:

• Convert a backordered item by creating a Purchase Order

• Create a report, export, history of the line, view the commodities, and
choosing columns
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Actions for Sales Orders

The Actions menu contains many options for the sales orders and can be 
accessed from the list view or the document view:

This pop-up menu can also be accessed by selecting an item in the list view and 
right-clicking it. Menu options are:

• To create reports, use the Actions button in the list view (not the docu-
ment view). There are many reports options such as creating reports by
buyer, seller, mode of transportation, etc. (If you added Custom Fields,
they can be used in reports.)

Also see the reports in the top toolbar menu for Profit Reports > Profit by
Customer. When the profitability of a SO is analyzed, other cost charges
on related Purchase Orders (POs) are considered.

• Cargo Releases and Shipments can be created from sales orders to ship
out goods to the customer. All the information in the sales order is auto-
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matically transferred to the new transaction you create. For more details 
on releasing cargo, see the topic “Release Cargo:”

How to Release Cargo

http://knowledge.magaya.com/#/article/create_cargo_release3

You can also drop ship items. See the topic “Drop Shipping” for details:

Drop Shipping

http://knowledge.magaya.com/#/article/drop_shipping

If you configured your system to allocate items when a release is created, 
then the line items will be allocated at that time. The system will use the 
sequence for picking items, if you have a sequence defined. Learn more in 
the topic “Sequencing in the Warehouse:”

Sequencing

http://knowledge.magaya.com/#/article/sequencing_warehouse

• Cancel SO: Any canceled S.O. will have a status of “Canceled” and display
in the S.O. List. The items will be returned to inventory.

Sales Orders that have already been canceled or contain items that have
been canceled from a Purchase Order may not be canceled again. Sales
Orders that have already been invoiced or loaded onto a shipment or
cargo release cannot be canceled.

• Invoices can also be created. All items must be “Resale items” and have the 
income and expense information in the Inventory Item Definition in
order to include the item in an invoice. If this information is missing, a
notice will tell you that all items must have appropriate charge definitions
assigned. (If you need to edit the information, open the Inventory Item
Definition dialog box and go to the Accounting tab.) See the section below
“Accounting Transactions of Sales Orders” for more. If selling a kit, the kit 
price displays, not the prices of the items inside the kit. See the topic “Kits”
for details:

Kits

http://knowledge.magaya.com/#/article/kits

If an invoice was already made, the option will be grayed out.

If there are charges from more than one vendor, the system will generate
an invoice for each vendor with the appropriate charges. If there are
charges in more than one currency for the same vendor, the invoices will
be split with the charges of the different currencies.

You can create an invoice even if the items are in Reserved status. The
inventory asset adjustments will need to be done when the SO is allocated
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because the specific cost for that item can only be known at that time. The 
system uses Specific Identification pricing method to calculate the price of 
the item in the Invoice and asset account.

• View attachments for a sales order by selecting the Attachments option.

• Print a batch of the sales orders. Select the sales orders to highlight them,
then choose the Print Batch option from the Actions button in the list
view.

• Batch Ship: Select more than one SO to create multiple Cargo Releases or
shipments for them at one time.

• View a document by selecting the “Go to Document” option.

• To exclude a sales order from view on the online tracking tool, Magaya
LiveTrack, select Exclude from Tracking. When an item has been
excluded from tracking, a checkmark will appear next to the option.

• Generate Commissions for salespersons. Only items or salespeople that
have inventory commission set up will calculate commissions. Create the
invoice before generating the commission.

To add a commission amount to an item, go to the Inventory Item Defi-
nitions list, select the item, and go to the Accounting tab in the item dialog
box. Then click the Commissions button to set the commission type and
amount.

A customized commission for an individual salesperson can be set up in
the profile for that salesperson in the Maintenance > Configuration menu. 
See the following Knowledgebase article for details:

http://knowledge.magaya.com/#/article/sales_commissions

• Customize the columns for the list by selecting the Choose Columns
option.
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• Select Template: This option includes a template with line numbers for all 
the items and a template to group items with the same part number and
price (the Summarized template).

• Import or export list data: For example, you can export the Sales Orders
list and upload it to the USPS “Click-N-Ship” program to get tracking
numbers.

• View the history of a sales order. This shows the history of the items in a
sales order that was shipped and delivered:

From the Sales Order list, you can view a date range of transactions by using the 
date menus at the top of the list. To save a view, click the star button next to the 
date range options.

The status of sales orders depends on the status of the items inside the sales 
order. For example, if the sales order has 10 items and 8 have been received, but 
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2 are still arriving, the sales order status will remain as “Arriving”. To see the 
status of individual commodities, see the Commodities list in the Warehousing 
folder. The status of the sales order (SO) can be:

• On Hand: As soon as items are entered, the SO has a status of On Hand.

• Backordered

• Loading: The items in this SO have been placed in a Shipment or Cargo
Release.

• In Transit: The shipment is in transit.

• Delivered: The shipment has been delivered.

Create Tasks: After the SO is created, you can create a Generic Task if needed to 
notify another employee to perform a task.

Sales Orders in LiveTrack

The Magaya Supply Chain Solution gives you the option to make a Sales Order 
visible or not visible online to your customers in LiveTrack. The default for the 
system is to make the SO visible.

Note: If you are using Logistico.com, the e-commerce platform, please see 
Logistico.com to learn about the platform. See also the Knowledgebase topic 
“Logistico” to learn about configuring your Magaya system to receive sales 
orders and to enable customer permissions:

Sales Orders and Logistico

http://knowledge.magaya.com/#/article/Logistico_configure_sales_orders

Magaya’s Online Sales Orders in LiveTrack:

If you do not want a customer to see an individual Sales Order, it can be 
excluded from online view by selecting the SO from the Sales Orders List and 
selecting the option “Exclude from Tracking” from the Actions button.

From Magaya LiveTrack, the customer can view and print the Sales Order, sort 
the list by date range, or use the Filter button to narrow down the view if the list 
is long.
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To exclude the list of all SOs from the tracking view of a customer, follow these 
steps:

1) Go to Maintenance > Customers.

2) Click the Actions button (or right-click on the customer name) and select
“LiveTrack/Logistico User List”. A list opens.

3) In the list, double-click on the customer name to open the LiveTrack User
dialog box. In the dialog box, click on the Tracking tab and uncheck the
“Submit Sales Orders” option.

Customers can also place Sales Orders online to buy items from your online 
store. Items in the online store are set up in Warehousing > Inventory Orga-
nizer. Permissions for this option are in the Maintenance folder > Customer List 
> Actions >Web Track Users list. See the topic “Online Sales Orders” in the
Knowledegebase for details.

Getting Started with Online Sales Orders

http://knowledge.magaya.com/#/article/online_sales_orders_intro

When a customer places a sales order online and it arrives in your Magaya 
system, the system can be configured to add the SO to the SO List even if there 
isn’t a Purchase Order. The items will have a status of “Backordered” and added 
to the Backordered Items list.

To get a quick view of which sales orders were placed online, add the column to 
your Sales Orders List by selecting the option “Choose Columns” from the 
Actions button. There are many columns to choose from. Here is an example:

If you configure your system to process online sales orders automatically and 
the sales order contains perishable items, the items are dispatched in the order 
set by the expiration date preference. For more on expiration dates, see the 
section “Add Resale Items.”
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Batch Ship Sales Orders

Multiple Sales Orders can be shipped out at one time. Filter the list or just 
right-click on a Sales Order with the status of “On Hand” in the list to launch 
the Batch Ship Wizard.

A Sales Order is eligible to be shipped if it contains On Hand items, if the buyer 
is not over their credit limit, and the items of the Sales Order are not in use by 
other user of the system.

If you want your Magaya system to automatically create Pick Tasks when Cargo 
Releases (CRs) are created, check the option for this function in Configuration 
> WMS > WMS Mobile.

To batch ship, right-click on an On Hand Sales Order in the list to launch the 
Batch Ship Wizard. After the introduction screen in the wizard, a list of eligible 
SOs will display.

Remember: If you filtered the list before starting the wizard, then you will see the 
transactions you selected. If you did not filter the list before starting the wizard, 
you can select what you want to ship here by filtering the list in the wizard or 
checking the transactions to ship.

In the next screen, decide how you want to release the items in the transactions:
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When you click “Next” in this screen, the changes are completed. You cannot 
return to this screen. Ensure you set the following as you need it processed:

Options:

• Process only single-line orders: Checking this option allows Sales Orders
with one line (item) only to be released

• Group by buyer/shipper address: By selecting this option, the Sales Orders
will be grouped by the buyer name and the shipping address saved in the
Sales Order, then all items of all Sales Order in each group will be added
to a single Cargo Release/Shipment. There will be as many Cargo
Releases/Shipments as number of groups created. If this option is not
selected, then there will be a Cargo Release/Shipment per Sales Order.

• Process Logistico clients only

Release to: (this sets the transaction type and mode of transport)

• Cargo Releases: If this transaction type is selected, the wizard continues to
a summary confirmation screen.

• Shipments: If you select this option, then select from the following:

- Force selected mode of transport: This will override the mode set in the
Sales Order transaction.

- Inherit mode of transport from Sales Order: This will use the mode
selected in the Sales Order.

- If the mode was not set in the Sales Order, select it here.
 261



Chapter 8 Sales Orders
Note: A mode of transport must be selected in order to continue in the wizard. 
If this batch of Sales Orders has different types of transport modes, the system 
will notify you so you can confirm this is okay.

If you selected the “Shipment” type of transaction, then the wizard shows you 
the folder list so you can select where to save the transaction.

Note: When you click “Next” the process is completed, and you cannot undo it.

Click “Finish” in the wizard when you are done. The transactions are created. 
Go to your list of Cargo Releases or Shipments to view them and fulfill them. If 
you want to create a batch of Pick Tasks for the orders, see the topic:

http://knowledge.magaya.com/#/article/wms_mobile_release/Create%20Mul-
tiple%20Pick%20Tasks

Other options for sending items out include just creating a Cargo Release or 
Shipment individually, or using the Express Link plug-in to release items using 
UPS or FedEx. See the Knowledgebase topic “Express Link: Getting Started” to 
learn more. Also see the topic on batch shipping with Express Link:

Getting Started with Express Link

http://knowledge.magaya.com/#/article/ExpressLink_batch_shipping
262

http://knowledge.magaya.com/#/article/ExpressLink_Get_Started


Sales Orders Chapter 8
Accounting Transactions of Sales Orders

Sales Orders can be converted into Invoices. Click the Actions button from the 
document view of the Sales Order and select “Create Invoice”. A dialog box 
opens:

All the charges in the Sales Order are automatically converted into the Invoice. 
When an invoice is created from a SO, the cost of each item is deducted from 
the related inventory asset account and added to the related Cost of Goods Sold 
(COGS) account.

Items can be removed from the invoice; then those items can be included in a 
different invoice later. When an invoice is created from a SO, the commodities 
are listed in the same order. (Change the order by right-clicking an item.)

If the income and expense information for any items in the Sales Order is 
missing, a notice will tell you that all items must have appropriate charge defi-
nitions assigned. All items must be “Resale” in order to be included in an 
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invoice. (It is recommended to use the Resalable items wizard when you first 
create a resale item.)

If you need to edit the accounting information for an item, go to the Ware-
housing folder, open the Inventory Item Definition dialog box, and click the 
Accounting tab.

If there are charges from more than one vendor, the system will generate an 
invoice for each vendor with the appropriate charges. If there are charges in 
more than one currency for the same vendor, the invoices will be split with the 
charges of the different currencies.

Note: To sell items (i.e., include them in a sales order), the items must have 
accounting information. This information can be found on the Inventory Item 
Definition dialog box on the Accounting tab. If you are a logistics provider who 
is shipping items but not selling them, then you do not need the accounting 
information for inventory item definitions.

If you are including landed costs or working with average cost of items, please 
see the Knowledgebase topic for details:

Landed Costs

http://knowledge.magaya.com/#/article/landed_costs
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Logistico: Configuration and Sales Orders

Logistico is an e-commerce platform that connects 3PLs to online retailers who 
are looking for distribution service providers. To learn more about the platform, 
see Logistico.com for details.

Using Logistico with Sales Orders

Version 10.2 (and higher) of Magaya software is needed for Magaya 3PL 
customers who have customers who use Logistico.

Operating System Requirements:

Logistico requires Windows Server 2012 R2, Microsoft Azure or Office 365. If 
you're using Windows Server 2003 as the server for Magaya System, Logistico 
will not work. You must upgrade your operating system. Microsoft ended 
support for Windows Server 2003 in July 14, 2015. See the announcement:

http://www.microsoft.com/en-us/server-cloud/prod-
ucts/windows-server-2003/

In this article, learn how to configure your Magaya system to manage Sales 
Orders received from Logistico subscribers, how to set permissions, and how to 
set schedules to update inventory and tracking numbers.

Configure Logistico

3PLs who interact with Logistico.com need to configure their Magaya system to 
allocate inventory items when the Cargo Release or Shipment transaction is 
created. Check the box “Automatically allocate Sales Orders when released.”
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Go to Configuration > Sales:

Enable Logistico:

Go to Configuration > eCommerce Fulfillment.
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Check the box to enable Logistico.

Configure Inventory Updates: To set up your Magaya system to update the 
inventory schedule, check the box. This will ensure the inventory quantities are 
updated in your Magaya system and in the Logistico subscribers’ systems.

Set the schedule by clicking the button with the 3 dots. In the dialog box that 
opens, name your schedule and set the conditions.

In the Schedule dialog box, name the schedule.

Select “Repeating” or “Once” from the Schedule dropdown menu.
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Check the “Enable” checkbox.

Select the frequency of the schedule from these options. Each option displays a 
subset of options specific to that choice:

• Daily: Select the number. For example, 1 means the schedule will be 
updated every day. 2 means it will be updated every 2 days, etc.

• Weekly: Select if you want it updated every week, select 1. Then check the 
day(s).

• Monthly: Select the day and the frequency

Set more details about the update schedule by making selections in the next part 
of the screen. This example shows a schedule that will check for updates each 
day, every hour during the start and finish times (all day).

Click Save and then OK to save.

Configure Tracking Numbers Updates:

To set up a schedule for retrieving external tracking numbers, set the times and 
dates you want. The buttons and menus in the dialog box work the same as the 
inventory schedule dialog box. This will enable your Magaya system to connect 
to Logistico.com and get the tracking numbers from orders that are shipped.
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Process the Sales Orders of the last - - - days: Set the number of days you want 
the system to go back and look for sales orders to find and process.

If you have the Transaction Tracking from Magaya, your Magaya system can 
send tracking updates to online stores and customers for carriers other than 
UPS, FedEx or USPS. To view tracking for UPS, FedEx or USPS, see Express 
Link.

Set User Permissions

Create a Customer profile for a new customer, or edit an existing customer to 
give them a login for connecting to your warehouse. This customer is the Logis-
tico subscriber. They may have more than one online store. You do not enter the 
names of the online stores inthe “Customer Name” field of their profile; you 
enter the name of the Logistico subscriber.

Create a user name and password for the customer, if they don’t have one yet. If 
they have a LiveTrack login, they can use the same one to connect their Logis-
tico account to your Magaya system.

Check the box on the General tab to "Enable Logistico access" .
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Right-click a name in your Customer list of an existing customer and select 
“Confiure LiveTrack/Logistico Access”.

Click OK to save.

Give the customer your Magaya Network ID, their user name and password. 
They will use it in their Logistico.com dashboard to add your warehouse to their 
system.

Assign Inventory Items to Logistico Subscribers

The definitions of the inventory items that your customer sells must be in your 
Inventory Items Definitions list. You can import them or manually enter them, 
just as you would with any other item. The “Client” field on the General tab 
must have the Logistico subscriber’s name.
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The Inventory Items Definitions list has many columns you can display to see 
information about the items such as what is allocated, reserved, on hand, 
incoming, etc.

If you use serial numbered items to fulfill orders, the channels in the Logistico 
portal will be udates with the serial numbers.

Create Substitute Part Numbers

If you define a substitute part number in the Inventory Item Definition dialog 
box, then the system will automatically offer if there isn't enough inventory of 
another item to add to a SO.

See the topic "Create Sales Orders" to learn how to use a substitute part number 
when creating a SO for a customer.
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Processing Logistico Transactions in your Magaya System

When a Sales Order (SO) is received from the Logistico e-commerce platform, 
then a “Logistico” tab appears on the SO dialog box. It will include:

• the Logisticon order number

• the sales channel (the online retail store the order came from

• the carrier

• the shipping cost

• the service type such as UPS Ground

Working with USPS for Tracking Numbers

Overview:

If you have a business account with USPS (the United States Postal Service), 
then you can use them to ship items and get the tracking numbers they generate. 
You can add those numbers into your Magaya system so they are on the Sales 
Orders and shipping transactions.

First you will export SOs to the USPS software Click-N-Ship program to create 
the shipments, and then import the tracking numbers back into your Magaya 
system.

Create a .csv file with these column names: Order Number, Full Name, Address 
1, Address 2, City, State, Zip, Country, Phone, Item SKU, Item Name, QTY

Steps:

• Go to the Sales order list, click Actions > Export.

• Export a CSV file from the Sales order list with the information needed by 
Click-N-Ship.
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• Go to your USPS Click-N-Ship account.

• Import the CSV file. Create shipments in batch and print labels.

• Export tracking numbers from Click-N-Ship and save them as a CSV file
(SO#, Tracking #)Import the CSV file into Magaya in the Sales Order List
> Actions > Import.

The Magaya system will update all Sales Orders, assigning the tracking numbers 
to the items as if they were created with ExpressLink. Then the Magaya system 
will send the shipment information to Logistico.

Right-click the order, select "Import External Tracking Numbers" (or use the 
Actions button in the List).
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Browse for the .csv file from the USPS program. Upload it into the SO List.

To see the number on the Sales Order (SO), open the SO, click on the "Allocated 
Items" tab. Double-click a line item to view the Commodity dialog box. Go to 
the "External Tracking Numbers" tab.

Now that you have the orders in your Magaya system, you can fulfill them by 
creating Cargo Releases or Shipments. If you have the Express Link plug-in you 
can use that to contact UPS or FedEx to schedule a pickup and print labels.

To ship multiple orders, filter the Sales Order list or select the SOs you want and 
then right-click to access the “Batch Shipping” option from the popup menu. 
For details on batch shipping, see the section on batch shipping in the topic 
“Create Sales Orders.”
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System Alerts for Logistico

You can set the following alerts in your Configuration menu:

Learn more about system alerts in the Configuration menu topic:

http://knowledge.magaya.com/#/article/configuration_menu
275



Chapter 8 Drop Shipping
Drop Shipping

Introduction to Drop Shipping

Drop Shipping is the process of selling items that you don't have on hand but 
are processed by ordering directly from a manufacturer or wholesaler and 
shipped directly to the customer. Benefits of this method include getting paid 
up front and doing business without having inventory on hand. To avoid back-
orders and delays, use multiple suppliers.

In the Magaya Supply Chain Solution, you can to load items from Sales Orders 
into an outgoing shipment even if the items are not on hand. This makes drop 
shipping possible in your Magaya system so items can move from the whole-
saler to your customers without having the items in your own warehouse.
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Steps

Configure your Magaya system to enable drop shipping:

1) Go to Maintenance > Configuration > Sales: Check the box “Allow
Drop-Ship orders on Outgoing Shipments.”

2) Process the order as usual by creating the Sales Order for the items.
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3) Create the outgoing shipment. When loading items, select the items from
the Load screen > SO tab:

As you load items, their status displays the same as from the Sales Order. 
After the items are loaded, their status changes to “Loaded.” The status of 
the items is updated throughout the journey, from “In Transit” to “Deliv-
ered.”

This drop shipping capability in the software creates a positive cash flow, even 
for items that are not on hand. It’s available in version 9.7 and higher of the 
Magaya Supply Chain Solution.
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Chapter 9
What are Jobs?

A Job is a specific project; it relates all transactions involved in a project and 
tracks them as a group from seller to buyer or from origin to their final destina-
tion. All transactions related to a Job are grouped in one place, and profit is 
calculated based on the items in that job.

The Jobs screen in the Magaya Supply Chain Solution is the project manage-
ment screen. It contains many functions that are designed to help you manage 
projects, track progress, and see all related data in one place.

Create a Job:

The process of creating and working with Jobs is to first create a Job by clicking 
the “Add” button in the Jobs screen. Then go to the first transaction (such as a 
PO) and connect it to the Job (in the PO dialog box). This connects all the items 
in that transaction to this Job.

As those items are included in other transactions (such as WRs), those items are 
added to the Jobs screen automatically, enabling you to view all the related 
transactions in one place.

If you connect a PO to a Job, it is not recommended to link a Sales Order to that 
Job. If so, the items from the PO will no longer be linked to the Job, but they will 
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be replaced with the items in the Sales Order. It is recommended that you begin 
the Job process from either the PO or from the Sales Order, not both.

If needed, an item can be manually added to a Job from the Commodity dialog 
box for the item. Click on the Identification tab and click the Job button.

Linking Transactions and Tracking Job Progress:

As you perform operations and create transactions in your Magaya system, you 
can link the transactions to a Job so you can see them all in one place.

To link a transaction such as a Pickup Order or Warehouse Receipt to a Job, go 
to the transaction and click “Actions” to select “Add to Job” from the menu.

For Purchase Orders and Sales Orders, open the transaction dialog box, and 
select the Job number using the Job field and “Set” button on the General tab.

The commodities (items) in each transaction are also linked, and every time the 
items are involved in another transaction, the Jobs screen will be updated, 
helping you see the overall progress of the Job as it moves from 0% to 100% 
completed.

If all or most of the items in a Job have the status of “Ordered”, the Job will have 
a low completion rate, perhaps less than 10%. When all the items have a status 
of “Delivered”, the Job status will reach 100% completed.

Status of Items in a Job:

As each item inside a transaction is moved along in the process - from ordering, 
arrival at the warehouse, storage, and shipping - a status is assigned to the items:

• Ordered

• Arriving

• On Hand

• Loaded

• In Transit

• At Destination

• Delivered

For example, when you receive the PO from your customer who is renovating 
the hotel, you purchase the items they request. You enter the PO into your 
Magaya system, and link the PO to the Job. (Add the Job in the Job screen if you 
did not already.)

When you pick up the items from the manufacturer, the items have a status of 
“Arriving”. When you enter them into your Magaya system by creating a WR, 
the status of the items is updated in the Jobs screen to “On Hand” automatically. 
When you ship them, they are “In Transit”. When they reach the customer, they 
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are “Delivered”. When you liquidate the shipment at the end, all the accounting 
transactions will be updated in the Job automatically.

The Job will remain “Open” until you close it via the “Actions” button; the “End 
Date” is updated on the General tab when you close the Job. The “Due Date” is 
a deadline you set when you create the Job. As the status of the items is updated, 
you will see how close the Job is to being completed and meeting the due date.

In one quick glance at the Job percent, you can see if the Job is where it needs to 
be so that it can get done on time.

Jobs Screen Toolbar:

Let’s take a look at the Jobs toolbar. The Jobs screen has a toolbar with buttons 
for moving between jobs, adding a new job, deleting a job, finding and filtering 
jobs, and the Actions button. This Actions button is used to set a Job as open or 
closed, to view the history of a Job, or exclude a Job from online tracking. Here 
is the Jobs screen showing the toolbar on the top and the tabs:

The job number is assigned automatically. Numbering for all transactions can 
be set in the Maintenance > Configuration menu.
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The completion percentage of the Job is updated automatically as transactions 
are completed. When the items are delivered, the Job status “Closed” and the 
percent complete is 100%.

Select the Customer for this Job, and set the Due Date. The End Date is the the 
deadline you set.

The buttons in the tab strip are similar to the tabs in the dialog boxes for other 
transactions such as warehouse receipts, cargo releases, etc. You can click on the 
buttons for the tabs such as General, Items, Purchase Orders, Sales Orders, 
Operations, Profit, etc.

From the Jobs List, Jobs can be added, edited, or deleted. New columns can be 
added by clicking the Actions button in the list view.

General Tab

The General tab displays fields for the employee name (the person who entered 
the job into the system), the end date of the job, a job description, and the events 
related to the job. These fields are optional, but entering information makes the 
Job screen and reports more useful.

To see all events related to this job, click the Show All button. The event list will 
populate automatically from the events of related transactions such as the WR 
or shipment.
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To add events specific to the Job, click on the Add button. This Event dialog box 
opens:

• The date and time default to the current time. Change it as needed.

• Select the event type such as “Cargo scanned in”.

• Add details (optional).

• Select a location for the event.

• To include the event in the online tracking, keep the checkmark in the 
checkbox. This event will be visible online to the customer for this job. 
Uncheck it as needed.
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Items Tab

The Items tab displays all the items in the Job:

The default columns in the list display the status of the items, the package type, 
description, dimensions, and other details. You can choose the columns to 
display in the list to view the information you want to see such as the Warehouse 
Receipt that the items are related to, etc.

Items cannot be added in this list directly. They are added when you relate a 
transaction to a Job (as explained in the section “What are Jobs?”). Items can be 
edited or deleted from the Job.

The options available from the Actions button for the Items list are the same as 
those available from the Commodity List in the Warehousing folder. See the 
topic on the Commodity List for more details. (This Actions button is not the 
same Actions button that is used for the Job screen itself.)

If an option is grayed out, it is not available. For example copies of items cannot 
be added to this screen.
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Purchase Orders Tab

The Purchase Order tab shows all Purchase Orders (PO) related to the Job.

POs can be added to the Job from the PO list or edited. The Actions button 
provides options such as create reports, go to the PO, exclude a PO from 
tracking, or cancel a PO. You can also create a Pickup Order, a Warehouse 
Receipt, a Bill or a Sales Order. These menu options are also available when you 
right-click on an item. For details on the Actions button menu for POs, see the 
section on Purchase Orders.

Sales Orders Tab

The Sales Order tab shows all sales orders related to the Job:

Sales Orders can be added from this screen or edited but not deleted from the 
Job.

Caution: If you connect a PO to a Job, it is not recommended to link a Sales 
Order to that Job. If so, the items from the PO will no longer be linked to the 
Job, but they will be replaced with the items in the Sales Order. It is recom-
mended that you begin the Job process from either the PO or from the Sales 
Order, not both.
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The Actions button provides options such as create reports, go to the document, 
exclude it from tracking, create an Invoice, and more. For more details on the 
Actions button menu for Sales Orders, see the section Create a Sales Order.

Operations Tab

The Operations tab displays all the related cargo transactions for the Job:

The default columns include the type, name, and date of the transaction, and 
more. The Name column shows the transaction number or shipment number 
(the air waybill number for air shipments and the Bill of Lading for ocean ship-
ments). To go to any transaction, right-click on it, or click the Actions button 
for this list.
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Profit Tab

The Profit tab shows all charges created in each transaction related to the Job.

The total expense, income, and profit for the whole Job are displayed at the 
bottom of the screen. The profit is calculated based on the items in that Job.

Right-click a transaction to view the charge for it, or to select other options such 
as if you want the charge to show in the document. If you need to change a 
charge, double-click it to open it. If you need to add a new charge, go to the 
transaction. Changes are automatically updated in the original transaction and 
in the total for the Job. You do not have to manually update it. You can go a 
transaction by right-clicking on it.
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Accounting Tab

The accounting tab shows all Accounting transactions created for this Job such 
as invoices.

Accounting transactions cannot be added or deleted from this list. Since Jobs 
track items, the items are included in the Job as transactions are linked to a Job. 
For example, when a Bill is created from a Purchase Order, that Bill will be 
added to the Job because the PO is linked to the Job. (If a PO is not linked to a 
Job, you will not see the accounting transactions in the Job screen.)

The following options can be accessed from the “Actions” button for this list or 
by right-clicking on the transaction: Go to the document, clear or unclear the 
transaction, print a batch, choose columns, export, and history.

Attachments Tab

The attachments tab show any images or other documents such as a contract for 
this project you want to attach to the Job.

To add attachments, click the Add button. (Images included in Inventory Item 
Definition dialog box will not display here because these are attachments at the 
Job level, not the item level.) For more on attachments, see the topic, “Attach-
ments”.

Internal Notes Tab

The Internal Notes tab is similar to the Internal Notes tab on other transactions. 
You can include notes that will not be visible to the customer via Magaya Live-
Track. For more details on Notes, see the Notes topic.
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Viewing Jobs Online

Your customers can see the data about their projects online by using Magaya 
LiveTrack. Click on the Job to open it and view the details:

Customers can view and save attachments and print the Job document.
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Jobs Reports

Many reports can be created in the Jobs list by clicking on the Actions button to 
access the reports menu:

For example run reports to see the profitability of all jobs for a specific client for 
a desired date range. Also determine which client is generating the highest job 
profit for you. Select the date range needed. To save the report, click the Actions 
button.
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Chapter 10: Pickup Orders

Introduction

A Pickup Order is a document that outlines the terms for the delivery of goods 
from one location such as a supplier to your warehouse.

The Pickup Order specifies the location of the pickup, identifies the carrier who 
will pick up and deliver the cargo, the location that the cargo will be delivered 
to, applicable charges, and the dimensions and description of the cargo.

When a customer calls you and asks you to pick up their cargo and bring it to 
your warehouse or to deliver it directly (without going to your warehouse), you 
will create a Pickup Order.

Pickup Orders are located under the Warehousing folder. You can view the 
Pickup Orders as a list or in document form.
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Pick Up Cargo: Create a Pickup Order

There is more than one way to create a Pickup Order in your Magaya system, 
depending on your business model. For example, you may give a customer a 
quote first. Then you can convert that Quotation into a Pickup Order, which 
transfers the information for you from one transaction to another. If you don’t 
make Quotations, you will need to know how to create and issue an order to 
pick up cargo. Let's look at how to create a Pickup Order from scratch.

Note: For an introduction to picking up cargo, including learning about docu-
ment templates, see the topic "Introduction to Pickup Orders" in the Magaya 
Knowledgebase available in Page One, the welcome screen in your software.

http://knowledge.magaya.com/#/article/intro_pickup_orders

To create a Pickup Order, go to the Warehousing folder and click “Pickup 
Orders.” Note: You can create a Pickup Order from the list view or the docu-
ment view. This topic explains the process from the document view.

There are different templates you can apply to the Pickup Order after entering 
data in the dialog box.

In the toolbar, click the “Add” button.

A dialog box opens. Let’s review how it works: In this dialog box, you will enter 
details that will be automatically placed in a document for you. You do not need 
to type any documents. The dialog box saves all the data you enter so you can 
print a document, send it via email directly from your Magaya system, or use 
any of the information in reports. You don't have to retype anything, so you save 
time and reduce errors.
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Tabs are listed across the top of the dialog box. You can click any tab to view it. 
Use the arrows to scroll and see more tabs. To widen the dialog box, click and 
drag the bottom corner. We'll look at each tab, one at a time, and explain the 
fields in each tab.

General Tab

The General tab is the best place to start (but it's not required). Let's look at each 
field on the General tab. A blank Pickup Order will have the status of “Empty” 
which is noted on the top of the General tab. This status will change after you 
save this transaction and as you work with it.

How are Pickup Order numbers defined? Magaya software comes with a default 
numbering system for transactions. To change it to any combination of letters 
and /or numbers, go to Maintenance > Configuration > Document Numbers. 
(We won't go into detail about the numbering here. That is covered in the 
Magaya Software Customization Manual, Chapter 3. See also the topic “Intro-
duction to the Configuration Menu” in the Magaya Knowledgebase.) The 
numbers are used to identify the transaction in your Magaya system.
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The Date and Time fields for Creation, Pickup, and Delivery all default to today. 
Change them as needed by clicking the arrow. (The “Creation Date” is the date 
and time that this Pickup Order is created in the Magaya system.)

The system automatically fills in the name of the user in the Employee field.

The “Issued By” field is set to display your company by default. Change it if you 
are an agent acting on behalf of someone else.

The Destination Agent can be left blank if you do not know it at this time.

Shipper Tab

The Shipper tab contains fields to select who is shipping the cargo (or items) and 
where to pick them up.

Select the Shipper by clicking the arrow. The list displays the Customers, 
Vendors and Forwarding Agents that are saved in your Maintenance folder. (If 
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you don't see any or if you need to add a new one, click the plus sign in the drop-
down menu's toolbar.)

The address for the entity will display on the Shipper tab. The Address "Change" 
button: click to select a different address than the default for the shipper. (These 
are saved addresses on the entity's profile. You can add an address here too, for 
example a branch office. It will be saved in the system for future use.)

Use the Copy button if the pickup location is the same as the shipper. Otherwise, 
select the pickup location from the dropdown menu.

The "Place" field is used if you have Rates entered in your system. Rates are 
recommended but optional. You can leave this field blank. To use this field, 
please read the following: In the Pickup Order, the rates work by generating 
ground freight rates automatically by the zip code of the Pickup Location field 
on the Shipper tab. It will also use the Place set on the Consignee tab for the 
Delivery Location. The system reads the zip codes in the Pickup Location and 
in the Delivery Location and compares them with the Zone Definitions (avail-
able via the Ports List > Actions). It will find the cities for those Zones, and then 
find the corresponding Rate entered for that city (in the Rates list). Rates are 
explained in Chapter 11 of the Magaya Software Accounting Manual.
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To add a zip code to a port, go to the Ports list, click the Actions button > Select 
Zone Definitions. Click the Add button and enter the zone details.
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Here are some examples zones defined:

Consignee Tab

The Consignee is the person or company who is receiving the goods ultimately. 
When you are creating the Pickup Order, you may not have this information. If 
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you have the details, add them to this tab by using the dropdown menus as 
explained earlier.

For the "Delivery Location" field, select the entity of the place where the items 
will go.

The "Place" field is used if you have Rates entered in your system. Rates are 
recommended but optional. Refer to the explanation in the section "Shipper 
Tab."

If you know the client who will be billed, select it. The “Client to Bill” field is the 
entity that will pay for the charges. The system defaults to the Ultimate 
Consignee for this field. Change it as needed. When selecting an entity for 
the“Client to Bill” field on the Consignee tab, this affects the Charges tab by 
telling the system to default to that entity when you add charges on the Charges 
tab, making charge creation faster. Of course, you can add a charge for any 
entity, not just the one set in the Consignee tab as the Client to Bill. Simply 
create the charge and select the entity you need to apply the charge to. We'll 
learn more about charges when we get to the “Charges” topic.
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Supplier Tab

The Supplier may contain some of the same information as the Shipper tab. The 
Supplier is the entity who provides the goods for the Shipper.

Select the entity name for the Supplier for this Pickup Order.

Enter the Invoice number if you have it. This invoice number is for the commer-
cial transaction that pays for the items.

Enter the Purchase Order (PO) number if you have it. This PO number the 
corresponds to the commercial transaction that purchases the items.

Carriers Tab

The fields on the Carrier tab are:

The Inland Carrier is usually an overland trucking company. This entity 
provides transportation for the Pickup Order.
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The Main Carrier is usually an ocean carrier if the cargo is sent by sea after the 
pickup is done. This applies when this is part of a complex transportation 
arrangement that has more than one leg.

The Return Address is the address where the container is returning to; this is 
mostly used by an NVOCC.

The PRO number is optional. Enter it if you have it. It is a progressive, or 
sequential, number used by the inland carrier trucking company to identify the 
straight BL and to track freight bills.

If you have the driver's name and license, you can enter it here.

If the carrier gave you a tracking number, enter it.

Enter the Booking number if this Pickup Order is part of a Booking that is made 
in your Magaya system.

If this transaction includes a preferred mode of transportation, select it from the 
dropdown menu. (The preferred mode field is filled automatically if this trans-
action was created online in LiveTrack by a user who entered a preferred mode 
of transport.)

The "Preferred Mode of Transportation" on the Carrier's tab is also connected 
to the Rates in your system, if you have rates set up. If you do have rates in your 
Magaya system, then select the "Preferred Mode of Transportation" on the 
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Carrier's tab in order to tell the system which rate to use such as the Ground rate 
for this transaction. The system also takes into consideration the origin and 
destination and other criteria in the rate.

Commodities Tab

In the Commodities tab, you can add commodities or a container.

The Pickup Order can be used by couriers or others who receive a high volume 
of small packages. Just scan the barcodes of the items into the Commodity tab, 
and then select the “Pickup Order Courier Manifest” template afterwards. This 
will enable you to receive the items faster. Then after the driver leaves, you can 
create WRs for each consignee.

A commodity can be a Part Number that’s already defined in your Magaya 
system, or it can be loose cargo that you describe now as you enter it.

There are a lot of functions on this tab, so let's discuss one at a time.

The first two buttons on the top right are used to add a commodity ("Add"), if 
you want to add a line item that does not need inner detail. Or add a container 
("Add Cont...") which will have many commodities and details inside it. To view 
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those details after you place items inside, click the "Detail" button. If you need 
to group items inside a container or other package type, click the "Repack" 
button.

To add a commodity such as a box, a pallet, or other item, click the "Add" 
button. This opens the Commodity dialog box where you enter the details. Then 
that commodity is added tothe transaction. You can add as many commodities 
as needed.

The Commodity Dialog Box:

The Commodity dialog box has many fields and tabs. It has tabs you can scroll 
through and use as needed, but for this topic we'll focus on the General tab. To 
learn more about the Commodity dialog box now, see the article in the Knowl-
edgebase:

http://knowledge.magaya.com/?search=commodities_tab
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On the General tab of the Commodity dialog box, you can enter information 
about an item for pick up. The information can be filled automatically when you 
select the Part Number field, or you can enter the details manually.

Fields on the General tab of the Commodity dialog box:

• If you don't have a part number to select, start with the Description field. 
A Part Number (PN) is a number that identifies an item. The PN may be 
from the manufacturer, the customer, or defined by your company.

• The “Pieces” field is how many packages will display on the line in the 
Commodity tab. For example, 1 box is 1 piece. Even if you have 1 box with 
other pieces inside it, enter "1" in the Pieces field. Another example: If you 
pickup 10 boxes, enter “10” in the Pieces field.
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• The dimensions are the measurements of a particular line item in the
Pickup Order. The dimensions are per piece. For example if you have a
pallet, enter the dimensions of the pallet, regardless of how many items are 
included in the pallet.

• The “By Totals” field is volume and weight of all the pieces together. This
is useful if you don't know the weight of each box; then enter the total for
all the boxes in the Total field. (When you check the box, the weight field
will be grayed out, so you can enter the total weight. This selection is
saved.

• The “Quantity” field is used to enter the quantity of items commercially
purchased. This field is used if you are declaring insurance or if you need
a Commercial Invoice to include the value per item. This is used for resale
items, not for cargo items. It’s optional and can be left blank.

Example, if you have 1 box with 12 items inside, you have a "Quantity" of
12. To track the value per item, enter the value of one item in the "Unitary
value" field. For example, if the box has 12 items, and each item is valued
at $50, enter "50" in the "Unitary value" field. The system calculates the
total value for you. If your Inventory Item Definition for a Part Number
includes the value, it will be filled in here.

Click OK to save the information in the Commodity dialog box and return to 
the Commodity tab in the Pickup Order.
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Other buttons on the Commodity tab help you with different functions, some 
you may use and others you may not. Let's look at them to learn about the 
options.

When you click a line item, that line is highlighted (or "selected") and certain 
buttons become active on the tab:

• The Edit Button: Click it to open the dialog box and make changes

• The Delete Button: Click it to delete that line item

• The Detail Button: Click it to open the dialog box for a container or
package. The Detail button is not active unless the item is a container with
items inside it.

• The Scan Button: Used with a handheld scanner to scan bar codes. This
topic will be covered in the Warehouse Receipts section of the course.

• The Repack button: Repacking is typically done in the warehouse after
items are received and they need to be repacked to be shipped out by
grouping them inside another package type or a container.

Additional options are available by right-clicking an item to open a pop-up 
menu:

By right-clicking, you can change the columns in the Commodity tab, create 
reports, and other functions.

How to Add a Container to a Pickup Order:
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If you need to create a Pickup Order for a container, click the "Add Cont..." 
button on the Commodity tab. This container will include commodities and 
details about the commodities inside the container.

The Container dialog box has many tabs. For a Pickup Order, the most 
commonly used tab is the first one, the Container tab. It enables you to select 
the type of container. To do this, click the arrow for the field "Container Type" 
and scroll through the list in the dropdown menu.

The Container Types included with the Magaya system are listed in order, 
starting with different types of 20-foot containers, then 40-foot containers, and 
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other package types. Containers for air freight are included, beginning with the 
letters "LD."

Tip: If you know the name of the container type you're looking for, type the first 
letter of the word, and the list will jump to that section, saving scrolling and 
searching.

Enter a description of the container (optional).

Enter the container number.

Enter the Seal number. If there are two seal numbers, enter both.

Enter the dimensions of the container if needed. If you select one of the 
container types of 20- or 40-foot containers or the LDs units, the dimensions are 
filled in automatically.

Check the box if you want to add the weight of the contained pieces to the total 
weight.

Select a warehouse location from the dropdown menu to define the place where 
the cargo will be picked up.

The Notes field is optional.

The Identification tab contains fields for the invoice number and PO number:

Enter the invoice number, the PO number and the Job (if applicable).
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The fields for EEI, Hazardous Materials, AMS, and Attachments tabs in the 
Container dialog box are the same as for the Commodities dialog box. Please see 
the Commodities section for information on entering data in these tabs.

Note: When you use the “Add Container” button, that container will appear in 
the Container Reports (available from the Shipment List Actions button). If you 
use the “Add” button to add a commodity and then selected the container type 
from the Package Type list, it will notappear in the Container Report.

The Refrigerated tab contains fields for the ventilation and temperature set up.

After you have entered the information needed, click the OK button. This 
returns you to the Pickup Order.

Charges Tab

The charges entered in the Charges tab are integrated into the accounting 
system in the Magaya Explorer and will appear on invoices, bills, etc.

To add a charge, click the Add button and select a charge type. Remember the 
“Client to Bill” field on the Consignee tab? If you set that field on the Consignee 
tab, then that entity will automatically be filled into the Charges dialog box, 
making it easier to create charges. If you want to change the entity, select 
another entity from the dropdown list.
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Since the mode of transportation is Ground, the Income Freight Charge and the 
Expense Freight Charge will be Ground. For local deliveries, Inland Freight is 
often used. If you have rates set up in your Magaya system and automated to 
appear in Pickup Orders, they will appear on this tab.

If you want the charges to list in a certain order, right-click to move them up and 
down and then select “Output charges as displayed.” Other options available 
when you right-click on a charge include the option to recalculate (regnerate) 
charges if you make changes; then click the “Generate” button again to update 
the A/R and A/P transactions, if you already made them.

For additional information about the Charges tab, please see the topic 
“Charges” in the Magaya Knowledgebase:

http://knowledge.magaya.com/?search=charges_tab

Events Tab

The Events tab is used to list any events related to the Pickup Order. The fields 
on this tab are optional.

There are many event types to select from, or you can add your own. Click the 
Add button. A dialog box opens to set the date and time for an event, and to 
 310



Chapter 10 Pick Up Cargo: Create a Pickup Order
select from a dropdown menu of choices. If you don’t see a choice that fits your 
needs, you can type the event in the Description field.

The “Location” field includes the ports that are commonly used by your system. 
These are set in Maintenance > Ports.

The option to display an event online is checked by default. If you do not want 
your customer or other entity to view the events online in LiveTrack, click in the 
box to uncheck the option.

Click the OK button to save the event information and return tothe Events tab.

As you work with this transaction, you may want events to display in this trans-
action. If so, check the box in the Events tab.

For more information on the Events tab and on how to define your own events 
for use in Pickup Orders and other transactions, see the topic “Events” in the 
Magaya Knowledgebase:

http://knowledge.magaya.com/?search=events
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Attachments Tab

The Attachments tab is used to add any photographs or documents to the 
Pickup Order. Add by clicking and dragging from another window on your 
computer, or by clicking the “Add” button. This tab is optional.

For details on adding attachments, see the topic “Attachments” in the Magaya 
Knowledgebase:

http://knowledge.magaya.com/?search=attachments

In version 10.4 or newer, you can click the “Get Pictures” button to attach 
photos if you use a CubiScan scanner with cameras. Learn more in the CubiScan 
article in theKnowledgebase:

http://knowledge.magaya.com/#/article/Cubiscan

POD Tab

Click on the POD Information checkbox to enable the fields if you want to 
require a POD: Delivery date and time, who received the delivery, and any 
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comments. (POD is Proof of Delivery. It is used when the consignee is not your 
warehouse.)

You can add a Task to create a pickup on th ePOD Mobile app. Learn more:

http://knowledge.magaya.com/#/article/POD_mobile_getting_started
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Notes Tab

The Notes tab is used for adding notes or clauses to your Pickup Order. These 
notes will be visible to the customer. This tab is optional.

For details on adding Notes, including how to define your own clauses, see the 
topic “Notes” in the Magaya Knowledgebase:

http://knowledge.magaya.com/?search=notes_and_internal_notes
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Internal Notes Tab

The Internal Notes tab is used to add notes for internal use within your 
company. These not will not appear on the Pickup Order and will not be visible 
to the customer or carrier. This tab is optional.

To add an internal note, click “New” and type your internal note. Be sure to click 
“Save” or the note will not be saved!

For details on adding Internal Notes, see the topic section “Notes” in the 
Magaya Knowledgebase:

http://knowledge.magaya.com/?search=notes_and_internal_notes

Finish:

Click the OK button on the Pickup Order dialog box when you are finished 
entering information. The Pickup Order document will be filled in automati-
cally. Verify the information. To make changes, click on the Edit button. Notice 
the status in the list view and if you open the dialog box again.
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Related Resources

Also see the topic “What Actions can I Perform with a Pickup Order?”

Actions for Pickup Orders:

http://knowledge.magaya.com/#/article/actions_pickup_orders
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What Actions can I Perform with a Pickup 
Order?

After completing the Pick up Order, you have many options in Magaya soft-
ware. You can print the pickup order or a label, email the pickup order, make a 
copy, or other options. This topic covers the options available from the toolbars 
and the Actions button.

The toolbar option you see may vary from these screenshots depending on 
which Magaya software product you have.
317



What Actions can I Perform with a Pickup Order? Chapter 10
Let’s look at some buttons on the top toolbar.

Find: This gives you the option to search by transaction number with the Quick 
Find feature, or to search by any text in a document. See the section “Find 
Button” for more.

Send: To send messages within the Magaya Network.

Email: For sending documents or tracking link via email.

For steps to create a Pickup Order, see the Magaya Knowledgebase, which is 
available from Page One, the welcome screen inside your software.

Let’s look at printing labels next.

Print Labels

By printing the receiving labels from the Pickup Order, you will not need to 
print them when a Pickup Order is converted into a Warehouse Receipt and the 
cargo arrives. This can save time when receiving cargo, but make sure to keep 
the labels in a safe place until they’re needed.

Another label printing option available is for online pickup orders: If a Pickup 
Order is placed online by your customer, they can print the labels for their items 
and place the labels on their boxes. You will need to configure your Magaya 
system to allow end users to print labels. The label they will print is called a 
“Tracking Pickup Label” 4x6.

Click the arrow on the Print button and select “Print Labels”:
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The Print Labels dialog box opens:

• Select the Pick label size and printer setup.(Note: The Tracking Pickup 
Label is used for online pickup orders.)

• Change the quantity of labels to print if needed. The system defaults to 
printing ALLthe labels, as shown in this example.
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Actions Button for Pickup Orders

You can perform the following actions from the Pickup Order document view 
by using the Actions button:

Note: The “Jobs” option is available in the Magaya Supply Chain Solution.

View Transaction Listing: Click on the Actions button and select Transaction 
Listing. You can filter the list so it only displays the transactions you want to see. 
For more on what you can do with the transactions list such as generate 
accounting transactions, see section below” Generate Accounting Transactions 
from Pickup Orders.”

Attachments: To view the attachments such as photographs or documents 
attached to the pickup order, click on the Actions button and select Attach-
ments. If an attachment was added to an individual commodity, view it by 
clicking on Edit to open the dialog box. Then click on the Commodities tab and 
open the commodity (cargo item) by selecting it and clicking on the Edit button. 
(It can also be viewed from the Commodities list in the Warehousing folder.)

Create a Copy: Click to copy the pickup order with all the same information. 
This is useful if you pickup the same type of cargo from the same location or 
supplier.

Create Warehouse Receipt: If the cargo has been picked up and brought to the 
warehouse, you can create a Warehouse Receipt (WR) from the Pickup Order. 
All the information from the Pickup Order will be transferred automatically to 
the WR. You can edit information such as package dimensions or weight.
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When you create the WR from the Pickup Order, a dialog box of the commod-
ities opens. You can select all the cargo or pieces:

In the dialog box, you can choose the columns by right-clicking on a 
commodity.

For more information on creating WRs, see the topic "CreateaWarehouseRe-
ceipt".

To set a cargo as “In Transit”, select the option: Set/Reset In Transit.

To set a cargo as “Delivered”, select the option: Set/Reset Delivered.

• Note: When you set cargo in transit, a checkmark appears next to the
option in the list. If you uncheck it, the status of the cargo will return to its
previous status: Loaded, In Transit, or Delivered. Refresh the cargo list to
see the current status. The status of the cargo is also updated in the
Commodities List.

• When using the POD Mobile app, the status changes automatically after a
pickup.

To Exclude from Tracking: To exclude the transaction from tracking (if the 
transaction is not complete and you do not want it viewed via LiveTrack), select 
the option: Exclude from Tracking.

Select Template: To choose a different template for the document, select the 
option: Select Template. For example, there is a template designed for NVOCC 
operations, a summarized template and more. The NVOCC template includes 
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space for the return of a container. This is filled in from the Carriers tab, the 
“Main Carrier” fields.

Another template is available that groups Part Numbers, making it easier to 
read instead of the PNs in a long list. Select “Pickup Order Summarized.” If you 
don’t see a template, check for the latest ones via File > Download Document.

View History: To view the history of the cargo release (such as a Warehouse 
Receipt or Invoice for this cargo), select the option: History. A dialog box opens, 
listing all the transactions related to this cargo.

You can view a transaction by selecting it in the History dialog box. The View 
button opens the dialog box for the transaction. The “Go To” button takes you 
to the document. To return to the Cargo Release, use the Back button.

Additional options are available from the Pickup Order List view also. You can 
also right-click on a Pickup Order in the list to access a pop-up menu of options. 
For details on working with the list view, see the topic "WorkingwithDocu-
mentand List Views".

For a video showing you how to create a Pickup Order and convert it into a 
Warehouse Receipt, see the Learning Center web page on Magaya.com.

Generate Accounting Transactions from Pickup Orders

Magaya Explorer gives you the ability to create accounting transactions such as 
invoices based on the information entered in a Pickup Order.
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For example when charges are entered in the Charges tab, the charges remain 
“Open” (are not posted to the Accounting system) until you click the Generate 
button or they are liquidated. Then they are “Posted.”

After the charges are generated or liquidated, the system will collect all the 
charges and group them and create invoices for each customer. The charges that 
will go to bills are also grouped, and bills are created for each vendor. Then these 
are posted into the Accounting system.

Note: Accounting charges cannot be generated if a Pickup Order has items used 
in a Warehouse Receipt or loaded into a shipment.

You can also create accounting transactions from the Pickup Order by listing all 
the transactions for that release. To do this, follow these steps:
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1. Click on the Actions button and select Transaction List. The Transaction
List opens.

2. In the Transactions List, click the Actions button and select an option: Link
Bill, Link Invoice, Receive Payment, or Pay Bill. Enter the information needed
in the dialog box. See more details below. (These transactions will be Posted
immediately unlike the charges entered in the Charges tab.)

When you are in the Transaction Listing, you can create the following 
accounting transactions directly from a Pickup Order by using the Add button 
at the bottom of the list:

• Invoice: You can create an invoice for the Pickup Order. (You can also
create accounting transactions when you are in the Pickup Order dialog
box by using the Generate button on the Charges tab.) An example of the
options for creating accounting transactions is the ability to add inland
freight charges to a Pickup Order by using the Transaction Listing Add
button instead of the Charges tab in the Pickup Order.

Make any edits to the transaction if needed. You can view the Pickup
Order dialog box or go to the document. (The screen is similar for Credit
Memos, Bills, and Credits.)

• Credit Memo: Use this option if you need to issue a credit or a refund to
a customer.

• Bill: Add a bill of what you need to pay.

• Credit: Use this option if you overpaid a vendor and they give you a credit.

The Actions button for the Transactions List has the option to link the transac-
tion to a bill or to an invoice or to a Pickup Order. You can also unlink it. If you 
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created a bill or other accounting transaction separate from the Pickup Order, 
you can link it this way.

You can also receive the payment or pay the bill from the Actions button.

When creating a report from the Transaction Listing, you can create script 
columns by clicking the Actions button in the report and selecting Column 
Settings. In the Columns Settings dialog box, click the arrow next to the “Add 
Columns” button to find the option to add script columns. This script columns 
option is also available in the Chart of Accounts reports.

Additional Options:

You can send your customers’ invoices to an online payment system, and the 
customer can pay it via credit card or bank check. For details, see the following 
Knowledgebase article:

Getting Started with Online Payments

http://knowledge.magaya.com/#/article/online_payments_getting_started

Customers can alsoplace Pickup Orders online in LiveTrack and print their 
own box labels with all the item details linked to the bar code. For details, see the 
Knowledgebase article:

http://knowledge.magaya.com/#/article/online_pickup_orders_intro

Notify your Customers

See the following additional resources that help your customers stay informed 
about the status of their transactions:

Send emails with a link to notify your customers of the status of their cargo:

http://knowledge.magaya.com/#/article/transaction_tracking

Customize the email message:

http://knowledge.magaya.com/#/article/email_templates

Give your customers LiveTrack access: Your customers can log in at any time to 
see their updates:

http://knowledge.magaya.com/#/article/livetrack_setup
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Chapter 11: Receiving Cargo

Introduction to Warehouse Receipts

A Warehouse Receipt (WR) is a document that records when cargo arrived, was 
unloaded, checked in, and assigned a location in your warehouse. A WR is 
needed for any cargo that enters your warehouse.

The WR informs the customer that you are now in possession of the cargo (also 
called commodities), and it provides proof that the commodities listed on the 
WR are in the warehouse stated on the WR.

Entering the cargo into the Magaya Explorer also updates your inventory 
records.

This chapter explains how to create a WR and work with the tabs on the WR 
dialog box.
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Receive Cargo: Create a Warehouse Receipt

Introduction

In Magaya software, a dialog box helps you create a Warehouse Receipt (WR) 
document. All the information you enter in the dialog box is converted into a 
WR document for you automatically. Then you can edit, print, or email the 
document. The dialog box is expandable and has a series of tabs across the top 
that you click on to enter information:

This example explains how to fill in the fields by starting at the General tab, but 
you can enter information in any order. Some of the fields may or may not 
appear on your WR dialog box based on settings in the Configuration menu.

Not all the fields are required. The system will notify you of required fields.
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You can change the information in any field by either typing in the field or by 
using the dropdown menu for the field.

When you are finished, click the OK button. The dialog box will close and the 
information you have input will be saved and appear in the Warehouse Receipt 
document form. If you need to make changes to the form, click on the “Edit” 
button. The items received will have a status of “On Hand”. Note: A WR can 
also be used if items are being returned (reverse logistics).

Speed up cargo receipt: You can receive items faster by scanning their barcodes 
with a handheld scanner, a wireless scanner, or a fixed mounted scanner that is 
attached to a scale and cameras for cargo photos to be taken all at one time. See 
following Knowledgebase article on scales and more:

Scales: Getting Started

http://knowledge.magaya.com/#/article/scales_weight_getting_started

Automate: Information about arriving items can be sent to your Magaya system 
via EDI. Then the data can be updated in the WR when the items actually arrive. 
Contact your Magaya representative for details.

Video Tutorial:

For a video tutorial illustrating how to receive cargo in the warehouse using 
your Magaya software, see the Magaya Software YouTube channel for the tuto-
rial, “Creating Warehouse Receipts” in the Warehousing group of videos.

Video: Creating Warehouse Receipts

Step-by-Step Procedure

1) Go to the Warehousing folder and click “Warehouse Receipts” (or “Ware-
house Receipts List”).

• If you are in the List view, click the Add button in the bottom 
toolbar. The Warehouse Receipt dialog box opens.

• If you are in the document view, click the Add button on the top 
toolbar. The Warehouse Receipt dialog box opens.

2) Enter information needed on the tabs as shown in the following sections. 
The information entered in the dialog box converts into a Warehouse 
Receipt document automatically. You do not need to type up a document.
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General Tab

The General tab contains information such as who created this WR and when. 
Select from the dropdown menus as needed.

Magaya software assigns a WR number to the WR that you are working on. 
(You can change this number if needed by typing over it. Document numbering 
is set up in the Maintenance > Configuration folder.)

Magaya software automatically fills in the date, time, and the name of the 
employee who is creating the WR, and fills in the Issued by field with your 
company name. You can also receive cargo on behalf of other agents by 
selecting their name for the Issued By field.

The “Issued by” field can display your warehouse or a warehouse provider that 
you are using for this transaction.

The Destination agent field is optional. (If you enter a name in this field, the 
agent will be able to view the WR if Magaya LiveTrack is enabled for the agent.)
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Magaya software enables creating Warehouse Receipts for bonded warehouses, 
a secure facility in which imported dutiable merchandise can be stored for up to 
5 years without payment of Customs duties. Select the type of bonded ware-
house:

• Domestic: Cargo is being transported domestically.

• Bonded: Cargo is under custody by the U.S. government and has not 
legally entered into a U.S. territory for consumption.

• C.F.S.: Cargo is being transported to a Container Freight Station (CFS).

• G.O.: A General Order (G.O.) type of bonded warehouse is a U.S. govern-
ment owned/leased facility where cargo is stored by order of Customs to 
be examined if it is pending final release or seized. The cargo in held by 
G.O. maybe auctioned off after a time limit.

• Other: Use this type when the other options do not apply.

U.S. Customs gives you the Entry Number to identify the cargo, and the date is 
the date it was declared, which means when the filing was done.
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Note: To activate the fields related to bonded warehouses, go to the Configura-
tion menu > Company Type and check the box for bonded warehouse.

If you have more than one warehouse, a dropdown field appears on the General 
tab of the WR so you can select the warehouse. (To learn about creating multiple 
warehouses and configuring your system to match warehouses with employees, 
see the topic “Multiple Warehouses.”)

Learn about Multiple Warehouses

http://knowledge.magaya.com/#/article/multiple_warehouses

Note: If your company is an Airline Carrier, the General tab of the WR will 
have the button “Get AWB”. This will enable you to select AWB numbers 
assigned to customers or numbers not assigned.

To add Air Waybills, go to the Maintenance folder > Carrier. On the Carrier 
profile dialog box, click the “Airline” tab. Click the “Add” button to add AWBs. 
For more details, see the Configuration in the Magaya Software Customization 
Manual.

Or see the Knowledgebase:

Learn about the Magaya Configuration Menu

http://knowledge.magaya.com/#/article/configuration_menu
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Shipper/Consignee Tab

Select the shipper from the dropdown menu.

The Shipper is often the manufacturer or wholesaler, i.e., the one who sent you 
the cargo. (If the shipper’s name is not in the dropdown list, add it by clicking 
on the plus sign + and selecting the entity type.) The shipper’s address will be 
filled in automatically based on the details in their profile.

Select the Consignee. The consignee is the ultimate recipient of the commodi-
ties at the destination. (Optional.)

Select the Client to Bill; this is the one who is paying for your services. (This can 
be the shipper, consignee, or a third party.) When you select the client to bill, 
then the system fills in this entity by default on the Charges dialog box when you 
add charges to the Charges tab. This makes it easier and faster to add charges to 
a Warehouse Receipt (and other transactions). Of course you can change the 
entity on a charge manually.
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Select the Mode of Transportation. This is the mode that is being used to get 
items to the warehouse. This field on this tab is connected to the Charges tab: If 
you do not select a mode of transportation, you will not be able to enter freight 
charges on the Charges tab of the WR. The option will be grayed out. (However, 
you will be able to enter freight charges later when this cargo is included in a 
shipment.)
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The fields on the Shipper/Consignee tab affect the Charges tab:

Without the Mode of Transportation selected, the Freight charges options will 
not be available. These tabs are connected to make it easier to create transac-
tions.
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The Origin and Destination information fields are optional. (If you know where 
the cargo is going, the Destination field can be used later to filter the cargo or 
create consolidations.) The only ports displayed here are the ones with the mode 
of transport selected. The origins and destinations displayed in these lists are 
from the Ports List. If a port you need is not visible in the list, click on the plus 
sign in the dropdown toolbar and select the port from the list or manually add 
the port.

Supplier Tab

Select the supplier (this may be the same as the shipper or the company that 
provided the cargo to the shipper). You can modify the address for the supplier 
for this transaction if needed by clicking on the Change button.

Enter the invoice number and/or purchase order if available. (These numbers 
can be useful later to find this transaction because this transaction number is the 
reference number of your customer.)

Click on the next tab.
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Carrier Tab

Select the inland carrier (usually an over-land trucking company).

Enter information in the other fields as needed. They are optional.

The PRO Number is an inland carrier’s bill of lading number, also called a 
“progressive number.” The driver’s name may be useful if any cargo is damaged 
or missing.

Recommended Next Topic

To learn about working with the Commodities tab of a Warehouse Receipt, see 
the following topic:

Commodities Tab

http://knowledge.magaya.com/#/article/commodities_tab

Fast Receiving Options: You can speed up the receipt of cargo with a bar code 
scanner or the WMS Mobile app on a handheld scanner such as from Motorola 
or other hardware vendor. See the Hardware Compatibility List for more 
models:

http://knowledge.magaya.com/#/article/hardware_compatibility_list
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Additional Resources

See the following articles in the Knowledgebase for more details about receiving 
cargo.

• Commodities

http://knowledge.magaya.com/#/article/commodities_tab

• Charges

http://knowledge.magaya.com/#/article/charges_tab

• Events

http://knowledge.magaya.com/#/article/events

• Attachments

http://knowledge.magaya.com/#/article/attachments

• Notes and Internal Notes

http://knowledge.magaya.com/#/article/notes_and_internal_notes

• Actions for the Warehouse Receipt

http://knowledge.magaya.com/#/article/actions_wr
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Commodities

Introduction to Commodities

The word “Commodities” means different types of items such as cargo, inven-
tory items you sell or store for your customers, vehicles, or other types of items. 
They can be added to many transactions in Magaya software such as Quota-
tions, Warehouse Receipts, Pickup Orders, Cargo Releases, and shipments. 
Depending on which Magaya software you have, commodities can be added to 
additional transactions such as Bookings, Sales Orders and Purchase Orders.

This topic explains the process of adding commodities by showing it in a Ware-
house Receipt. We'll look at the different tabs in the Commodity dialog box and 
the fields in each tab. We'll also learn about serial numbers, lot numbers, adding 
hazardous materials details, containers, photographs, how to scan barcodes and 
repack cargo.

The Commodities tab looks different for different transactions, but the func-
tions are the same. For example the Cargo Release and Quotations Commodi-
ties tab have the buttons on the bottom instead of on the right side.
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Let’s look at the Commodities tab of a WR in the Magaya Supply Chain Solu-
tion:

Note for users of the Magaya Cargo System and Magaya WMS: The Commod-
ities tab will not include the “Get PO” button because Purchase Orders are only 
available in the Magaya Supply Chain Solution and the Magaya Commerce 
System. All other functions on this tab are the same for all the software products.

Use this tab to add commodities to the WR. You can add items by clicking the 
Add button or the Scan button. Let’s look at each button and its function.

Placing Items On Hold:
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Extra: If a customer has not paid, you can place commodities on hold. 
Right-click on the item in the list to select the menu option. Multiple items can 
be placed on hold by selecting more than one item in the list.

Click the “On Hold” option. In the dialog box that opens, check the box to place 
the item on hold. Select a clause from the list or add a new one (optional).

To see which items in the WR List are on hold, select the column “On Hold” 
from the Choose Columns dialog box (via the Actions button). You can also 
make a report of all On Hold items from the Actions button.
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Add Commodities

To receive items, click the “Add” button to add a commodity:

If you have the Magaya VIN Decoder plug-in, the Add button will display an 
option to add a vehicle. Then scan the vehicle’s US-based VIN bar code. (If you 
don’t have this plug-in, you won’t see this pop-up.)

It is recommended that you start entering data on the first tab, the “General” 
tab, and enter all the information that you need.

Extra Info: To copy an item after you enter it, right-click on the item in the WR’s 
Commodity tab and select “Add Copies” from the pop-up menu.
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See the following sections for details on entering data into the Commodity 
dialog box.

General Tab of the Commodity Dialog Box

On the General tab of the Commodity dialog box, you can start with any filed. 
For example if you have Inventory Item Definitions (Part Numbers) defined in 
your Magaya system, then select the part number from the dropdown list. This 
will populate the fields with the definition.

enter the commodity description.

Part Numbers: A part number identifies a type of item (in contrast to a serial 
number which identifies a specific item). The serial number is unique and 
assigned by the manufacturer. For example, computers have part numbers to 
identify which type of computer is it, but each computer has a serial number to 
identify each individual computer. You may receive 50 computers with the 
same part number, but each will have its own serial number.

Extra Info: If you are receiving inventory items that you want to keep track of by 
part number, select the Part Number. This will populate many of the fields with 
the item details and speed up the receipt. The Part Numbers are those that were 
defined as an “Inventory Item Definition.” Any item can have a Part Number, 
not just resale items.

Location: Assign the item to a location in the warehouse or yard. Extra Info: If 
your company always receives cargo in the same location, you can set the 
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receiving location as a default so it does not have to be selected every time. See 
the Locations list and right-click a “receiving” type of location.

Select the package type, and enter the number of pieces and dimensions. The 
volume is calculated automatically. You can set up the system to display volume 
or volume weight.

Units can be set up as pounds (lb) or as metric units: Go to the Maintenance 
folder and select Configuration. (If this item is defined in your Magaya system 
as an Inventory Item Definition, then the Units from the definition will popu-
late automatically here.)

The WR number displays on the top of the tab as “WH.” This example also 
shows the document prefix of “WH” in front of the number. Prefixes can be set 
in the Configuration menu > Document Numbers.
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Pieces Example:If you have 1 box with items inside, enter 1 in the Pieces field. 
If you need more information about the commodities, then enter the Quantity 
field (for example, 1 box with 8 pieces). If you know the weight of each piece, 
enter it in the Weight - Piece field (below the dimensions).

Dimensions are per piece. For example, if you have 2 pallets that are both 44L 
x 44W x 44H each, enter 44 x 44 x 44 in the Dimensions fields.

Quantity field: This field is also used if you are declaring insurance or if you 
need a Commercial Invoice and need to have the value per item. This is not 
often used for cargo, mostly for resale inventory and for commercially 
purchased items. For example, if you have 1 box with 8 items inside, enter 8 in 
the Quantity field. If the item has a value defined in its Inventory Item Defini-
tion, then the Unitary value field will fill in here.

By Totals: Check this box if you do not know the weight of each box; then enter 
the total for all the boxes in the Total field. (When you check the box, the weight 
field will be grayed out, so you can enter the total weight. This selection is 
saved.)

Location: If you assign a location to the item, then the status of the item will be 
“On Hand” after you click OK and save the data entered in the dialog box. 
Option: Set a default receiving location by right-click a Receiving location in the 
Locations list and selecting the option “Default Receiving Location.” The loca-
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tion must be of the Type “Receiving” set it as a default. This speeds up receiving 
items.

If you receive an item that is defined as having variable weight, then weigh the 
items and add the total. For example, if you receive 10 boxes of one item (such 
as chicken) and all 10 weigh 100 pounds together, enter 100 pounds. (Releasing 
variable weight items is explained in the Cargo Release chapter.)
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Identification Tab

On the Identification tab, enter information in the fields as needed. For 
example, you can select or add a commodity description such as “Electronics” 
or “Perishable.” Click the dropdown menu to select a description, or click the 
plus sign in the submenu to add a new description. This Commodity definition 
is used to classify items for pricing and for rates and tariffs.
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Serial Numbers:

When receiving items with serial numbers, there are options that depend on 
whether you scan bar codes or enter the numbers manually. First, ensure your 
system is configured to save serial numbers. This can be done system-wide in 
the Configuration > WMS menu.
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Inventory items can be saved by serial number by checking the box on the 
Inventory Item Definition dialog box.

Receive the items with serial numbers, with or without a bar code scanner:

• With a bar code scanner: Scan the Part Number and each Serial Number 
to receive the items.
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• To enter multiple serial numbers for the same Part Number, manually 
enter the item information, and click “OK” to save it. Then right-click on 
the item in the Commodity tab. Select “Add Copies.”

Enter the quantity of copies you want in the dialog box. The system will 
add the copies to the WR.

Edit each line item by opening it and changing the “Pieces” field to “1” on 
the General tab. Type in the serial number in the “Serial” field on the Iden-
tification tab. Click OK to save. Be sure to edit each item this way for every 
copy that you created. This is the manual process of saving serial numbers 
in the system.

Also on the Identification tab of the Commodity dialog box is a field for an 
Invoice Number. The invoice number comes from the seller of the item. If you 
have the same invoice number for all the items, you can enter this at the WR 
level. Otherwise, you can enter it per item seperately. Only enter an invoice 
number if you have one for the item, not for the whole WR.

Note: In LiveTrack, your customers will see the serial numbers grouped under a 
plus sign. They must click the plus sign to expand the list of serial numbers and 
view them.

Notes on the PO, Lot Numbers, and Jobs fields of the Identification tab of the 
Commodity dialog box:

If the item was included in a PO and converted into a WR, the PO number will 
display here (POs are available in the Magaya Supply Chain Solution and 
Commerce System). Any other PO number can be added here if needed.
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The PO number is from the buyer of the item. If you have the same PO number 
for all the items, you can enter it at the WR level. Otherwise, you can enter it per 
item seperately.

Note: The Job feature is available in the Magaya Supply Chain Solution; it’s used 
to group transactions into projects.

Lot Numbers: Enter the lot number for the item, if applicable. The lot number 
identifies a certain batch of items of the same type/part number. Many items 
that have lot numbers also have expiration dates. This lot number is tied directly 
to the expiration date.

Also on the Identification tab: The buttons “Shipping in” and “Came in” are 
only activated later if this item is included in a shipment or other transaction. 
When an item is loaded into a Cargo Release, this will link to that Cargo Release. 
The “Came In” information applies to imported shipments, not exports and it’s 
not used in the Magaya WMS program.
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Expiration Date: If an expiration date is entered in the dialog box, it will appear 
on the document (default template). Expiration dates are often used with items 
that have lot numbers.

NCM Code: The NCM code is the Harmonized Tariff Schedule code for inter-
national commerce in the South American common market, Mercosul, which 
includes Argentina, Brazil, Paraguay, and Uruguay. The NCM code has 8 digits; 
the first 6 digits correspond to the HTS. The NCM code can be viewed as a 
column in the WR dialog box on the Commodities tab, in the Commodity List 
under the Warehousing folder, and the Inventory Item Definition List or run as 
a report.

External Tracking Numbers

External tracking numbers can be added to the Commodity dialog box.

To manually enter a number, click “Add” and type it in the field. The Type is 
“Other.”

This allows the user to print labels and identify the items with an external 
tracking number as well as the Magaya Tracking Number.

The external tracking number will fill in automatically in this tab when using the 
CubiScan Scale Integration or when a Manual Receive Task is done on the 
handheld with WMS Mobile.

This external tracking number also prints on labels. (Option: If items have part 
numbers, you can tell your Magaya system: “Do not create tracking numbers for 
items with part numbers” in the Configuration > Labels menu option.)
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The system can find the number later: Click the "Find" button on the top toolbar 
and Select “Quick Find.” Then select "Tracking Number" and enter the number.

Extra Info: To learn about different ways to identify items in your Magaya 
system, see the topic “Identify Items” (or search for the keywords “identify 
items” in the Magaya Knowledgebase.

Add a Container

If you need to add a container, click on the “Add Cont” button. A dialog box 
opens to enter the container information. Also see the topic on Pickup Orders 
to learn more about adding a container.

• On Container dialog box, start on the first tab, “Container”. Select the 
Container Type from the dropdown menu.

• Enter a description of the container (optional).

• Enter the container number.

• Enter the Seal number. If there are two seal numbers, enter both.
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• Enter the dimensions of the container if needed.

• Check the box if you want to add the weight of the contained pieces to the 
total weight.

• Select a warehouse location from the dropdown menu to define the place 
where the cargo will be picked up.

• The Notes field is optional.

The Identification tab contains fields for the invoice number and PO number:

• Enter the invoice number, the PO number and the Job (if applicable).

The fields for EEI, Hazardous Materials, AMS, and Attachments tabs in the 
Container dialog box are the same as for the Commodities dialog box. Please see 
the Commodities section for information on entering data in these tabs.

Note: When you use the “Add Container” button, that container will appear in 
the Container Reports (available from the Shipment List Actions button). If you 
use the “Add” button to add a commodity and then selected the container type 
from the Package Type list, it will not appear in the Container Report.

The Refrigerated tab contains fields for the ventilation and temperature set up.

• Enter the ventilation and temperature information

• Select Celsius or Fahrenheit from the dropdown

• Check the box if the container has a generator

• Non-operating reefer

After you have entered the information needed, click the OK button. This 
returns you to the WR dialog box.
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Attachments Tab

On the Attachments tab of the Commodity dialog box, click the Add button to 
add a document or photograph. Use the other buttons as needed. Any attach-
ment added here can be viewed from any other transaction that includes this 
item. For more information, see the topic “Attachments”.

When you are finished entering information in the Commodity dialog box, 
click the OK button. All the information will be saved. You will be returned to 
the WR dialog box. If you need to add more commodities, repeat the steps listed 
above.

Additional Resources

Also see the following Knowledgebase articles for additional functions related 
to enter commodities:

Use the Repack button to repack items as needed. A wizard opens with fields to 
enter the information about the container. You can select the type of container, 
including boxes and pallets. See:

Repack Cargo

http://knowledge.magaya.com/#/article/repack_cargo

EEI Tab: If you have the EEI information for the commodity, you can add it 
now while creating the WR. If you don’t have the EEI information while you are 
creating the WR, you can add the EEI details later. See following Knowledgebase 
article for information on the EEI tab and exporting commodities:

EEI Tab

http://knowledge.magaya.com/#/article/EEI_tab

Hazardous Materials Tab: For information on entering details for hazardous 
commodities (or dangerous goods), see following Knowledgebase article:

Hazardous Tab

http://knowledge.magaya.com/#/article/hazardous_tab

AMS Tab: For information on entering details on the AMS tab for commodities 
that are to be imported, see the following Knowledgebase article:

AMS Tab

http://knowledge.magaya.com/#/article/AMS_tab
354

http://knowledge.magaya.com/#/article/repack_cargo
http://knowledge.magaya.com/#/article/EEI_tab
http://knowledge.magaya.com/#/article/hazardous_tab
http://knowledge.magaya.com/#/article/AMS_tab


Commodities Chapter 11
Create a Warehouse Receipt: To learn about other functions when creating a 
Warehouse Receipt, see:

Create a Warehouse Receipt

http://knowledge.magaya.com/#/article/create_wr2
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Hazardous Materials

This topic explains how to enter information about hazardous materials into 
your Magaya system.

Introduction to Hazardous Materials

The Department of Transportation (DOT) regulates the transportation of 
hazardous materials for moving goods on US highways. The International 
Maritime Organization (IMO) regulates shipping hazardous materials for 
ocean freight. Not all hazardous materials are eligible to be transported by all 
modes of transport. Some are banned from air transport, for example. Air trans-
port of hazardous item requires compliance with IATA regulations.
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Hazardous Materials Tab

On the Hazardous tab, check the checkbox and enter information in the fields 
as needed.

The information required on shipping papers to ship hazardous materials is 
listed in the U.S. Department of Transportation's (DOT) Hazardous Materials 
Table (HMT), section 172.101. The basic description of the hazardous materials 
must include the identification number of the material, the proper shipping 
name of the material, the hazard class or division, and the packing group. Addi-
tional information may be required, depending on the materials you are ship-
ping. The US DOT's Hazardous Materials website is

http://phmsa.dot.gov/hazmat

You will need the code representing the hazardous class or division designated 
for the material in the International Maritime Dangerous Goods (IMDG) code.
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Let’s look at the fields on the Hazardous tab. These fields are not required but 
depend on the commodity.

To enter information in the fields, click on the box “Hazardous Material” to 
activate the fields. The following define the fields in the “Hazardous” tab:

• Identification Number: A code representing the identification number 
assigned to the hazardous material. The most commonly used are the UN 
codes considered appropriate for international shipments as well as 
domestic shipments.

• Material Class: The UNDG is the four-digit number that identifies the 
class of a hazardous goods items such as explosives, flammable liquids, etc. 
They are assigned by the United Nations.

• Class Qualifier: A code that describes the hazardous material class. Click 
the button with the three dots next to the field to select the code from the 
list that opens. The IMO code is defined by the International Maritime 
Organization (IMO).

• Material Description: The proper shipping name of the material desig-
nated as hazardous.
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• Emergency Contact: The name and/or phone number of the person or
department to contact in case of an emergency.

• Material Page: The page number in the IMDG code in which the
hazardous material identification appears.

• Flashpoint Temp: The lowest temperature at which the vapor of a
hazardous combustible liquid will ignite in the air. Degrees Centi-
grade/Celsius.

• Special Instructions: The material name, special instructions, and/or the
phone number, if applicable.

• Description of Class: Free form description of hazardous material classi-
fication, division, or label requirements.

• Hazardous Level: Select the danger level of the hazardous material.

Click OK when done entering data on the Hazardous tab.

The fields on the Hazardous tab of the Commodity dialog box are connected to 
the INTTRA ocean carriers interface that Magaya offers. See the topic on 
INTTRA for more:

INTTRA

http://knowledge.magaya.com/#/article/inttra_getting_started
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Dangerous Goods Document

Shipping dangerous goods requires different forms of documentation that only 
a certified individual can sign.

When shipping hazardous goods, include the IMO Dangerous Goods Declara-
tion form. It’s available from the Document button on the Shipment Toolbar.

Only personnel certified to handle dangerous goods or sign the document are 
eligible to manage hazardous materials.
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Scan Bar Codes to Enter Commodities

This topic explains how to enter commodities into a Warehouse Receipt (WR) 
using a bar code scanner.

Scan Bar Codes to Enter Commodities

In addition to using the “Add” button to add commodities, you can also use the 
“Scan” button to add commodities.

To use the Scan button, your system must have the Magaya Bar Code Scanner 
plug-in activated. Contact Magaya to activate it.
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Scan the bar code on the items with the handheld barcode scanner.

The scanner will populate all the fields that describe the item such as its dimen-
sions based on the information entered into the Magaya system when the Inven-
tory Item Definition was created. The item will be added to the list in the WR.

Add Copies of Items:

If you are receiving more than one package of the same commodity, you can 
right-click on the commodity in the WR dialog box and click Add Copy. After 
adding copies, edit any details of the items by opening the Commodity dialog 
box for that package and add new information such as if the weight is different 
from the first package.

Extra Info: The bar code scanner is also useful to speed up the release of cargo 
and verifying packing lists in shipments. See the Related Resources at the end of 
this topic for details.

To place items inside a pallet (or other container or package type), select an item 
and click the “Repack” button. See the Related Resources at the end of this topic 
for details.

When you build a pallet and place items in it, the icon in the WR commodity 
list will change to a pallet icon to indicate items are inside a pallet:

To take items out of a pallet, select the item and click the Unpack button in the 
Commodities screen. The individual items will be listed on the commodity list. 
The icon will change to indicate the commodities are not inside a pallet.

Other buttons on the WR dialog box include Edit, Delete, Detail, or Unpack. To 
use one of these functions, select the commodity and click the button you need.

Use the “Detail” button to view the items inside an existing pallet or to add 
more items to it. (If you select an item that is not a pallet and click the Detail 
button, the system will tell you “The number of pieces must be 1 to edit the 
detail of an item.”)
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The status icons in Magaya Explorer indicate status of cargo items and of trans-
actions:

• Yellow is In Process (or Ordered)

• Aqua is On Hand (in the warehouse)

• Purple is Loaded (in a shipment)

• Light Green is In Transit (Dark Green is Arriving)

• Blue is Delivered

After items are received, they are visible in the Commodity List. The list can be 
filtered by status of the items, by Warehouse Receipt number (WHR), part 
number, or other criteria. See the Related Resources at the end of this topic for 
details

The WR list (and other lists) can be customized so you see the information you 
want. Adjust the columns as needed by clicking and dragging the column to 
widen it or narrow it. Click Actions > Choose Columns to select what you want 
to see. Save the list by clicking the star button on the top toolbar. The total 
weight, volume, and number of pieces displays on the bottom of the screen.

Get PO: To receive items from Purchase Orders, click the “Get PO” button. In 
the dialog box that opens, select the PO or partial (pieces). You can add items 
when you create the WR or add items later to an existing WR. (This button is 
available in the Magaya Supply Chain Solution and Magaya Distribution 
System.)

Related Resources

See the following article for other options to speed up receipt of items, including 
adding weight, dimensions, and photos:

Scales and Weighing Items

http://knowledge.magaya.com/#/article/scales_weight_getting_started
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Learn about the linear scanner plug-in, the Magaya Bar Code Scanner:

Magaya Bar Code Scanner plug-in

http://knowledge.magaya.com/#/article/bar_code_scanner_get_started

Learn how to repack cargo:

Repack Cargo

http://knowledge.magaya.com/#/article/repack_cargo

Learn about the Commodity List functions:

Commodity List

http://knowledge.magaya.com/#/article/create_commodity_reports
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Charges

Overview:

Magaya software enables you to add, edit, and process charges for transactions 
such as Pickup Orders, Warehouse Receipts, Cargo Releases, Bookings, Quota-
tions, and Shipments.

Extra Info: Charges can be automated to appear in transactions. To automate a 
charge, go to the Accounting folder > the Items & Services. Open the item or the 
service, and go to the “Automatic Creation” tab to set the automation.

Charges entered on a Charges tab will be used for accounting functions such as 
generating bills and invoices. Information from Items and Services is used to 
calculate the charges and liquidations of shipments.

There are four types of charges, (two income and two expenses):

• An Income Charge: can be a flat fee or depend only on measurements of
items used to invoice a customer.

• An Income Freight Charge: This price depends on origin, destination,
mode transportation, packaging and measurements of items used to
invoice a customer.

• An Expense Charge can be a flat fee or depend only on measurements of
items used to pay a vendor.

• Expense Freight Charge depends on origin, destination, mode transporta-
tion, packaging and measurements of items used to pay a vendor.

The Charges tabs in different transactions may look a little different from each 
other. Some of the buttons may be in different places, but they have the same 
features in each of the transactions.
367



Charges Chapter 11
For example, take a look at the Charges tab in a Warehouse Receipt (WR):

The Add, Edit, and Delete buttons are on the right side.

The Generate button will generate the charges and create applicable accounting 
transactions such as invoices and bills. After they are generated, the charges will 
have a status of “Posted.” For more information, see the section “Generate 
Accounting Transactions from a WR.”

Total expenses, income, and profit are displayed on the bottom of the tab.

The “Status” column shows if a charge is open or posted. The green $ dollar sign 
symbol is for income charges. The red $ dollar sign shows an expense.
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Take a look at the Charges tab in a Shipment:

The Add, Edit, and Delete buttons are on the bottom. The same functions are 
available, just in different places. (When working in a shipment, generate 
charges by using the Liquidation button on the Shipment Toolbar - not visible 
in this screenshot.)

The Units button enables you to change the measurement units. Check the 
Units button to open a new dialog box:

In the Units dialog box, you can change the measurement units such as length 
to change it from the default of Inches to other choices: Meter, Foot, MM, CM, 
or DM. Each of the Units can also be changed to calculate to a different decimal 
place than the default “0.00”. Use the dropdown menus to make changes. Click 
the OK button when done to save. The changes will apply to this transaction 
only. To change the measurement units for your entire Magaya system, go to 
Maintenance folder > Configuration > Measurement Units.

For the following example we will use the Charges tab from a Warehouse 
Receipt to illustrate the functions.
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Working with the Charges Tab

When you click on the Add button to add charges, a menu pops up:

When you select a charge type, a dialog box opens.

The Income Freight Charge and Expense Freight Charge dialog boxes are the 
same (except for the title).
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NOTE:  If the Freight charges option is grayed out, you cannot select it. To make it 
available, return to the Shipper/Consignee tab and select a Mode of Transporta-
tion.

The freight charge tab will indicate the mode of transportation in the title (Air, 
Ocean, or Ground) depending on the mode selected. Note: Select “Income 
Charge” for Inland Freight, instead of using “Income Freight Charge” if you are 
adding a charge for local trucking.

A Tax Code field will appear if you have set up sales tax in the Chart of 
Accounts. (It is not displayed on this screenshot.)

To enable the option “Allow automatic update” for a charge, check the box. If 
you make a change to a commodity such as the weight, the charge for the new 
weight will be calculated and updated automatically. Uncheck the box if you do 
not want this automated.

If you check the box to show charges in documents, the charges will show in 
operations transactions and documents such as WRs and Pickup Orders (and 
will be visible to customers). The charges will always appear in bills and invoices 
even if you do not check this box.

Sample Scenarios for Adding Charges:

If you are a freight forwarder and you are creating a Warehouse Receipt, you 
add a freight expense charge and apply it to the trucking company because they 
are charging you and you need to pay them.
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Add an income freight charge when you are billing the customer so they can pay 
you if you pick up the cargo for them.

An income charge or expense charge is applied to the customer for services you 
offer such as crating or documentation.

Adding Charges:

The charges entered in a WR are integrated into the Accounting system in 
Magaya Explorer and will appear on invoices, bills, etc., as applicable when the 
accounting transactions are generated. Use the Generate button in the WR or 
the Liquidation feature in a shipment to generate charges. (For more details, see 
the section on Liquidation in Chapter 14 “Creating Shipments” in the Magaya 
Cargo System Operations User Manual.)

When viewing one of the Charges dialog boxes, you can choose the columns in 
the dropdown menus such as for the “Charge” dropdown or the “Freight Service 
Class” dropdown. For example, you may want to know what type of charge 
you’re looking at. Click the dropdown menu and click the "Choose Columns" 
button in the toolbar of the dropdown. The checkmark the column "Type". 
Then view the dropdown menu again to see the types of charges. This column 
can also be seen in the list of Items & Services. It is helpful to understand the 
charges, especially while learning to use the software.

For Income Charges and Expense Charges:
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Remember: Income charges will appear on your customer’s invoice. An expense 
charge is what you pay your vendor.

• Select the charge from the dropdown menu. (Notice the income charges
are “fees” and “income”. The expense charges are “cost” and “expense”.)

• Add a description (optional).

• “Apply To” - Select who the charge is applied to such as a customer or
carrier. The system defaults to filling in the name of consignee for an
Income charge and the Carrier for an Expense charge. (If the customer
needed is not shown in the dropdown list, use the button next to the drop-
down to show all entities.)

• “Paid as” - Select if the charge is Prepaid or Collect. (Prepaid means the
charge is paid or invoiced at origin. Collect means the charge is paid at
destination. It is collected by the destination agent if you have one at the
destination.) Note: Define this per customer in their profile on the
“Payment Terms” tab.)

• “Tax Code” - Select a sales tax code if applicable to your services. (In the
US, sales taxes are not applied to freight services, but they are applied in
other countries.)

• Select the checkbox to show the charges in the documents if you want the
charges to appear in operations documents such as WRs, visible to the
customer. (Charges will always appear in accounting transaction docu-
ments such as invoices and bills).
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• Enter the quantity applicable for the service you are charging. (For
example, for handling services at $2.00 per pound, enter the amount of
pounds.)

• Enter the Unit you are using. For the example above, enter pounds (lb).

• Enter the price for your service (for example $2.00 per pound). If you set
up the price in Items and Services, it will available from the dropdown.

• The amount will be calculated by multiplying quantity by price.

• Click on the Notes tab to add notes (optional) if you need more informa-
tion on the invoice about the charge.

• Click OK to save the information and close the Income Charges dialog
box. This will return you to the Charges tab of the Warehouse Receipt
dialog box.

Add additional charges as needed. Use the Edit button to make any changes.

Use the Units button to select units of dimensions and weight.

For Income Freight Charges and Expense Freight Charges:

Remember: Income Freight Charges depend on origin, destination, mode trans-
portation, packaging and measurements of items used to invoice a customer. 
Expense Freight Charge is what you pay a vendor based on the origin, destina-
tion, mode transportation, packaging and measurements of items.

• Select the freight service class. (This will pull the type of freight from the
Items and Services list in the Accounting folder.)

• Enter a description (optional).
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• Select who to apply the freight charge to such as the carrier for expense 
charges or apply to customer for income charges. (If the customer needed 
is not shown in the dropdown list, use the button next to the dropdown to 
show all entities.)

If you want to customize the rates, click the Rates button. A dialog box will 
open for that carrier or customer. Enter data and click OK to save the rate 
and return to this screen.

When you change how you apply the charge (by weight, pieces, etc.), the 
totals across the bottom change. The unshaded fields (yellow) will be 
multiplied automatically to calculate the total. You only need to fill in the 
unshaded fields.

• Select if the charge is Prepaid or Collect. (Prepaid means the charge is paid 
or invoiced at origin. Collect means the charge is paid at destination. It is 
collected by the destination agent if you have one at the destination.)

• Allow Automatic Update: Check this option to allow changes made to the 
charge to be calculated automatically.

• Select the checkbox to show the charges in the documents if you want the 
charges to appear in operations documents such as WRs, visible to the 
customer. (Charges will always appear in accounting transaction docu-
ments such as invoices and bills).

• Select from the dropdown menu to apply the charge by Pieces, Weight, 
Volume, or Container.

The totals for the number of pieces, Gross weight, Gross Volume, Rate 
Charge, and Total Amount are displayed in the fields across the bottom.

Remember Weights: The Chargeable Weight is the larger of these two 
weights: the gross weight and the volumetric weight.

The gross weight is the weight of the items inside a container plus the 
weight of the container. (Items + container = Gross Weight)

For more on weights such as dimensional weight, see the Knowledgebase 
topic “Air Waybills”.

• Click OK to save the information and close the Expense Freight Charges 
dialog box. This will return you to the Charges tab of the Warehouse 
Receipt dialog box.

Tip: For every expense you add, also add an income.

Other options on the Charges tab: You can edit or delete a charge by selecting 
it and clicking on the button you need.
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To view options, right-click on a charge and a pop-up menu appears:

The pop-up menu has many options such as moving a charge up or down in the 
list. This will affect how the charges display in documents and in LiveTrack. 
Priority of some charges can be set in the Items & Services list; see the Magaya 
Software Accounting Manual.

If you make changes to one or more charges, select “Regenerate charges” to 
recalculate.

Other functions on the Charges tab:

Units: If you want to change the measurement units for this transaction, click 
on the Units button. This will only change the units for the transaction you are 
working on such as a WR.

The total expense, income, and profit display on the bottom of the screen.

The Generate button is for generating any bills or invoices associated with the 
charges entered.

You can adjust the columns as needed by clicking and dragging the column to 
widen it or narrow it.
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Events

Introduction to Events Tab

The Events tab is used to list any events related to the transaction such as a 
Warehouse Receipt or Pickup Order. Magaya software comes with a default list 
of event definitions you can choose from. You can also create your own event 
definitions.

Events entered in the dialog box will appear in the email message sent with 
Magaya Transaction Tracking and Magaya LiveTrack communications, visible 
to the customer, based on the configuration setup.

You can also view Events for a transaction by going to the transaction list and 
clicking on the “Detail” button. A new panel opens. In the panel, select “Events” 
from the menu.
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Add an Event

To add an event to a transaction, click on the Add button. A dialog box opens. 
It contains a list of pre-defined events.

• Set the date and time for the event.

• Select the event type from the dropdown menu.

• Details are optional.

• Select a location if needed. The location is the geographical place where 
the event will take place.

• The box is checked to include the event in tracking. When the customer 
or agent views the transaction in LiveTrack, the Events are visible in the 
section called “Tracking Details”.

• Click OK to save.
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Define New Event

Magaya software enables you to define events. In addition to using the default 
events included in the software, you can create your own to suit your business 
needs. To define events:

1) Go to Maintenance folder > Configuration.

2) Click on the Event Definitions icon on the menu.

The following screenshot shows the Event Definitions screen:
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Click the Add button. A dialog box opens:

• Type in a name for the event.

• Type in details on the event (optional).

• Select a location to connect with that event (optional).

• Select from the dropdown to choose the type of automatic creation for this 
event. There are many options: For example, you can make an event 
appear in a WR or Cargo Release when it is created, emailed, or liquidated. 
Selecting “Manual” will not automatically create an event: You will have 
to select the Event each time for each transaction you are creating that you 
want the Event to appear in.

• The checkbox “Include in Tracking” is checked by default. This means this 
event will be visible to the customer (or agent) in the online tracking, Live-
Track.

• Click OK to save.
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Attachments

Introduction to Attachments

Attachments such as photographs and scanned documents can be added to 
transactions in Magaya Explorer by browsing for them on the computer or 
directly via a scanner.

Magaya software is compatible with cameras, webcams and scanners that are 
TWAIN or Windows Image Acquisition (WIA) compatible. You can take 
photographs of cargo or items and include the photos in transactions. See a list 
of hardware that has been certified to work with Magaya software:

Hardware Compatibility List

http://knowledge.magaya.com/#/article/hardware_compatibility_list

Drag and drop attachments from a Microsoft Outlook email message into 
Magaya: Click the attached file in the Outlook message and drag it into the 
Attachments window in Magaya.

IMPORTANT: We recommend optimizing your database to help your system 
handle large files better. Go to the Configuration menu option > “Maintenance 
& Performance.” It is recommended that you perform the Recycling options in 
this Configuration menu. Check the box to extract heavyweight data to the 
Blobs folder, which is where the photographs are stored. These are stored 
outside your database; they are not automatically backed up when you perform 
a backup.
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Learn more about optimizing your database to handle large files and a large 
volume of data:

Database Performance

http://knowledge.magaya.com/#/article/attachments

Take Photographs of Cargo

Photographing cargo when it arrives at your warehouse and attaching the 
photograph to the WR creates a record of its condition for you and the 
customer. To install the camera, plug it into your computer. The computer will 
detect the new hardware; follow the steps to install it.

Tip: Smaller file size is better for photographs; they will be easier to email and 
view on LiveTrack.

When using the camera or scanner for the first time with Magaya software, you 
must click the "Select Device" button to tell the Magaya system which devices to 
use. This step is only done once when installing the camera or when restarting 
the computer. It is done from the Attachments tab in a Magaya transaction such 
as a Warehouse Receipt.

To use a webcam or other camera, attach it to your computer or clamp it to the 
weight scale. The camera can be unclipped from the scale and held to take 
photos from different angles. Click the "Acquire" button on the Attachments 
tab, and the camera takes the photo.

To connect more than one camera, see:

Connecting Networked Cameras

http://knowledge.magaya.com/#/article/networked_cameras
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Add an Attachment

Attachments can be added to transactions in one of the following ways:

• Click on the “Add” button on the Attachments tab to attach a photograph 
or other document one at a time, or hold the Shift key to select multiple 
items to attach.

• To view it after adding it, select a image or document and click the “View” 
button. You can also delete it, or save it in another location such as on 
another computer in your network or in a different folder on your 
computer.

• Click and drag items from your computer into the “Attachments” screen.

The following is an example of a photograph and a PDF attached to a Ware-
house Receipt and displayed in the Attachments tab:

You can also drag and drop attachments from a Microsoft Outlook email 
message: Click the attached file in the Outlook message and drag it to the 
Magaya transaction Attachment window.

Result: The photo or document is added to the transaction (i.e., at the transac-
tion level). To add an image to an item (i.e., at the item level), open the item’s 
dialog box.
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Add Attachment from Scanner

Documents can be acquired directly from a scanner and attached to a transac-
tion such as a Warehouse Receipt, Cargo Release, etc. Photographs can be added 
directly from the camera (after you connect it). The attachment can also be 
saved to your computer or network so you have a copy of it.

Smaller file sizes and lower resolution are recommended. Larger files are slow 
to email.
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Before starting these steps, make sure your scanner is plugged in and working 
properly.

1) Go to the Attachment tab in the transaction you are working on such as a 
Warehouse Receipt or Cargo Release.

If you have not used the scanner feature in Magaya Explorer previously, 
the buttons for acquiring from the scanner will be grayed out and need to 
be activated.

To activate the Acquire buttons, click the “Select Devices” button:

A dialog box will open:

2) Click on the scanner you want to use. (Note: You must have the device 
connected to your computer.)
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3) Select the scanner you want to use as the default device for documents.
Then click the button “Default for Documents.”

This is useful for scanning documents that you need to attach to a trans-
action such as a Warehouse Receipt, Pickup Order, or Shipment. The
document is saved as a PDF.

A different device can be set as the default for images, or you can set the
same device as the default for both functions.

4) Click the OK button to save your devices selections. You will be returned
to the Attachment tab.

Now your Magaya system is connected to the devices. In the next steps,
you can use the devices for scanning documents or adding pictures to your 
transaction. (Note you can also add pictures from some Motorola hand-
held devices that have the Magaya WMS Mobile application.)

5) To add in image: click the “Acquire” button on the Attachment tab. A
dialog box opens.

• The “Acquire” button is used to scan an image.
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• The “Acquire Doc.” button is used to scan a document. It will be 
saved as a PDF.

A progress bar shows the progress of the scanning. A preview of the docu-
ment will appear in the panes after scanning.

To scan more than one page, click the Acquire button for each page. All 
the pages will appear on the left, one after another, and a preview of the 
selected page will appear on the right:
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6) Click the OK button when you are done scanning. The scanned image or
document will appear in the Attachments tab.

If you want to make an attachment visible only internally in your 
company, not for customers to see via Magaya LiveTrack or Transaction 
Tracking, click on the “Internal” checkbox.

If the file size is large, the system will give you a message to notify you that 
large attachments may cause a slow delivery of the attachment.

You can still send the file, regardless of the size. To set your Magaya 
system to automatically reduce image size, go to the Maintenance folder > 
Configuration > Maintenance & Performance. Click in the checkbox 
“Optimize images for the Web”.

The Attachments tab includes options to delete, save, or view an attached docu-
ment or photo. The Save button opens a folder on your computer or network so 
you can save the image; this is useful when uploading images directly from a 
camera.
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Notes and Internal Notes

Magaya Explorer gives you the option to add notes to your transactions. There 
are two types of notes: Notes that are included on the documents and visible to 
customers, and Internal Notes that are not visible to customers.

Notes

Notes can be added to transactions such as Warehouse Receipts or Pickup 
Orders by using the Notes tab in the transaction:

• Enter the note by typing the notes field.

• Click on the button to select a clause that has been set up in your Magaya 
system.

Add Clauses to Use in Notes

You can save clauses in Magaya Explorer for notes that you add frequently to 
transactions. For example, you may have a clause such as “Consolidiate per the 
cargo manifest” that you add to every shipment. Save this clause or any others 
in your Clauses List and it will be available for use every time you need it.

Clauses can be added while you are working on a WR or by going to the Main-
tenance folder and opening the Configuration option.
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• Click on the button to select a clause that has been set up in your Magaya
system.

• Click the Add button in the Clause List dialog box. A new dialog box
opens to add the clause information.

• Enter the name of the clause.

• Select a category for the clause such as Bill or Cargo Release. (To add to
this dropdown list of choices, use the button with the three dots next to the 
dropdown.)

• Enter the text of the clause as it will appear on the transaction.
 390



Chapter 11 Notes and Internal Notes
• Click OK to return to the Clause List. (Now the clause is available to use.)

When you select a clause, it appears in the Notes list on the Notes tab.

To delete a note from a transaction, select it and press the Delete key on your 
keyboard (or press the Backspace button).

To delete a clause from the Clause List, open the Clause List by clicking on the 
button with the three dots. Select the clause and click the Delete button.

Internal Notes

Internal notes are internal within your company. They will not appear in the 
transactions and will not be visible to the customer. 

To add Internal Notes:

• Click on the New button to add an internal note.

• Enter the note by typing in the field.

• Click Save when you are done. The note appears in the list.

To make changes to an internal note, select it and click on the Edit button.

To delete an internal note, select it and click on the Delete button.
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Print Labels

This article covers how to print labels from the Commodity List and from 
different transactions in Magaya such as Warehouse Receipts, Pickup Orders, 
and Shipments.

Print Labels from Magaya Transactions

Labels can be printed for items in a Warehouse Receipt, Pickup Order, or the 
Commodity List, by right-clicking the item in the Commodity tab of the WR 
dialog box and selecting “Print Label” from the pop-up menu:
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To print labels for a shipment, click the arrow on the side of the “Print” button 
in the main toolbar.

Select “Print Labels.” In the print dialog box, select the options you need such as:

• Select the label size and printer setup.

• Verify/change the amount of labels to print.

Click OK to print.
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Label Types

Labels printed via thermal transfer type of printing are made on a printer with 
a ribbon. Evaluate how much printing you will do so you can estimate how often 
you will need to replace the ribbon. See the manufacturer's documentation.

Direct thermal printing on labels does not use a ribbon, but it prints directly on 
the label. The print heads in the direct type of printers wear out more quickly 
than thermal transfer type. You must keep the direct thermal printer clean of 
dust or other particles that could damage the print head. If you print many 
labels, consider the print head replacement costs in your choice of print types.

Also determine the quality of labels to ensure the best printing surface and to 
minimize and jams in the printer inferior labels may cause. See the printer 
manufacturer's documentation for recommendations.

Also consider how labels will be used. For example, will they be placed on 
commodities that are stored outdoors in weather and sunlight? These could 
affect the label and the information printed on it. Thermal transfer printed 
labels last longer than direct thermal printed labels. If you ship pharmaceuticals 
or perishables, verify the industry regulations that may affect the label choice.

Related Topics

To set up a printer, click File > Print Setup
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To configure a label, go to Maintenance > Configuration:

If using the Zebra printer, it must be shared and you will need to enter the 
computer name and printer name where the printer is located under the port. 
To see which printers are compatible with Magaya software, see the following 
Knowledgebase article:

http://knowledge.magaya.com/#/article/hardware_compatibility_list

For a current list of document printers that are recommended for Air Waybill 
printing and for label printers that are compatible with Magaya, please contact 
your Magaya Logistics Advisor. Also see the topic “Air Waybill Printing Tips” 
in the Knowledgebase:

http://knowledge.magaya.com/#/article/AWB_print_errors

To print labels from WMS Mobile, click the “Label” button on the screen in the 
wireless handheld. See:

WMS Mobile

http://knowledge.magaya.com/#/article/wms_mobile_receive

Labels can be customized. See:

Customize a Label

http://knowledge.magaya.com/#/article/customize_labels

To print the document for a transaction such as a Warehouse Receipt, click the 
Print button on the top toolbar and follow the prompts in the wizard.

To print documents from a shipment, see the article “Print Shipment Docu-
ments” for details. You can also view and then print attached documents from 
the Attachments tab.
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Print Shipment Documents

http://knowledge.magaya.com/#/article/print_shipment_documents

To print pallet IDs, go to File > Print Pallet IDs.

Batch Printing: To print in batch (i.e., print multiple documents at one time), 
see:

Batch Printing

http://knowledge.magaya.com/#/article/2_work_document_and_list
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What Actions can I Perform with a Warehouse 
Receipt?

Introduction

There are many functions you can do with a Warehouse Receipt (WR). The 
information you enter in the WR can be transferred automatically into other 
documentation by using the Actions button. The following section will explain 
how to generate accounting transactions and other actions that can be 
performed from a WR.

Generate Accounting Transactions from a WR

Magaya Explorer gives you the ability to create accounting transactions such as 
invoices based on the information entered in transactions such as a WR.
397



What Actions can I Perform with a Warehouse Receipt? Chapter 11
It’s recommended that you generate charges when you need them to be invoiced 
or billed, i.e., when you need to collect that income (for example before a Pickup 
or when the items are received).

The accounting department can create a bill or invoice inside the WR or via the 
Accounting folder (and then link the bill or invoice; see more about linking in 
the section “Linking Transactions”). Usually the staff in the warehouse don't 
generate the accounting. The generating will often be done when the cargo is 
released, so charges can be added to the Cargo Release and generate (link) and 
post them. Charges (Bills) from carriers are often added later and will need to 
be linked to the operations transaction.

Magaya Explorer links the transactions and transfers the information from one 
transaction to another. For example when charges are entered in the Charges 
tab, the charges remain “Open” (are not posted to the Accounting system) until 
you click the Generate button or they are liquidated. Then they are “Posted.”

After the charges are generated or liquidated, the system will collect all the 
charges and group them and create invoices for each customer. The charges that 
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will go to bills are also grouped and bills are created for each vendor. Then these 
are posted into the Accounting system.

There is a pop-up menu available from this dialog box. It includes options such 
as viewing the transaction, importing/exporting data, choose columns, and 
more.

After clicking the “Generate” button, the accounting transactions display in the 
Transaction List, which is available from the Actions button. These newly 
generated accounting transactions are now linked to the WR.

Add Accounting Transactions from the Transactions List:

When you are in the Transaction Listing, you can create the following 
accounting transactions directly from a WR by using the Add button at the 
bottom of the list:

• Invoice: Add an invoice. Learn more about linking invoices to the opera-
tions transaction by reading the section below.

• Credit Memo: Use this option if you need to issue a credit or a refund to
a customer.

• Bill: Add a bill of what you need to pay.

• Credit: Use this option if you overpaid a vendor and they give you a credit.

Other options available from the pop-up menu and Actions button:

• Go to the document view of the accounting transaction.

• Print a batch of transactions by selecting a group of them.

• Receive a Payment: When a customer pays you for the WR, you can
process the payment in your Magaya system by selecting this option.
(Other option: via the Payments List)
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• Pay a Bill: When you are paying a vendor, you can process the transaction 
in your Magaya system by selecting this option.

When creating a report from the Transaction Listing, you can create script 
columns by clicking the Actions button in the report and selecting Column 
Settings. In the Columns Settings dialog box, click the arrow next to the “Add 
Columns” button to find the option to add script columns. This script columns 
option is also available in the Chart of Accounts reports.

Linking Transactions

There are two ways to link an accounting transaction to an operations transac-
tion, for example, linking an invoice to a Pickup Order:

1) An accounting transaction is linked to an operations transaction if the 
charges were added in the Charges tab and the accounting was generated from 
the Charges tab of the operations transaction by clicking the "Generate" button. 
Generating creates the accounting transactions and changes the status of the 
charge from Open to Posted. Otherwise the charges are just charges that remain 
open and do not affect any Accounts Receivable (A/R) or Accounts Payable 
(A/P) balance; they're not bills or invoices yet.

or,
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2) Create the accounting transaction manually either one of two ways:

• a) Use the "Add" button in the Transaction List of the operations transac-
tion such as the WR,

• b) or, go to the Accounting folder and add the invoice or bill. Next, link it
to the operations transaction this way: Go to the operations transaction
(such as the WR) and click the “Actions” button and select “Transaction
List.” Then right-click the accounting transaction and select “Link
Invoice” or "Link Bill." (or you click the Actions button in the Transaction
List to open a dialog box which shows all the unlinked accounting trans-
actions; select the one that you want to link.) It will then appear in the
Transaction List for the operations’ transaction.

Here’s an example for scenario 1 above:

You create a Pickup Order, add charges, and generate the charges. Now the 
charges are Posted and linked to the Pickup Order.

Then you convert that Pickup Order into another operations transaction such 
as a Warehouse Receipt. The charges are carried over from the Pickup Order to 
the WR and show in the WR Charges tab because they're linked.These charges 
are automatically linked to the first operations transaction (the one that you 
clicked the Generate button) and they are part of the history of that operations 
transaction.

Here’s an example for scenario 2 above:

You create a Pickup Order. No charges are added.

Later, a bill needs to be added to that Pickup Order. So, you create it manually 
(or someone in the Accounting department creates the accounting transaction 
manually). This can be done either in the Accounting folder or in the Transac-
tion List.

Now that bill needs to be linked to that Pickup Order: Right-click the bill in the 
Transaction List and select "Link" (or you click the Actions button in the Trans-
action List, find the bill and select it to link it).

There are many options: You can add some charges to the Pickup Order when 
you create it or not. You can post them at the time you create the Pickup Order 
or not. You can add charges later and generate them later. You can link them 
when you create them or link them later. We recommend that you generate the 
charges when you need them. For example, the generating will often be done 
when the cargo is released, so charges can be added to the Cargo Release and 
generate (link) and post them. Expenses (Bills) from carriers are often added 
later and will need to be linked to the operations transaction.
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If you don't generate the charges, they are "Open" and unlinked. Then, if you 
convert the PU Order into a WR, the charges will NOT show in the WR Charges 
tab because they're NOT linked. You can link them by either returning to the 
PU Order and generate them on the Charges tab, OR by adding a Cargo Release 
(or Shipment) and the charges will show up in those transactions as “Open” 
until you press the "Generate" button.

Other Actions

You can perform other actions from the document view (or list view) of a Ware-
house Receipt (WR) by using the Actions button (or by right-clicking on a WR 
in the WR List):

To see a list of all the transactions related to the WR, select the option Transac-
tion Listing. (See the section on linking transactions for more)

To view or add attachments, you can use the Actions menu or the Attachments 
screen in the dialog box.

To create a copy of the WR, select the “Create a Copy” option.

To exclude the transaction from tracking (if the transaction is not complete 
and you do not want it viewed via LiveTrack), select the option: Exclude from 
Tracking.

Place items or WR on hold if a customer requests it, or if the customer owes 
money.

To send the WR to another Magaya user in the Magaya Network, click the Send 
To option. This opens the same dialog box as clicking the Send button.
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To choose a different templatefor the document, select the option: Select 
Template. The template “Warehouse Receipt Detailed” shows more informa-
tion about each commodity. The template “Courier Waybill” is for couriers who 
use the WR as a courier waybill. Be sure to link the template to the current trans-
action by clicking the option.

To group Part Numbers in a WR document, choose the “Warehouse Receipt 
Summarized” template.
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To view the history of the WR (such as a Pickup Order for this cargo) at any 
time, select the option “History.” A dialog box opens, listing all the transactions 
related to this cargo:

You can view a transaction by selecting it in the History dialog box. The “View” 
button opens the dialog box for the transaction. The “Go To” button takes you 
to the document. To return to the WR, use the “Back” button.

Extra Info: Magaya software provides you with the option to create a WR from 
a Pickup Order. If you picked up the cargo and you have a Pickup Order that 
you created in Magaya software, you can transfer the information from the 
Pickup Order automatically into a WR. To do this, go to the Pickup Order docu-
ment and click the arrow on the side of the Actions button.

The list view of the WR also has an Actions button with additional options: 
Reports, Go to Document, Print Batch, Choose Columns, Import, Export, On 
Hand Warehouse Receipts, Put Away, and Statistics. The functions you see 
depend on which Magaya software product you have. The On Hand WR option 
will open a new tab; this view is useful for couriers. (Also view what’s on hand 
per customer in the Customer List > Detail button > select the panel.)

You can add columns to the list view and save that view. For details on working 
with the WR List, see the topic “Working with Document and List Views.”

Print Labels

To print labels, click on the arrow on the Print button and select Print Labels.
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The Print Labels dialog box opens:

• Select the label size and printer setup. The “WMS4x6 - Shipper” label
includes the shipper’s name.

• Change the amount of labels to print if needed.

If you need to print a label for a pallet, go to File > Print Pallet >IDs
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If you do not want the tracking number to print on labels for items that have 
part numbers, set this option in Maintenance > Configuration > Labels

Check the option “Do not create tracking numbers for items with part 
numbers”. This prevents the tracking number from appearing on the label for 
companies that want to identify items by part number when working with the 
Magaya WMS Mobile but need to print labels with other information about the 
items.
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Details Panel

In the WR List, click the “Detail” button to open a new panel.
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In this panel, select items from the dropdown list to view.

The Detail button is available in all lists. Options in the menu include:

• Events: View Events added

• HTML: Displays the WR the same as in LiveTrack

• Charges: Right-click on a charge to view it

• Transaction Listing: Shows generated charges such as invoices and bills

Notify your Customers

See the following additional resources that help your customers stay informed 
about the status of their transactions:

Send emails with a link to notify your customers of the status of their cargo:

http://knowledge.magaya.com/#/article/transaction_tracking

Customize the email message:

http://knowledge.magaya.com/#/article/email_templates
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Give your customers LiveTrack access: Your customers can log in at any time to 
see their updates:

http://knowledge.magaya.com/#/article/livetrack_setup
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Receive Cargo with Magaya WMS Mobile

Introduction to Receiving Cargo with WMS Mobile

This section explains how to receive cargo using the Magaya WMS Mobile 
application on handheld devices. There are two options:

1) Begin the Receiving process for incoming items by creating the Ware-
house Receipt (WR) on the PC and then send the task to the Magaya WMS 
Mobile handheld devices to be completed. This process is called
"Informed Receiving". The WMS Mobile user completes the process by
scanning the incoming items into the Magaya system and assigning each
item a location in the warehouse. All information is updated on the PC.

or,

2) Begin the Receiving process on the handheld devices to create a WR for
incoming items. This process is called "Uninformed" (or Blind) Receiving.
The Magaya WMS Mobile user scans the incoming items and assigns
them to locations in the warehouse. All information is updated on the PC.

It is important to perform these steps correctly on the handhelds to ensure accu-
racy in reports or other related transactions.

The following sections will explain both these options in detail.

Informed Receiving

Informed Receiving is the process of receiving cargo that you know you are 
expecting to arrive at the warehouse. You have the shipper information, the 
client (customer name), the item descriptions, dimensions, and other details. 
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For example, your customer sends you WR data via EDI before the cargo phys-
ically arrives.

To receive cargo using the Informed Receiving process, begin by following these 
steps on the PC:

1) Create the WR on the PC. See the section on creating Warehouse Receipts
for details.

Do not assign a location to the items when you enter them in the
Commodity dialog box of the WR because the items have not arrived yet.
The WR will have a status of “Pending” until the receiving task is
completed on the handhelds.

2) From the Warehouse Receipt, create a Receiving Task and send it to the
Magaya WMS Mobile application running on the handheld devices by
following these steps:

Click on the arrow on the side of the Task button and select “Create Task”
from the dropdown menu:
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3) In the Task dialog box, enter the details of the task such as the user who
will perform the task (optional), the date it is due, the Task Type = Receive
(WMS), and other details as needed.

Option: You can enter a location here to tell the handheld user where to
place the items when they receive them, or leave the Location field blank.

Click the OK button when done. The Task appears in the Pending Tasks 
list on the PC and is sent to the Magaya WMS Mobile handheld for the 
assigned user.
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You can print labels at this time if needed. This is useful if boxes do not have 
part numbers:

1) Click the arrow on the Print button and select “Print Labels”.

2) In the dialog box, select the label size and enter the quantity of labels to 
print:

Complete the Steps Using Magaya WMS Mobile Devices:

Next perform the following steps in the Magaya WMS Mobile application on 
handheld device to complete the receipt of the cargo:
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Note: If you have more than one warehouse defined in your system, ensure the 
WMS Mobile user has been given access to that warehouse in their employee 
profile.

1) The handheld user clicks the “Receive” task icon on the handheld’s main
menu:

The “Receive” icon shows the number 3 below it, indicating that there are 
three “Receive” tasks pending.
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2) When you click the Receive icon, the Tasks appear. View them in the Task
List or the view the details of each one in the Detail tab.

You can also scroll through the tasks by clicking the arrows on the bottom 
of the screen to scroll through the available tasks to find the task to 
perform.

The Detail screen shows the task type, who created it, the date, the Ware-
house Receipt number, the client (or customer), and the quantity of items.

The “Est. Pallets” field will only show a number when the Inventory Item 
Definition for this item contains the amount of items required to make a 
pallet. The system will estimate how many pallets you will need to create 
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based on the quantity of items received. This example shows that a loca-
tion was specified when the task was created.

Click the “Select” button to perform this task.

The next screen that opens shows the location if the location was specified 
in the Task. (If the location is not specified, scan/enter it.)

The next screen shows the items that need to be received. Select an item 
and click the “Quantity” button:

Note on Locations: If a location was assigned, you can change the location 
if needed by clicking on the “Location/pallet” button to enter a new loca-
tion.

For example if a location is full or the items ar toolarge and you need to 
assign these items to another location, the change can be made here and it 
will be saved in the system.

As you scan items to receive them, the items will be assigned to that loca-
tion in the system and saved when you change the location (or pallet) or 
click “Finish”. Each item that is saved will no longer be displayed on the 
screen because it is saved. You can end this step before you receive all the 
items if necessary. Then later or the next day, you can continue where you 
left off.
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3) Scan the items or manually enter the quantity:

Tip: Manually entering the quantity instead of scanning is useful when 
there is a large quantity of items and you want to save the time it would 
take to scan each one. You must scan the first item, then you can enter the 
quantity in the next screen.

Click OK.
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4) Receive the remaining items in the list.

If the quantity received was less than the quantity stated on the task, enter
the quantity received. The task will appear again on the handheld screen
with the number of outstanding items remaining to be received.

You can print labels or click “Finish” when you are done or to temporarily
end the task. You can return to it later. All the items you scanned up to this
point are saved as Received in the system.

Other Options in the WR list screen:

To receive perishable items with WMS Mobile:
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Select the item to edit it and open the Identification tab. Select the expiration 
date.

Palletize Items:

From this screen you can also palletize items or create a new pallet if needed.

1) Click on the “Location/Pallet” button from the items list.

2) Scan (or enter) the barcode for the pallet. (The barcode is on a pallet ID
label. Affix the label to the pallet if the pallet does not have a label.) This
will identify the pallet:

If you scan (or enter) the same pallet ID, the system will ask you if you 
want to use the same pallet. Click Yes to add more items to an existing 
pallet. Click No to enter a different pallet ID or a new pallet.
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3) The next screen shows the pallet in this location and the items list below it:

4) Select the first item in the list. When you scan this item, it will go inside 
the pallet in RECA.

When you change that pallet, the system will save what you have scanned, 
and the items will not display on the screen. You can click “Finish” if 
needed and return to the remaining items at a later time.

You can create another pallet as needed.

Click OK to return to the item list. Labels can be printed at this time by 
clicking the “Labels” button.

5) Click “Finish” to complete the task or to temporarily end the task and 
return to it later. All the items you scanned are saved in the database.

Print Labels

To print labels, click on the “Labels” button. In the next screen, enter the 
number of labels to print.
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You can print all the labels for all the items or select a range of labels:

In this example, all the items have part numbers. The part numbers will appear 
on the labels, so you may not need to print labels here.

Affix the labels to the boxes (or items).

Note: You can print labels for any individual item during the receiving process.

When all the pending Receive tasks are completed (or if you end a task tempo-
rarily), the handheld will display the main menu again.

The status of the received items will be “On Hand” after scanning them. If a 
Receive task is incomplete, it will remain on the main menu so you can return 
to it at a later time and complete it.

Printing Over a Network Printer:

The WMS user’s printer settings must be configured on the machine running 
the Magaya Communication Server. Setting up the user’s printer settings in any 
other machine will not work. This applies not only when setting them up 
initially but also when modifying any user’s printer settings; make sure that it is 
done in the machine running the Communication Server.

The windows user under which the Communication Server runs is very 
important. By default the Communication Server will run under a local 
windows user, and when printing over a network printer this is incorrect 
because the printer will not recognize the user from which the print request is 
coming. Therefore, the user under which the Communication Server runs must 
be a domain user available throughout the network. Additionally, this domain 
user should have permissions to print on the desired printer.
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The WMS Mobile print screen has two options: ‘Print all non-printed labels’ 
and ‘Print the following range of labels’. The first option (Print all non-printed 
labels) is the default option; this option will print any labels that have not 
already been printed. If a label for an item has already been printed, requesting 
a print job with the default option will not yield any labels. Instead, you should 
check the second option which allows you to re-print the labels.

Uninformed Receiving (Manual Receiving)

Uninformed Receiving (the “Manual Receive” task) is done when the handheld 
user does not have information about what cargo is coming into the warehouse. 
This process is also called “Blind Receiving.” It is performed on the handheld 
devices running the Magaya WMS Mobile application.

Tip: Create a System Alert when a Manual Receive Task is done on WMS 
Mobile.

To speed up the receiving process with the handhelds, be sure to follow the 
recommendations here for setting Configuration options and also see the topic 
“Put Away.”

The steps for manual receiving vary, depending on your WMS Mobile Config-
uration settings:

How these settings affect operations is explained in the following steps.
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To receive cargo using the Manual/Uniformed Receiving process, follow these 
steps:

1) Click the “Manual Receive” icon on the main menu of the handheld:

2) In the next screen, scan the location where you will receive the cargo 
(unless a Default Receiving Location was configured; then you will not see 
this screen; skip to Step 3):

For example, this cargo will go in Receiving area 01(REC01). Scan or enter 
the location codes exactly as they are defined in your Magaya system. The 
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system is not case sensitive (upper case or lower case letters are not 
required).

Note: If a default receiving location was set in the WMS Configuration 
screen, then the user will not see this screen on the handheld. The system 
will automatically use the default location you configured. Then the hand-
held user will not have to scan the Receiving location repeatedly.

Click OK.

3) In the next screen, enter the entities to receive the items: the Shipper, the 
Consignee, the Tracking Number, and the Bonded Type (if applicable, 
such as Domestic, C.F.S., or G.O.) and the Entry Number.

To access the list of entities in your Magaya database, enter the first few 
letters of the shipper (or consignee) name. This will activate the “Get” 
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button. Click on the Get button to retrieve the list of names that start with 
those letters. Select the correct entity from the list.

Note: To skip this screen, check the box to “Skip entities” in the WMS 
Configuration menu. Then the user will not see this screen; they will be 
taken straight to the next screen where they can begin scanning.
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4) On the next screen you can begin to scan barcodes on items to receive 
them:

Note on the interface: In a screen such as this one that displays a list, you 
can choose the columns by tapping the “Description” columm header. 
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The settings are stored for each user for each operation (except Pick and 
Load which share the settings).

Scan the item or part numbers. If you cannot scan an item, click the “New” 
button to type in the part number.

If the code you enter does not match an existing item in your database, the 
system will ask if you want to use that tracking number to create the item. 
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Click OK to use it. If you click No, the system will not create that item.

Note: If you want to skip this screen, change the Operations Settings in the 
WMS Configuration menu to ensure no checkmark for the option 
“Confirm item creation.”

If you uncheck the box for “Confirm item creation” then the system will 
not ask the handheld user if they want to create the item with the tracking 
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number scanned. The result of this configuration is that the handheld will 
go straight from scanning to the Dimensions screen when a user is 
performing the “Measure” function.

As you continue with the receiving process of scanning items with the 
handheld, the items will be added to the list on the WMS Mobile screen 
and saved to your Magaya database.

Tips: If you are receiving a large order of palletized items of the same type, 
use the New button. It is the easiest way to enter several pallets of the same 
type of item. For example, to receive 40 pallets of the same type of Dell 
PCs, and each pallet has 6 PCs, you can optimize the receiving process by 
using the New button and entering the information in the next screen.

To receive items that don’t have part numbers, configure the system by 
checking the box “Default to item creation without code.” Then users can 
skip that step on the handheld.
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5) After entering or scanning the part number (if applicable), and the system 
will fill in the description and dimensions for that item.

If you are receiving items that do not have a part number, then you can 
enter the description (optional). Click the “Edit” button to enter more 
details such as the dimensions, etc.

Option: To speed up the receiving, you can enter dimensions later by using 
the “Measure” feature.

If you entered a Part Number (PN), the system will search for the PN in 
your Inventory Item Definitions List and fill in the screen when it finds the 
data.
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Enter the Quantity.

The “Warehouse Item” screen has tabs you can scroll through to select and 
view or enter information about the item. This screen shows the “Item” 
tab where you enter the quantity received.

If you will receive identical items, enter the Quantity to save time.

Click OK. The quantities are updated:
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To continue receiving more items, scan the next item (or click “New”). If 
you are done receiving items, click “Finish.”

If the cargo is palletized, click the “Location/Pallet” button. See the section 
on pallets for details.

Continue to receive all the items for this Uninformed Receiving task by 
following the steps above. As you receive items, the items will be added to 
the list on the screen and saved to the database.

6) Click the “Finish” button. If you have not printed labels for all the items, 
the system will ask you if you want to finish the task without printing 
labels.

Extra Info: With the Online Pickup Orders feature, customers can place pickup 
orders on Magaya LiveTrack and print labels for their boxes at their location. 
When you receive those boxes, you can scan those labels and the system will 
connect the information in the Pickup Order to the WR.

Expiration Dates: To receive perishable items with Magaya WMS Mobile:

Select the item to edit it and tap on the Identification tab. Select the expiration 
date by tapping on the arrow. To change the month, tap the month name in the 
calendar heading or scroll by tapping the arrows to go to the next month or 
previous month.
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Palletize Items

To create a pallet of different part numbers or if you receive a pallet with 
different part numbers inside, follow these steps on the handheld device:

1) Click on the “Location/Pallet” button:

2) In the screen that opens, enter/scan the Pallet ID label code:
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Note: For more on creating and printing pallet IDs, see Chapter 17 in the 
Magaya Supply Chain Manual, section “Create a Move Task.”

3) Scan the barcodes of the items.

The screen will display the pallet ID number just scanned.

Complete the Uninformed/Manual Receive process until all items are 
received and assigned a location. This will update your Magaya system 
with a Warehouse Receipt (WR) that has the items and locations.

After the WR is created using the handheld, the next step in the process is to 
verify the cargo information on the PC by opening that WR and adding charges, 
photos, or other details needed as needed. Then the receiving process is 
completed.

To move items from different Warehouse Receipts to a pallet, set the Configu-
ration option explained in Chapter 16’s configuration section.

Extra Info: If you receive items with the same part number but different 
Purchase Orders, Lot numbers or invoice number, the system will make sepa-
rate line items for each PO (or lot # or invoice).

To learn about the different types of tasks to put away cargo or items, see the 
topic “Put Away Cargo or Items.”
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Measure

Using the “Measure” option on the handhelds speeds up the process of receiving 
items that have tracking numbers because it enables you to add item dimensions 
by using the handheld instead of the PC. (It only works for items with tracking 
numbers, not for Part Numbers.)

After a manual receive for items with tracking numbers is done, click/tap 
“Measure” to enter item dimensions.

In the next screen, scan the item tracking number or pallet ID.
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In the next screen, enter the dimensions.

This is useful because you can go back to an item and enter the dimensions at 
any time with this “Measure” feature. You do not need to enter the dimensions 
while receiving, but it can be done later on the handheld instead of the PC. If 
there are multiple items with the same tracking number, the system will assign 
the same dimensions to them all.

You can update weight and dimensions of items and pallets that are loaded into 
outgoing shipments.
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Take Pictures

Take Pictures with WMS Mobile

Taking pictures of cargo with your Motorola scanner is available from the func-
tion called “Pictures” on the main screen of your WMS Mobile application. The 
photos are automatically saved to the Attachments tab of the transaction such 
as a Warehouse Receipt or Shipment (or to Attachments tab of the Commodity 
dialog box).

Note: The recommended handheld is the MC9590. For a list of Motorola devices 
that work with Magaya WMS Mobile software, please see: http://knowl-
edge.magaya.com/?search=wms_mobile_setup

Steps:

1) Log into your WMS Mobile Motorola device.

2) Tap the “Pictures” icon on the main menu.
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3) Scan the barcode (or enter it) to identify the operation, item or pallet:

- If scanning a document’s barcode, the operation number will appear in
the field. This photo saves on the transaction’s Attachments tab.

- If scanning a barcode on a pallet or item, that barcode ID number will
appear in the field. (The barcode ID number is not a Part Number; it’s a
tracking number. This item photo saves on the Commodity dialog box.)

Click OK after scanning.

4) Then assign this photo to the correct transaction by selecting it from the
list shown in the screen. Note: This screen only displays if there is more
than one transaction with the same number. In this example, a WR and
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CR both have the same number. Select the transaction you want to work 
with.

5) Now take the photo by clicking the “Capture” button. Optional: Check the
“Lamp” checkbox to use a flash.

6) Click Next to keep this photo, or click “Retake” to take another photo and
discard this one.
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7) Name the photo, or click “OK” to let the system generate a name.

The photo is saved and attached to the transaction Attachments tab (when scan-
ning a transaction) or the Commodity dialog box Attachments tab (when scan-
ning an item) in your Magaya system and saved in your database the same as 
any other photo.
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Put Away Cargo Items

There are three types of “Put Away” Tasks available on WMS Mobile (as of soft-
ware version 10.0)

We will look at each type of Put Away and the reason for each:

• Put Away: This is done when a Task was created on the PC for a mobile
user who will put items away.

• Manual Put Away: Done if you don’t have a Task created from the PC.
This process only works if you have a Default Receiving Location set up.

• Guided Put Away: Done if your warehouse is set up to use sequencing.
The system then suggests locations to put away items.

Put Away

The “Put Away” option is explained in this section. It has some similarity to the 
“Manual Receive” Task, but the Put Away Task is done after items are received 
in the warehouse and are in a Receiving location with a status of “On Hand.” 
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The Put Away Task will move the items to a storage location or other type of 
location such as a Replenishment location as defined in your Magaya system.

This process uses the Location Definitions that are set up in the Warehouse 
Inspector.

Tip: To speed up the process of putting away items during a manual receiving 
process, set a Default Receiving Location in the Locations list in your Magaya 
Explorer (right-click on the location).

Remember: Before working with Put Away Tasks on the handhelds, the loca-
tions must be defined for put away. Use Storage or Replenishment location 
types to define a Put Away sequence. This is useful for the “Directed Opera-
tions” procedures. See the topic “Directed Operations: Getting Started” for 
details.
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1. Create the Task on the PC:

1) From the Warehouse Receipt document, click Task > Create Put Away.
Task

(Alternate method to put away items from more than one WR: Select the 
WRs from the list to highlight them and right-click):
443



Put Away Cargo Items Chapter 11
2) A “Put Away Setup” wizard opens. Click the “Next” button.
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3) The next screen shows what items are available to put away.

If there are items in different Warehouse Receipts, they will display here.

If a Put Away Sequence is not set up for a warehouse, then items received
in that warehouse will not display here. This is a Read Only screen. Go to
the next screen.
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4) Next, define the maximum weight and size for this task. This is an optional 
step.

You can configure your system to populate this screen with capacity 
defaults (in Configuration > WMS > Directed Operations).
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5) Next, the wizard shows the tasks that were generated. Click Finish.

These Put Away tasks are generated for any user to perform, and the tasks 
are sent to the handhelds.
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2. Put Away Items with Handheld:

1) On the main screen, tap/click the Put Away task icon. It will show the 
number of tasks.
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2) Select the task to perform.

If there are multiple tasks, scroll through them with the arrow buttons to 
view and select a task.
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3) Select the location to move the items from.

4) Select the items and then click “Quantity” to enter the quantity in thenext 
screen.
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5) Enter the quantity received and click OK.

6) Select the items to move/put away.
451



Put Away Cargo Items Chapter 11
7) Enter/scan the barcode of the location where the items will be put away.

8) After putting away the items in the tasks, if there are no more tasks, the
system gives you a message.

The items are in their new location, and the Magaya system is updated 
with the new location information.
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Manual Put Away

The Manual Put Away process is done from the handhelds, similar to a Manual 
Move Task. Use this task if cargo arrives without prior notice. This process 
requires a Default Receiving Location.

1) Select the Manual Put Away icon on the main menu.

Since the receiving location is defined already, you do not need to scan it 
in this process.

2) Enter the name of the customer that shipped the items to you. (You can
look up the name with the “Get” button by entering the first few letters.)

Note: To make the process faster, you can configure your system to skip
this step in the WMS Configuration menu.

3) Scan the bar codes of the items. If you can’t scan a bar code, click the
“New” button and enter the code. If the item is a part number already
defined in your Magaya system, the details will fill in for you. If not, you
can enter details about the item, including the quantity received.

This process is similar to the Manual Move; for detailed steps, please see
the section “Uninformed Receiving (Manual Receiving).”
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Guided Put Away

The Guided Put Away task is done completely on the handheld. It uses the 
suggested locations that are defined in the Warehouse Inspector’s “Sequence” 
tab.

Requirements: The sequence and Location Definitions must be defined before 
using the Guided Put Away option.

If you’ve defined quantity for a location, thenthe system shows the following: a 
checkmark appears next to a Part Number that has enough quantity to fill the 
location. If not enough quantity, then there won’t be a checkmark.
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Introduction to Quotations

Two different types of Quotations can be made in the Magaya Supply Chain 
Solution: One to sell freight (“Cargo Quote”) and one to sell inventory 
(“Commerce Quote”). The Quotation dialog boxes contain fields so you can 
enter the details of the quote and they are saved in a Quotation document for 
you automatically.

From the “Add” button, select the type of quote you need:
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Create a Cargo Quotation

Overview of Cargo Quotes

The Cargo Quote transaction includes the commodities, the routing details, and 
the freight charges for shipping items from one port to another. Follow the steps 
below to create a quotation for cargo.

The template for the Quotation document can be selected and set as a default 
for your system by clicking the Actions button. More templates are available 
from the File > Download Document option in your system.

The Quotation is often the first transaction in the logistics process. In Magaya, 
all the data entered in a quote is saved and can be converted into other transac-
tions such as a Booking (also called a Routing Order) to request space on a 
carrier. You can also convert a quote into a Warehouse Receipt, Shipment or 
other transaction without re-typing the details. For more information, see the 
section below “Related Resources.”

Steps

1) Click the “Add” button. A dialog box opens where you can enter details of 
this cargo quote. You can begin on any tab. This example starts with the 
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General tab to give a customer a quote for exporting cargo from the 
United States. You can create quotes for any origins and destinations.

2) General Tab:

Note: The status of the quotation will remain “Empty” while you’re adding 
details in the dialog box. After clicking the OK button, the status will be 
“Open.” Fill in as many tabs as you need. You can always add more infor-
mation later.

• The Quote Number is filled in automatically. To set up numbering, 
go to Maintenance > Configuration > Document Numbering.

• Select the customer’s name in the Contact Name field. Note: Infor-
mation from the Customer’s profile such as their address or Inco-
terms will display automatically.

• Enter the description of the goods. (This is optional but recom-
mended.)

The button (with the three dots) next to the description field can be 
used to add a preset clause to the quotation.

• The Expiration Date is one month from the date the quote was 
created by default. Change it as needed.
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• The Payment Terms field will be filled in if there are payment terms 
defined for this customer or for your system. If not, you can select 
them or change them here. Payment terms set in a Quote are trans-
ferred to the Sales Order and Invoice.

3) Routing Tab:

• Select the mode of transportation from the dropdown menu. If you 
do not select a mode, you will not be able to add freight charges.

• In the “Origin” part of the screen, select the port of origin from the 
dropdown menu. (Only the ports for the selected mode appear.)

• For the Origin “Name” field, click the dropdown menu to select the 
name of the entity where the cargo will be picked up. (This may or 
may not be the customer.) The address fills in automatically. Change 
it as needed.

• In the “Destination” part of the screen, select the port of destination 
from the dropdown menu.

• In the Destination “Name” field, select the name of the final 
consignee from the dropdown menu.
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4) Commodities Tab:

• Click the “Add” button on the Commodities tab to add cargo into
the Commodity dialog box. The status of the items is “In Quote”
when you create the Quotation.

As items are added, the total weight and volume is updated on the
tab.

The commodities will display in the Quotation document. If you
have many commodities and need more than one page, you can
create a template that has multiple pages. See the Knowledgebase for
details:

Customize a Template

http://knowledge.magaya.com/#/article/customize_existing_tem-
plate

• To add a container, click the “Add Cont.” button. Enter details about 
the container in the dialog box. Additional details on adding
commodities and container are available in the Knowledgebase:

Add Commodities and Containers

http://knowledge.magaya.com/#/article/commodities_tab
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5) Charges Tab:

Add charges for freight, documentation, etc. as needed. Learn more in the 
following article:

Charges

http://knowledge.magaya.com/#/article/charges_tab

Options:

Click the Attachments tab to add photographs or documents to the Quotation 
as needed. For details on adding attachments, see the topic:

Attachments

http://knowledge.magaya.com/#/article/attachments

Click the Notes and/or Internal Notes tabs to add notes, clauses, etc. The 
internal notes are not visible to customers. More details are available in the topic 
on “Notes and Internal Notes:”

Notes and Internal Notes

http://knowledge.magaya.com/#/article/notes_and_internal_notes

If you have added any custom fields to your Magaya system, they will be avail-
able on a tab called “Custom.” If not, then the tab will not appear.
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Click “OK” to save the Quotation. You can save it as a PDF and email it, send it 
via the Magaya Network, or print it. If you have the Transaction Tracking 
plug-in, you can send a link to them which displays real-time data.

View the Quotations List: When viewing the list of Quotations, you can see 
details of any quote by clicking the “Detail” button. In the panel that opens, 
select a detail option from the dropdown list.

The status of a Quote is “Open” after it is created. When a Quote is converted 
into another transaction, the status is “Posted.”

Related Resources

See the following articles for more information related to Quotations:

Actions: See the actions you can perform with a quote:

Actions for Quotations

http://knowledge.magaya.com/#/article/quotation_actions

Add Multiple Pages to a Quote Template: If you have many commodities and 
need more than one page in your quote, you can add pages to the template. See 
the Knowledgebase for details:

Customize a Template

http://knowledge.magaya.com/#/article/customize_existing_template
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Commerce Quotation

Commerce Quote Steps

1) Click the “Add” button and select “Commerce Quotation” and enter the 
details on the following tabs.

2) General Tab:

Select the Contact Name of the customer for this quote. If this customer 
has payments terms set (or your system is set), then the terms will appear 
in the Payment Terms field. Otherwise, you can select the terms as needed.

If you are also quoting freight, set the mode of transportation in the “Via” 
field. Otherwise it can remain blank. Selecting a mode here activates the 
freight charges on the Charges tab.
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3) Commodities Tab:

Click the “Add” button. A line is highlighted. Click in the “Part Number” 
column. A dropdown menu is activated. Select the part number your 
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customer wants to buy. (These part numbers pull from your Inventory 
Item Definitions list.)

You can sell inventory even if it is not on hand. The system will add the 
items to the Backordered Items list.

The items will display in the Quotation document. If you have many items 
and need more than one page, you can create a template that has multiple 
pages. See the Knowledgebase for details.
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Items have a status of “In Quote.”
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4) Add Charges:

The charges could include freight if you will ship the items. The income 
charge “Inland Freight” choice is available on this tab even if you do not 
select a mode of transportation on the General tab.

5) Add other details as needed such as Events, attach photos or documents,
or notes.

6) Click “OK” to save the Quotation. You can save it as a PDF and email it,
send it via the Magaya Network, or print it. If you have the Transaction
Tracking plug-in, you can send a link to them which displays real-time
data.

When the customer accepts the quote, you can convert the quote into a Sales 
Order (via the Actions button).
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Actions for Quotations

Overview of Actions you can do with Quotations:

After you create a Quotation and the customer accepts it, you can transfer the 
information in the Quotation automatically to create the following transactions 
by clicking on the arrow on the side of the Actions button and selecting the 
transaction choice from the menu (you may see different options, depending on 
the software product you have):

• Booking

• Warehouse Receipt

• Pickup Order

• Shipment

• Invoice

• Purchase Order

• Sales Order (Note: The commodities will remain in the same order when 
creating a SO from a Quote)

This Actions menu is available from a button in the document view or the list 
view, or by selecting a Quotation in the list view and right-clicking on it. Addi-
tional options are available from the list view such as Reports.
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The Magaya Supply Chain Solution menu offers the option to create Sales 
Orders and Purchase Orders from the Quote.

The Magaya Cargo System menu offers choices such as the ability to create 
other Magaya transactions such as Pickup Orders and Warehouse Receipts 
from Quotes.

Other actions that can be performed with a Quotation are:

• To view the history of the Quotation, select the History menu option. A
dialog box opens, listing all the transactions related to this quotation. If
you create a Booking or other transaction from this quotation, that history 
will appear in the History list.

Extra Info: In the menu, “History” is in bold; this means this is the default
action if you just click the Actions button instead of the arrow on the side
of the button. The Actions button in all the Magaya screens functions in a
similar way.

• Reports: You can create reports about the quotations by selecting the
option in the Actions button when you are in the Quotations List view
(not the document view).

• Query Rates: This option enables you to run a query of all the selling rates
in your system to see the best price. See the section "QueryRates" for
details.

• Show Related Object: This will take you to the next transaction created
from this Quotation. For example, if you create a Warehouse Receipt
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(WR) from this Quotation, click this option from the Actions button and 
it will take you to that WR.

• Set This Quotation as Lost: Use this option if the customer does not
accept an Open Quotation. If a quotation is set as Lost, a checkmark
appears next to this option in the Actions button options. The status of the
quotation is set to “Lost” and the icon becomes red. To recover a lost
quotation, click on the option in the Actions button option. The check-
mark will be removed and the status updated.

• Import or export data from the Quotation list: You can import informa-
tion into Magaya Explorer or export data out in XML, PDF, or CSV
formats. A dialog box opens with options.

• To choose a different template for the document, select the option: Select
Template (this option is only available from the document view). For
example, the template “Quotation with Taxes” is used to display the taxes
for each charge.

• You can also print, print a batch, copy, or email a Quotation.

• Filter the Quotation List: The Filter button allows you to select how you
want to view the information in a list. For example, you may want to see
only transactions for the past week or transactions for a certain customer
or destination.

The Filter button has two options: Standard and Advanced. For details on
using the Advanced Filter, see the section “The Filter Button” in the topic
that explains how to work with the documents and lists:

The Filter Button

http://knowledge.magaya.com/#/article/2_work_document_and_list
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Query Rates

To access the “Query Rates” function, click the Actions button in the Quotation 
document view or list view. The Query Selling Rates dialog box opens:

1) Enter a Customer name (optional).

2) Select a Freight Service Class such as Ocean Freight Service Cost.

To include multiple charges in your query, click the button with the three 
dots that is next to the Freight Service Class field. A dialog box opens with 
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options. Check as many as apply, and click OK.

3) Enter the Origin and Destination in the Query dialog box.

4) Click Find (or enter more details such as weight and commodity type).

Results: The results of the query search will display in the bottom of the screen, 
displaying rates that are entered into your Magaya system:

The best option will be checked. These rates are pulled from the rates entered in 
the Accounting folder > Rates.

To create a Quotation from this rate:

1) Select the Customer (if the field is blank).

2) Click “Create Quotation”.

The information about that customer and rate will be automatically 
included in the Quotation dialog box. Make any changes needed, and click 
OK when done.
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Note: The next time you open the Query Rates dialog box, your last query is 
saved so you do not have to re-enter data to search again for that information.

The Query Rates dialog box can be moved aside so you can work in the screen 
and click in different functions in your Magaya Explorer, without losing the 
Query screen.
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Standard Booking

Overview

The Standard Booking in Magaya includes more fields than the Quick Booking 
option. This article explains how to create a standard booking using an air 
export as an example. The software includes options to create bookings for 
exports and imports via air, ocean, and ground modes of transport to reserve 
space for your customers' cargo.

For details about using the Quick Booking option, see the Knowledgebase 
article:

Quick Booking article:

http://knowledge.magaya.com/#/article/quick_booking2

You can create Bookings at any time, or create one from your Trips list (if 
configured). For more on setting up your Trip Schedules, see the Knowledge-
base article:

Trip Schedules:

http://knowledge.magaya.com/#/article/trip_schedules

Create a Standard Air Export Booking

To create a Standard Booking, follow the steps below. Note: The steps are 
similar for creating an import or export booking for all modes of transport such 
as ocean or ground. Each mode has its own wizard. This example shows an air 
export standard booking.
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Click the “Add” button on the toolbar in the document or list view of the Book-
ings. A sub-menu opens. Select the type of booking you want to create.

General Tab of a Booking

The dialog box for a Standard Booking opens to the General tab. You can begin 
to enter information on any tab, but this example shows you how to begin with 
the first tab, the General tab.

As you enter information on each tab, click to view the next tab across the top 
of the dialog box.

Notice some of the fields are filled in automatically such as the Reference 
number, employee who created it, and the dates. These can be changed as 
needed.

Also notice the arrow and “Outgoing” on the top of the General tab. This indi-
cates this is an export shipment. Next to it is the status icon. The status of this 
example is Open.

The screen can be resized to expand the view and work space; just click and drag 
the edge of the dialog box.

Bookings can have a status of Open, Closed, or Canceled. A Booking is closed 
when it's converted into another transaction such as a shipment or warehouse 
receipt.
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You can use a Booking as a shipment template by leaving the Commodities tab 
blank. Then you can reuse that Booking, even if the status is Closed.

The Reference Number is the Booking number for your customer, often defined 
by them; they often give it to their customers. (Note: To set up numbering for 
your documents and transactions, go to Maintenance > Configuration > Docu-
ment Numbers.)

Select the Carrier from the dropdown list. This pulls from your Carrier List.

Enter an air waybill number. The Booking number comes from the carrier.

Set the Spotting Date and Cut Off Date and Time by using the dropdown 
menus. (The date and time are filled in automatically with today’s date and time 
by default.) The Spotting Date is the date that the container is placed at the 
customer’s location. The Cut Off date is when the container needs to be ready 
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to be taken to the port. To deactivate either field, uncheck the box. The deacti-
vated field will not appear in the document or in the online tracking document.

Enter a declared value for carriage and/or Customs, if needed.

Enter a description of the goods.

Entities Tab

Select the entities for this booking:
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These entities are pulled from your lists of customers, agents, etc. The fields for 
Notify Party and Intermediate Consignee are optional. To change an address for 
an entity, click the button with the three dots next to the address.

The “Client to Bill” defaults to the Shipper, but it can be changed.

Routing Tab

Select or enter the details of the routing for this booking.
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The Service Type: “Port to Port” is the default. Click the dropdown menu to 
select a different option such as Door to Door.

The Mode of Transportation of “Air, Containerized” is displayed by default for 
an Air Booking. To change it, use the dropdown menu.

Select a route from the dropdown menu, if you have routes set up in your 
system. Learn more about creating routes in the following Knowledgebase 
article:

Routes and Segments

http://knowledge.magaya.com/#/article/routes_segments

The Carrier field is filled in automatically with the carrier name selected on the 
General tab. If the carrier needs to be changed, go to the General tab to change 
it. Type in the Flight Number in the field, or select it by clicking the button with 
the three dots.

Select the Departure and Arrival ports, date and time. (The date is filled in auto-
matically with today’s date.) The fields for transfers are optional.

Select the origin and destination codes. US Custom codes for origin are 
Schedule D codes. Schedule K codes are non-US destinations.

Commodities Tab

The Commodities tab gives you the flexibility to enter a container, commodity 
or vehicle. You can select from your list of Inventory Item Definitions (Part 
Numbers) also.

To add a container, click the “Add Cont.” button. In the dialog box that opens, 
select the container type.
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For commodities such as part numbers in your system or for vehicles, click the 
“Add” button.

Notes: The “Load” button will only be active if this booking is created from a 
Trip. If you don't have any containers set up in your trips, the button will be 
grayed out. Use the “Settings” button if you need to change the measurement 
units.
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Charges Tab

Enter charges such as income or expenses for freight or other types.

Learn more about charges, see the Knowledgebase article:

Charges:

http://knowledge.magaya.com/#/article/charges_tab
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Additional Tabs

The Standard Booking includes other tabs that are optional. Fill them out as 
needed. Details about each tab are included in the following articles:

Events: See the Knowledgebase articles listed and linked below:

Eventstab info

http://knowledge.magaya.com/#/article/events

Attachments: See:

Attachments info

http://knowledge.magaya.com/#/article/attachments

Notes and Internal Notes: See:

Notes and Internal Notes info

http://knowledge.magaya.com/#/article/notes_and_internal_notes

When you’re finished entering all the information you need for this booking, 
click the “OK” button to save the transaction. The Booking document template 
will fill out with the details from the dialog box.

Actions for a Standard Booking

After completing a Booking, Magaya Explorer gives you many options. You can 
make changes to a booking by using the Edit button.
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The following actions can be performed from a Booking by using the Actions 
button and selecting from the menu.

You can create a copy of this booking or create a transaction from it such as a 
Pickup Order, Warehouse Receipt or a Shipment.

You can exclude the transaction from tracking if the transaction is not complete 
and you do not want it viewed via Magaya LiveTrack or Transaction Tracking.

To choose a different template for the document, select the option: Select 
Template.

To view the history of the booking, select the option “History.”

The direction of the booking can be changed from incoming to outgoing by 
selecting it on this menu.

If you need to cancel a booking in the case of a customer deciding not to move 
the cargo at this time, click on the Actions and select “Cancel Booking.” A dialog 
box will ask you to confirm the cancellation. The status will change to 
“Canceled.” A canceled transaction cannot be used to create another transac-
tion. To change the status from “Canceled,” use the Actions button again and 
uncheck the cancellation option.
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Additional Resources

You can also offer your customers the option to place bookings online using 
Magaya LiveTrack. They can send you booking requests to reserve space on 
airplanes, ocean vessels, and trucks for ground shipments. You can link the 
requests to trips in your Trip Schedule or set your system to accept any requests, 
regardless of origin and destination requested. For details, see:

Online Bookings: Getting Started

http://knowledge.magaya.com/#/article/online_bookings_intro
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Introduction to Creating a Quick Booking

A booking is a reservation made by your company (such as a freight forwarder, 
NVOCC, or a carrier) for your customer (such as the shipper or consignee) to 
move cargo.

Bookings can be created for air, ocean, and ground shipments, both import and 
export.

You can also configure your system to check your Trip Schedule in Magaya 
Explorer to verify if space is available in a container or on a vessel (plane or 
truck) for your customers’ cargo when you create bookings. For more on setting 
up your Trip Schedules, see the topic:

Trip Schedules:

http://knowledge.magaya.com/#/article/trip_schedules

The Bookings list and documents can be found in the Bookings folder in 
Magaya Explorer:

There are two ways to create bookings in Magaya Explorer:

• Quick Booking: The Quick Booking feature is used frequently because it
has only the necessary fields to complete a booking. The Quick Booking
fields can be filled in quickly while you are on the phone with a customer
who is placing a booking with you.

• Standard Booking: The Standard Booking feature offers more fields so
you can enter additional information about a booking. It has much of the
same information that you will find in the Shipment dialog box screens.
All the information that you enter into the booking can be converted into
a shipment or other transaction. To learn how to create a Standard
Booking, see the following Knowledgebase article:

Standard Booking:

http://knowledge.magaya.com/#/article/standard_booking
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You can also offer your customers the option to place bookings online using 
Magaya LiveTrack. They can send you bookings to request you to reserve space 
for their cargo on an airplane, ocean vessel, and trucks for ground shipments. 
You can link the requests to trips you set up in your Trip Schedule, or set your 
system to accept any requests, regardless of origin and destination requested. 
For details, see:

Online Bookings: Getting Started

http://knowledge.magaya.com/#/article/online_bookings_intro

How to Create a Quick Booking

The following instructions explain how to use the Quick Booking feature in 
your Magaya Explorer using the example of creating an Ocean Booking Export.

The Magaya system is set to Standard Booking by default.

You can change your system to use the Quick Booking method by going to the 
Action button and selecting “Use Quick Booking Entry.” You will only need to 
do this once, and then your system will always use Quick Booking until you 
uncheck the option.
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Step-by-Step Procedure for Quick Booking:

1) Click the Add button and select “Ocean Booking Export” (or Ocean 
Booking Import). The booking wizard opens:

• The Reference Number is the Booking number for your customer. It 
is filled in automatically. (To set up document numbers, go to Main-
tenance > Configuration.)

• The Employee and Creation Date are filled in automatically. (They 
can be changed with the dropdown menu.)

• Select the Client (Customer who is booking with you) from the 
dropdown menu. (The address is filled in automatically if you have 
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it set up in the customer’s profile. To change the address for this 
delivery, click the Delivery Address button.)

• Enter the Trip Number, or click the “Set” button to select from your
list of trip numbers. All the information from the trip will be filled in
on the rest of fields of this tab. If you do not have a Trip Schedule set
up, you will need to fill in this information manually.

• Enter the Line Booking Number. This is the booking number from
your Trip Schedule, if you are a freight forwarder and you have a
booking with a carrier or shipping line.

• Select the Carrier from the dropdown list.

• The Mode of Transportation of “Vessel” is displayed by default for
an Ocean Booking. To change it, use the dropdown menu.

• Select the vessel from the dropdown menu.

• Select the Departure and Arrival (at the destination) ports and date.
(The date is filled in automatically with today’s date.)

• Set the Spotting Date and Cut Off Date and Time by using the drop-
down menus. (The date and time are filled in automatically with
today’s date and time by default.) The Spotting Date is the date that
the container is placed at the customer’s location. The Cut Off date
is when the container needs to be ready to be taken to the port. To
deactivate either field, uncheck the box. The deactivated field will
not appear in the document or in the online tracking document.
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2) Click the “Next” button to enter commodities in the cargo screen.

• When you click the “Add” button to add cargo, the fields in the
columns will be highlighted. Enter the number of pieces, select the
type of container, enter the cargo description, and dimensions. The
totals are displayed on the bottom of the screen. If the maximum
weight is reached for this trip, the system will notify you.

• Click the “Load” button to use a container that you have previously
defined in your Trip Schedule (in the Equipment tab). If you do not
have any containers set up in your trips, the button will be grayed
out.

• Use the “Settings” button if you need to change the measurement
units.

3) Click the “Next” button to go to the Notes screen. Add any clauses or notes 
that you want to appear in the notes field (or the Remarks or Comments
field) of the Booking. This may be a reminder to your customer to bring
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important documents with the cargo such as the title of a vehicle (for those 
companies that ship cars and vehicles).

• Select a clause category from the dropdown menu. There are many 
categories.

• Click the button with the three dots to select from a list of preset 
clauses. (A dialog box opens. You can also add clauses. See the topic 
"Add Clauses" for details.)

• Check the box next to the item in the list to include it in the Notes 
for the Booking.

• The field “Selected Clause Text” displays the full text of the clause 
you selected.

Notes, comments and clauses can be edited or deleted after saving the transac-
tion.

After completing the booking wizard, click the Finish button. The booking is 
placed in your Magaya Explorer with a status of “Open”. When the booking is 
used to create a shipment, the status will change to “Closed”.
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Actions for a Booking

After completing a Booking, Magaya Explorer gives you many options. You can 
make changes to a booking by using the Edit button. The screens can be resized 
to expand the view and work space; just click and drag the edge of the dialog 
box.

The following actions can be performed from a Booking by using the Actions 
button and selecting from the menu.

• Create a Copy: The copy of a booking will contain all the same informa-
tion except for the Booking Number, which the Magaya system will assign 
automatically.

• Create a Pickup Order: All the information from the Booking is 
converted automatically into a Pickup Order.
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• Create a Shipment: In the wizard that opens, you can select the option to 
create a Back-to-Back shipment. The system will create a Master and a 
House.

Select the commodities to convert from the Booking to the next transac-
tion:

In the “Select Commodities” dialog box, click the “Mark All” button to 
convert all the commodities and their details, or click the “Pieces” button 
to select only those items you want.

For example, if you booked three containers and you pick up only one at 
this time. Create a Pickup Order for that case and use the “Pieces” button 
to enter the one container.

If a Booking has Attachments when you convert it to a Shipment, the 
Attachments are moved to the Shipment transaction; they are not copied.

• To exclude the transaction from trackingif the transaction is not 
complete and you do not want it viewed via Magaya LiveTrack or Trans-
action Tracking, select the option: Exclude from Tracking.

• Select Template: To choose a different template for the document, select 
the option: Select Template.

• View History: To view the history of the booking, select the option 
“History” from the Actions button. For example, the following screen 
shows a Shipment that was created from a booking. A dialog box opens, 
listing all the transactions related to this booking. If you need to open the 
dialog box for that transaction, click the “View” button. The “Go To” 
button takes you to the document. Once there, you can return to the 
booking by using the Back button.
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• To set a Booking as incoming or as outgoing: The direction of the
booking can be changed from incoming to outgoing. When you change
the status, it will be reflected on the General tab in the dialog box. Click the 
Edit button to see the status.

• To Cancel a Booking: If you need to cancel a booking in the case of a
customer deciding not to move the cargo at this time, click on the Actions
and select “Cancel Booking”. A dialog box will ask you to confirm the
cancellation. The status will change to “Cancelled”. A cancelled transac-
tion cannot be used to create another transaction. To change the status
from “Cancelled”, use the Actions button again and uncheck the cancella-
tion option.

As with any list, you can filter the list of Bookings. This is especially useful when 
the list grows very long. You can set a filter to display only those bookings that 
you want to see. The Filter button offers two options: Standard and Advanced. 
For details on using the Filter button, see the topic:

Filters in "Working with Documents and ListViews"

http://knowledge.magaya.com/#/article/2_work_document_and_list
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Introduction to Trip Schedules

For Carriers, the Trip Schedule is the list of your actual flights and/or sailings. 
For NVOCC's and freight forwarders, the Trip Schedules feature in Magaya 
Explorer provides a method of saving information about the vessels you own or 
carriers you use regularly that travel to the same destinations.

For example if you book flights from Miami to Freeport, Grand Bahama, every 
week, then adding the flight information into the Trip Schedule will make the 
information available when you schedule a booking, saving you time. All you 
have to do is select the trip from the schedule, and all the information is auto-
matically filled into the booking.

The Trip Schedules feature can be found under the Bookings folder:

You can also give your customers access to your trips so they can send you 
bookings requests via Magaya LiveTrack. For details see the Knowledgebase or 
Chapter 5, “Magaya LiveTrack” in the Magaya Software Communications 
Manual.

If you are using the Magaya Ocean Carriers Interface with INTTRA, please see 
the Knowledgebase or the Magaya Software Communications Manual.
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How to Create a Trip Schedule

1) Go to Bookings folder > Trip Schedules

2) Click the “Add” button and select a trip type:

A dialog box opens. Enter data as shown in the steps below. You can start 
on any tab, but this topic explains the process starting with the General tab 
and working from left to right.
 498



Chapter 14
On the General tab, select or type in information for this trip:

This example shows an Air Export trip, marked with an arrow labeled as 
"Outgoing" on the General tab. (You can use these steps to create an 
import trip because the screens are the same.)

The Trip number field is filled in automatically. (The Trip numbers can be 
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defined in the Configuration menu.)

Select the carrier from the dropdown menu.

The Employee field will be filled in automatically based on the user who is 
logged in and creates this trip. The Creation Date field is also set automat-
ically to today’s date.

The Description field is optional.

The Flight Capacity fields are optional. Set them as needed based on infor-
mation from the carrier.
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3) On the Entitiestab, select the entities for this trip such as the Shipper,
Consignee, and Destination Agent. The Forwarding Agent field fills in
automatically with your company information.

Addresses for any entity can be changed by clicking the button with the 
three dots. You can add new addresses also.

The Entities tab is often only used by NVOCCs and Freight Forwarders, 
not by Carriers.
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4) On the Routing tab, select the Service Type: “Port to Port” is the default. 
Click the dropdown menu to select a different option such as Door to 
Door.

Select the trip mode of transportation: Air flights can be “Air” or “Air, 
containerized.” See the Appendix of this topic for other modes.

The Carrier field is filled in automatically on the Routing tab with the 
carrier name selected on the General tab. If the carrier needs to be 
changed, go to the General tab to change it. Type in the Flight Number in 
the field.

Select the Departure and Final Arrival cities from the dropdown menus. 
Also select the dates for each. The First and Second Transfer fields are 
optional, based on the trip.

If the Departure is from a US city, select the US Custom code Schedule D 
for the city. Schedule K codes are foreign (not US) destinations.
 502



Chapter 14
5) The Equipmenttab is used to select the type of equipment for this trip 
such as a container. Click the “Add” button. In the dialog box, click the 
dropdown menu in the “Type” column to select a container. The 
container types shown are those related to the trip type such as air or 
ocean.

Note: When you create a booking for this trip later, the available 
containers will be displayed along with their status, indicating if they are 
available or have already been booked.

6) On the Bookings tab, you can see a list of all the bookings that are already 
included for this trip. Totals at the bottom tell you how much space you 
have already booked in this trip. If you do not have any bookings for this 
trip, this tab will be empty.

7) On the Commodities tab, the commodities (or loose cargo) that are 
booked on this trip are displayed as you entered them in the bookings.

8) Add any events to the Events tab.
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9) To add notes, use the Notes tab (optional). These notes are included on 
documents. The Internal Notes tab is for notes within your company. For 
details, see the topic “Notes”.

10) Add Attachments as needed.

11) Click “OK” to save.

Result:

After you have completed entering the information into the Trip Schedule, the 
trip is now available for use in your Magaya system and in LiveTrack.

You can also configure your system to accept bookings that are defined by the 
Trip Schedule. Go to Maintenance > Configuration > Online Bookings and 
check the box.

For example, when you create a booking, the trip schedule can be selected and 
all the information will be filled into the appropriate fields in the Booking dialog 
box. For details, see the topics "Bookings" and "INTTRA" in the Knowledgebase.
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Actions for the Trips List

The following actions can be performed from the Trip Schedule List from the 
Actions button or by right-clicking on the trip:

• Create Reports: Reports can be made about the trips based on any of the
fields listed in the reports list. The report can be saved or emailed.

• Create a Consolidation: A wizard opens that enables you to create a
consolidated shipment from the trip. The Bookings from the trip will be
converted into House shipments, and the trip will become the Master
shipment for the consolidation. You can choose to make the shipment
number the same as the booking number. Any Attachments in the Trip
are moved to the Consolidation transaction, not copied.
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• Create a Copy: The copy of a trip will contain all the same information
except for the Trip Number, which the Magaya system will assign auto-
matically.

• View a Booking: This opens a new list showing the booking(s) associated
with this trip.

• View Commodities: This opens a new list showing the commodities in
this trip.

• Choose Columns: Use this option to select which columns you want
displayed in the Trip Schedule list.

• Import or Export Data: Use this option to import or export data to or
from the Magaya database in CSV, XML, or other formats.

• View History of a Trip: A dialog box opens showing any transactions
related to this trip.

The Actions available depend on the type of trip. For example, if you right-click 
an Ocean Trip, the menu is different from a Ground Trip or Air Trip:

You can make a consolidation from an ocean trip or connect to the Ocean 
Carriers Messages via INTTRA.
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Appendix for Trips

The Routing tab for Ground trips includes fields to add vehicle and driver infor-
mation.

The Routing tab for an Ocean trip includes fields for many details such as the 
carrier who will do the pre-carriage, the loading pier (or terminal) at the port, 
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and details for the destination. All these details are explained in the “Shipments” 
topic.

The Description tab include a button that enables you to add clauses to the Trip.

To learn more about the tabs in the Trips dialog box such as Attachments or 
Notes, search the Knowledgebase for the keywords of the feature you need to 
learn more about.
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Chapter 15: Manage & Move Items in the Ware-
house

Overview

This topic explains how to identify and manage items in the warehouse. Magaya 
Explorer has a feature to help management of items called the Warehouse 
Inspector. It is located in the Warehousing folder.

Also learn how to perform Informed Moves and Uninformed Manual Moves of 
cargo, and how to find locations and items in your Magaya Explorer using the 
Warehouse Inspector feature.
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Warehouse Inspector

This topic covers the Warehouse Inspector function available in the Ware-
housing folder in Magaya WMS, Distribution System, and Magaya Supply 
Chain Solution software.

Introduction to the Warehouse Inspector

This topic discusses managing and moving items in the warehouse using the 
Warehouse Inspector in Magaya software.

What is the “Warehouse Inspector”? The Warehouse Inspector is the view of 
your warehouse in the database that enables you to create tasks to move cargo 
and send the tasks to an employee who is using the Magaya WMS Mobile appli-
cation running on wireless handheld devices. The mobile users move the items, 
and the system keeps track of the location of every item, updating it in real time.

In addition to controlling the movement and storage of items in your system, 
the Warehouse Inspector enables you to search for items, to perform inventory 
counts, and more. Use the Warehouse Inspector to efficiently manage storage 
capacity to reduce empty space and implement a Just-In-Time inventory 
management. The information about the inventory items can also be viewed 
online in Magaya LiveTrack with real-time updates.
510



Warehouse Inspector Chapter 15
Let’s look at the toolbar and buttons.

The Warehouse Inspector screen displays the zones and locations in your ware-
house. Expand a zone to see locations. Expand a location to see items inside that 
location.

If you have more than one warehouse, you can define it by using the “Ware-
house Promotion” wizard. The icon will change as shown in this screenshot 
which shows icons for the Tucson AZ WH and the Houston Warehouse in 
comparison to the other icons:
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Clicking a zone to highlight it will open new tabs on the right side of the Ware-
house Inspector screen. You can view the locations in the zone or click the 
“Sequence” tab to see the sequence for the locations.

If you have more than one physical warehouse, then use the “Promote Ware-
house” wizard which will promote a warehouse, making it a separate warehouse 
not just a zone in your Default warehouse zone. Just right-click the zone to open 
the wizard. This will change the icon to distinguish the warehouses from zones. 
Then you can add or assign locations to it. Learn more in the topic “Multiple 
Warehouses.”

Multiple Warehouses

http://knowledge.magaya.com/#/article/multiple_warehouses

The Sequence tab in the Warehouse Inspector is used to change the order of 
locations so your system will recommend those locations first to users in the 
warehouse who put away items or pick items for release. A sequence can be 
imported into your system using the “Import” button. Save any changes. To 
learn about sequencing in a single warehouse, see the topic “Sequencing in the 
Warehouse.”

Sequencing in the Warehouse

http://knowledge.magaya.com/#/article/sequencing_warehouse

After expanding a zone: Click on a location name to display the items in the list 
on the right-hand side of the screen. To rearrange the columns on the right, 
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click and drag the column headers. The details of any item can be viewed by 
double-clicking on an item to open the Commodity dialog box. Find more 
options by right-clicking a Location to open a pop-up menu.

When you click a Location, a new options appears on the screen: It’s a way to 
view items in a location alongside the locations list in detail or in summary.

Click on the “Detail” tab on the bottom of the screen to see what’s inside a loca-
tion side by side with the locations list in your Magaya Explorer.

Click the “Summary” tab to see part numbers, tracking numbers and quantities.

The Warehouse Inspector toolbar contains buttons for functions to move items, 
find, filter, set columns (Configure), delete pallets, and perform counts.
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The dropdown menu “Locations” enables views of all locations, empty loca-
tions, non-empty and non-counted locations.

Check the box to show empty zones.

The following sections explain the functions available from the buttons on the 
Warehouse Inspector toolbar.
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Additional Warehouse Inspector Functions

The following explains the additional buttons on the Warehouse Inspector 
toolbar to help manage items in the warehouse. The functions on the buttons 
include finding items or locations, filtering, configuring column settings, and 
performing inventory counts. To learn about counting inventory, see the 
Knowledgebase article:

Counting Inventory

http://knowledge.magaya.com/#/article/counts

Find Locations

To find locations in your database, click the “Find Location” button:

Enter the location code and click “Find.” The location will be highlighted.
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Find Items

To find items in your database, click on the “Find Items” button:

Enter a part number or an item name. The system can find full or partial item 
names. The zone(s) that contains the item will be displayed. To view all loca-
tions again, click on the Unfilter button.

To find only on record code and name, check the box.

To match the case (upper case and/or lower cap letters), click the box “Match 
Case”.

Filter Items

The Filter button contains two options: Standard and Advanced. By clicking the 
arrow on the side of the Filter button, you can select the type of filter you want.

The Standard filter opens the Commodities Filter dialog box with options such 
as filtering by Warehouse Receipt number, Status, Part Number and more. The 
Advanced Filter contains more options than the Standard Filter and the ability 
to create your own filter. To clear a filter, click the Unfilter button.

For details on how to use the Filters, see the Magaya Knowledgebase from Page 
One, the welcome screen in your Magaya software interface:

Learn about Filters in the article on DocumentandList Views
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http://knowledge.magaya.com/#/article/2_work_document_and_list

Configure Columns

The view of the Item details is set by using the Configure button:

This screenshot shows an example of the column settings. For the first item in 
Zone B, Location B1LA, there are 35 pieces, the Warehouse Receipt number is 
16, the item description is Baseball gloves, the dimensions and the package type 
are last. To change these column settings, checkmark the columns you want to 
display and uncheck the ones to exclude. Change the order using the Up and 
Down arrows.
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Delete Pallets

To delete a single pallet, select the pallet and click the “Delete Pallet” button. 
The pallet must be empty. You must be in the Warehouse Inspector view to 
access this function.
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To delete multiple pallets at one time, right-click on a promoted warehouse or 
any zone for a pop-up menu, and select the option “Delete empty pallets.” This 
screenshot shows the pop-up menu from a zone:

When you right-click a zone and select “Delete empty pallets”, a dialog box 
opens, showing only the empty pallets in that zone.

This view shows the menu when you right-click a warehouse icon:
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When you right-click the warehouse icon and select “Delete empty pallets”, a 
dialog box opens, showing all the empty pallets in that warehouse in all loca-
tions in all zones.

Select the pallets to delete, and click the “Delete” button. Close the dialog box 
when done.

Reports to Manage Items

There are many types of reports to help you manage items that are in the ware-
house and in a different status such as “Arriving.”
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Access item reports by right-clicking an item in the Detail tab of the Warehouse 
Inspector screen.

Other reports about Locations or Zones are available from those lists in the 
Warehousing folder via the Actions button. Also see the Commodity List for 
more reports.

See the following topics in the Knowledgebase to learn more about each report:

• Commodity List and reports

Commodity Reports and more

http://knowledge.magaya.com/#/article/create_commodity_reports

• Cargo In and Out Reports

Cargo In and Out Reports

http://knowledge.magaya.com/#/article/reports_in_and_out_cargo

• Inventory Reports

Inventory Reports

http://knowledge.magaya.com/#/article/reports_inventory
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How to Manage & Move Warehouse Items

Cargo Movements: Introduction to Moving Items within the 
Warehouse

Overview: To move items within the warehouse, you can choose from one of 
three options in the software:

1) Go to the Warehouse Inspector and create a Move using the Cargo Move-
ment wizard. This allows you to send the Move task to the Magaya WMS
Mobile application on the wireless handheld devices or make the move on
the PC,

2) Start a Manual Move task on the handheld device with Magaya WMS
Mobile, or

3) Go to the Cargo Movements folder and create the Move there using the
Cargo Movements wizard. This allows you to send the Move task to the
Magaya WMS Mobile application on the wireless handheld devices or
make the move on the PC.

The advantage of using the wizard is all the information about the items is in 
your Magaya system, making it easy to create an error-free process.

The system saves the Move transaction in the “Cargo Movements” folder in the 
Warehousing folder.
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Note: The functions you see under the Warehousing folder depend on your 
system permissions and on what Magaya software product you have. This folder 
image shows the Warehousing folder from the Magaya Supply Chain Solution.

When working with the Magaya WMS Mobile application on the wireless hand-
held devices, there are two types of movements available:

• Informed Moves, called a “Move” task

• Uninformed Moves, called a “Manual Move” task

Additional Information: The Magaya Supply Chain Solution also has the option 
to move items between warehouses (to transfer items) and still keep the items’ 
status as “On Hand” in your Magaya system. This creates a “Warehouse 
Transfer” document, which is saved in the Cargo Movements folder. See the 
topic “Transfer Items between Warehouses”:

Transfer Items between Warehouses

http://knowledge.magaya.com/#/article/transfer_between_warehouses
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Create a Move Task: Informed Moves

If you have the Magaya WMS Mobile application on wireless handheld devices, 
you can create a Move Task (also called an Informed Move) on the PC in 
Magaya Explorer, and send the Move Task to the handheld devices for users to 
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perform. This will move items from their existing location to a new location you 
specify. First start on the PC to create the “Move” task:

1) Click on the “Move” button in the Warehouse Inspector toolbar. The
Cargo Movement Wizard opens:

• If you don't see the items you're looking for, expand the locations,
clear any filters, or view locations that are empty, non-empty, or
non-counted:

- All: Shows all locations and all items

- Non-empty: Shows all locations that have items within them

- Empty: Show all locations that do not have items in them

- Not counted: Shows all locations that have items that are not
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counted

• Select the items you want to move. You can move individual items
or multiple items at one time. Items must be on hand or loaded.

To move only some of the pieces, select the item and click on the
“Pieces” button. Enter the quantity to move.

To move all the items in one location, click the location and click the 
“Mark Group” button. The "Mark All" button is only active after you 
select a Location in the warehouse. All items in that Location are 
available to be selected except those in Pending Tasks or On Hold.

The information about the items that you see in the wizard is the 
same as displayed in the Warehouse Inspector screen, as set by the 
“Configure” button.

• Click the Next button.
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2) On the next screen, select the destination location or pallet:

• Select the new location that you want to place the item in.

Tip: If you don’t remember the definition or type of location, you
can double-click it to open the description dialog box. This will help
when looking at a list of Location Codes that might not be descrip-
tive.
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• To move the items to a pallet, create a pallet by clicking on the
“Create Pallet” button. A dialog box opens:

Enter a Pallet ID number or click the “Get Next ID” if you have set 
up Pallet ID numbers in the Configuration menu.

Click OK to save.

Then move the pallet.

Option: You can also print labels from this dialog box. After you 
enter or create a pallet ID, the “Print Label” button is active:

This will print a label to identify this pallet. Give the label to the 
employee who will perform the move so the correct pallet is identi-
fied.

After creating the pallet, you can then move it in the next screen.
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3) Create a Task: You can assign the movement to a user or complete the
Move in other ways. Let’s look at the options.

This screen in the wizard includes a Movement number. It is assigned
based on the numbering set up in Maintenance > Configuration > Docu-
ment Numbers. This will be the number of the Cargo Movement docu-
ment that the system will create after you finish the wizard.

Continue with the other selections on this screen to tell the system how
you want to this move to be performed:

1) Create a task for a handheld user: Click this if you have the Magaya
WMS Mobile handhelds. Select an employee who has permissions set in
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the User tab of their profile; no other employees will display in this drop-
down. Then click the “Finish” button.

2) If you click the button to “Commit changes right away”, this will update
your Magaya database right away and the status of the task will be
“completed.” It is best to click this only after the items have been moved.

3) If you want the changes to be pending, click this button. You can return
to it later and move the items to a Mobile location and then the destination 
location.

The “Transfer Information” section of the screen has the option to select 
a “Movement Type” The wizard is set to “Local” by default. The Move-
ment Type “Transfer” is used to transfer cargo from one warehouse to 
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another. This will create a Cargo Movement document, which is saved in 
the Cargo Movements folder.

For more information on Transfers, see the topic “Transfer Items Between 
Warehouses.”

Transfer Items between Warehouses

http://knowledge.magaya.com/#/article/transfer_between_warehouses

If you have more than one warehouse, the information about that ware-
house can be entered in your database so you can transfer items between 
warehouses. To define a warehouse zone as a separate warehouse, 
right-click the zone to open the Warehouse Promotion wizard. For more, 
see the topic “Multiple Warehouses”:

Multiple Warehouses

http://knowledge.magaya.com/#/article/multiple_warehouses

Click the “Finish” button when done.

After the Wizard Closes:

When items are moved, the information about the location of the items in the 
warehouse is saved in your Magaya database and can be viewed online in the 
online tracking program, Magaya LiveTrack.

Where to View Results of a Move: You can see the Move transaction details and 
see items in the Commodity List and in the Cargo Movements List in the Ware-
housing folder. In those lists, you can choose additional columns from the 
Actions button, including current location and previous location of items.
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In the Cargo Movement List, you can double-click the transaction to view the 
dialog box which shows the information about the move created, including the 
status.

If a Move is in “Completed” status, it cannot be edited.

The Items tab shows the items in the Move transaction. To see more columns in 
the Items tab, right-click and select “Choose Columns.” Options include adding 
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related columns such as Warehouse Receipt. You can go to a related transaction 
for an item by selecting the item in the list and clicking the “Go To” button.

In the Cargo Movements List, you can also choose related columns to see infor-
mation such as the Destination Zone or Mobile Location.

Next Steps for WMS Mobile Users:

If a Move Task was created in the wizard and sent to a handheld user, the task 
is now available on the WMS Mobile handheld to complete in the warehouse. 
The move task is called an Informed Move because it was created by the wizard. 
See the section below, “Perform Move Task on the Magaya WMS Mobile 
Device,” for steps.
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Perform Move Task on the Magaya WMS Mobile Device

Follow these steps to complete the “Move” task on the handheld device. This 
process is also called an “Informed Move.”

1) Click on the “Move” icon on the screen.

This example shows 3 Move tasks pending.
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2) Select the Move task you will perform. The first of the three Move tasks
appears in this example. To see another task, click the arrow buttons on
the bottom of the screen.

The screen tells you the existing location, the quantity of items there, and
the new location where the items will be placed.

3) Scan (or select) the location of the item that will be moved. This example
shows two locations B1LC for the bamboo stakes and B1LA for the
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pruning shears. Then click the “Select” button. These are the existing loca-
tions of the items:

Notice the barcode symbol in the top right corner; when this is displayed 
on a screen, the scanning function is enabled for that screen.

4) In the next screen, click the location and click the “Select” button.
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5) Scan the items to move (or click on the item). To see details about the item, 
click the View button. Alternatively, click the Quantity button and enter
the number of items to move.

The “Code” column may show a code such as “P” for Pallet or “L” for 
Location.

To view item details, click the View button. The screen shows tabs with 
item information, dimensions, identification, and custom fields (if any).
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6) When you click the Quantity button, another screen opens where you can
manually enter the number of items to move:

Click OK to return to the list of items.

7) When all the items are checked off, click the Move button. This will open
a screen to scan (or enter) the destination where the items are moving.
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8) Click “OK” when done. You can print labels if needed.

The Move task is completed.

Perform Manual Move Task on the Magaya WMS Mobile Device

This process is started and completed on the handheld devices using the Magaya 
WMS Mobile application (not the PC).
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A “Manual Move” is also called an “Uninformed Move.” For this example, we’ll 
move some items from the Receiving area by following these steps:

1) On the handheld device, click on the “Manual Move” icon.

2) Scan (or enter) the location of the items (or the pallet if the items are on a
pallet) to move:

Note: If your system has a default Receiving Location set, then this screen 
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will be skipped. (To set, go to Configuration > WMS > Operations 
Settings.)

3) Scan the item (or items) to move from the location you entered in Step 2.
The screen will fill up with the item information.

4) At the destination location, scan the destination location. You can also
place the items in a pallet and scan the pallet ID for this step.

The Manual Move is completed.

When moving expiration date controlled items from one location to another, 
you may be prompted to pick the specific expiration date you are working with. 
This will happen when more than one expiration date is kept in the same loca-
tion.

Pick the desired expiration date being picked and click ‘OK’. The system will tell 
you how many items are in that location with that expiration date.

Task Reports

On the PC, reports can be created in the Tasks lists by clicking the Actions 
button and selecting the report option.

Options include reports by status of the tasks, by elapsed time, and more. The 
elapsed time report shows when a task was started and completed and the 
amount of time it took to complete it.
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Transfer Items Between Warehouses

Learn about how your Magaya system enables you to transfer items from one 
warehouse to another and keep track of the movements.

Cargo Movements: Introduction to Transferring Items Between 
Warehouses

If you have more than one warehouse, you can create a Move Task and send it 
to the Magaya WMS Mobile handheld devices to load the cargo into a truck, 
transfer it to another warehouse, and place it in a new location there. With the 
Warehouse Transfer feature, you can keep track of the items at all times by 
defining the trucks as your “mobile locations” in your Magaya database.

This feature works using existing concepts in Magaya WMS, Distribution 
System and Supply Chain Solution such as warehouse zones and locations.

Transfer Items Between Warehouses: Setup

1. Warehouse Promotion: If you don’t have multiple warehouses defined in
your Magaya system, do that first. To define a warehouse facility, you will
“promote” it using the Warehouse Promotion wizard, which is available by
right-clicking a warehouse zone icon when you are in the Warehouse Inspector.
To learn more about promoting a warehouse, see the topic “Multiple Ware-
housing.”

2. Adding Zones and Locations: If that newly defined warehouse needs zones
and locations, add them.

3. Define Mobile Locations: Each truck must be entered as a “mobile location”
in your system.

4. Assign Employees per Warehouse: You can assign employees to each ware-
house by setting this in the Employee profile on the “User” tab. Optional
settings can be found in Configuration > WMS.
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This screenshot of the Warehouse Inspector shows warehouse zones and loca-
tions, both mobile locations (trucks) and rack locations inside the warehouse:

Note: Your view of the Warehouse Inspector depends on your permissions 
setting and which Magaya software you have.
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Transfer Items Between Warehouses: Steps

Scenario: This process of transferring items to a different warehouse is illus-
trated here by showing the transfer of items from a warehouse in Miami, FL, to 
Houston, TX.

1) Go to Warehousing > Cargo Movements. Click “Add” A wizard opens. (A
Move can also be created in the Warehouse Inspector by clicking the
Move button. This will open the same wizard.)

2) Follow these steps in the wizard:

Manage and Move Items

Note: Complete details about the wizard are covered in the topic “How to
Manage and Move Warehouse Items”:

http://knowledge.magaya.com/#/article/move_items_wh

In the first screen of the wizard, select the cargo items to transfer. You can
move individual pieces or multiple items. This example shows items
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selected from the Miami Warehouse:

In the next screen, select the destination location. This example shows 
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the destination is the Receiving area in the Houston Warehouse:

3) In the last screen of the Cargo Movement wizard, choose how to complete
the Move:

• Assign the Move task to a WMS Mobile user. This will create a Task
for the handheld.

• You can also click “Commit changes right away.” This will assign a
status of “Completed” to the Move in your database and show the
items in the destination location.

• You can also select the option to leave the Move as Pending and
complete it later.

• In the “Transfer Information” section of the screen: Select the Move-
ment Type as “Transfer.” The system will create the Warehouse
Transfer document automatically and save it in the Cargo Move-
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ments List. This document can be used as a Straight Bill of Lading for 
the driver.

• Select the Mobile Location.

Click Finish.

Next, the Task dialog box opens when you finish the last screen in the Cargo 
Movement wizard (if you selected to create a task).

In the Task dialog box, you can assign the Task to a mobile user or leave it blank 
for any user to fulfill. The system will show users for that warehouse. (Note: 
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Assign employees to warehouses in the Employee profile.)Then fill in other 
fields as needed:

Click “OK” to save the Task details. The Task will be sent to the mobile hand-
held devices.

Your Magaya system automatically updates the status of the Warehouse 
Transfer transaction throughout the process. The status of the items remains 
“On Hand” and the items are available to be used in Cargo Releases or ship-
ments. The following defines each status of the Warehouse Transfer transac-
tion:

• Pending: The task was just created, and items have not been loaded in the
truck (“mobile location”).

• Loading: Some items are loaded in the truck, and some items are still in
their original location.

• In Transit: All the items are loaded in the truck.

• Unloading: Some items are in the truck, and some items are in the desti-
nation location.

• Completed: All the items are in the destination location.
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The system saves the move as a “Warehouse Transfer” document.

The Warehouse Transfer document can be printed and used as a Straight Bill of 
Lading. The document is saved in the Warehousing folder > Cargo Movements. 
It can be customized as needed.

Transport the items in the truck to the other facility (the destination ware-
house).

Complete the Transfer

At the destination warehouse, unloaded the cargo from the truck via a Move 
Task performed on the handheld devices. This Move task can be created from 
the Actions button when the Warehouse Transfer transaction has a status of “In 
Transit.” The Actions menu includes the following options:

Create an Unloading Task:

To unload the items, select “Create Unloading Move Task.” This will send a 
Task to the WMS Mobile handheld scanner. This Task will enable the user to 
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move the items from the mobile location (such as the truck) to the destination 
location.

In the Task, assign the task to a WMS Mobile user (or leave the user blank), and 
the system will add all the items from the Warehouse Transfer into the Task for 
you.

This completes the transfer and updates your database with a status of 
“Completed.” A user with Administrative rights can see the status of all Move 
Tasks for all warehouses in the system.

Other Actions:

Other options in the Actions menu include:

• Move all items to the Mobile Location: This option is for manual use (not
WMS mobile) and will move the pending movement items from the
source location to the mobile location.

• Move all items to the Final Location: This option is for manual use (not
WMS mobile) and will move the pending movement items from the
mobile location to the destination location.

Reports:

You can create reports about the Cargo Movement tasks from the List view. 
Click the Actions button in the list view and select to run reports by status, 
Cargo Movement number, division, or destination.
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Commodity List Introduction

The Commodity List displays all the commodities you’ve handled, including 
cargo, inventory items, vehicles, and more.

The items in the Commodity List display real-time updates of quantities.

The columns in this list also appear in the Commodity tab of a WR, Pickup 
Order, or Cargo Release. To change columns in the list, go to the Actions button 
and select “Choose Columns.”

Reports from the Commodity List

When you need a report on the commodities your company has handled, use 
the Commodity List under the Warehousing folder. It shows the status of 
commodities such as what is on hand, in transit, or delivered for any date range 
you set.

Steps:

1) Go to the Warehousing folder and click the Commodity List.

Note: Your view of the Commodity List may differ from this screenshot
depending on your permissions and which Magaya software product you
have.
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2) Click the Actions button and select “Reports.” You can choose from many
report options such as reports by shipper, by warehouse location, by part
number, and others.

Container List: There is also an option to see all the containers in your 
warehouse that are on hand. (This does not include containers added onto 
shipments.)

Options include:

• To email the report, click the Email button on the top menu.

• To save the report in your Magaya Explorer, click the Actions button 
and select Save Report.

• To save the report to your computer (or another computer in your
network), click the Actions button and select Export.
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Other Types of Reports

The following are different types of reports you can create from the Commodity 
List:

• See where items are and their previous location.

• See part numbers.

• View all items for a specific export code or Schedule B commodity classi-
fication.

• See the Customs entry date for items so you can answer Customs ques-
tions quickly.

Answer questions about your business such as:

• Which commodities were included in which shipments?

• Which commodities do you ship to which destination ports most often?

• Which division of your company is handling the most cargo and what
types?

Additional Cargo and Item Reports:

For more reports about commodities, see also the Accounting folder > Items & 
Services > Actions button.

Also see in the Warehousing folder > Inventory Item Definitions > Actions 
button for “In and Out Reports.”

http://knowledge.magaya.com/#/article/reports_in_and_out_cargo
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How to Find Commodities in Magaya Explorer

Overview of the Commodity List

There are a few different ways to find commodities in your Magaya Explorer. A 
good way to start is to open the Commodity List, found under the Warehousing 
folder.

In the toolbar at the bottom of the list is a useful button called the “Detail” 
button. When you click it, a new list opens. The Detail view has different panels 
to select from and view more about a commodity. (The Detail button is also 
available in many other lists.)

To make it easy to see information at a glance in the Commodity List (or any 
list), add columns to the list by following these steps:
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1. Go to the Actions button and select “Choose Columns.”

2. There are many columns available. For example, to see if any items are on
hold, select the column called “On Hold” from the list of options in the
“Column Settings” dialog box.

The result of choosing the column of “On Hold:” Now the Commodity List has 
the new column added.
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Note the icon: Any item that is on hold will display an icon that is different from 
the regular icon.

Try as many columns as you need to make your lists as useful and easy to use as 
possible.

Using the Find Button

Another way to find commodities in your Magaya system is to use the Find 
while you are viewing any screen (not just a list), or use Filter button in the 
Commodity List (or any list). Let’s look at the options available from the Find 
button.

1) Click the “Find” button (on the top toolbar). A search dialog box opens.

2) In the dropdown menu for “Find Type” select “Cargo Item”.

3) Set the date range.

4) Select to find by either transaction number or text.

5) Enter the number or text in the field below the "Find By" radio buttons.

6) If you enter text, you can enter partial text. For example if you are looking 
for shoes that you handled a month ago, set the date range and enter the 
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word: shoes. Any commodity containing the word “shoes” will display in 
the results list.

Using the Filter Button

To view the commodities list by certain criteria, use the Filter button. To filter 
by date only, use the Date Range options on the top of the list. The Filter button 
has two options:

• Standard Filter: This filter has a small set of criteria to filter your list by 
such as by Purchase Order (PO) number, Warehouse Receipt number 
(WR), by part number, port, consignee, and others.
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• Advanced Filter: This filter has many options for filtering your list. Click
the Filter button and select “Advanced”. This screen opens:

Click the Filter button and select “Advanced”. This screen opens:

Click the field you want to use in your filter by selecting it from the list of 
Available Fields on the left.

Set the condition you want to apply. For example, if you want to see the 
list by Carrier:

1) Select the field “Carrier” (or any field in the list of Available Fields);
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2) Select the dropdown option such as “Equals” if you know the exact 
name, or select “Contains” if you know part of the name. Type in the 
carrier name in the field next to the condition dropdown;

3) Click the “Add” button. This will add the carrier and the condition of 
“Equals” to the “filter” part of the screen. You can add any additional 
conditions as needed by following the same steps above to combine the 
Boolean Operators to refine your search.

Click OK to see the filtered list.

Remember! Any time you view a list and don’t see what you’re looking for, 
check to see if a filter has been applied to the list.

After you get the list looking the way you want it, you can save it. Save a view by 
clicking the star button at the top of the list.

Learn more about working with lists in the following Knowledgebase article:

http://knowledge.magaya.com/#/article/2_work_document_and_list
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Reports: Inventory

Reports: Managing Items with Inventory Reports

Reports about your inventory can be created in your Magaya software. In the 
Inventory Item Definitions list, you can see the amount of pieces on hand, what 
is arriving, and what is sold. You can also create “In and Out” reports from the 
Inventory Item Definitions list. See the topic In and Out Reports for details:

In and Out Cargo Reports

http://knowledge.magaya.com/#/article/reports_in_and_out_cargo

Other inventory reports can be created in Magaya software such as commodity 
reports, which tell you what you have in the warehouse. In contrast, inventory 
reports show you what is arriving. For information on creating Commodity 
Reports, see the topic “How to Create Commodities Reports”:

Create Commodity Reports

http://knowledge.magaya.com/#/article/create_commodity_reports
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To view the information about what pieces are arriving, follow these steps to 
make these columns visible in the Inventory Item Definitions list:

1) Go to the Inventory Item Definitions list.

2) Click the Actions button and select “Choose Columns.” In the dialog box
that opens, place a checkmark in the columns you need:

The columns selected in this image will display the following information:

• Pieces: The quantity on hand

• Arriving Pieces: The quantity of items in Pickup Orders or
Purchase Orders that are coming to the warehouse

• Requested Pieces: The quantity of on-hand items that are included
in Sales Orders

• Requested Arriving Pieces: Of the arriving pieces, this is the quan-
tity that is sold and included in Sales Orders

To calculate the total quantity of inventory you have available to sell, start with 
the number of pieces and add arriving pieces, subtract Requested Pieces and 
subtract Requested Arriving Pieces.
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In this example, there are a total of 55 Pieces on hand, 458 Arriving Pieces, 4 
Requested Pieces, and 1 Requested Arriving Piece. The total pieces available to 
sell are 508:

55 + 458 - 4 - 1 = 508

To view the inventory for any individual item, select the item from the list and 
right-click on it (or go to Actions > View Inventory). This shows what is on 
hand for this part number.

To view details of inventory that is arriving, select the item and right-click on it 
(or go to Actions > View Arriving Items). This shows what is arriving for this 
part number.

This option is only active for items with quantities greater than zero. This will 
display the status of the item, a description, package type, dimensions and other 
information. Reports can also be made from this view also. The totals are 
dynamic; they reflect changes in quantities as the items are received or released. 
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The total quantity of pieces in Inventory Item Definitions list should match the 
quantity of on-hand pieces.

The Items & Services List

In the “Items & Services” List in the Accounting folder, click the Actions button 
and select a view to see all the inventory items or non-inventory items.

From that list, you can make a report by sales item or by purchase item.
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In and Out Cargo Reports

In and Out Reports

The “In and Out” reports provide a snapshot of how much cargo is on hand or 
was delivered for the time period you select. These reports can be used to fore-
cast quantities that you need to buy to fulfill demand during certain time 
periods. If you are providing distribution for a customer, you can email the 
report to them from your Magaya system.

For each part number in the “In and Out” report, you will see the inventory you 
have at the beginning of the time period selected, the quantity that arrived in a 
Warehouse Receipt (WR) during that time, the quantity released for that time 
period, and inventory remaining at the end of that time period. This report 
shows item quantities as of the date you select in the date range. You can create 
reports for a past time period also.
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To create an “In and Out” report, follow these steps:

1) Go to the Inventory Item Definitions list

2) Click on the Actions button, select Reports, and “In and Out” reports
(detailed or summary):
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The Summary view of the “In and Out” report shows one line per part number, 
initial inventory (Start), items in, items out, and ending inventory quantity:
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Detailed report view (filtered by item definition):

This view enables the Filter option to filter the report by item definitions:
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Detailed report (filtered by Inventory Item) gives you the option to filter by 
commodities:

You can select columns in these reports to show other information such as loca-
tion in the warehouse.

Hide part numbers that do not have activity in the timeframe of the report by 
clicking the “Configure” button > General tab.

Other reports can be generated in the “Other Reports” option in the Actions list 
such as reports by manufacturer, for example, so you can see how many items 
you have from the same manufacturer. All the information used to define an 
inventory item is available for a report.
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Directed Operations: Getting Started Building a 
Smart Warehouse

Directed Operations is a phrase for all the procedures that make a “smart ware-
house.” This type of warehouse is used for not just receiving, storing and ship-
ping cargo; it also replenishes orders, has directed (i.e., guided) put away and 
picking sequences that optimize warehouse space and employee time.

Magaya software includes features that help these types of warehouse busi-
nesses, including 3PLs, Distribution Centers (DCs), and others.

Procedures include:

• Defining Items

• Defining Locations in the warehouse

• Defining zones in the warehouse

• Setting up a sequence to Put Away and Pick Items and the tasks for users
follow a logical, efficient path to perform tasks using the WMS Mobile on
handheld scanners

• Replenishment: Including configuring your Magaya system and defining
minimum quantities to create automated replenishment tasks for WMS
Mobile on handheld scanners

These processes all work together to optimize how items are put away so it will 
be easier to pick them later to fufill orders faster.

Business Case for Directed Operations

What are the benefits of optimizing a warehouse with Directed Operations to 
make it a smart warehouse? There are many smart appliances in our homes and 
businesses that help us get things done faster, from smart refrigerators to 
copying machines that can print on both sides of the paper and staple it for us. 
Now let's compare that with how a smart warehouse will help you at work.

We’ll look at the picking operation in a warehouse for an example because 
picking is often the most expensive task in a warehouse. Issues that contribute 
to the high cost include:

• Different SKUs in one bin, making picking more difficult and slower
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• Tasks that don't list locations in a logical sequence, making warehouse 
workers waste time travelling back and forth between distant and nearby 
locations instead of picking items from a nearby location first before 
visiting a distant location

• Tasks that send a warehouse worker to the same location many times 
during one day instead of consolidating the trips

• Not storing frequently picked items in easily accessed locations

• Not keeping inventory full in picking locations

How do I know if a smart warehouse is what I need? Consider these questions:

• Do you or your warehouse employees spend more time travelling to the 
same parts of the warehouse multiple times per day?

• If you are a manager, do employees continually ask you where to put 
items?

• If you are a warehouse employee fulfilling orders, do you often have to 
stop filling orders because the bins are empty and you have to find the 
person to refill the bin or go and refill it yourself?

What type of warehouse operation can benefit the most from a "smart ware-
house"? Companies that distribute goods for others and companies that buy and 
sell their own inventory.

By improving these processes and having a software that can implement those 
changes, a warehouse will see cost reductions, error reductions, and an increase 
in efficiency.

Getting Started: A Guide to Preparing a Smart Warehouse

To optimize your warehouse, apply Directed Operations by analyzing your 
workflows and then configuring your Magaya software to facilitate the work-
flow.

Magaya software is capable of helping you create and fulfill your goals of a 
smarter warehouse. The following topics will help you plan and implement a 
smart warehouse:
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• Warehouse Setup:

- Define warehouse zones and locations in a single warehouse

- Importing existing data

See the topic "Warehouse Zones and Locations Introduction" in the 
Knowledgebase:

http://knowledge.magaya.com/?search=intro_WH_zones_locations

Find an overview of the Warehouse Inspector in this topic:

http://knowledge.magaya.com/?search=warehouse_inspector

Extra: Employees can be assigned to work in separate warehouse, if you 
have more than one. See the topic “Multiple Warehouses” for details:

http://knowledge.magaya.com/?search=multiple_warehouses

• Directed Operations:

- Define criteria for locations. See the topic “Location Definitions” in the 
Knowledgebase:

http://knowledge.magaya.com/?search=location_definitions

- Replenishment tasks: See the topic “Replenishment” in the Knowledge-
base:

http://knowledge.magaya.com/?search=replenishment

- Define sequences for guided put away and picking tasks. See the topics 
on receiving cargo and releasing cargo. See also:

http://knowledge.magaya.com/?search=sequencing_warehouse

• Warehouse Operations:

- Receiving

- Storing and Moving Items

- Releasing

- Sales Orders

If you have multiple warehouses, you can view them all in your Magaya system 
by defining them with the Warehouse Promotion Wizard. See the topic 
“Multiple Warehouses” in the Knowledgebase:

http://knowledge.magaya.com/?search=multiple_warehouses
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Replenishment

Introduction to Inventory Replenishment

To maintain inventory levels, it’s important to keep inventory picking locations 
full of items so they are available to fulfill orders without delays. The Magaya 
system enables you to set up a schedule to replenish locations based on criteria 
you define. The scheduling will create Move Tasks for the WMS Mobile users in 
the warehouse when needed.

The replenishment schedule uses information set up in the Inventory Item Defi-
nitions such as any LIFO/FIFO criteria for an item, and the system also uses 
Location Definitions. (If you do not have definitions added to your locations, do 
that first. See the topic “Location Definitions” for steps.)

The replenishment schedule takes into consideration to Inventory Type (such 
as FIFO) over the sequence.

The minimum requirements for replenishment/Move tasks is to set up your 
Location Definitions, a sequence, and a replenishment schedule.
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To tell the system to create a Purchase Order (PO) for your preferred vendor 
when stock is low, check the box “Place a Purchase Order to preferred vendor.”

Also fill in the other fields for Replenishment:

• Enter a quantity in the “Minimum Stock” field to tell the system if the
quantity falls below this number, then order more.

• Enter how many you want to order in the field “Quantity to Order.”

• Select a preferred vendor, and who to notify and how to notify them

To tell the system to run a task and check for these replenishment criteria, go to 
Configuration > Task Scheduling and define the schedule you want. See the 
section below for steps.

The next section in this article explains how to configure your Magaya system 
to create tasks automatically for replenishing locations. There is also informa-
tion on Replenishment Locations and performing the tasks.

Configure Replenishment Schedule

1. To configure the schedule for replenishment, go to Maintenance > Configu-
ration > WMS

2. Click the tab “Directed Operations.”
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3. Check the box to enable replenishment.

4. Click the button with the three dots. A dialog box opens to schedule replen-
ishment tasks.
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In the dialog box that opens, check the box to enable to scheduling. Then click 
the “Add” button. A new dialog box opens which includes the settings for this 
replenishment schedule.

1) Enter a name for this replenishment schedule. The system enables you to
have more than one schedule.

2) Select how you want this schedule to run one time or to repeat.

Check the “Enabed” box to activate this schedule.
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3) Select how frequently you want the system to create Tasks, which will be
sent to the handheld units when inventory is low. (Tasks will not be
created for dormant locations.) The options include daily, weekly or
monthly:

Daily: The system will check daily to see if inventory needs to be replen-
ished according to the setting you define here. Select if you want it to run
every day or every 2 days, or 3 days, etc.

Also set the time of day: If you select once per day, set the time. If you 
select the option “Every” then define if you want to run the schedule every 
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hour, every 2 hours, etc. Then set the start and finish time for the schedule 
to run during the warehouse hours of operation.

Weekly: If you want the replenishment schedule to run weekly, select the 
days of the week to run it. If you want it to run each week, select “1”. If you 
want it to run every other week, select “2”.

Monthly: If you want to run the schedule monthly, select from the 
following options:

Days: Select which days of the month to run the schedule, and if you want 
it to run every month (select 1), every other month (select 2), etc.

The other option for a monthly schedule is to select a day each month to 
run the schedule. This example shows the first Monday of every month.

Click “Save” to save this schedule.

Click “OK” in the Task Scheduling dialog box.

Click “Save” in the Configuration menu for the WMS screen.

Result: The system will generate Move Tasks on the handhelds according to the 
replenishment schedule.

Note: Replenishment will only be done on locations that have been modified, 
i.e., items have been picked from them, not from dormant locations without
activity.
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If there are multiple schedules, the first one in the list will be given priority if 
there is a conflict or overlapping schedules.

The scheduled task appears on the LIst in both the Configuration screen for 
WMS and for Task Schedules.

Define Replenishment in Location Definitions

The Replenishment Schedule uses information in the Location Definitions.

To add definitions to a warehouse location, open the Location from the Loca-
tions list (or create a new location).

Click the “Definitions” dropdown menu. Select a definition. If definitions do 
not exist yet, then create them by clicking the plus sign button in the dropdown 
menu’s toolbar. For more details, see the topic “Location Definitions.”

Select the Type of location as “Replenish.” (The “Picking” location can also be 
used.)

Assign the location to a warehouse or customer as needed. (If you have more 
than one warehouse, assign it to the correct one. If you do not assign it to a 
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specific warehouse, it will be in the Default, or Root. Learn more in the topic 
“Multiple Warehouses.”)

Fulfill Replenishment Move Tasks

When the Replenishment Schedule runs and detects low inventory, the system 
creates Move Tasks for the WMS Mobile users. (No tasks are created on 
dormant locations.) Then the handheld operator will move the items from a 
storage location to the Replenishment or Picking locations to ensure these loca-
tions have enough items in them to fulfill orders quickly.

The locations eligible for replenishment are the Picking and Replenishment 
location types.

Notes: Be sure to configure the WMS Mobile users in the Configuration menu 
and on the Employee profile’s User tab.

The process for replenishment begins after items are received and put away. See 
the topic on Receiving Cargo Put Away and Move Tasks.
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Chapter 16: Releasing Cargo

16.1. Introduction

This chapter explains the process of releasing cargo, including creating a Cargo 
Release on the PC, fulfilling Pick and Load tasks using the Magaya WMS Mobile 
application on handheld wireless devices, and creating shipments.

A Cargo Release is the document created for “in and out” deliveries and any 
time you send cargo out of your warehouse. The Cargo Release wizard in 
Magaya Explorer walks you through the process of creating a Cargo Release step 
by step.

Sections in this chapter include:

• Create a Cargo Release

• Generate accounting transactions from a Cargo Release

• Verify the Packing List

• Use the Magaya WMS Mobile application on wireless handheld devices to
Pick and Load items to release them from the warehouse

• Creating a shipment in Magaya software using the wizards
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Introduction to Cargo Releases

A Cargo Release is the document used for “in and outs” for local deliveries. A 
Cargo Release can also be created when a customer sends their own transporta-
tion to pick up the cargo.

A Cargo Release identifies the carrier, charges for the service, and a description 
of the cargo. If you transport goods across an international border by truck, use 
the Ground Shipment wizard for extra features such as Customs documents.

When to create a Cargo Release or create a Shipment:

If the cargo you are moving out of the warehouse requires extra documentation 
(such as a Bill of Lading or a Cargo Manifest), or if the cargo will be consoli-
dated, then use the shipment feature in Magaya Explorer instead of creating a 
Cargo Release.

Cargo Releases are located under the Warehousing folder:
581



Chapter 16
 582



Chapter 16 Release Cargo: Create a Cargo Release
Release Cargo: Create a Cargo Release

Introduction to Releasing Cargo

The following steps explain how to create a Cargo Release using the wizard, 
which creates the Cargo Release document for you. While working in the 
wizard, you can move back to a previous screen as needed. After completing the 
wizard, all the information you entered is saved and filled into the document. 
Then you can edit it, add other charges, print it, email it, etc.

Start:

Click the “Add” button. A wizard opens. The first screen in the wizard is for 
entering General information to create the Cargo Release (CR) document.

Let's look at the fields on the General screen.
583



Release Cargo: Create a Cargo Release Chapter 16
General Information

The following fields are filled in automatically: the release number, time, date, 
employee, and issued by (your company is the default).

Notice that the system uses today’s date as the default for the Creation Date and 
the Release Date. To change the date, click the arrow in the dropdown field to 
open a calendar. Select the correct date.

The “Released to” field is for the ultimate consignee. The “Released to” entity on 
this tab is also the "Client to Bill" entity by default. Exception: If the entity who 
is picking up the items is a third party or a carrier, then select that third party or 
carrier in the “Client to Bill” field. The entity selected for the “Client to Bill” field 
will be used when the charges are generated.

If the “Release to” entity is over their credit limit, but the “Client to Bill” is 
another party, then the order can still be released.
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If the client has an alternate address that you will release to, select their name in 
the “Released to” field and then click the “Change” button to select the alternate 
address.

Note: Charges are not genearted in the wizard. The wizard walks you through 
entering basic information to release cargo or other items. It does not have a 
screen for entering charges; that is done after the wizard. Details about charges 
are explained in the section “Charges Tab.”
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Carrier Information

Click the dropdown list to select the carrier who is taking the cargo out of the 
warehouse.

Fill in the other fields as needed:

• Driver’s name and driver license number

• PRO Number: The PRO Number is a "Progressive number", a sequential
number, used by transportation companies to identify and track freight
bills.

• Purchase Order number

Note: After finishing the wizard, the carrier information enter here will be saved 
on the “Inland Carrier” tab and in the CR document.
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Select the Cargo to Release

The next screen shows the cargo items and/or commodities that can be released. 
A total is displayed on the bottom of the screen.

The buttons across the top of the screen are lists of items such as those in the 
warehouse, by inventory, or by location.
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The following screenshot is from the Magaya Supply Chain Solution:
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Let’s look at each of the options to release cargo:

• Click the “Warehouse” option if you want to ship out cargo as you
received it (by Warehouse Receipt). To select all the WRs, filter the list and 
click the “Mark All” button. All items are availabe to be selected except
those in Pending Tasks or On Hold. To select only a few pieces, highlight
the item and click the “Pieces” button.

• Click the “Inventory” option if you are shipping by part numbers. To
select all the items under one part number, select the PN and click “Mark
All.”

Extra Info: If you want your inventory items to display in a certain order
in the Inventory tab, for example, by expiration date, set the “Inventory
Type” field on the Identification tab of the Inventory Item Definition
dialog box. Options include FEFO (First Expiring First Out), which will
sort the list to show the items that will expire first (the ones with the oldest
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date) at the top of the list. To see the expiration dates in this screen, click 
the “Configure” button and select “Choose Items Columns.”

• The option to load by “Lot Numbers” is available in the Magaya Supply
Chain Solution and Magaya WMS. It can only be used for items that are
On Hand.

• Click “Locations” to load cargo from locations in the warehouse (WMS
only). To select all the items in one location, select the location and click
“Mark All.” All items in that Location are available to be selected except
those in Pending Tasks or On Hold.
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• Click “PO” to include items from Purchase Orders, or click “SO” to select
items from Sales Orders (Note: available in the Magaya Supply Chain
Solution).

• Click the “Scan” option if using a scanner to scan the bar codes on the
packages. (Note: The bar codes are the ones created when you received the
cargo and printed labels. The scanner enters the bar code numbers into
the Cargo Release. To use this option, your system must have the Magaya
Bar Code plug-in activated.) You can also scan by external tracking
number when loading the CR.

• If you want to create a partial shipment of the cargo, select the item in the
list and click on the Pieces button. Enter the number of pieces. Part of the
box next to the item will be shaded, indicating that part of the inventory
was released not all of it. To include all the cargo in a release, click on the
box next to the item. The full box will be shaded.

• If an item is defined as having variable weight, the system will ask for the
number of pieces and total weight of those pieces.

The total weight and piece quantity will be updated in the Inventory Item 
Definition list, shown by the column “Total On Hand Weight.” The WR 
and the storage fee will also be updated. This is useful for items such as 
perishables that vary in weight per package.
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Other buttons on the screen help you work with the screen:

• Check the "Fill in Reverse Order" button to see the inventory list with the
most recently received items at the top of the list.

• “Mark All” will checkmark all the items in the view.

• “Unmark All” unchecks all the checkmarked items.

• “Pieces” is explained above

• “Filter” works similarly to any Filter button in Magaya software with Stan-
dard and Advanced options. The filter you see differs when viewing the list 
of warehouse receipts, locations or inventory. This section explains the
filters for the Cargo Release wizard. For more details, especially on the
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Advanced Filter, see the section "The Filter Button" in the topic "Working 
with Document and List Views."

When viewing the list of Warehouse Receipts, the Filter button (Standard) 
opens the Warehouse Receipts filter dialog box.
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Inventory filters by the Item Definitions or the Items.

The “Items Filter” opens the Commodities filter dialog box with many 
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options:

When viewing the Locations shows the Commodities filter, and the Ware-
house Receipts filter open when viewing the WRs. After setting a filter, the 
list will show only those items you selected in the filter. This is useful to 
narrow down long lists.

After you finish using the filtered list, you can clear the filter by clicking 
the red X button.

• “Find” - To search for inventory, click the Find button and select to search
by number or text.
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• “View” - Click to view any item you select, the location definition, or the 
Inventory Item Definition dialog box.

• “Configure” - Click to change the columns shown for the WRs, the items, 
or per location. If viewing the WRs, the Configure button gives you the 
option to change the columns for the WR or the item.

A dialog box of Column Settings opens. The columns shown depend on 
the list you view. Explore the options to configure the view to your prefer-
ences.

Note: If your system is configured to prevent loading items that are in a 
Receiving location, then you cannot load them in a release.
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Click the “Finish” button. The wizard creates the CR document for you auto-
matically. The inventory records in your Magaya database are updated 
according to the items you just released. You can print or email the release as 
needed. You can also print labels.

If a commodity has an expiration date entered, the date will appear in the Cargo 
Release document (default template).

Charges Tab

To add charges to a Cargo Release, open the CR dialog box by clicking the “Edit” 
button.

Go to the Charges tab, and click the “Add” button. Select from the pop-up 
menu: income or expense for general items or services or freight-related.

Income: Use this to charge for documentation, any crating fees, storage, or 
other fees not related to transportation.

Income Freight Charge: Use this to select the transporation charges, the freight 
service class and who to apply it to. If you have rates saved in your system, you 
can select them here for that entity. You can choose to set it to Prepaid or 
Collect. Decide if you want the charge to show in documents. Do you want this 
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rate to be updated automatically if changes are made to your system by you or 
another employee who has permissions to modify rates?

Expenses: Expenses include handling charges and other charges that are not 
freight related.

Expense Freight Charge: For transportation costs that you have to pay a vendor 
who is providing the transportation for you.

The Charges tab also includes a button to enable you to change the units for this 
transaction such as inches or centimeters, etc.

A detailed discussion of charges is covered in the topic “Charges.”
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To generate charges, click the “Generate” button.

The system asks you to confirm the charges.

The topic "Generate Accounting Transactions from a Cargo Release" covers this 
process in detail.
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Events Tab

To view all events related to this transaction, click in the checkbox at the bottom 
of the screen. Add or edit events as needed.

Details for entering new events are covered in the topic “Events.”
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POD Tab

To require a Proof of Delivery, click the POD tab. This tab is optional.

Click on the checkbox to enable the fields if you want to require a POD. Set the 
delivery date and time, select the name of the recipient (final consignee), and 
add any comments as needed. The “Signature” button is activated if you have 
Magaya POD Mobile active for your Magaya account. If so, the electronic signa-
ture of the final consignee will be saved here.
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Attachments Tab

To attach a photograph of the cargo or attach a copy of a document, use the 
Attachments tab.

Full details are covered in the topic “Attachments.”
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Notes Tab

Click the button with the three dots to open the “Clauses” list.

Select the clause needed. These notes are included on documents and can be 
viewed by customers or other entity.

Full details are covered in the topic “Notes and Internal Notes.”
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Internal Notes Tab

The Internal Notes tab is for notes within your company. Customers will not 
view these, and the internal notes will not display on documents.

Full details are covered in the topic “Notes and Internal Notes.”

Related Resources

To see how to generate accounting transactions, verify the packing list, and 
create tasks and other actions that can be performed from a Cargo Release, see 
the topic "What Actions can I Perform with a Cargo Release?"

http://knowledge.magaya.com/#/article/actions_cargo_release

Learn how to use the WMS Mobile handheld devices to release cargo from the 
warehouse with Pick and Load Tasks:

http://knowledge.magaya.com/#/article/wms_mobile_release

Learn how to request UPS or FedEx to come to your facility and pick up the 
items by creating an Express Link request from the Cargo Release:

http://knowledge.magaya.com/#/article/ExpressLink_Ship_CR

Your customers can request a release of cargo via LiveTrack:
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http://knowledge.magaya.com/#/article/online_CR
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What Actions can I Perform with a Cargo 
Release?

This topic explains how to generate accounting transactions and other actions 
that can be performed from a Cargo Release.

Generate Accounting Transactions from a Cargo Release

Magaya Explorer gives you the ability to create accounting transactions such as 
invoices based on the information entered in operations transactions such as 
Cargo Releases.

Magaya Explorer links the transactions and transfers the information from one 
transaction to another. For example when charges are entered in the Charges 
tab, the charges remain “Open” (are not posted to the Accounting system) until 
you click the “Generate” button or they are liquidated. Then they are “Posted.”

When you click the “Generate” button, a confirmation screen opens, showing 
the generated charges and group them and create invoices for each customer. 
The charges that will go to bills are also grouped and bills are created for each 
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vendor. Then these are posted into the Accounting system automatically for 
you.

You can also create accounting transactions from the Cargo Release by listing 
all the transactions for that release. To do this, follow these steps:

Option: If you need to change the currency to one from a previous date, change 
the transaction date (permission and role is needed for user).

1) Click the Actions button and select Transaction List. The Transaction List
opens.

2) Click the Actions button in that list and select an option: Link Bill, Link
Invoice, Receive Payment, or Pay Bill. These transactions will be Posted
immediately unlike the charges entered in the Charges tab.

When you are in the Transaction Listing, you can create the following 
accounting transactions directly from a Cargo Release by using the Add button 
at the bottom of the list:

• Invoice: You can create an invoice for the Cargo Release. (You can also
create accounting transactions when you are in the Cargo Release dialog
box by using the Generate button on the Charges tab.)
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An example of the options for creating accounting transactions is the 
ability to add inland freight charges to a Cargo Release by using the Trans-
action Listing “Add” button instead of the Charges tab in the Cargo 
Release. This is the invoice screen:

Make any edits to the transaction if needed. You can view the cargo release 
dialog box or go to the document. (The screen is similar for Credit 
Memos, Bills, and Credits.)

• Credit Memo: Use this option if you need to issue a credit or a refund to
a customer.

• Bill: Add a bill of what you need to pay.

• Credit: Use this option if you overpaid a vendor and they give you a credit.

Link Transactions: The Actions button for the Transactions List has the option 
to link the transaction to a bill or to an invoice or to a Cargo Release. You can 
also unlink it. If you created a bill or other accounting transaction separate from 
the Cargo Release, you can link it this way.

For more details on linking transactions, see the following Knowledgebase 
article:

http://knowledge.magaya.com/?search=actions_wr

You can also receive the payment or pay the bill from the Actions button.
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When creating a report from the Transaction Listing, you can create script 
columns by clicking the Actions button in the report and selecting Column 
Settings. In the Columns Settings dialog box, click the arrow next to the “Add 
Columns” button to find the option to add script columns. This script columns 
option is also available in the Chart of Accounts reports.

Other Actions

You can perform other actions from the Cargo Release Actions button while 
viewing the document or the list. Click the button on the side of the Actions 
button to access the pop-up menu:

Set Status:

When cargo departs from your warehouse, set the CR as “In Transit” by 
selecting the option: Set/Reset In Transit.

When cargo arrives at its final consignee, set the CR as “Delivered” by selecting 
the option: Set/Reset Delivered.

• Note: When you set cargo in transit, a checkmark appears next to the 
option in the menu. If you uncheck it, the status of the cargo will return to 
its previous status. Refresh the CR List to see the current status. The status 
of the cargo is also updated in the Commodities List.
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• To automate an Event so it appears in the Events tab and online for your
customers to see, create an Event Definition in Maintenance > Configura-
tion > Event Definitions.

To exclude the transaction from tracking (if the transaction is not complete 
and you do not want it viewed via Magaya LiveTrack), select the option: Exclude 
from Tracking.

Express Link: This option connects you to FedEx and UPS so you can send a 
request to them when you want them to pick up a package. Learn more in the 
Knowledgebase topic “Express Link: Getting Started:”

http://knowledge.magaya.com/#/article/ExpressLink_Get_Started
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To choose a different template for the document, select the option: Select 
Template. Some of the different templates include:

• The default Cargo Release template

• Cargo Release Distribution (Summarized by Location): Displays items 
grouped by part number for each different location

• Cargo Release Distribution (Summarized): Displays items by grouped by 
part number

• Cargo Release Sorted by Item Index: Displays items sorted by the order in 
which the user put them
 611



Chapter 16 What Actions can I Perform with a Cargo Release?
To view the history of the cargo release (such as a Warehouse Receipt or 
Invoice for this cargo), select the option: History. A dialog box opens, listing all 
the transactions related to this cargo:

You can view a transaction by selecting it in the History dialog box. The View 
button opens the dialog box for the transaction. The Go To button takes you to 
the document. To return to the cargo release, use the Back button.

To cancel a CR (or other transaction), delete it. All the items in that CR will 
return to your database. The record of the cancellation/deletion is kept in the 
Transactions Log (on the top menu, go to Options).

List View

The list view of Cargo Releases offers you a lot of flexibility to view the list in 
different ways. Sort the list with the Filter button or move the column headers.

Right-click a transaction to view a pop-up menu of options. Many of these 
options are also available from the Actions button in the list view.

Add or change the columns you view by clicking the Actions button and 
selecting “Choose Columns.” Options include columns to view the Sales Order 
connected with your Cargo Release (depending on which Magaya software 
product you have), and more.
612



What Actions can I Perform with a Cargo Release? Chapter 16
Filter with the Standard Filter or Advanced:

Save the view of the list by clicking the star button on the top of the list. Learn 
more about working with the lists:

http://knowledge.magaya.com/#/article/2_work_document_and_list

Verify a Packing List in a Cargo Release

When items will be released, it is recommended to verify items the items to 
ensure they match the packing list in a Cargo Release. The process works with a 
bar code scanner. Click the Actions button and select “Verify Packing List.” For 
details on this procedure, see the topic “Verify a Packing List with a Bar Code 
Scanner.”

The items to be verified appear in the top half of the Packing List screen. Scan 
the items. As items are scanned, they appear in the bottom half of the screen.
 613



Chapter 16 What Actions can I Perform with a Cargo Release?
Create Tasks from Cargo Releases

To create one Task (to be sent to the handheld units running Magaya WMS 
Mobile), click the “Task” button from the document view of a Cargo Release.

To create multiple tasks, select multiple CRs from the list and click the “Task” 
button. You can create Pick Tasks, Load Tasks, or POD Tasks in batch.

A wizard will open to enable you to create multiple tasks for multiple CRs 
instead of creating one at a time.
614



What Actions can I Perform with a Cargo Release? Chapter 16
Select the type of tasks you want to create:

Next, select the CRs to process.

You can select CRs from the list before starting the wizard, or select the CRs 
from this screen in the wizard. To be eligible for this wizard, the CR must have 
items in it, and the CR status cannot be “In Transit” or “Delivered”. Items in 
pallets cannot be loaded.
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The wizard displays the total tasks created.

Click “Finish” to complete the wizard. The system will now generate the Tasks 
and send them to the handhelds.

Notify your Customers

See the following additional resources that help your customers stay informed 
about the status of their transactions:

Send emails with a link to notify your customers of the status of their cargo:

http://knowledge.magaya.com/#/article/transaction_tracking

Customize the email message:

http://knowledge.magaya.com/#/article/email_templates

Give your customers LiveTrack access: Your customers can log in at any time to 
see their updates:

http://knowledge.magaya.com/#/article/livetrack_setup
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Release Cargo with WMS Mobile Devices

Introduction to Releasing Cargo with WMS Mobile:

This topic explains how to use the WMS Mobile handheld devices to release 
cargo from the warehouse. When you use the Magaya WMS Mobile handheld 
devices to release cargo, you create Pick tasks and Load tasks:

• A “Pick” task is used to move items from their current locations to a
Quality Control area (QC) or to an outgoing shipping/staging area. With
the Pick task, cargo can be palletized before it is released. Types of Pick
Tasks include Single, Multiple, and Partial.

• A “Load” task is used to move items from QC to the shipping door. You
can also use a Load task to send items out of the warehouse without stop-
ping at QC. This task is useful when cargo does not need to be repacked or
palletized but is going out of the warehouse as is. This task does not have
the option to palletize cargo.

If you want your Magaya system to automatically create Pick Tasks when a 
Cargo Release is created, check this option in Configuration > WMS > WMS 
Mobile.

If you want to speed up scanning of Part Numbers, check the option “Ask for 
quantity after first scan in a Pick/Load task.” This will prompt the handheld user 
to enter the quantity instead of scanning each Part Number.
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Create a Single Pick Task

To pick the cargo items that you want to release, follow these steps.

1) Start on the PC by creating a Cargo Release (CR). If you need help creating
a CR, see the section “Create a Cargo Release” in this chapter for details.

Note: Cargo can also be released from a shipment. This example shows
releasing cargo items using a Cargo Release transaction.

2) Create a Pick task from the Cargo Release document by clicking on the
arrow on the side of the Task button and select “Create Task”:
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3) In the Task dialog box, enter the details of the task:

• Assign the task to the WMS Mobile user who will perform the Pick 
task. (Note: If you have not set up WMS Mobile users, go to the 
employee’s profile and check the permission box on the “User” tab. 
If you have multiple warehouses, add columns to see city, state and 
country as needed.)

• Select the task type: Pick (WMS).

• Enter a location (required). This is the final destination location, 
where you will move the items to, not where the items reside before 
or during Picking. There are only two types of locations available 
from this menu: Shipping and Quality Control. When you create 
Locations in your Magaya system, ensure you create these types. 
(Note: If using mobile locations, the user selects the mobile location 
on the handheld.”

• Set the due date. The reminder is optional.
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• Enter a subject and notes as needed.

Click OK. The task is sent to the WMS Mobile handheld device and will 
appear in the Pending Tasks list. The items included in the Cargo Release 
are the items that will appear in the WMS Mobile task to be picked.

Create a Partial Pick Task

Overview: If a Pick Task will contain many items, the task can be done by more 
than one person. With this option, you can select the items to include in one 
Pick task, and you can create as many Picks as needed for multiple employees.

This is useful for large orders or shipments that will require more than one 
person to complete. This will create one Task. To create more than one Task, 
run this process again.
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Steps: In the task screen that opens, assign the task as usual. In the second 
screen, enter the quantity of pieces for this partial task.

The tasks are sent to the WMS Mobile device the same as any other task.

The History of the transaction shows the partial pick tasks.

Create Task for Houses:

The option "Create Task for Houses" is available on master shipments only. It 
enables the user to create Delivery tasks in batches for houses.
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Perform a Single Pick Task on the WMS Mobile Device

1) Click on the “Pick” icon on the main screen of the WMS Mobile handheld
device:

2) Select the Pick task you will perform. If there is more than one task, scroll
through the tasks by clicking on the arrow buttons on the bottom of the
screen. Click the “Select” button:
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Note: Pick tasks must have a destination location assigned to them when 
created. If not the task must be corrected on the PC.

This screen shows the Pick task details. All these details are gathered from 
the Cargo Release automatically and displayed on the handheld screen.

3) Scan the location to begin picking the items. This Pick task contains items
from different locations. Select the first location to begin picking items
from it.
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4) In the next screen, the items to pick are listed. Scan the items (or click on
the item on the screen if you cannot scan and manually enter the quan-
tity.)
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5) To move the items you scanned to the destination, click the “Move” 
button.

In the next screen, you have the option to move the items to a pallet. If you 
want to do this, scan the pallet. If not, leave the field blank and click the 
OK button.

This screen is useful when picking many items and placing them on a 
pallet. The forklift takes the pallet to the QC area and returns to the rack 
with an empty pallet to continue the Pick task. Scan each pallet ID, and 
click “Move” each time the pallet is full. This can be done multiple times 
during a Pick task until all the items are picked.

The system can also define the forklift (or a cart) as a “mobile location” so 
it can be scanned. This saves every step of the picking process and provides 
greater visibility into the warehouse tasks. For details on creating mobile 
locations, see the section on creating warehouse locations in Chapter 7 of 
the Magaya WMS User Manual.
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6) Scan (or enter) the destination location:

7) Print labels if needed. From the Cargo Release, you can print shipping 
labels (also from File > Print Labels). The label will identify the pallet (and 
items), the customer, and shipment information.

As items are picked, they disappear from the list on the handheld screen. You 
can finish the task at any time, even if there are still items to be picked. The 
system will save the portion of the task finished so it can be completed later. You 
can also continue picking items by returning to the item list and continue 
picking the items as explained in Step 4 above.

Create Multiple Pick Tasks

Overview: This feature enables the creation of many tasks from multiple trans-
actions. You do not have to make Pick tasks one by one. It is ideal for companies 
that fulfill many small orders for many customers.

This is useful so you don’t have to create many tasks that send one employee 
across the warehouse to one location repeatedly to get one item at a time. This 
will group the orders by location so the user can go to one location and get all 
the items for different orders. This process will not break an order. For example, 
all the items ordered in one Sales Order will be in one task.
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There’s an option to view order numbers so you know which item belongs to 
which order (see the WMS Mobile screen).

This process can be done from the list of Cargo Releases, Sales Orders or for 
multiple shipments. A wizard guides you through the steps. This feature is avail-
able in Magaya software 9.3 and higher.

Steps:

Let’s show how it works by using some Sales Orders. These Sales Orders have 
Cargo Releases created for them. You can begin in the SO list or the CR list. Let’s 
begin in the SO list.

You can select multiple SOs from the list or start the process from the Actions 
button “Create Picking Tasks.” If you select multiple SOs from the list, 
right-click on them and select “Create Picking Tasks” from the pop-up menu.
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If you select SOs from the list, the wizard opens and takes you to a screen to 
select the destination.

If you do NOT select SOs from the list, the wizard opens and takes you to a 
screen that enables you to select the type of transactions. Then click Next.
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In the next screen, select the SOs.

Next, specify the destination location.

Next, specify the capacity of a task. If you limit how much weight can be in one 
task, then the system will create multiple tasks to distribute the weight across 
tasks.

In the next screen, the system generates the tasks for you to review.
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Click “Finish” to save the tasks and complete the wizard. The system creates the 
tasks for you and create a Movement document in the Cargo Movements list. 
Now users can complete the tasks with the handheld scanners.

Fulfill a Multiple Pick Task using a Mobile Location

If you use a mobile location such as a forklift or cart to complete a task, the 
WMS Mobile application will begin the same way for any Pick task, and then it 
will give you a screen to “move” the items to the mobile location.

For example, you scan an item and the location such as a shelf or rack, and then 
scan the mobile location such as the cart. Then you move the items to the final 
location and scan that final location as you remove the items from the cart and 
place them in their final location.

To create a Mobile Location, first create it in the Locations list and then 
configure it in the Configuration > WMS screen. To see detailed steps for 
creating mobile locations, please see the topic “Mobile Locations” in the Knowl-
edgebase.
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After you create Mobile Locations, they will display in the Locations list with the 
Type identified as “Mobile”:

Users of the WMS Mobile handheld scanners can select the mobile eqipment 
they need to use for a task:

While one employee is using that piece of mobile equipment, no other employee 
can use it (until they select another option or “None”). If a user does not need 
to use mobile equipment, they can select “None” from the menu. (Note: The 
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user can be cleared in the Configuration menu option “Warehouse Equip-
ment.”)

The main screen displays the equipment in the bottom taskbar.

Select and scan the location. (Under each location is the part number inside that 
location.)
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Then scan the item and the mobile location. Click the “Move” button. Repeat 
for all the locations and their items in the task.

When all the items are in the mobile location, the status of the items is “In 
Transit.”

Move the cart or forklift of items to the final location, scan the barcode of the 
final location.

Depending on the type of “Finish” configured, you may need to scan the 
barcode of each item as it is removed from the cart and placed in the final loca-
tion. This is called a “Detailed Finish.” Note: No repacking can be done during 
this process. The system gives you a choice of methods to finish the task:

• A Detailed Finish requires all the items be scanned again as they are 
removed from the cart and placed in the final location.

• A Quick Finish does not require more scanning of the items.

To configure your system to perform Detailed Finishes, go to Maintenance > 
Configuration > WMS. Check the box “Verify items after batch pick.” When 
this option is unchecked, the system enables a Quick Finish (no verifying).

Note: The system saves a record of all picks as the items are moved by creating 
a Cargo Movement document (in the Warehousing folder). The status changes 
from Pending to Complete.
633



Release Cargo with WMS Mobile Devices Chapter 16
If using the Quick Finish option, clicking the “Move” button displays the screen 
for the final location to be scanned. Just scan that location barcode, and all the 
items are automatically moved there in the system. Just unload the cart/forklift.

When the Pick Task is completed, the system saves a record of all picks in the 
Cargo Movement document. The status changes to Complete.

Create a Load Task

To load the cargo directly without picking items and repacking or palletizing 
them, follow these steps. You can also use this process to move cargo from QC 
to the shipping door.

Tip: If you want to speed up scanning of Part Numbers, check the option “Ask 
for quantity after first scan in a Pick/Load task.” This will prompt the handheld 
user to enter the quantity instead of scanning each Part Number.

1) Start on the PC by creating a Cargo Release. See the section “Create a
Cargo Release” for details.

2) Create a Load task from the Cargo Release by clicking on the arrow on the
side of the Task button and select “Create Task”:

3) Fill in the information for Load task in the Task dialog box. The screen is
the same as explained in the Pick Task, Step 3, except for selecting the type
of task: select “Load (WMS)”.

Extra Info: If you need to update weights and dimensions of pallets or items that 
are already loaded, use the “Measure” icon on the main screen of WMS Mobile.
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Perform the Load Task on the WMS Mobile Device

“Load” tasks are for cargo that does not need repacking but is going directly out 
of the warehouse; a Pick task is not issued in this case. This will speed up the 
shipping process.

1) Click on the “Load” icon on the main screen of the WMS Mobile handheld 
device:

2) Select the Load task to complete.

If there is more than one task, click the “Task tab to see them or scroll
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through the tasks by clicking on the arrows on the bottom of the screen.

3) Scan the location to begin loading the items.
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4) Scan the items to load them. You can also click on the item and the Quan-
tity button and manually enter the quantity instead of scanning each item.

Items scanned (loaded) will have a checkmark on the item icon. For items 
scanned, you can click the “Move” button to move the items. You can also 
scan all the items first and then click the Move button to move them all at 
once.

When you click the “Move” button, scan or enter the location where the 
items are going. See Pick Task Step 6 above for details.

5) Click the “Finish” button when done. The system will save the task. If you
click Finish when items still remain to be loaded, the system will ask you
if you want to finish. If you click Yes, the system will clear the Load task
from the main menu. To temporarily close an incomplete task and return
to complete it later, click the Cancel button. All scanned items are saved.

Set Cargo Status to “In Transit”:

After the Load task is finished, the status of the items is “Loaded.” To set the 
items (and the transaction) as “In Transit” when the items depart the ware-
house, go to the PC, open the originating Cargo Release and click on the arrow 
on the side of the Action button. Select “Set/Reset In Transit” from the menu.

View Tasks Status and More with Column Headings in Lists:
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In the list of Cargo Releases, Warehouse Receipts or Shipments, you can choose 
columns to easily view information about the tasks such as the type of task, the 
employee who is it assigned to, the status and more.

You can also click the “Detail” button in the list and view the panel for Related 
Tasks. Just highlight a transaction to see the details. Tap the Up or Down arrow 
on your keyboard to move through the transactions list.

Just highlight a transaction to see the details. Tap the Up or Down arrow on 
your keyboard to move through the transactions list.
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Shipments

Introduction

Magaya Explorer offers you many ways to create shipments:

• Use the wizards that will walk you through the steps to create a consoli-
dated shipment or a straight shipment for air, ocean, and ground (imports
and exports) by using the buttons on the main toolbar.

• Create a shipment from the File menu by going to File > New and
choosing Air, Ocean, or Ground Shipment.

• Right-click on a subfolder in your shipment folder and select “Add Ship-
ment” from the pop-up menu and the type.

• Convert an existing transaction such as a Sales Order, Quotation, or a
Booking into a shipment by using the Actions button in those transac-
tions.

The screens and tabs for creating shipments are the same for import and export, 
so we will use an export shipment as an example. For more on imports, see the 
Magaya Cargo System Operations Manual or the Knowledgeable:

http://knowledge.magaya.com/#/article/imports

For a detailed overview on creating shipments in Magaya, see:

http://knowledge.magaya.com/#/article/intro_shipments

To create Back-to-Back shipments, use the Actions button in a Booking.

The first example illustrates how to use the Straight shipment wizard. We will 
use an export air shipment as an example.

The second example explains how to use the Consolidation wizard to create an 
export ocean shipment.
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Create an Air Export Shipment

This topic explains how to create an air export shipment transaction in Magaya 
software using the shipment wizard. This is an example of a straight shipment.

Note: While this topic explains how to create a shipment using the wizard, ship-
ments can also be created by right-clicking on the shipment folder in the left 
menu and adding a shipment.

Use the Wizard to Create a Shipment

Follow the instructions below to create an Air Export shipment using the 
Straight Shipment wizard. Note: The procedure for straight ocean and ground 
shipments is the same as this example.

Tip: Straight shipments are often created if you are not working with a destina-
tion agent.

Go to the toolbar across the top of Magaya Explorer and click the arrow on the 
side of the Air button. From the dropdown menu, select Straight Shipment 
Wizard (Export)

Enter information in the wizard screens according to the steps below. Note: 
Each screen contains instructions.
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General Screen in the Straight Air Export Wizard

1) The first screen of the wizard is the “General” screen. Notice that the Ship-
ment Name is filled in automatically. (It can be changed by typing over it).

• Select the carrier from the dropdown menu (this example uses LAN
Cargo). You can add the carrier in the dropdown if it is not listed by
clicking on the + plus sign.

• Enter the Air Waybill Number (or click the Set button to select from
a preset list of numbers.) Notes: A carrier must be selected to activate
the “Set” button. To set up AWB numbering, go to Maintenance >
Carriers. Click on the carrier and go to the Airline tab.) Setting AWB 
numbers by IATA compliance is explained in the Magaya Software
Customization Manual.

• Enter the Booking Number (optional).

• Select the place where the shipment is being executed (in this
example the executed place is Miami; this is not the departure city).

• The fields for “Executed By” and “Executed Date” are filled in by the
system. Change them as needed.

• Enter the Declared Value for Carriage and for US Customs. (If you
leave these fields blank, “NVD” for No Value Declared and “NCV”
will appear on the Air Waybill form.)

• Enter a description of the goods, if you know it (optional). This
description will appear in the Master air waybill; the individual
cargo will not be listed. (Note: The button with the three dots next to
the Description field is used to add clauses to the description. Select
a clause or add a new one.)

• Click the “Next” button.
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Entities Screen in Straight Air Export Wizard

1) Enter the information in the Entities tab as follows:

• Select the Shipper from the dropdown list.

Notes: This dropdown and others on the screen show all the entities, 
not just the Shippers. If it’s a long list, type the first letter of the 
company you want, and the list will go to that part of the list. If you 
are creating an EEI for this shipment, the Shipper must have an ID 
number in their profile (in the Maintenance folder).

When filing an EEI to US Customs, the user can select if the USPPI 
is the Shipper (Default) or the Forwarding Agent in the Entities 
screen.
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• Select the Ultimate Consignee.

• Select the party to notify and the intermediate consignee if appli-
cable.

• Select the Forwarding Agent. (This is your company if you are a
freight forwarder. It’s taken from the “My Company Info” automat-
ically for straight shipments.)

• Select the Destination Agent. (When a freight forwarder creates a
straight shipment, the carrier may handle the transactions instead of
a destination agent. If so, the Liquidation will show what amount is
owed to you.)

• The fields for “Client to bill” will be filled in automatically based on
the information you entered.

• Click the “Next” button.
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Routing Screen in Straight Air Export Wizard

1) Enter the information in the Routing tab for the shipment:

• Select the Service Type.

• Select the Route if you are using the Routes feature. (See the section
on Routes to learn how to create routes and use them; all the route
details will fill in automatically.)

• The Mode of Transportation and the Carrier fields are filled in auto-
matically. (Notes: The button with the three dots opens a list of addi-
tional modes of transportation you can choose from if needed. To
set a default mode, go to Configuration > Air.)
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• Enter the flight number. If this is a passenger-only flight, only cargo
from a known shipper can be loaded. The Known Shipper status is
found on the entity’s profile dialog box on the “Pmt Terms” tab.

• Fill in the Departure and Arrival information by using the drop-
down menus.

• Click the "Next" button.

Documents Screen in Straight Air Export Wizard

1) Select the documents you need to add to this air shipment:

• For example, click in the box next to the document you want such as
the Air Waybill option. A checkmark appears in the box next to the
document name. This air waybill will now appear with your ship-
ment documentation, and all the information from this wizard will
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appear in it. You do not need to type the document or fill it in by 
hand. You can add as many documents as needed.

For definition of each AWB type in Magaya, please see the topic “Air 
Waybill Printing Tips.” It explains the difference between laser, 12 
inch and dot matrix pre-printed forms.

Extra Info: Documents can also be viewed online in LiveTrack by 
your customers and agents based on the permissions you set up for 
them. For steps, see the Magaya Software Customization Manual.

Tip: If you have documents that contain information that you use 
regularly and repeat, use the “Templates” button. Templates can be 
created by copying a document into the Template folder, located in 
the Miscellaneous folder. Examples include a letter of credit in a Bill 
of Lading with banking information that you added and which will 
be the same for many shipments.

Add Other Documents: To add other documents such as a PDF of a 
Letter of Credit, complete the wizard and click the Attachments tab.

• Click the "Next" button.
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Cargo Screen in Straight Air Export Wizard

1) You can select cargo from different locations or previous transactions by
clicking on the button across the top of the screen. This example selects
from the Warehouse Receipts (in the Magaya Supply Chain Solution):

Notes: Your view of this screen in the wizard will vary from this screenshot 
depending on which Magaya software product you are using.

If you do not see the items you are looking for, verify if a filter is on, limiting the 
cargo you see, or verify if the cargo is from a known shipper.

If your system is configured to prevent loading items that are in a Receiving 
location, you will get an error message when attempting to load these items. It’s 
set in Maintenance > Configuration > WMS.

The following list explains the tabs and their functions. Not all tabs are available 
in all software products.

• Warehouse: To select from the Warehouse Receipt (to ship the same way
you received the items). Notes: Any charges from the WR will be carried
over into the shipment and appear in the Charges tab. This screenshot
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shows how to select a partial quantity of pieces from the WR instead of all 
the items. The description of the items is “Diesel fuel conditioner.” The 
numbers before the description (38-10-24) are: 38 items available, Pickup 
Order number 10, and Warehouse Receipt number 24. (The order of these 
fields can be changed by clicking on the Configure button.)

To select all the WRs, click “Mark All.” All items are availabe to be selected 
except those in Pending Tasks or On Hold.

• Pickup: For cargo that does not come to your warehouse. To include items 
from a Pickup Order into a Shipment, the Pickup Order must have a status 
of “Arriving.”

To select all the PU Orders, click “Mark All.” All items are availabe to be
selected except those in Pending Tasks or On Hold.

• Inventory: To ship by part numbers (used by distributors). The "Mark All" 
button is only active after you select a part number. These items are On
Hand.

• Lot Numbers: Select from lot numbers

• Scan: For using handheld scanners to scan barcodes. Magaya Bar Code
plug-in required.

• Locations: Select items directly from locations in the warehouse. The
"Mark All" button is only active after you select a Location in the ware-
house. All items in that Location are available to be selected except those
in Pending Tasks or On Hold.

• PO or SO: Use these to select items from Purchase Orders or Sales Orders.

Click the “Next” button to continue.
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Repack Screen in the Straight Air Export Wizard

If you need to repack, click on the “Repack button.” A dialog box opens. This 
will pack all the items inside one container.

If cargo is to be packed into more than one container, do NOT use this Repack 
button. Finish the wizard and then go to the shipment and use the "Repack" 
button in the Cargo Toolbar.

Enter the information in the repacking dialog box as needed:

• Select the container type and enter the dimensions. This can be an air
container such as an LD or a regular pallet.

• Enter information in the other tabs as needed, and click the OK button
when you are done. You will be returned to the shipment wizard.

For more details on working with repacking, see the section “Repack Cargo.”

Click the “Next” button to continue.
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Save the Straight Air Export Transaction

To save the shipment transaction, select a folder:

Extra Info: If you need to add a new folder, click the New Folder button.

When done, click to the next screen in the wizard.
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Summary Screen the Straight Air Export Wizard

Verify the information in the Summary screen.

To make any changes, click the "Back" button to go to the screen you need to 
edit. You can also make changes after finishing the wizard.

View the Saved Shipment Transaction

All the information from the wizard is automatically transferred to create a 
shipment.

The documents appear in the top pane of the shipment screen with all the details 
from the wizard automatically filled in. Click on a document to view it.
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If you added cargo, it appears in the right panel. The details of the shipment are 
in the tabs. These panes can be widened by clicking and dragging the separator 
line.

The structure of the shipment is displayed on the left menu. The master is on 
the top and any houses for a consolidiation are under the master.

In the Cargo list, cargo can be unpacked and repacked as needed. More cargo 
can be added or unloaded. The totals for the number of pieces and weight and 
volume are displayed on the bottom.

From here you can set the shipment in transit, liquidate it, and other choices. 
These are explained in detail in the topic “Working with Shipments.”

When ready to send EEI export information to US Customs or shipping 
instructions to INTTRA, click the Actions button or Customs button for 
options. See details for these functions in the Magaya Knowledgebase 
(http://knowledge.magaya.com) and the Magaya Software Communications 
Manual.
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Split a Shipment to Make Subhouses

If you have a shipment with one House that contains cargo from different WRs, 
you can split that House so you can file EEIs for each House and declare the 
cargo for each shipper.

1) Click the arrow on the side of the Houses button on the Shipment Toolbar, 
and select the option "Breakdown into Subshipments".

2) In the dialog box that opens, select how you want to split the Houses:

• Same Shipper

• Same Consignee

• Same Shipper and Consignee (this creates a consolidation)

Other options in the dialog box (usually used when converting a straight ship-
ment into a consolidation):

• Generate charges for the newly created houses

• Include default documents to the newly created houses

Click the Refresh button to see the subhouses created.

Then you can file the EEI for each House as needed. Customs will send the ITN 
information back to you.
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View subhouses in the Shipment List by choosing the column “Subhouse” from 
the Actions button > Choose Columns.

File eAWB

To file the Air Waybill (AWB) electronically, click the Actions and select 
eAWB. Your Magaya system must have the eAWB activated and configured. 
See the details in the following Knowledgebase topic:

http://knowledge.magaya.com/#/article/eAWB_getting_started
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How to File an eAWB

This topic explains how to send an eAWB message for a straight shipment and 
for a consolidated shipment with multiple Houses for air exports. The master 
eAWB message is the XFWB, and the House air waybills are sent in an XFZB 
message.

Your Magaya system displays the AWB document for you to view and print if 
needed, but you do not need to print it for the carrier. All the data is transmitted 
electronically to the carrier when you send the eAWB message.

Requirements:

• Magaya software version 10.4 or newer

• All entities in the shipment must have address and phone number (limit
70 characters; create a separate eAWB address to use in the entity profile
on the “Other Addresses” tab).

Addresses can have a maximum of 70 characters. A freight forwarder
name can have a maximum of 20 characters.

• If there are changes or amendments to a shipment, you can file another
eAWB.

• Enter the ITN in Waybill Notes or Description of Goods; it does not get
transmitted via a field in the eAWB.

• Enter the "Notify Party" in the Waybill Notes, if you need to add the Notify 
Party. The eAWB does not have a designated field currently. (Waybill
Notes print in the Handling Information part.)

• The cargo must have volume, either on the commodity or on the charge.

File a Single eAWB for a Straight Shipment

If you are sending a straight air export shipment, you will send the eAWB from 
the Master view of the shipment transaction in your Magaya system:

Click Actions > eAWB > Air Waybill (XFWB). This will send the information 
about the master shipment to the carrier.
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Required: All entities in the shipment must have address and phone number 
(character limits - see above).

If you don’t create a separate eAWB address to use, the system will pull the main 
address from the forwarding agent’s profile. If the address is longer than 70 
characters, then the eAWB field will only display the frist 70 characters.
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Required: The shipment must have at least one freight charge with an amount 
greater than zero.

A document opens that displays the eAWB information from your shipment. If 
any information is missing, the field will be marked in red. Make any correc-
tions in your shipment, and click the Actions button > eAWB menu again.

If all the fields are valid, click the “Send” button.
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A confirmation message appears after sending.

The acknowledgement also appears in your Magaya Network folder of messages 
for air carriers.

If you need to send an amendment, click the XFWB again from the Actions 
eAWB menu. The amended eAWB will display the word “Amendment” on the 
top of the document.

File Multiple eAWBs for a Consolidation

If you are sending a consolidated air export shipment with multiple houses, you 
have the option to send the master only or just the houses. How to decide which 
menu option to click? For example, the first time you send the eAWB, send the 
master and the houses. When you click the option to send the Houses from the 
Master view, then all the houses are sent. You don’t need to send each one sepa-
rately (see below). What you send will depend if you have all the information for 
the houses ready.

Required: All entities in the shipment must have address and phone number.

Required: The shipment must have at least one freight charge with an amount 
greater than zero.
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Currently the House Air Freight field in the eAWB cannot display words such 
as “As Agreed” but requires a number in the field. If you have an automated 
charge that populates that field, but you don't want to display that price, then 
delete the price and replace it with the number 0 (zero). Otherwise, there will be 
an error in processes the electronic air waybill.

The first time you send the eAWB, perform both of these steps:

1. File the Master: View the Master shipment and click Actions > eAWB >
Master Air Waybill (XFWB). This will send the information about the master
shipment to the carrier.

2. File the Houses: View the Master shipment and click Actions > eAWB >
House Air Waybills (XFZB). This will send the information about all the houses 
at once to the carrier. You donotneed to file each House individually.

When you click XFWB to file the Master, a document opens that displays the 
eAWB information from your shipment. If any information is missing, the field 
will be marked in red. Make any corrections in your shipment, and click the 
Actions button > eAWB menu again.
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When click XFZB to file all the Houses, a screen opens in your Magaya system 
displaying a list of the houses and any errors (if applicable). Click a house to see 
the errors displayed in document format. This will enable you to return to the 
shipment screens and correct the errors. Then click XFZB again.

If all the fields are valid, click the “Send” button.

Your Magaya system will display a notice for messages successfully sent:

If there is an error is found by the carrier on a House, a message will be sent to 
the “Air Carrier Messages” folder in your Magaya Network folder. You can 
correct the house(s) and re-send the houses as amendments (one house or 
more, as many as needed) from this eAWB menu: XFZB.

An amended eAWB will display the word "Amendment" in red at the top of the 
document.
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View Messages

To view messages, go to your Magaya Network folder and open “Air Carrier 
Messages.”

Acknowledgements of messages sent from your Magaya system will appear in 
this folder.

When there is an update such as the departure or delivery, the air carrier sends 
a status update messages called “XFSU” to your Magaya system. After you view 
a message, a checkmark appears in the “Direction” column. The updates will 
also appear in the Events tab of the shipment.

Results of your eAWB submission can also be viewed from the Actions menu in 
the shipment. Also, the Events tab of the shipment will be updated, confirming 
that the data has been delivered into the eAWB system’s connection to the 
carriers.
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See Also

For details on Air Waybills and how they are processed in Magaya, see the topic 
“Air Waybills” in the Knowledgebase:

http://knowledge.magaya.com/#/article/air_waybills

If you have not configured your Magaya system, please see the article “eAWB: 
Getting Started” in the Knowledgebase:

http://knowledge.magaya.com/#/article/eAWB_getting_started
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Create an Ocean Consolidation Export

Overview: Creating Consolidated Ocean Export Shipments

This topic demonstrates how to create a consolidated ocean export shipment 
transaction in Magaya software using the wizard. The procedure is the same for 
air and ground consolidations.

When creating a consolidation and adding containers, tips to remember:

Consolidations combine cargo from different customers into one container.

An LCL is a “less than a full container load” shipment, and the container is 
always placed on the Master.

An FCL is a “full container load” shipment, and the container is placed on the 
House.
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Note: This topic explains how to create a shipment using the wizard, but ship-
ments can also be created by right-clicking on the shipment folder in the left 
menu and adding a shipment.

To include container Waybill notes in the Bill of Lading, select the option in 
Maintenance > Configuration > Ocean. If you have the connection with 
INTTRA, you can configure your Magaya system to send container waybill 
notes in INTTRA requests.

There are two options to send the Verified Gross Mass (VGM) of the containers 
can be sent to the carrier: Via the VGM document, or via INTTRA (eVGM). See 
the following Knowledgebase article for details:

http://knowledge.magaya.com/#/article/VGM_document

In a Shipment, the Container dialog box has a tab called "Waybill Notes." This 
is where to add the notes. Click the button to add notes.

For more on FCL, LCL and configuring shipments, see the Getting Started 
article:

Getting Started with Shipments

http://knowledge.magaya.com/#/article/intro_shipments
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Steps to Create an Ocean Consolidation Export

1) Click the arrow on the side of the Ocean button and select “Consolidation
Wizard (Export)” from the dropdown menu.

2) Enter general information about the shipment in the first screen of the
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wizard:

• The shipment name is filled in automatically. To change it, type over
it. (To set up numbering, go to Options > Configuration > Docu-
ment Numbers.)

• Enter the Master Bill of Lading Number (from the shipping line).
Note: The system can be configured to ensure that duplicate BL
numbers are not entered. See Configuration > Ocean.

• Enter the Booking Number (from the shipping line).

• Select the place where the shipment is being executed (in this
example the place is Miami). The system pulls this from you profile
in “My Company Info.” This field is required if sending shipping
instructions to INTTRA.

• The fields for “Executed By” and “Executed Date” are filled in by the
system with today’s date. To change them, use the dropdown menu.
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• Enter the Declared Value. (If you leave this blank, the system will fill 
in “NVD” (No Value Declared) in the Bill of Lading.

• Enter a general description of the goods, if you know it (optional). 
Add a preset clause to the description field by clicking on the button 
with the three dots. An example of a preset clause is “Consolidation 
as per attached cargo manifest.”

• Click the "Next" button to go to the next screen in the wizard.

3) Enter information in the Entities tab at the Master level as follows:

Remember: The Master Bill of Lading is the contract from the ocean 
carrier to the freight forwarder or logistics provider.

• Select the Shipper from the dropdown list.

Note: The Shipper will be filled in automatically with your company 
information (if you are a freight forwarder). If you are creating and 
sending an EEI for this shipment, the Shipper must have an ID 
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number in their profile (in the Maintenance folder of Magaya 
Explorer).

When filing an EEI to US Customs, the user can select if the USPPI 
is the Shipper (Default) or the Forwarding Agent in the Entities 
screen.

• Select the Ultimate Consignee. (For a consolidation, the consignee
will be the destination agent.)

• Select the party to notify and the intermediate consignee if appli-
cable.

• Select the Forwarding Agent. (This is your company if you are a
freight forwarder.)

• Select the Destination Agent.

• Click the "Next" button.

4) Enter information in the Routing tab as follows (in a consolidation, the
routing information will be copied to all the Houses):
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• Select the Service Type: Port to Port, Door to Port, Door to Door, or
Port to Door. The option for Port to Port is selected by default.

If using a Route, select it here. Details from the route and its
segments will fill in automatically. See the section “Routes” for more
details.

• The Mode of Transportation field is filled in automatically. (Notes:
The system will display only maritime type transportation options
when you are in the ocean wizard. For more options, click on the
button with the three dots. “Vessel” is LCL. “Vessel, Containerized”
is FCL. To set a default mode, go to Configuration > Ocean.)

• For the Origin: Enter the point of origin or the Free Trade Zone
(FTZ) number. The point of origin is the city where the transporta-
tion starts. Select the pre-carriage company and where they will pick
up the items.
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• For the Export: Enter the pier or terminal name or number. Select 
the port where the cargo will be loaded. Select the exporting carrier 
(the shipping line). Select the vessel name and flag, and enter the 
voyage ID number.

• For the Destination: Select the port where the cargo will be 
unloaded, who will do the carriage, and the place (city) where the 
cargo will be delivered by on-carrier (this is from the Ports list in the 
Maintenance folder).

• Click the "Next" button.

5) Select the documents for the Master shipment:

• For example, click on the checkbox for Bill of Lading and Cargo 
Manifest options. A checkmark appears in the box next to the docu-
ment name. These documents will now appear with your shipment 
documentation, and all the information from this wizard will appear 
in the applicable fields in the documents.

Extra Info: Documents can be viewed online in LiveTrack. To 
change which documents are displayed online, go to Maintenance > 
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Configuration >Shipment Documents. For steps, see the Knowl-
edgebase or the Magaya Software Customization Manual.

Add Other Documents: To add other documents such as a PDF of a 
Letter of Credit, complete the wizard and click the Attachments tab.

Use the “Templates” button to use documents that contain informa-
tion that you use regularly and repeat. (Templates can be created by 
copying a document into the Template folder, located in the Miscel-
laneous folder. Examples include a letter of credit in a Bill of Lading 
with banking information that you added and which will be the same 
for many shipments.

If you need your Terms and Conditions on your Bill of Lading, you 
can add them to the back page, or add as many additional pages as 
needed. This is especially useful if you are sending a large consolida-
tion or shipment with many items and lines of cargo. See the 
following Knowledgebase article to learn how to add a page to the 
document template:

Customize a Template:

http://knowledge.magaya.com/#/article/customize_existing_tem-
plate

• Click the "Next" button.

6) Select the cargo you need to ship. You can choose to select cargo, vehicles,
or inventory from previous transactions such as Warehouse Receipts,
locations, inventory, etc.
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• Warehouse: To select from the Warehouse Receipt (this means you
can ship the same way you received the items. You can also select
partiail pieces in a WR instead of all the items).

Note: The screens vary, depending on which software you use.

How to read the numbers before the item description: The first 
number is the total number of items available, and the following 
numbers are the Pickup Order and WR (if there was a WR).

When loading items into a Shipment from WRs, all items are avail-
able to be selected except those in Pending Tasks or On Hold. Just 
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click "Mark All."

• Pickup: For cargo that does not come to your warehouse. All items
are available to be selected except those in Pending Tasks or On
Hold. Just click "Mark All."

• Inventory: To ship by part numbers (used by distributors). The
"Mark All" button is only active after you select a part number. These 
items are On Hand.

• Lot Numbers: Add by lot numbers (available in the Magaya Supply
Chain Solution)

• Locations: To select items from locations in the warehouse. The
"Mark All" button is only active after you select a Location in the
warehouse. All items in that Location are available to be selected
except those in Pending Tasks or On Hold.

• PO and SO: To select items from a Purchase Order (PO) or a Sales
Order (SO).

• Scan: For using handheld scanners to scan barcodes.

To Group Houses:

The Houses are grouped by Warehouse Receipt by default (the number of 
WR’s equals the number of Houses that will be created). Any custom fields 
created for the WR will be carried over to the shipment.

To select another way to group the cargo, select the radio button you want. 
(This step does not repack the cargo; it organizes the documentation. You 
can organize the documents based on who is paying and how much detail 
you want on their documents. For example if the consignee is paying and 
they want one House, then group by consignee. If they want one House 
per shipper, group by shipper.)

The system will group the shipment labels by House shipment and group 
them by Warehouse Receipt to print them together.

You can add a House for cargo that does not have a warehouse receipt by 
clicking in the box to add additional houses and typing in the number of 
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Houses. You can also use this option if you want to group the items in a 
different way.

7) If you would like to repack the cargo, click the “Yes” checkbox. Then click
the Repack button and fill in the information in the repack dialog box.

This will repack the cargo from all Houses into one container at the 
Master level. For more details, see the section “Repack Cargo”.

Go to the next screen in the wizard.
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8) Select documents for the House shipments. (Note: The screen functions 
the same as the one for the Master shipment documents. remember: The 
House is the information per customer. )

Tip: Be sure a checkmark appears in the checkbox when you select a docu-
ment. This will add the selected document to each House.

To Add More Documents after Completing the Wizard: If you need to add 
more documents later, click the “Add Doc.” button on the shipment 
toolbar after completing the wizard. Another option is to attach docu-
ments to the Attachments tab (such as a PDF of a Letter of Credit).
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9) Select a folder where you want to save the shipment in your Magaya 
system.

10) Verify the information about your shipment in the summary screen of the 
wizard. To make any changes, use the back buttons to go to the screen you 
need.
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11) Click the “Finish” button when you are done.

All the information from the wizard is automatically transferred to create a 
shipment. Magaya Explorer places each document in the Shipment folder; lists 
the House Bills of Lading and other documents in the top pane; and the ship-
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ment screens and tabs (the same as in the wizard) and the cargo packing list are 
displayed below the Shipment Toolbar and the Cargo Toolbar.

In the cargo list, cargo can be unpacked and repacked as needed. More cargo can 
be added or unloaded. The totals for the number of pieces and weight and 
volume are displayed on the bottom.

In the shipment screens and with the buttons on the toolbars you can set the 
shipment in transit, liquidate it, and other choices. These are explained in detail 
in the topic “Working with Shipments.” 

When ready to send EEI export information to US Customs or shipping 
instructions to INTTRA, see details in the Magaya Software Communications 
Manual.

The same information is available in the Magaya Knowledgebase:

http://knowledge.magaya.com/#/article/exports_EEI_getting_started
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Navigating Shipment Screens

This topic provides an overview of the Shipment screen and Shipment Toolbar 
buttons and the functions available when you are working on your shipments.

Introduction to Working with Shipments

Magaya Explorer displays shipments in three panes. The panes and toolbars are 
the same for outgoing and incoming shipments of air, ocean, or ground.

• The Documents List shows the documents such as the Air Waybills or
Cargo Manifest and any House shipments that were added to that ship-
ment. To view a document, double-click on it. To copy, cut, delete, or send 
a document, right-click on it and select from the pop-up menu.

• The Shipment Data pane shows all data for this shipment organized on
tabs. The fields in the tabs can be edited as needed. If you used the wizard
to create a shipment, the data from the wizard will appear in these tabs.

• The Cargo List shows the cargo in the shipment. Above the Cargo List is
the Cargo Toolbar which lets you modify the content of the Cargo List.
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• The Shipment Toolbar covers the span of the Shipment Data pane and the 
Cargo List. Buttons on the Shipment Toolbar include a Liquidation 
button, a button for Customs, one for adding documents to a shipment, 
and more. These functions are explained in the following sections of the 
manual.

The Magaya folders on the left show the Shipment folders. By right-clicking on 
a folder or document, a pop-up menu appears. The options on the menu vary. 
This example shows the pop-up menu for the Air Waybill. The document is 
automatically linked to the shipment, but you can unlink it if you want to add 
information manually into the document.

If the document is linked, and you make changes to any fields in the shipment 
tabs, the system will add those changes to the document and overwrite any 
manual changes typed into the document.

To reload data means the information from the fields in the tabs will be placed 
in the document.

To widen the screen, click and drag the center line between the panels.
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The Master shipment is the top folder. Expand it to see the Houses under it. All 
the documents listed under the House belong to the House. The Master docu-
ments are after the House(s).

When you click on the Master, the “Master” button is grayed out on the Ship-
ment Toolbar. When you click on a House, the Master button is available. This 
is useful if you have a long list of Houses; you can quickly go to the Master 
instead of scrolling through the list.

Working with the Shipment Tabs

All the information entered in the shipment wizard appears in the tabs. You can 
verify or make changes by clicking on the tab and entering information in the 
fields.
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To widen the screen and see more of the tabs, click on the line between the two 
panels and drag it.

General Tab

TheGeneral tab has fields specific to the type of shipment you are doing (air, 
ocean, or ground). Let’s look at each.

An Air Shipment has the following fields on the General tab:

The data you entered in the wizard appears in the fields. You can make edits if 
needed. If you do not use the wizard to create a shipment, enter the following 
information into the fields:

• The Shipment Name is assigned automatically by the system. To change 
it, type over it. To set up numbering, go to the Maintenance folder and 
click on Configuration. (This is the same for air, ocean, and ground.) If 
you copied a shipment to create another, click the arrow button next to the 
“Shipment Name” field to get the next shipment number available so you 
do not have two shipments with the same number.

• Enter the Air Waybill Number from the airline. If the field is grayed out, 
use the Set button. The Set button is used to select the air waybill number 
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from a list of pre-set numbers given to your company by the airline. Create 
a pre-set list in the Maintenance > Carrier folder.

To prevent duplicate AWB numbers, set your preference in Maintenance 
> Configuration > Air.

• Enter the Booking Number.

• Select the place where the shipment is being executed (in this example the 
place is Miami).

• The field for “Executed By” is filled with the user’s name (the person 
logged into the system) and “Executed Date” is filled in by the system with 
today’s date. To change them, use the dropdown menus.

• Enter the Declared Value.

• Enter a general description of the goods, if you know it.

• Enter a pre-set clause by clicking on the button with the three dots. The 
clause will appear in the Description of Goods field, overwriting the 
description.
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Now let’s look at the General tab for an Ocean Shipment:

• The Dates are filled in automatically by the system with today’s date.
Change the Departure and Arrival date and time for the shipment. If the
actual date varies from the original date, update it here. Changing the date
on the Master will also change the dates on the House.

• Enter the Declared Value for the goods.
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• The totals for the Quantity of the goods is shown on the bottom of the
screen. To change the units of measurement, click on the Settings button.

The Settings button has two tabs: One for setting up how you want forms 
filled in (shown above), and another tab for the measurement units, 
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shown below:

The settings in this screen affect the measurement units for this shipment 
only. To make changes system-wide, edit the Measurement Units in the 
Configuration menu.

The volume weight dimensional factor default is set to 166.00, but it can 
be changed to 194.00 (used by the USPS for certain package sizes and ship-
ping zones) or 166.079428, which is 6000 cm (3)/kg (cubic).
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Now let’s look at the General tab for a Ground Shipment:

• To prevent duplicate BL numbers, set the preference in Maintenance > 
Configuration > Ground.

• Enter a Declared Value for the goods.

• Enter a general description of the goods.

• The Settings button has two tabs: One for setting up how you want forms 
filled in (such as air waybills and Bill of Lading), and another tab for the 
measurement units (pounds, kilos, etc.).

Routing Tab

On the Routing tab for all types of shipments (air, ocean, and ground) the mode 
of transportation is set by the system for the type of shipment. You can use the 
dropdown menu or the button with the three dots to make changes to the mode 
of transportation.
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The Routing tab for an Air Shipment contains the following fields:

• Select the Service Type and mode of transportation. If you are using the
Routes feature, select the route. Then the details of the route will be auto-
matically filled in. For more on routes, see the topic “Routes.”

• The Carrier is filled in from the wizard (in this example). In the case of air
shipments, the carrier is entered in the General tab; on the Routing tab it
is Read Only (grayed out). To change it, go to the General tab.

• The Air Routing tab includes a place to add flight transfer information.
Enter the airport, the carrier and flight number for each transfer as
needed. If you use the Route field, then transfer information is filled in
automatically. If you need to update the actual date and time, change it
here.

• Select US Customs codes for Origin (Schedule D) and for Destination
(Schedule K). Use the button with the three dots to browse through a list
of codes that are in the Magaya database. After a code is used once, it is
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associated with that port; the next time you use that port, the code will be 
readily available in the dropdown list.

• Check the Routed Transaction (AES) box to indicate that this shipment is 
coordinated from the destination. (AES is the Automated Export System 
for sending information to US Customs).

• Check the Related Companies (AES) box if the entity receiving the goods 
is related to the company at origin.

The Routing tab for an Ocean Shipment has the following fields:

The fields in the Ocean Routing tab are the same as shown in the instructions 
for creating an Ocean Consolidation. Fill in the fields with information for your 
shipment.

The Mode of Transportation is automatically filled in by the system.
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• Select the Service Type and mode of transportation. If you are using the
Routes feature, select the route. Then the details of the route will be auto-
matically filled in. For more on routes, see the topic “Routes.”

• Origin information: Select origin, who will do the pre-carriage, and where
(the place where the cargo will be picked up by the inland carrier and
taken to the loading port.)

• Export information: Enter the pier or terminal, select the port of loading,
carrier details.

• Destination information: Enter the Port of Unloading: This is where the
cargo is going to be unloaded from the vessel. Enter the Place of Delivery
by On-Carrier.

• Select US Customs codes for Origin (Schedule D) and for Destination
(Schedule K). Use the button with the three dots to browse through a list
of codes that are in the Magaya database. After a code is used once, it is
associated with that port; the next time you use that port, the code will be
readily available in the dropdown list.

• Check the Routed Transaction (AES) box to indicate that this shipment is
coordinated from the destination. (AES is the Automated Export System
for sending information to US Customs).

• Check the Related Companies (AES) box if the entity receiving the goods
is related to the company at origin.
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The Routing tab for a Ground Shipment has the following fields:

• Select the Service Type and mode of transportation. If you are using the 
Routes feature, select the route. Then the details of the route will be auto-
matically filled in. For more on routes, see the topic “Routes.”

• The Mode of Transportation is set to “Truck” by default for ground ship-
ments. The dropdown menu and the button with the three dots gives you 
the option to add new modes of transport.

• If using the Routes feature, select the route. For more details, see the 
section “Routes.”

• Enter the PRO number, tracking number, the Driver’s name and number 
(optional).

• Enter the Departure and Arrival date and time information. The “To” and 
“From” dropdown menus use the ports list for location names. (Note: If 
using the Routes feature, these details will be filled in automatically.) If 
you need to change the original date or time to an actual date or time, 
change it here.
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• Select US Customs codes for Origin (Schedule D) and for Destination
(Schedule K). Click the dropdown menu to browse. After a code is used
once, it is associated with that port; the next time you use that port, the
code will be readily available in the dropdown list.

• Check the Routed Transaction (AES) box to indicate that this shipment is
coordinated from the destination. (AES is the Automated Export System
for sending information to US Customs).

• Check the Related Companies (AES) box if the entity receiving the goods
is related to the company at origin.

Charges Tab

The Charges tab displays all the charges for the shipment. In a consolidation, the 
charges for each House shipment are displayed together, and the Master charges 
are shown on the Master view of the shipment. For more details, see the topic 
“Shipment Charges.”

Other Tabs

The Delivery tab has information about handling the delivery of the goods to 
the final consignee in the final part of the shipment.

The Commodities tab displays the information in the Cargo Screen, i.e., the 
items in the shipment.

If you want to provide a Proof of Delivery to your customer, click on the 
Delivery tab, and check the box for POD. Fill in the needed information. If you 
have the Magaya POD Mobile handheld plug-in activated, the information 
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gathered using the handheld is uploaded to this tab, including the signature of 
the person who received the packages.

• The Local Delivery Agent is the company handling the local delivery at the 
destination.

• The Destination Pickup Address is the address of the location where the 
cargo will be picked up for the final delivery, for example, the airport.

• If you check the POD box, then fill in the Delivery date and time, the name 
of who received the cargo (the person who signed), and any comments 
such as if the packed was left with a neighbor, etc. This information will be 
given to you after the goods are delivered. If the destination agent has 
Magaya, they will enter this information and it will be updated in your 
system.
696



Navigating Shipment Screens Chapter 16
The Events tab shows the events added for the Master and Houses. They will be 
visible in tracking (if online viewing is activated for the LiveTrack user). For 
more details, see the topic “Events.”

For details on the Attachments tab, see the topic "Attachments". Check the box 
to view any attachments from related transactions. You can also drag attach-
ments from a Microsoft Outlook email message into your Magaya Attachments 
screen.

For details on the Notes tab, see the topic "Notes". The Waybill notes tab 
displays container waybill notes if you configured your Magaya system to 
display them: Maintenance > Configuration > Ocean.

If you have added custom fields, they will appear on a custom tab. (Set up 
custom fields in the Maintenance folder in the Configuration subfolder.)

Cargo Status

The icons for the cargo indicate the status of the cargo:

• Yellow is In Process (or Ordered)

• Aqua is On Hand

• Purple is Loaded

• Light Green is In Transit (Dark Green is Arriving)
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• Blue is Delivered

To prevent loading items that are in a “Receiving” location, set the preference in 
Maintenance > WMS.

Status of Shipments:

After the shipment is done and has left your warehouse, you set it as “In 
Transit”. This will update the status in the tracking so your customers can see 
the status.

If you are using an agent who also has Magaya Explorer, they will update the 
status when the cargo is received at destination and when it is delivered. Your 
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system at origin will be updated automatically. Otherwise, you will have to set 
the cargo as “Received” and “Delivered” manually.

The status of the cargo in the shipment will be updated in other places in 
Magaya Explorer that are linked to that shipment such as a Pickup Order or 
Warehouse Receipt that are related to the shipment.
 699



Chapter 16 Shipment Charges
Shipment Charges

Freight charges and other charges for a shipment are entered on the Charges 
tab. If your shipment was created from a previous transaction, the charges 
entered in that transaction such as a WR will be transferred to the Shipment. 
You can also add or edit charges when you create a shipment. If a charge was 
automated, it will appear here. For details on how to automate charges, please 
see the Magaya Software Customization Manual, chapter 2.

Shipment Charges

The Charges tab of a shipment shows the status of Open, Posted, or Paid. The 
description of the charge is shown, if it is a Pre-paid charge (Yes or No), Quan-
tity, and other information is displayed.

• Costs are in red

• Income charges are in green

If using the Routing feature, the charge icons look different than if you are not 
using the Routes.
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Right-click on a charge to view options such as regenerating open charges, 
moving charges up or down to change the order of display in documents, etc.
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When you click on the Add button, a menu pops up:

• Income charges and expense charges are not related to the movement of
the freight. Income examples include documentation and crating fees.

• Expense Freight charges (and Income Freight Charges) include fuel, secu-
rity surcharges, and air freight.
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The following is a screenshot of the dialog box that opens when you add an 
Income Freight Charge for an Ocean Shipment:

Examples of ocean income freight charges include Ocean Freight Service and 
Fuel Surcharge. These are available from the first dropdown menu “Freight 
Service Class”. This dropdown menu is filled from the “Items and Services” List 
(under the Accounting folder); the Type Definition is “Freight” or “Other 
Freight”. Fill in the rest of the information as follows:

• Enter an additional description of the charge (optional). If you enter a
description here, it will appear in the air waybill or BL document instead
of the description of the “Freight Service Class” .

• Select the client to apply the charge to (such as the shipper or consignee).
The Rates button opens the profile for the entity in the “Apply by” field. If
you are working in the Expense Freight Charge, the Rates button will open 
the Rate tab of the Carrier profile.

• Determine if the charge is Pre-paid or Collect and select the appropriate
option from the dropdown menu. (Pre-paid charges are invoiced at
origin. Collect charges are invoiced at destination. Charges for straight
shipments are often Collect because the carrier often handles the collec-
tion at destination instead of an agent handling it.)

• If you check the box to show charges in documents, the charges will show
in operations transactions and shipment documents. The charges will
always appear in bills and invoices even if you do not check this box.

• Allow Automatic Update: To enable automatically update a charge,
check the box. If you make a change to a commodity such as the weight,
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the charge for the new weight will be calculated and updated automati-
cally. Uncheck the box if you do not want this automated.

If you manually enter a rate in this screen, the box will uncheck for “Allow 
automatic update.” If you want to activate the updating feature for the 
manually entered spot rate, check the box again. Then the system will use 
the rate you entered if any changes in weight, etc. occur; it will not revert 
to a saved rate.

• Apply the charges by weight, pieces, volume, or by container. (When you
change how you apply the charge (by weight, pieces, etc.), the totals across
the bottom change. The unshaded fields (yellow) will be multiplied auto-
matically to calculate the total. You only need to fill in the unshaded
fields.) Each method of applying charges is explained below:

– Pieces: Applying charges by pieces will calculate the total based on
the total number of pieces.

– Weight: This is the gross weight of all the pieces in the shipment.

– Volume: The volume of all the pieces added together.

– Chargeable Weight: In Air shipments, the chargeable weight is
calculated based on the volume weight (dimensional weight);
compare the volume weight to the gross weight and use the larger
amount.

• Select the Rate method to use:

– Enter a Rate: Enter a value.

– Enter a Minimum: Enter a minimum amount

– Enter a Maximum: Enter a maximum amount

• Enter the number of pieces and the charge. The total will be calculated
automatically.
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The following screenshot of an Air Freight income charge shows the Chargeable 
Weight:

The Magaya Explorer system will notify you of the chargeable weight amount.

If using Routes, a new tab appears inside the Charges dialog box. Open a Charge 
to view the tab and see what route or segment is associated with the charge.

Generate Transactions for a House

The Charges tab of a House shipment has a “Generate” button that you can use 
to generate the invoices for a House shipment even if the entire consolidation is 
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not ready to be liquidated, or if the consolidation has been liquidated and a new 
House added.

For additional details on working in the Charges tab, see the topic “Charges.” 
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The Shipment Toolbar

The Shipment Toolbar offers many functions. Some of the buttons have an 
arrow on the side that you can click for more options. The following explains 
each of the buttons and what they do:

The Master and House Buttons

Master: This button navigates to the Master shipment when you are in the 
House shipment view. (It is grayed out when you are in the Master.)
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Houses: When you need to add a House to a consolidation, you have two 
options:

• 1) Choose “Create House Shipment” to add a House to a consolidation
that you will enter information into manually, or

• 2) Choose “Create Houses using the Wizard” to use the wizard to add a
house.

This button also enables you to load Houses from the online shipment folder, to 
break the shipment into subshipments, or to regenerate charges.

When regenerating charges, the system will regenerate the charges for all the 
Houses in a consolidation in a batch, i.e., all at once. You don’t need to go one 
by one to each House to do it. You must be in the Master view to do this. Regen-
erating charges is often useful if weight or the number of pieces has changed, or 
when a shipment comes into your system via the Magaya Network and has 
many Houses and you need to add destination charges to it.

Add a Document: This button has two options: 1) Select a document from 
Magaya Explorer such as an Air Waybill, or 2) select “Other Document” which 
is a document from your computer such as an Excel spreadsheet or Word docu-
ment.

To ensure you have the latest documents from Magaya, download them into 
your Magaya system by clicking the “File” button on the top of your software. 
Select “Document Download.” Any document with a star or arrow icon is new. 
If you have custom documents, your Magaya Implementation specialist will 
help you download those and use them. If you have questions, contact Magaya 
Tech Support via Magaya.com .

To print documents, click the Printbutton on the top toolbar and follow the 
prompts in the wizard. See the topic “Print Shipment Documents” for details. 
View and then print attached documents from the Attachments tab.
 708



Chapter 16 The Shipment Toolbar
Profit: Click to see the profit for a consolidation. A list opens with details of all 
the expenses, income, and profit for all the Houses. From the Actions button 
select the columns to view (including related columns), reports, or to export the 
data from your Magaya system.

Liquidation: This liquidates the shipment and creates accounting tasks (see the 
topic on Liquidation).

Transactions: This button has two options: 1) Transactions for Consolidation, 
which is all the accounting transactions related to the Master and House that 
will be summarized in one screen, and 2) Transaction for the Shipment, which 
enables you to edit the accounting transactions. (See the section on viewing 
transactions.)

Send: Send the shipment information and documentation to an agent or other 
in the Magaya Network. This will send the transaction to another Magaya user, 
and they will receive it in their Magaya system, so they do not need to retype any 
shipment information.

Customs: Used for accessing US Customs options. If the button is grayed out, 
contact Magaya Corporation to activate the Customs options such as AES to 
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export goods from the U.S. and to file the EEI. Use this button to file the EEI for 
commodities and vehicles, to see results from the AES system, to connect to the 
customs broker ABI interface, and more functions for imports. See the Magaya 
Software Communications Manual for more.

Commodities: This button has options to show or hide the cargo list, to verify 
the packing list, or to choose the packing list columns. (If you have a scanner 
and the Magaya Bar Coding plug-in activated, scan each item and the list will 
move the items from unverified to verified.)

The Shipment Actions Button

There are many options available from the Actions button:

• Set/Reset as In Transit, as Received, and as Delivered: Use this menu
option to change the status of a shipment. When you set the shipment In
Transit, the cargo has departed from the warehouse, and therefore items
inside that shipment cannot be modified. The status will be updated in the
Shipment List under the Warehousing folder. The Warehouse Receipt list
will also be updated. (These options are for Imports. See the Imports topic
for details.)

• Set as Incoming or as Outgoing: This option changes the direction of a
shipment. “Incoming” is a shipment that your company is receiving
(imports). “Outgoing” is a shipment that your company is sending
(exports).

• Add to a Job: This function is available in the Magaya Supply Chain Solu-
tion. It allows a shipment to be connected to a Job and the progress
updated in the Job screen. Please see the Magaya Supply Chain Solution
Manual.
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• Reception and Release options are for Imports. See the “Imports” topic for 
details.

• Reports: Use this option to create a report for the selected shipment such 
as a report of the cargo by shipper, consignee, etc. The Cargo Manifest 
report option is available here.

• History: You can view the history of all the transactions that are related to 
this shipment. You can go to the document or the transaction (the dialog 
box) for any item listed in the History list. (The History option on the 
Actions button is displayed in bold, indicating this is the default option for 
the Actions button. This means that if you click on the Actions button 
instead of the arrow to select an option, the History screen will appear.)

• Verify Charges: This displays a verification screen of the charges in a ship-
ment in comparison to the rates you have entered into the system. Click 
the “Create” button to create a Charges Correction Advice. This form will 
be available in the document list in the shipment screen. This option is 
commonly used by airlines to verify charges that their customers calculate. 
If there is a difference, the system will alert you.

For Ocean shipments, the Actions button will give you access to ocean carrier 
messages (INTTRA), a Magaya plug-in.
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Cargo Insurance is also available from the Actions button. For information on 
cargo insurance, please see the Magaya Software Communications Manual.
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Repack Cargo

Cargo can be repacked after you add it to a shipment. This topic explains how 
to use the repacking wizard for cargo items including containers. Also covered 
is how to print labels.

Using the Repack Cargo Wizard

To repack cargo within a shipment, click on the shipment in the Shipment 
folder to select it and click on the Repack button on the Cargo Toolbar. A wizard 
opens.

• Select the container type. A “container” can be a pallet, an ocean
container, air container, etc. Pallets are often used in repacking in the
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warehouse while containers are often used when creating ocean ship-
ments. This dropdown menu pulls its definitions from the Package Types 
list (under the Warehousing folder). In Magaya software 9.1 and higher, 
you can select items from different locations to put inside a container.

• Enter the cargo description.

• Enter the container number. (Note: The system can be configured to
require that only valid container numbers be entered. See Configuration
> Ocean.)

• Enter the seal numbers for the container (for ocean shipments only).

• Enter the container dimensions if necessary.

• Click to check the box if you want to add the weight of the contained
pieces to the total weight. Note: This is required when sending informa-
tion to US Customs.

• Select a location in your warehouse where this container is located.

• Add notes as needed and click the Next button to go to the next screen in
the wizard.

• If you want to make more than one package, check the box “Create
multiple packages.” For example, if you receive 1000 pieces but they come
in boxes of 50, this will create 20 boxes in one step. There are two options
for creating multiple packages:

– Create as many as possible - use when you don't have a specific
request from a customer, or

– Create a specific number of packages. Enter the number.
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Click “Next” to go to the next screen in the wizard to select items to repack:

• Select the items you want to include inside the container. The items shown 
in this screen are the ones in the transaction you’re working on.

• Click the Finish button when you are done. The cargo will be repacked. If
you want to add more items to this container after you finish this screen,
you can select the container in the Cargo List and click the Repack button
again.

You can use the Repack option more than once in a WR. For example, if you 
receive 10 items, you can repack 5 items in one pallet and the other 5 items into 
another pallet. The items must be from the same location.

You can also create additional pieces by adding a number in the field for “Addi-
tional pieces.” This is useful if a customer sends you a Sales Order or informa-
tion via EDI in advance of the items physically arriving at your warehouse. If the 
quantity that arrives is different than the information on the EDI, then you can 
add an extra pieces here.
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Handling Containers

Containers can be added to a shipment from the toolbar in the cargo screen of 
a shipment. Click the “Add” button and select the container from the dropdown 
menu in the Commodity dialog box.

The Repack Wizard is available from a shipment: Click the “Repack” button on 
the toolbar of the cargo screen in the shipment. You can repack loose items and 
move them inside a container.

Items from different locations can be placed inside a container.

When using Magaya WMS Mobile, there is an option to repack items from 
different locations. See the Knowledgebase article on partial picks and loads:

Pick and Load with WMS Mobile

http://knowledge.magaya.com/#/article/wms_mobile_release
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Verify Packing List

The software contains a function to verify a packing list. This is used to ensure 
all the correct items are loaded into the correct shipment.

Verify Packing List

To verify a packing list after loading the cargo, click the arrow on the side of the 
Commodities button in the Shipment Toolbar.

Select “Verify Packing List”:
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In the screen the opens, all the items for the shipment appear:

As you scan each item, it is moved automatically from the top half of the screen 
into the verified section.

External tracking numbers can be scanned when loading items into shipments 
(in Magaya software version 10.4 and newer).

If the scanner failed to read a bar code, you can enter the code manually by 
clicking on the “Enter Code” button. A dialog box opens for you to type in the 
bar code number:

Create a report of the items by clicking on the Actions button.
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The Packing List document can be added to a shipment from the “Add Doc.” 
button on the Shipment Toolbar.

The “Summarized” Packing List template will group Part Numbers together to 
make the document easier to read. It can also display Serial Numbers.

You can also show the Locations in a Packing List document by selecting the 
template “Packing List (with Location)”.
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Print Shipment Documents

Magaya software includes a printing wizard to help you print shipment docu-
ments.

Using the Print Wizard

To print shipment documents from the Master or House, click the shipment 
level you want (either Master or House) and click the “Print” button. A wizard 
opens. (This wizard is available in Magaya software version 9.3 and above.)
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Click “Next” and in the next screen, select what you want to print (this example 
shows a Master shipment with the Houses listed):

Click “Next.” In the next screen, you have the option to select a different printer 
for different documents. For example, if one document needs to be sent to the 
Accounting department’s printer and another document needs to be printed in 
the warehouse, click on each document and click “Configure” to select the 
printer.

Click “Print” to begin printing. Note: If a printer is busy, the system will begin 
printing on the first available printer (of those selected).
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Extra Info: To print a watermark in the background, select it from the “Type” 
field.

Print Attachments: To print documents that are in the Attachments tab, go to 
the Attachments tab, select the document and click the “View” button. When 
the document opens, print it.

Note: You can also drag and drop an attachment from your Microsoft Outlook 
email program into the Magaya Attachments screen.

For printing tips, please see the "Air Waybill Printing Tips" article in the Magaya 
Knowledgebase. It also explains how to make a custom paper size and explains 
the differences between the different AWBs:

http://knowledge.magaya.com/#/article/AWB_print_errors

For a list of compatible printers, see:

http://knowledge.magaya.com/#/article/hardware_compatibility_list

Known Shippers

The system has built-in restrictions for printing air shipment documents for 
known shippers.
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To print documents for a known shipper, the shipper's profile must have the 
checkmark that they are a known shipper (on the "Pmt. Terms" tab).

Other conditions that must be met to print documents for known shippers are:

• You must have the Flight Number of the air shipment specified in the
shipment, and
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• if the Flight Number is associated with a passenger flight, it must be check-
marked in the Carrier's profile on the "Airline" tab.

This applies only to air shipments.
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Email Shipment Documents

To email the documents from a shipment, click the Email button on the top 
toolbar.

In the dialog box that opens, you can view the shipment and what will be sent 
by clicking the “.htm” link. When that screen opens, the email recipient can 
click on a document to view it.

To add other documents, click the plus sign.
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You can also send documents from one Magaya system to another by clicking 
the “Send” button. This opens a dialog box to select an other Magaya customer 
such as a destination agent.
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Liquidation

Liquidation is the process that creates all your Accounts Receivables, Accounts 
Payables, and transactions related to a shipment or consolidation in one step.

Liquidation Steps

To liquidate a shipment follow these steps:

1) Click on the Liquidation button on the Shipment Toolbar.

A list opens, displaying a summary of income and expenses. These are the 
charges from the Charges tab.

2) Click “Generate.”

3) Review the items in the confirmation screen, and click “OK” when ready.
Optional: You can change the date (if you have permissions/role).

Liquidate House Charges:

To liquidate charges for a House separate from the whole consolidation, click 
the “Generate” button on the Charges tab for the House.
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Totals are displayed at the bottom. The set of buttons on the side of the list gives 
you the ability to configure the liquidation set up, to generate the transactions, 
and to update and filter the list.

The default columns in the Liquidation screen are:

• Waybill number (the air waybill or ocean/ground bill of lading number)

• Customer name

• Description of the fee

• Cost Pre-Paid (PP): Cost invoiced at origin

• Cost Collect (Coll): Cost invoiced at destination

• Income Pre-Paid (Inc. PP): Income invoiced at origin

• Income Collect (Inc. Coll.): Income invoiced at destination

• Gross Profit is the (Income Pre-Paid + Income Collect) - (Cost Pre-Paid + 
Cost Collect)

• Agent Name: Set their currency preference by activating the option in the 
Configuration menu and then set it in the Agent’s profile on the Payment 
Terms tab

• Agent Participation: This column shows the rule or formula such as 50% 
that is used to calculate the agent participation per charge (per itemized 
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line). Not all charges will show an agent participation; normally only the 
freight charges are shared with an agent.

• Agent Profit: The amount that goes to the agent per charge type.

• Your Profit: The amount that your company is making per charge after 
subtracting agent and salesperson’s commissions.

• Balance: The amount that the agent owes you per charge. If the amount is 
a negative amount, then you owe the agent that amount.

As with any list, you can choose the columns and rearrange the order of them 
by using the Actions button. Options include adding a salesperson and cargo 
dimensions. In the “Choose Columns” dialog box, you can also select columns 
from related transactions.

Each line in the Liquidation list itemizes the details of the charges for each 
House, showing the income amount and the prorated amount.

The following screenshot highlights the section of the Liquidation list that 
shows the House air waybills, customer name, fee description and costs:

• In this example there are two Houses (HAWB11with four charges and 
HAWB12 with three charges). All the Costs are Pre-paid.
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The following screenshot highlights the income for the Houses:

• The Income charges are Collect for HAWB11, and for HAWB12 the
Income charges are Pre-paid.

Also see the sections on Agent Participation and how to configure your system 
to generate the charges for the liquidation.

Agent Participation

The following screenshot highlights the agent’s participation and profit, and 
your profit and the balance itemized per line of what the agent owes you. (A 
negative signs means that you owe the agent):
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In this example we are sharing 50% of the air freight gross profit with our agent 
for both Houses.

The profit sharing for an agent can also be set in the Forwarding Agent’s profile 
(in the Maintenance folder). Click the Participation tab. Click “Add” and select 
the type of participation, either for a shipment or other charges.

The participation can be set as a percent, a flat value, or amount per weight, 
volume, or piece by selecting from the “Type” dropdown menu in the Participa-
tion dialog box:

• To calculate the participation by weight, multiply the dollar amount (for 
example $1.50) by the weight; the formula you enter on the line would be: 
1.50*W. (Enter an asterisk (*) for the multiplication function.) Weight is 
in pounds (lb).
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• To calculate the participation by volume (for the above example), enter 
the formula: 15*V. Volume is in cubic feet (ft3).

• To calculate the participation by pieces (for the same example), enter the 
formula: 15*P.

To add a Shipment Participation for an agent, select the “Shipment Participa-
tion” option from the Add button’s pop-up menu.

Select the options you want for the type of participation, the value, and which 
shipping transactions to apply it to.

To set a preferred currency for an agent, activate the option in Maintenance > 
Configuration > Accounting, and then set the currency in the agent’s profile on 
the Payment Terms tab.

In the Shipment Liquidation Screen: To modify an agent’s profit sharing for 
the shipment in the Liquidation list, click on the cell in the table and enter the 
number and the percent symbol. After you enter the formula, the amount will 
be calculated by the system and appear in the column.

The totals on the bottom of the screen show:

• Cost: Pre-Paid and Collect

• Income: Pre-Paid and Collect
 732



Chapter 16 Liquidation
• Gross Profit: subtract costs from income

• Salesman Profit (the person who brings you the customer; to set up, go to
Maintenance and the Salesperson’s profile)

• Agent Profit (To set up the Agent’s profit sharing, go to the Maintenance
folder and edit the agent’s profile in Forwarding Agents.)

• Your Profit

• Your Agent Owes You/You Owe Your Agent: The correct one will appear,
determined based on if the amount is pre-paid or collect.

The profit of the agent on the bottom of the screen will be calculated by the 
amounts on the line items. If the agent collects all the fees at the destination, 
your agent will owe you and the system will generate an invoice for the agent. 
(If the destination agent enters all the charges when they create an import ship-
ment, then they enter “100%” in the Agent Participation column for charges 
that were pre-paid at origin. For more on imports, see the topic "Imports".)

If you collect more money at the origin and have to pay the agent, the system 
will create a credit memo. In the example, there is a combination of Pre-paid 
and Collect Houses. The system will calculate to create an invoice or a credit 
memo for the agent. These accounting transactions will appear in the Transac-
tions list after you generate the charges.

The Liquidation is the place to catch any billing errors. If one line item shows a 
negative profit, verify two things: 1) if the amount was incorporated into a cost 
charge (if it is too high), or 2) if you are charging the correct amount.

Set Agent Participation System-wide:

In Magaya software versions prior to 9.8, it was necessary to assign the 
percentage to all possible charge definitions that could be added to a shipment. 
In Magaya software version 9.8 and higher, it can be defined in the Configura-
tion menu:
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Go to Configuration > Accounting > Main tab: Click the "Incoming" and/or 
"Outgoing" buttons for "Configure Liquidation Options." In the dialog box, 
check the box for Agent shipment participation and enter a percent.

The percentages set here will be calculated automatically when you liquidate a 
shipment. Note: This same configuration option is also available per shipment 
by clicking the “Configure” button in the Liquidation screen. The percent 
applies to all the line items in the Liquidation screen. Any line can be edited by 
typing over a number in a column.

Configure how the Liquidation is Generated

The system will generate an invoice for the agent (if they owe you) or credit 
memo (if you owe) for the agent. That transaction will appear in the Accounting 
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folder and the Transaction List, not here in the Liquidation list because it is the 
result of the liquidation. All other accounting transactions will be created when 
you click the Generate button.

To generate transactions, click on the Generate button. A dialog box will open, 
listing the accounting transactions. Verify them and click the OK button, or 
cancel to make corrections. Charges included in the generated transactions will 
change from “open” to “posted” after liquidation.

The Update button will update (reset) the profit sharing information from the 
Maintenance folder for agents to reflect the amounts preset in the system. If you 
make changes in the Maintenance folder, the system will recalculate based on 
the new information by clicking the Update button.

To create reports based on the liquidation, click the Actions button and select 
the option to create a report by waybill number or by shipment name. These are 
the reports you can send to your destination agent, so the agent can see the 
results of the liquidation.

Also see the topic “Using the Shipment List” for more on reports and choosing 
columns for information such as liquidation costs prepaid and collect.

To configure how the transactions will be generated in the Liquidation for this 
shipment, click the Configure button on the right side of the Liquidation 
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screen. A dialog box opens. The system sets the defaults to this shipment as 
shown in the dialog box. Make changes as appropriate to your business.

See also the Maintenance folder > Configuration > Accounting for setting 
incoming and outgoing liquidation options system-wide.

Invoices generated will go to the Accounts Receivable account selected here in 
this Configure screen. Bills generated will be assigned to the Accounts Payable 
account that is set up in this screen.

The Salesperson’s commission will be generated and the item on the bill will 
show as “Sales Commission”. The commission can be set here, in their profile, 
or system-wide in the Configuration menu.

The Agent Profit Income Item will be assigned as “Agent profit share” in the 
invoice and summarized in the invoice. You can choose to expand the itemiza-
tion. (You can summarize here and send a detailed report.)
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The system checks by default the option to “Use destination agent for collec-
tions.” The agent will collect the money at the destination for consolidated ship-
ments, and the system will not generate invoices for charges that are collect; it 
will summarize all these charges in an invoice for the agent. If you do not have 
this checked, the system will create invoices for all charges (pre-paid and 
collect), and there would be no invoice for the agent in this case. In the case of a 
straight shipment, the carrier acts as a collection agent and collects the charges 
for you. If the charges are collect, the system will create a Bill Credit for the 
carrier with the amount they owe you.

The system also checks by default the option to “Show detail in generated trans-
actions.” The system will show all the line items from the liquidation and place 
them in the invoice. You can also group the charges, for example to show all the 
ocean freight for the Houses will be grouped on one line.

The option to “Generate Agent’s Commissions as Expenses” does not have a 
check in the box (it is off by default). If it is off, the amounts that will appear in 
the invoices generated will be less than the amount than if this is on. If it is off, 
the income will have the agent amount already subtracted. If it is on, you will 
have the whole income and the commission will be on a separate line on the 
invoice.

Profit Calculation Order: Agent participation can be calculated at the same 
time as the salesperson, or after the sales commission is taken out.

Generate One Transaction per Entity per Consolidation: The system will 
group all the transactions for the same entity under one transaction, such as 
more than one House for the same customer.

Agent (or Salesman) shipment participation: Check the box and enter a 
percent for this shipment.

Split Taxed and Non-Taxed Transactions: This will separate taxed from 
non-taxed transactions, even if they belong to the same entity.

The date for the transactions can be set to today, the creation date, the departure 
date, or the arrival date.

When an outgoing shipment has been liquidated, a red checkmark will appear 
on the General tab:

Adding, deleting, cutting or pasting of House shipments from a liquidated 
master shipment can only be done by an administrator.
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View Accounting Transactions

To view all accounting transactions, click on the arrow on the side of the Trans-
actionsbutton on the Shipment Toolbar. The Transaction button has two 
options: to view the transactions from the shipment or from a consolidation.

If you select to view the transactions for a consolidation, a summary will be 
displayed. You will not be able to edit any transactions in this summary.

This list shown here is for a shipment (not all of these options will be available 
in the consolidation view). In the shipment list, you can add, edit or delete trans-
actions. You can right-click on a transaction and select from the menu:

• To view one of the documents, select “Go to the document”.

• Select “Link Invoice” or “Link Bill” to link a previously created invoice or
bill to this shipment. A dialog box will open, showing a list of transactions
to choose from.

• Select “Pay Bill” to write a check to pay the highlighted bill. A dialog box
opens with all the information for the check.

• Other options enable you to choose the columns in this list, to export the
data, or view the history of that transaction.

• In this screen you can also add transactions by clicking on the Add button.
For example you can add another invoice and it will be related to this ship-
ment. It will get the information from the shipment you are working on
and the invoice will appear directly in Accounting as Posted. (If you create
the invoice in the Invoices List, you will have to link it from there.)
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These same options are available from the Actions button. (The options in the 
Actions button menu vary depending on the shipment’s mode of transporta-
tion.)

View Customer Statement: To view a customer’s statement with shipment 
details, go to the Customer List in Maintenance and right-click on the customer 
name and select the statement you want.
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The Cargo Shipment Toolbar

The Cargo Toolbar enables you to work with the cargo in your shipment. At the 
House level, you will see the cargo for that House; at the Master level, you will 
see the consolidation of the cargo for all Houses.

For any item listed, you can double-click it to open it and view details.

If there is a container in the list and loose cargo items that you want inside the 
container, just click and drag the items into the container.

To copy a commodity in this list, right-click the commodity and select “Add 
Copies.”
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In the dialog box that opens, enter the number of copies you want.

To change the columns in the Cargo List, click on the Commodities button in 
the Shipment Toolbar and select “Choose Packing List Columns.”

Loading Cargo in a Shipment

Cargo can be loaded into a shipment transaction from the Cargo Toolbar. Let’s 
look at the following buttons and their functions:

The “Load” button opens different screens, depending on the software you 
have.

• Load: This opens another screen to load cargo into the House you have
selected, not at the Master level:

To load items, select them from the list view you want such as Warehouse, 
Pickup, Inventory, etc.

• Add: Use this to add cargo that does not have a Warehouse Receipt (to add 
on the fly). The Commodities screen opens. See the topic “Commodities.”
Cargo from different locations can be added into containers only.
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• Unload: To remove cargo from this House and place it back in the ware-
house in “On Hand” status (if it was part of a Warehouse Receipt).

• Repack: See the “Repack Cargo” section.

• Unpack: To move some items out of the container. The items will remain
in the House. If you click the Unpack button when you have a container
selected, all the items in that container will be unpacked. If you click on an
item, only that item will be unpacked from the container.

• Edit: To make changes.

• Mark All and Unmark All: Use these to select or unselect all items.

Cargo Status

The icons for the cargo indicate the status of the cargo:

• Yellow is In Process (or Ordered)

• Aqua is On Hand

• Purple is Loaded

• Light Green is In Transit (Dark Green is Arriving)

• Blue is Delivered
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To prevent loading items that are in a “Receiving” location, set the preference in 
Maintenance > WMS.
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Using the Shipment List

How to View Shipments in your Magaya System

This topic explains the different places you can view shipment information in 
your Magaya system.

Shipment List

What is the Shipment List? The Shipment List shows all the shipments your 
company has handled. A Magaya user with administrative rights can give or 
restrict access to the Shipment List by selecting the list and clicking “File > 
Permissions” (and in Maintenance > Employees list).
744



Using the Shipment List Chapter 16
The Shipment List is located under the Warehousing folder in Magaya Explorer. 
(This screenshot shows the Magaya Cargo System’s Warehousing folder; your 
view may differ depending on the software you are using and your permissions.)

Use the Filter button to display only those shipments you want to see or click 
the “Detail” button to view shipment details.
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There are many options in the Detail panel; explore to see what helps you:

As with all lists in Magaya Explorer, you can rearrange the columns and select 
which columns you want to see by using the Actions button. Column options 
include costs, profits, status of AES or AMS, master waybill numbers, 
subhouses, etc. You can also import and export the data in and out of Magaya 
Explorer.

To send a batch of email messages, select multiple shipments from the list by 
holding down the “Shift” key. Then click the Email button on the top toolbar. 
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Select the option “Send Batch Email”. The email template dialog box will open. 
Fill in the fields to send the messages.

To change the status of more than one shipment at a time, select multiple ship-
ments by holding down the Shift key and right-click. In the pop-up menu, select 
the transit status you want. It is best to sort the list first by using the Filter 
button: Select to view all Houses or all Masters (do not mix them to avoid dupli-
cation) and also select the direction (either outgoing or incoming). Then select 
the shipments you want to change the status as a group.

Using the Actions button offers the following options:

• Create Reports: There are two report options available: To create a Ship-
ment report or a Container report. You can create reports in the Shipment 
List that will group all the shipments together to see how much cargo you 
are moving to one port or for one consignee, etc. (In contrast, the reports 
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you create from a shipment itself will only show information about the 
cargo on that shipment.)

Containers Reports will show the items created as containers, either by 
using the “Add Container” button in Warehouse Receipts or the Repack 
button in the Cargo Toolbar for the Shipment.

• View Transactions: You can view the transaction listing for any ship-
ment. Select the transaction and then use the Actions button to select
Transaction Listing. (Shortcut: Click on the View button or double-click
on the transaction.) The Shipment List is also available for others to view
shipments such as warehouse staff who need to know what shipments are
arriving. (Due to permissions access restrictions, some employees will
only be able to view shipment transactions here because they may not have 
access to the shipment folders.)

• View Statistics: You can see the total quantity of shipments and of pieces,
the total weight, volume, and volume weight. The statistics will show you
the totals of what you have filtered. You can use this to see if the total
weight of a shipment will fit inside a container, etc.
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• Exclude from Tracking: This option is useful if a transaction is not
complete and you do not want it to be visible through any tracking offered
in the Magaya Explorer.

• Choose Columns: The Actions button includes the “Choose Columns”
options, where there are many columns such as those related to liquida-
tion of shipments, as well as other information you may want to see.

Remember: After you select columns, you can save the view of the list by 
clicking the star button on the top of the list (on the right).

One of the column options is to view the subhouses (after splitting a ship-
ment):

• Go to Folder: You can select a shipment and then go to the folder for it
and view it. Click the Back button to return to the Shipment List.
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• View History: You can view the history for any transaction by selecting it
and using the Actions button.

When you use the Filter button in the Shipment List and select the Standard 
Filter, be sure to choose either Master or House to filter. Otherwise, if you select 
“any”, the list produced will show both (piece counts, weight, and volume will 
be duplicated).

Work Load Folder

The Work Load list shows shipments that need to be loaded or are being loaded 
now. Go to Warehousing > Work Load.

Note: Your view of this folder may differ from this screenshot depending on the 
software you are using and your permissions.

The Work Load list is useful for warehouse staff and others who need to see 
what shipments are to be loaded that day.

Permissions:

Set employee permissions to this folder in the Maintenance folder > Employees. 
Select the folder and click “File > Permissions” to adjust access to this folder.

After the shipment is loaded and the status changed to In Transit, the shipment 
will not appear in the Work Load subfolder.
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In Transit Folder

The “In Transit” subfolder shows what is coming into the warehouse. Go to 
Warehousing folder > In Transit.

The In Transit subfolder is useful for warehouse staff and others who need to 
see what shipments are arriving that day.

Permissions:

Set employee permissions to this folder in the Maintenance folder > Employees. 
Select the folder and click “File > Permissions” to adjust access to this folder.

After the shipment arrives and been unloaded, the status changes in Magaya 
Explorer and the shipment does not display in the In Transit subfolder.
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Outgoing and Incoming Shipment Folders

Your Outgoing Shipment folder shows all the shipments going out of your 
system. The Incoming Shipments folder shows all shipments coming in. This 
image highlights the master and house folders.

Learn more about the folders and navigating the shipment screens in this 
Knowledgebase article:

http://knowledge.magaya.com/#/article/navigating_shipment_screens

Online Shipping

Your customers can use LiveTrack to send you shipping instructions online. 
Learn more in this Knowledgebase article:

http://knowledge.magaya.com/#/article/online_shipping_orders_intro
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Import Shipments

Introduction to Creating Import Shipments

Magaya Explorer provides wizards to help you process import shipments. The 
screens for import and export shipments are the same in the wizards for air, 
ocean, and ground shipments.

If the origin agent used Magaya Explorer to create the import shipment, then 
the shipment data will be sent to the destination agent via the Magaya Network. 
Then you will begin with Step 2 below. If the origin agent did not use Magaya 
Network, then begin with Step 1.

After Step 2, the operations procedures are the same whether the shipment was 
created in Magaya Explorer at origin or not.

Overview of Steps:

The following is an overview of the steps of creating and processing incoming 
shipments (imports):

1) Create an Import Shipment in Magaya Explorer using the wizard and
enter shipment data. (This step is not necessary if the shipment was
created by the agent at origin and sent to you via the Magaya Network.)

2) Liquidate the shipment to generate invoices and bills.

3) Perform the Reception process, which creates Warehouse Receipts.

4) Create Arrival Notices for customers.

5) Release cargo for final delivery.

The following sections provide details on each of these operations and liquida-
tion steps.

Note: For import regulations such as filing a manifest or Air waybill with US 
Customs, using the AMS or ISF systems, see the Magaya Software Communica-
tions Manual.

Drop Shipping: For deatils on creating drop shipments, please see the section 
“Drop Shipping.”
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1. Create an Import Shipment

This example shows an Air Consolidation. It is explained from the point of view 
of a freight forwarder in the US receiving goods. The steps are the same for 
Ocean and Ground imports.

1) Click on the arrow on the Air Shipment button and select the option
needed:

The import wizard opens. The first screen contains fields for general ship-
ment information such as the shipment name (filled in automatically), the 
carrier, the place and date that the incoming shipment transaction is being 
entered in the Magaya Explorer, and general information about the goods 
that are arriving.

The destination agent will need to create an incoming shipment if the 
origin agent did not use Magaya Explorer to transmit the shipment data 
electronically to the destination agent.

Magaya Corporation encourages importers to involve their agents at 
origin to prepare their shipments using Magaya Explorer and to send 
them electronically via the Magaya Network. This will reduce data entry 
time by about 70% in comparison to creating the import shipment from 
scratch at destination.
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2) Enter the shipment information in the General screen of the import
wizard:

• The “Executed Place” is the location of the destination.

• All the fields are the same as in the exporting wizard.
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3) Enter the shipper and consignee information in the Entities tab for the 
Master:

In the case of an import consolidation, your company is the destination 
agent and the consignee at the Master level.

All the fields are the same as in the exporting wizard. 
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4) Enter the routing information in the Routing tab:

All the fields are the same as in the exporting wizard. See the topic “Create 
Shipments”.
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5) Select the documents needed for the Master:

• You will normally receive the documents from the agent at origin
either in the mail or electronically through the Magaya Network. If
you need to have a copy of the documents in the system for refer-
ence, you can select the cargo manifest and air waybill for example.

• If you need to file the AWB with US Customs, do this after you finish 
the wizard. All the data from the wizard will be transferred into the
Magaya shipment screens. Use the Customs button on the Shipment 
Toolbar to file the documenation. See the Magaya Software Commu-
nications Manual for more.
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6) Select the cargo that will arrive in this import shipment. If you don’t have 
the cargo, skip this screen:

There are two options for selecting cargo:

• Option 1: Select the cargo from a Warehouse Receipt (WR) if you 
have already received the cargo information and made WRs for it,

or
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• Option 2: Add a number in the blank field to create “Additional 
House Shipments” (if you have not received the cargo information 
yet).

In this example, the screenshot shows the number “2” typed into the field 
to create two additional house shipments. You can add cargo after 
finishing the wizard by using the buttons on the Cargo Toolbar in the 
Magaya shipment screen.

7) Check the box to repack the cargo if needed. You can skip this screen if 
you don’t have the cargo to repack.

For details on how to repack, see the topic “Repack Cargo.”
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8) Select the documents needed for each House:

The Houses need Arrival Notices. (If you do not create them here, you can 
add them later.) You can also add any other document that you want to 
send to the customer or to keep in the system for reference.

Import shipments may also need a Destination Order, which can be 
selected here. If you don’t need to create any documents, skip this screen. 
You can scan and attach any document related to the shipment after 
completing the wizard.
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9) Save the incoming shipment transaction in a folder in Magaya Explorer:

10) Verify the shipment data in the summary screen:
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• Click the Finish button when you are done.

The shipment data will be transferred into the shipment folder and 
displayed in Magaya Explorer:

Click on the Actions button and set the cargo “In Transit”. This will 
update the status of the shipment and begin the next part of the process - 
entering shipment data.

To add cargo, click the “Add” button on the Cargo Toolbar. To expand the 
panels, click and drag the line between the panels. To view documents, 
click on a document.

Enter Shipment Data in Houses:

Next you will need to enter the Shipper, Consignee, charges, and cargo informa-
tion for each House. (This step will not need to be done if the shipment was 
created and sent via Magaya Network.)
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The following instructions will explain the procedure for one house, but this will 
need to be done for all the houses.

1) In the Shipment folder for the import, go to the Cargo List.

If you did not have a Warehouse Receipt for the cargo, then the Cargo List
will display a note “Double-click to enter cargo” for each House:

2) Double-click on the line in the Cargo List. The Commodities dialog box
opens.
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3) Enter information such as the commodity description and dimensions:

For information on how to use the Commodities dialog box, see the topic 
“Commodities”.

4) Add charges to the shipment.

If the origin agent did not send the shipment through the Magaya
Network, the destination agent will need to enter all the charges to create
the accounting transactions. The destination agent may add any charges
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related to the deconsolidation of the cargo, to repacking, and for delivery 
of the cargo to the final consignee.

Enter the charges in the Charges tab of the shipment:

For details on how to enter charges, see the topic “Charges”.

2. Liquidate the Shipment

Liquidating the import shipment will generate all the accounting transactions 
related to the incoming shipment.

The destination agent needs to create invoices that are collect so the amount due 
can be collected from the customer before pickup or delivery of the items.

Prepaid invoices are usually not created by the destination agent.

Click on the Liquidation button on the Shipment Toolbar. A list opens, 
displaying a summary of income and expenses. These are the charges from the 
Charges tab.

For information on the Liquidation screen, an explanation of the columns, and 
how to work with the buttons, see the topic “Liquidation”.

When liquidating the import, remember:
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• Cost Pre-Paid (PP): Cost paid at origin

• Cost Collect (Coll): Cost paid at destination

• Income Pre-Paid (Inc. PP): Income invoiced at origin

• Income Collect (Inc. Coll.): Income invoiced at destination

When liquidating an export, you generate the prepaid charges at origin, and 
collect charges will be settled with the destination agent. Liquidating an import 
is the reverse: You invoice the collect charges at destination, and the prepaid 
charges are settled with the origin agent.

When you click the Generate button, the accounting transactions are created. 
Invoices and bills will be created for charges that are collect.

3. Perform Reception Process

The Reception process is done as the shipment arrives at the destination. It 
prepares the cargo information for the warehouse and creates the Warehouse 
Receipts (WR) with all the information related to the shipment automatically 
filled into the WRs.

You can also let your customers know their cargo arrived by sending them an 
email message: For example, send a tracking link to each House customer.

Another advantage of receiving the shipment electronically via the Magaya 
Network is the ability to have documentation ready to meet customs regulations 
for imports which can start before cargo arrives at its destination.

1) Click on the Master, then click on the Actions button arrow to select “Recep-
tion”. (The shipment transaction must have a status of “In Transit”. If the
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“Reception” menu option is grayed out, verify the shipment status.) When you 
click “Reception,” a dialog box opens:

• 2) Select the cargo you are receiving. You can select all the cargo or partial.
You can also select a location in the warehouse to place the cargo. If you
always receive cargo at the same door, select the Default Location. (Extra
Info: To setup a default receiving location, go to Warehousing > Locations
and right-click on a receiving location.)

• Option: Click on the checkbox to use the shipment waybill number as the
Warehouse Receipt number.

• Click the Receive button, and click Yes on the next dialog box. This
changes the status of the shipment to “On Hand”.

The Reception process copies information from the incoming house ship-
ments and places it in the Warehouse Receipts that are created. Informa-
tion copied includes the mode of transport, the ports of origin and
destination, and the freight forwarder.

The status of the cargo is updated automatically at origin in Magaya Explorer if 
the shipment was received via Magaya Network.

Other options in the Reception screen:
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• The “Unpack” button is for a container. You can select a container and
unpack it, and then create a WR for the items inside the container,
excluding the container.

• The “Undo” button will roll back the reception steps so you can make a
change.

• To view the Warehouse Receipt, click on the “Go To WHR” button.

If you want to configure your system to send Transaction Tracking email 
messages automatically to the customer for each WR that is created during the 
Reception process, see Maintenance > Configuration > Transaction Tracking 
and check the appropriate box.

4. Create Arrival Notices

An Arrival Notice is the document that you send to the customer to let them 
know their cargo is here and what fees they need to pay to pick it up (or for 
delivery).

If you did not create Arrival Notices in the shipment, add them now. (If they 
were not created at origin and sent to you, then you will need to create them for 
each house.)

1) Click the “Add Doc.” button on the Shipment Toolbar (if you click on the
arrow on the button, select “Document...”):

A screen opens with a list of documents. This screen is the same as the one 
in the wizard.

2) Select the documents you need by clicking in the box beside the name of
the cargo item.

3) Click the OK button. The document is added to your shipment with all the 
information related to this shipment.

To view the document, click on the document name in the shipment
folder on the left side of the Magaya Explorer screen.

After creating the Arrival Notices, the pickup or delivery will need to be 
arranged.
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If you want the invoice number to appear in the Arrival Notice (after liquida-
tion), right-click on the document in the shipment folder and select “Reload 
data”.
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5. Release Cargo for Final Delivery

To release the cargo to its final destination, use the Actions button in the Ship-
ment screen. (This process can also be performed in the Warehousing folder by 
using the Cargo Release function.)

1) Select the House, and click on the Actions button and select “Release”. A
dialog box opens.

The Shipment Release dialog box displays the cargo information and gives 
you the options to release the cargo, unpack the cargo, and more.
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2) Select the cargo to release, and click the Release button. The system creates 
a Cargo Release document for the items in the selected house.

When you create the Cargo Release, the status of the items changes to
“Loaded”. When the cargo is loaded into the truck for delivery, set the
cargo status as “In Transit” by going to the Actions button and selecting
the “In Transit” option. When it is delivered, set it to “Delivered” via the
Actions button.

This will update the Magaya system at origin, showing the cargo as Deliv-
ered if the shipment was sent via the Magaya Network.

3) The Import Shipment is now complete.
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Multimodal Routes and Segments

Overview

The Route Management feature helps with the pricing of multimodal ship-
ments. It is useful for logistics providers who arrange shipments consisting of 
different forms of transport and need to find the most cost-effective route from 
shipper to consignee.

Multimodal shipments are the transportation of goods under a single contract 
but performed with at least two different forms of transport. With this feature, 
you can add different carriers for the same segments and compare rates.

Benefits: Creating a shipment with a route saves time because all the details of a 
route are filled into the shipment Routing tab and the Charges tab for you.

Routes and Route Segments are located in the Rates folder. It is recommended 
that you add rates into your Magaya system so you can select them for the 
segments.

A “Route Segment (or Segment)” is a leg of a multimodal shipment, with one 
point of origin and one destination, by one carrier and one mode of transport.

A “Route” is a combination of different segments that represent one multimodal 
shipment option.

When you create routes, the system follows the guidelines below to create 
different routes with the same origin and destination but different rates with 
different modes of transports. The system always applies the appropriate rate.

• Routes could have an assigned mode of transport

• The Sale rate created from a route will have the mode of transport of the
route

• When a route is selected for a shipment, it will copy the mode of transport
to it
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• Charges on shipments will find best-matched rates for the origin/destina-
tion/mode of transport

Create Segments

A “Route Segment (or Segment)” is a leg of a multimodal shipment, with one 
point of origin and one destination, by one carrier and one mode of transport.

To add a segment, click the “Add” button.

On the first tab of the Route Segment dialog box enter general information 
about the segment. The “Name” field is name of the segment. It is recom-
mended that the name include information to help distinguish it from other 
segments. This example name shows the origin, destination and carrier.

In the “Transportation Information” section of the screen, select details of the 
exporting carrier.

Cost:
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On the Cost tab, click the “Add” button. Select a cost from the dropdown.

These costs are pulled from your existing Items & Services list. Add a new one 
as needed.

Freight charges: The system pulls from existing freight charges. If no rate is 
found, click the “Option” button and select “Create Rate.” You can also query 
existing rates.

Non-freight charges can be selected and prices set using the “Set Tariff” button. 
Only use the Tariff button for charges that do not depend on origin and desti-
nation.

Note: When you create a shipment that uses this segment, the system will apply 
the cost to the Master in shipments.

Sale:

Sale is the income for this segment. Sales charges apply to the Houses in ship-
ments. Tip: It is more common to only add the costs to the segment and leave 
this tab blank because you are selling the whole route, not just a segment. But 
you can add sales here so the charge is not forgotten when creating a shipment.

The Routes tab shows the routes that include this segment.

Extra Info: You can add different carriers for the same segments and compare 
rates. You can also use a segment in different routes.

If you want to disable a route segment so it is not available for users to select, 
uncheck the “Enabled” checkbox on the screen. This will save the data but deac-
tivate it.
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Create Routes

A “Route” is a combination of different segments that represent one multimodal 
shipment option.

Click the “Add” button to add a Route.

Enter a name for the route. Select a name that will distinguish this route from 
others.

The "Main Segment Information” section of the Route tab is for the exporting 
carrier. This is the carrier that will appear on the Bill of Lading or the Air 
Waybill. If the Route has additional segments before and after this main carrier, 
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do not select those as the ports here. Even if your Route name includes those 
other cities, do not select them in these dropdown menus.

The system calculates transit time of all the segments in the route, but it can be 
overridden as needed.

Add Segments to the Route:

Click “Add” and select the segments for this route.

When adding the segments, ensure to order them to connect each segment in 
logical order. The system flags any segment out of order. The starting point of 
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the next segment must be the ending point of the previous segment. A green line 
means the order is logical; the red line indicates an error.

Note: When a segment is included in a route, the segment cannot be edited. To 
make any changes to a segment, delete it from the route first.

Cost:

Add costs for the overall route, including freight, agent cost, and documenta-
tion cost for the whole route. Cost charges are applied to Master in shipments. 
Use the “Options” button to query rates, create a rate, or show segment charges.

Sale:

Sale is income for the route. Sales charges apply to the Houses in shipments.

Use the “Options” button to “Create Sales Rate from Costs.” A wizard opens:

This is the Multiple Rates wizard, which is used to create multiple rates when 
you are working in your Standards Client Rates list and other rates lists.

This wizard pulls all the charges from the segments so you can create an 
“all-in-one” rate that you want to sell. This means the rate will show one price 
on one line in the shipment transaction. Let’s go through the fields on the first 
screen:

• The Resale Item is pulled from the route you were working with.

• The Commodity Type field is optional.
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• The Effective Date and Expiration Date fields are used to set the date that
you want this rate to take effect. The dates set here will override other
dates in your Rates list for this same route (if one exists).

• Select the charges that are shown in the screen that you want to add.
Include as many or few as you want. To create an “all in one” rate, click
them all.

• Modify the cost rates by applying a markup such as a percent. Then the
system will calculate the selling price for you.

Follow the prompts in the remaining screens of the wizard. The wizard gener-
ates the rates for you and saves them.

Extra Info: This wizard contains functions that are the same as those for creating 
multiple rates. If you want more details on the wizard, it is explained in more 
detail in the Magaya Software Customization Manual, Chapter 2.
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Use Routes in Shipments

When you select a route ina shipment, all the route details are filled in, including 
transfers and charges.

Routes can also be used when creating a booking, which can later be converted 
into a shipment.

Choose the Route in the Routing tab when creating a shipment transaction.

The route details automatically populate the fields in the Routing tab, saving 
data entry and time.

If you have existing charges that are automated to appear in a shipment trans-
action, the system will override this automation and use the segment charges. 
Charges do not appear until cargo is added. When the system uses charges from 
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a Route or Segment, the icon for the charge indicates that the charge is from the 
route.

Create the rest of the shipment as you normally would.

Reports:

Reports can be created from the Routes screen. Right-click (or click the Actions 
button), and select report:
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• “Summary of Cost Rates per Route” - used for your information about
your costs

• “Summary of Sales Rates per Route” - for agents agents at origin so they
can see the rates and help them to sell the routes and for your customers
to help them choose the route that is best for them.

In the report, click on any charge to view its details. As with all reports, you can 
configure the columns, save it, print it or email it. Other reports can be made by 
origin, destination, carrier, etc.
 783



Chapter 17

 784

Appendix



Chapter 18 Kits
Kits

Introduction

What are kits? Kits are logical groupings of items such as tables and chairs to 
make a dining set that can be shipped together in one box or in separate boxes. 
A kit can be added as a regular part number on Sales Orders and Commerce 
Quotations.

Create a Kit

To create a kit in your Magaya system, follow these steps:

1) Go to Inventory Item Definitions, click Add and select "Add Kit Item".

2) Enter general information on the first screen in the dialog box such as the part 
number, description and model name or number.
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If this item is for one customer, select them from the dropdown menu. To sell 
this kit to all your customers, leave this field blank.

3) Enter the sales price for the kit (if you sell it): Use this field to set a price
different from the totals of the individual items such as a discount. If you leave
this field blank, the system will calculate the kit price based on the price of each
item in the kit.
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4) Click “Next.” In the next screen, click “Add” to add items to the kit and the
quantity of each item.

When selecting an item, the system pulls from your list of existing Inventory 
Item Definitions. Add new ones in the dropdown menu if needed.

Checkboxes:

• Add kit items ungrouped on Sales Orders: By checking this, the individual
items will be added to a Sales Order, not the kit. This can speed up the
selection of individual items on SO. When this is checked, the second
checkbox is grayed out.

• Display kit items in documents: By checking this, the kit's items will
display by default in the Sales Order document and be visible to the end
customer when tracking orders online.

View Kits in the Inventory Item Definitions List:

To view kits or items inside (the Bill of Materials), click the “Details” button and 
select the panel option from the dropdown menu.

Notes:

- After an item is included in a kit, the item cannot be deleted from the system.

- Kits are non-stock items, therefore inventory is not kept for the kit itself, and
kits are not added on cargo operations such as Pickup Orders, Warehouse
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Receipts, Cargo Releases, Shipments, etc. Only the individual items can be 
added to these operations transactions, so the items can be picked and packed 
in the warehouse in any order.

Add a Kit to a Commerce Quote

To add kits to a Commerce Quotation, create the quote as you normally would. 
On the Commodities tab, enter the kits by clicking the “Add” button. Note that 
the kit icon is different from a regular item (the icon is in the “Status” column). 
Also note the kit price.

Options:

• To view items inside a kit, select the kit and click the “Kit” button.

• To ungroup items from the kit, click “Ungroup.” The prices of individual
items will be displayed. Note: A kit item cannot be ungrouped after it is
invoiced or after the kit charge is created on a Cargo Release or Shipment.

After the quote is completed, it can be converted as usual to many other trans-
actions such as an Invoice, Purchase Order, Sales Order, Pickup Order, Ware-
house Receipt and Shipment.

When an invoice is created, the kit price is displayed, not the individual item 
prices.

When a Sales Order is created from a Commerce Quote, the SO shows the kit. 
The system searches for the items in the available inventory and in arriving 
items. It creates backordered items if no items are on hand or arriving (and if 
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the Configuration is set to enable this step). If the items cannot be resolved, the 
SO will not be created.

Add a Kit to a Sales Order

Create a Sales Order (SO) as usual, and add the kits to the Commodity tab.

If there is at least one backordered item in the kit, the status of the kit will be 
Backordered. The system updates the kit status as items are being loaded or 
processed in different transactions. If items are ordered online, the system func-
tions the same way.

Create an Invoice from a Sales Order:

To create an invoice from a Sales Order document, click Actions and select 
“create Invoice.” The kit price is displayed, not the individual item prices.

Create a Shipment or Cargo Release from a Sales Order:

When you create a shipment or a Cargo Release from a Sales Order that has a 
kit in it, the items that constitute the kit can be picked and packed as needed. If 
some items are backordered, the on hand items can be shipped first.

If the invoice for a SO has not been created and the kit items in the SO are loaded 
onto a Cargo Release or Shipment, then a charge is added to the operation for 
the entire kit. This happens even if the kit is shipped partially because the price 
is per kit, not per individual item. This charge can be removed from the opera-
tion and to prevent it from being included in the consolidation of the operation 
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until the full order is shipped. When the remaining items are added to a future 
shipment, then the kit charge will be added again to ensure the client is invoiced.

Commissions on Kits:

Sales person’s commissions on kits are calculated based on the cost of the kit, 
and the kit price will be used for the profit calculation.
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Purchase Order 39
Purchase Orders 223

cancel 236
convert into a Bill 239
convert to Pickup Order 236
convert to WR 236
exclude from tracking 236
how to create 225
 iv



item status 237
online tracking 238

Purchasing 224
Put Away items with scanner 442

Q
Query rates 471
Quick Booking

set up 488
Quotation 31

cargo 457
create other transactions from a 468
view history of 469

R
Receive cargo with Magaya WMS Mobile
handheld devices 410
Receive identical items 431
Receiving Task 411
Refrigerated 353
Release cargo 583

using Magaya WMS Mobile handheld de-
vices 617
Repack cargo 713
Replenish inventory notice 103
Replenishment setting 104
Reports

In and Out 564
Inventory 560

Request Date, in a PO 234
Requested arriving pieces 561
Requested pieces 561
Resale inventory item 255
Resale items 120
Restrict adding items into Sales Orders 244
Returned items 328
Roles, how to assign 66
Route reports 782
Route, select in shipment 644
Routes 774, 777

add costs 779
add segment to 778
all in one charge 779
Charges 782
rates override system 781
use in a shipment 781

well formed 778

S
Sale price time limit 152
Sales Order 39
Sales Orders 242

allocate locations 244
cancel 255
convert into Invoices 263
generate commissions 256
how to create 244
online tracking 258
status of items 257

Scan attachments 384
Scan cargo for receipt 363
Scan items

verify packing list 718
Schedule B codes 202
Search 556
SED 33
Segment 775

cost 776
freight charges 776

Serial number
on Inventory Item Definition 102

Serial numbers on labels 215
Serial numbers, receiving 347
Service Type, Port to Port 669
Shipment General tab 685
Shipment List 744
Shipment reports 747
Shipment Routing tab 690
Shipment screen 682
Shipment screen, widen panels 685
Shipment Statistics 748
Shipment Toolbar 683, 707
Shipments 639

add documents to House 675
add freight charges 700
agent profit sharing 732
copy 685
create a consolidated export shipment 665
create a straight shipment 640
Documents, email 725
Edit 737
Generate charges 735
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link document 683
Liquidation 727
print documents 720
Proof of Delivery 695
reload data 683
set in transit 710
split Houses 653
verify charges 711
view history 711

Shipper Export Declaration 33
Shipping charges 700
Shipping instructions to INTTRA 652, 678, 711
Shipping labels 219
Signatures, electronic 696
SKU 100
Startup Wizard 43
Statement, customer’s shipment details 739
Straight Bill of Lading 549
Subhouses 653
Supply chain 29
Systems administrator 49

T
Tasks

Load 634
Pick 618

Tax, split transactions 737
Taxes

display in Quotation 470
Thermal labels 394
Third-party logistics provider 31
Tracking Details 378
Trip Schedule 497

copy a 506
create a consolidation from a 505
view history 506

Trucks as mobile locations 542

U
Uninformed Receiving 422
Unpack icon 364
US Customs 709

V
Variable weight, in a PO 236
Variable weight, receive item 345
Vehicle EEI filing 710
Verify Packing List 717

W
Warehouse Inspector 510
Warehouse Location

Set Default 342
Warehouse locations 157
Warehouse locations, how to add 164
Warehouse Receipt 326

add commodities 339
create 327

Warehouse Receipt number 329
Warehouse transfers 542

status 548
Warehouse zones 157
Watermark, print 722
Weight, variable 102
Wholesalers

Overview of processes in Magaya Supply
Chain Solution 6
Wireless requirements 72
WMS Mobile

handhelds supported 73
save task 416
scanner signal 536

Work Load folder 750
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